
 



 

Support 
At LEIGHTRONIX, every customer of our standard product line 
gets free support for the life of their product at no extra charge. 
There are no service contracts, no annual renewals, no allowances, 
no deductibles, and no exclusions. 
Benefits include: 
 
In addition to a 5 year hardware warranty, benefits include access to: 
 

 Priority toll-free telephone support 

 Email support 

 Online support, desktop to desktop via Webex® 

 Software updates 

 Firmware updates 

 Assistance with updates 
 

Phone: (800) 243-5589  
Email: support@leightronix.com 

Product Registration 
Be sure to register your new UltraNEXUS-HD video server at 
supportcenter.leightronix.com to receive all of the additional online 
product support benefits. 
 
Along with email notifications on product updates and introductions, benefits include 
access to: 
 

 Our 24/7 online Support Center 

 Software and firmware updates 

 Product training videos 

 Product diagrams and images 

 Tutorials and white papers 
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Introduction 

The UltraNEXUS-HD video server/controller is a multi-function device that: 

 Plays high-definition (HD) and standard definition (SD) video with accompanying 
audio 

 Records HD and SD video with accompanying audio 

 Supports embedded, balanced AES, and balanced analog audio input and output 
signals 

 Includes a programmable scheduler for automated playback and recording 
functions 

 Includes a dedicated graphics generator which is used to play slides and 
generate overlays that are superimposed upon playing video 

 Includes the ability to control compatible external routing switchers 

 Allows for flexible media storage via external USB hard drive and/or network 
attached storage (NAS) 

 Publishes a programmed schedule to a Web framework or by way of an 
embedded code 

 Provides a rich, Web-based graphics editor 

 Outputs an SD replica of the main output (HD or SD) as a composite video signal 

Included with the UltraNEXUS-HD is WinLGX, a software application that provides all of 
the tools necessary for local and remote system operation. WinLGX offers a system 
control panel, digital media resource library, and an easy-to-use, drag-and-drop 
scheduling interface. 
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Important Safety Instructions 

Read these instructions. 

Keep these instructions. 

Heed all warnings. 

Follow all instructions. 

Do not use this apparatus near water. 

Clean only with dry cloth. 

Do not block any ventilation openings. Install in accordance with the manufacturer’s 
instructions. 

Do not install near any heat sources such as radiators, heat registers, stoves, or other 
apparatus (including amplifiers) that produce heat. 

Do not defeat the safety purpose of the grounding-type plug. A grounding-type plug has 
two blades and a third grounding prong. The third prong is provided for your safety. If 
the provided plug does not fit into your outlet, consult an electrician for replacement of 
the obsolete outlet. 

Protect the power cord from being walked on or pinched particularly at the plugs, 
convenience receptacles, and the point where they exit from the apparatus. 

Only use attachments/accessories specified by the manufacturer. 

Unplug this apparatus during lightning storms or when unused for long periods of time. 

Refer all servicing to qualified service personnel. Servicing is required when the 
apparatus has been damaged in any way, such as power-supply cord or plug is 
damaged, liquid has been spilled or objects have fallen into the apparatus, the 
apparatus has been exposed to rain or moisture, does not operate normally, or has 
been dropped. 

When the apparatus is turned off, certain components in the power supply and system 
board remain energized. In order to remove all electrical power from the apparatus, 
unplug the power cord from the MAINS socket outlet. 
 

 
WARNING 

To reduce the risk of electric shock, do not expose this apparatus 
to rain or moisture. 

 
WARNING 

This apparatus must be connected to a MAINS socket outlet with a 
protective earthing connection. 
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Features/Specifications 

NOTE: In no event shall LEIGHTRONIX be liable for any damages whatsoever 
resulting from loss of use, data, or profits, whether or not advised of the 
possibility of damage, and on any theory of liability, arising out of or in 
connection with the use or performance of the UltraNEXUS-HD high-definition 
server/system controller and WinLGX software. 

 

FEATURE SPECIFICATIONS 

Dimensions 1.75"H X 19.0"W X 8.0"D  

Weight, without carton or 
cables 

6.4 lbs. 

Display 2 X 16 character liquid crystal display 

Keypad Six push buttons which allow password protected front 
panel status and configuration 

Power Supply Internal power supply which accepts 90–264VAC @ 47–
63Hz 

Product Safety Audio, Video and Similar Electronic Apparatus — Safety 
Requirements certification by ETL Semko for U.S. 
Standards (UL-60065) and Canadian Standards 
(CAN/CSA C22.2 No. 60065) 

Emissions Compliance FCC Part 15 

Hardware Encoder 
(Recorder) 

 One HD/SD digital video channel, operating as a 
recorder 

 H.264 High Profile video encoding, HD Level 4 and SD 
Level 3 

 ACC-LC audio encoding 

 Automatic video and audio multiplexing during 
recording results in a single MPEG-2 transport stream 
(.m2t) file containing an H.264 High Profile video 
stream and AAC-LC audio. 

 Supports HD-SDI (1080i and 720p) and SD-SDI (480i) 
recording 

 High Definition 

o 1920 x 1080 (29.97 Hz Interlaced, IBP group of 
pictures [GOP] structure) 

o 1280 x 720 (59.94 Hz progressive, IBBP GOP 
structure) 
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FEATURE SPECIFICATIONS 

 Standard Definition: 720 x 480 (29.97 Hz interlaced, 
IBBP GOP structure) 

 4:2:0 Chroma subsampling, 8-bit, YCbCr 

 Variable video bit rate encoding up to 10 Mb/s 

 48 KHz audio sampling frequency with audio bit rates 
of 128, or 192 Kb/s 

Hardware Decoder (Player)  Supports playback of the following formats: 

 MPEG-2 Transport stream (.m2t) 

 Video codec: H.264 HIGH profile, up to level 4.0 

o 1920 x 1080 (29.97 fps, interlaced) 

o 1280 x 720 (59.94 fps, progressive) 

o 720 x 480 (29.97 fps, interlaced) 
o Constant and variable video bit rate 

encoding up to 10 Mb/s 
o Chroma sampling: 4:2:0 

 Audio format: AAC-LC, Layer-2 

o AAC-LC 128 kb/s, 192 kb/s 

o Layer-2 128 kb/s, 192 kb/s, 224 kb/s, 256 kb/s 

o 44.1 kHz, 48 kHz 

 MPEG-2 Program stream (.mpg) 

 Video codec: MPEG-2 program stream, MAIN 
profile, MAIN or HIGH level 

o 1920 x 1080 (29.97 fps, interlaced) 

o 1280 x 720 (59.94 fps, progressive) 

o 720 x 480 (29.97 fps, interlaced) 

o 352 x 480 (29.97 fps, interlaced) 
o Constant and variable video bit rate 

encoding up to 10 Mb/s 
o Chroma sampling: 4:2:0 

 Audio format: Layer-2 

o 128 kb/s, 192 kb/s, 224 kb/s, 256 kb/s 

o 44.1 kHz, 48 kHz 

 MPEG-4 (.mp4) 

 Video codec: H.264 HIGH profile, up to level 4.0 

o 1920 x 1080 (29.97 fps, interlaced) 

o 1280 x 720 (59.94 fps, progressive) 

o 720 x 480 (29.97 fps, interlaced) 
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FEATURE SPECIFICATIONS 

o Constant and variable video bit rate 
encoding up to 10 Mb/s 

o Chroma sampling: 4:2:0 

 Audio format: AAC-LC 

o 128 kb/s, 192 kb/s 

o 44.1 kHz, 48 kHz 

 MOV (.mov) 

 Video codec: H.264 HIGH profile, up to level 4.0 

o 1920 x 1080 (29.97 fps, interlaced) 

o 1280 x 720 (59.94 fps, progressive) 

o 720 x 480 (29.97 fps, interlaced) 
o Constant and variable video bit rate 

encoding up to 10 Mb/s 
o Chroma sampling: 4:2:0 

 Audio format: AAC-LC 

o 128 kb/s, 192 kb/s 

o 44.1 kHz, 48 kHz 

 

Digital Video Input/Output  One BNC-F HD/SD-SDI video input 

 One BNC-F HD-SDI video output (HD-SDI signal pass-
through not available) 

 Society of Motion Pictures and Television Engineers 
(SMPTE) standards for inputs/outputs: 

 HD: SMPTE292M 

 SD: SMPTE259M 

 Support for embedded audio 

Analog Video Input/Output  One BNC composite video input (not used) 

 One BNC composite video output 

 NTSC composite video 1Vp-p 

Digital and Analog Audio 
Inputs/Outputs 

 Digital AES balanced audio connections 

 Analog balanced audio connections 

Secured Digital (SD) Card 8 GB SD Card for operating system and other system 
files.  

Warning: Do not remove the SD card during 
operation. Serious damage may occur. 

Internal Hard Drive 1 TB of storage, of which 32 GB is reserved for system 
processing and information, including schedule and log 
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FEATURE SPECIFICATIONS 

files, and 968 GB is partitioned for temporary digital video 
storage 

NOTE: To preserve the life span of your internal hard 
drive, primarily record and store your digital 
video on external USB hard drives and/or NAS 
storage devices. 

Three RS-232 Serial 
Interface “COM” Ports 

 Control up to 250x250 inputs/outputs on a compatible 
external switcher  

 Terminal communications 

Ethernet Network Host 
Management 

 Network Support Interface: 

 Eight-position, eight-conductor RJ-45 modular jack, 
10/100/1000 BASE-T, unshielded twisted pair, 
Ethernet 

 Ethernet II frame type 
 Protocol: TCP/IP 
 Services: Telnet, FTP, and HTTP 

 Remote system management via TCP/IP network 

 Digital media upload/download capabilities 

Logging Internal, file-based 

Firmware Updateable via Ethernet 

WinLGX Software  Compatible with Windows® 7/8/10 operating systems 

 Standalone operation 

 Event capacity: 3000 

 Control modes: 

 Drag and drop event scheduling with error checking 
and conflict reporting 

 System control panel for immediate control 

 Library stores up to 6000 resources, including digital 
video files 

Web Interface  Connects to your UltraNEXUS-HD server’s IP address 
with Edge, Chrome, Firefox, and Safari Web browsers 

 Password protected with user rights maintained from 
WinLGX 7 

 Contains system status and digital storage drive 
information, configures and activates Virtual Channels, 
and view current schedule 

 Controls the transfer of digital video files to another 
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FEATURE SPECIFICATIONS 

UltraNEXUS-HD, LEIGHTRONIX VieBit Video-On-
Demand Streaming Service, or third party server (FTP 
capable) 
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Device Control Options 

FEATURE SPECIFICATIONS 

External, Scalable File 
Storage 

Increase file storage capacity with up to two external USB 
hard drives purchased from LEIGHTRONIX.  
LEIGHTRONIX formats each drive with an EXT3 file 
system and a digital video file directory. 

Each USB drive used with the UltraNEXUS-HD must be:     

 Only used to store digital video files 

 Powered on until the UltraNEXUS-HD is shut down. 

 Only removed or installed after the UltraNEXUS-HD 
is shut down.  Do not connect the drives to a PC 
for file management operations.  

The UltraNEXUS-HD supports a total USB drive storage 
capacity of 4 TB. 

For more information on using USB drives with the 
UltraNEXUS-HD, refer to www.leightronix.com or contact 
LEIGHTRONIX at (800) 243-5589. 

See “Digital Video Recorder Specifications,” on page 23, 
for information on the server’s digital video recording 
rates. 

Support for NAS 
Storage/Expanded 
Channel Capacity 

Included TOTAL SHARE option provides support for an 
additional 16 Terabytes of digital media storage.  TOTAL 
SHARE allows users to create a dedicated, high-speed 
network that supports a combination of up to four 
UltraNEXUS-HD units and up to four network attached 
storage (NAS) devices 

Support for Compatible 
External Routing Switcher  

Control up to 250x250 inputs/outputs on a compatible 
external switcher 

ePRO-BUS Control NOTE: The ePRO-BUS feature is included with the 
UltraNEXUS-HD. 

 Control up to 16 devices by sending PRO-BUS 
commands over your Ethernet network 

 Compatible with select LEIGHTRONIX controllers 

 Provides two or four function control 

http://www.leightronix.com/
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Slide, Overlay, and Background File Specifications 

Slides, overlays, and backgrounds may be created with third-party graphic software, 
including Adobe Photoshop® and Corel PaintShop Pro®, as long as each is saved with 
the supported file format. 

NOTE: Slides/overlays with resolutions larger than 1920 x 1080 cannot be uploaded 
to the UltraNEXUS-HD. 

Slides 

 Slide resolutions (pixels) 

Slides for the UltraNEXUS-HD must be created as 1920 x 1080 images. 

 Save slides as JPEG (.jpg) files. Slide filenames may contain up to 27 characters 
(no spaces or symbols) in addition to the required “.jpg” extension. 

 Maximum slide file size is 2 MB. 

 Use RGB color space. Avoid CMYK. 

Overlays 

 The recommended overlay resolution (pixels)  is 1920 x 1080. 

 Save overlays as PNG (.png) files. PNG files support transparency and allow overlay 
graphics and text to layer over digital programming without blocking the entire 
screen. Overlay filenames may contain up to 27 characters (no spaces or symbols) 
in addition to the required “.png” extension. 

Slide Backgrounds 

Background files are used in the WebNEXUS slide editors for slide creation.  Upload to 
your WebNEXUS slide editor through the WinLGX Storage Manager window (see 
“Managing Storage of Video, SLIDE, and OVERLAY Files,” on page 253, for more 
details). 

 Recommended background resolutions (pixels) 

Images of any size resolution may be uploaded to a WebNEXUS slide editor, but 
keep in mind the editor’s slide creation area and save resolution is 1920 x 1080. 

 Backgrounds may be saved as either JPEG (.jpg) or PNG (.png) files.  Background 
filenames may contain up to 27 characters (no spaces) in addition to the required 
“.jpg” or “.png” extension. 
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Digital Video Recorder Specifications 

NOTE: Video being fed to the UltraNEXUS-HD digital video recorder must have a 
stable signal. If you are unsure of the stability of the signal being fed to the 
UltraNEXUS-HD, the use of a frame synchronizing switch or standalone 
device in-line prior to the UltraNEXUS-HD input is recommended. 

NOTE: The maximum recorded file length allowed by the UltraNEXUS-HD is 23 
hours, 59 minutes, and 50 seconds.   

Digital video recording results are based on a combination of the user-defined record 
presets and the quality of the input source. In each new UltraNEXUS-HD image file, the 
record presets for the internal digital video player/recorder contain default settings under 
the names “Good,” “Better,” and “Best,” as shown in Illustration 1. 

Illustration 1, UltraNEXUS-HD Default Recording Presets 

 

You may use the default recording presets or change the presets based on your 
recording needs. When selecting your recording presets, consider how video bit rate, 
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video resolution, and audio quality settings will affect the quality and file size of your 
recordings (refer to the following sections for more information). Once you have 
selected your recording presets, create short files for playback on your UltraNEXUS-HD 
to test the quality of your presets. 

 Video Bit Rate 

The size and overall quality of your file is directly related to the selected video bit 
rates. The H.264 High Profile video compression standard used by the UltraNEXUS-
HD for encoding allows you to create files with high quality video at lower bit rates. 
Higher bit rates result in higher quality recordings, but keep in mind that your file 
sizes will be larger and you will be able to fit less video onto your storage devices.   

NOTE: Digital video recording does not improve the quality of your input sources.  
When recording a low quality source, use higher bit rate settings to record 
a digital file of equal quality.   

 Variable Bit Rate (VBR)  

The UltraNEXUS-HD encodes using a variable bit rate. When VBR is used for 
recording, the UltraNEXUS-HD records most of the source at the selected 
minimum bit rate. WinLGX allows you to select a minimum bit rate between 1.50-
10.00 Mb/s, at intervals of .10. The lowest recording quality results at a minimum 
bit rate of 1.50 Mb/s and the best at 10.00 Mb/s. 

The video maximum bit rate does not impact file size. The UltraNEXUS-HD only 
records at the maximum bit rate when there is a lot of movement in the source 
and returns to the minimum bit rate when the movement decreases.  The 
maximum bit rate must be set at least 2 Mb/s above the minimum bit rate. 

 Video Resolution 

The picture quality of your recorded video also depends on the video resolution. The 
UltraNEXUS-HD will record a video signal at its native resolution. During playback it 
will scale the file to match the UltraNEXUS-HD’s output resolution setting – normally 
1080i. Keep in mind that the UltraNEXUS-HD (or any recorder) cannot improve the 
quality of a video signal and if it requires scaling up this will not improve its quality. 
Resolution setting options for the UltraNEXUS-HD recorder are as follows: 

 The UltraNEXUS-HD recorder has two resolution setting options: 4:3 or 16:9.  

 HD-SDI content: The UltraNEXUS-HD will ignore this setting – it is 16:9. 

 SD-SDI content: Select either “4:3” or “16:9” to match the input signal. 

 Audio Quality Settings 

 Audio bit rate: select 224 or 256 kb/s for sources with audio tracks or 192 kb/s for 
sources with little or no audio. 

 Audio sample rate: the 48k sample rate captures data from the audio signal 
48,000 times per second to ensure high quality audio recording.   
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UltraNEXUS-HD Front Panel 

The UltraNEXUS-HD’s front panel layout includes, from left to right, top to bottom (see 
Error! Reference source not found.): 

Illustration 2, UltraNEXUS-HD Front Panel 

 
 

 A: Display — View system status, diagnostic information, and current 
configurations through the UltraNEXUS-HD’s LCD display. (See Display 
Screens section below.) 

 

 B: Keypad — The UltraNEXUS-HD server has a six-button keypad for 
displaying system information, configuring network addresses, rebooting 
and shutting down/starting up the unit.  The four arrow keys are used to 
display status information as well as for the entry of TCP/IP network 
addresses. If you hold down an arrow key for more than one second, it 
begins to scroll through all of the available options. Release the key when 
the desired option is displayed. 
 
The front panel keypad also reboots the UltraNEXUS-HD.  When held for 
10 seconds, the green check button reboots the UltraNEXUS-HD.   
 
The front panel keypad also shuts the UltraNEXUS-HD down. When held 
for 8 seconds, the red “X” button shuts down the UltraNEXUS-HD.  After it 
shuts down the front display will read, “System halting Remove power” at 
that point use the power switch on the back to turn the power off. To turn 
the UltraNEXUS-HD back on, move the power switch to the on position. 
 

 C: 2 RJ-45 Ethernet jacks with corresponding LED indicators 

 Ethernet port (1): 10/100/1000 BASE-T 

 Ethernet port (2): 10/100/1000 BASE-T (Cannot be on same subnet as 
port 1) 

 D: “COM 1” communication port with 9-pin male RS-232 connectors for use 
with a LEIGHTRONIX-compatible external switcher with an input/output 
capacity of 4x4 (minimum) to 250x250 (maximum), or Host mode (factory 
testing) for terminal communications. 

 E: Secured Digital (SD) Card — The UltraNEXUS-HD SD card contains 
operating system and other system files.  

Warning! Do not remove the SD card during operation. Serious damage 
may occur. 
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Display Screens 

After the UltraNEXUS-HD has been booted up, press the up or down arrows on the 
server’s keypad to display the following status screens: 

NOTE: The status screens are currently subject to change. 

 Video Playback Status 

The bottom line of this screen shows the playback status for the UltraNEXUS-HD 
digital video player (see Illustration 3, Digital Video Playback Status Screen). When 
the UltraNEXUS-HD is playing a video file, the playback time is indicated on the 
bottom line of the screen. 

Illustration 3, Digital Video Playback Status Screen 

 Serial Number 

The bottom line of this screen displays your UltraNEXUS-HD serial number (see 
Illustration 4, Serial Number Status Screen). 

Illustration 4, Serial Number Status Screen 

 IP Address 

The bottom line of this screen displays the IP address for Ethernet port 1 on the 
UltraNEXUS-HD (see Illustration 5, IP Address Status Screen). 

Illustration 5, IP Address Status Screen 

 

 Internal Voltage (Support use) 

The bottom line of this screen displays the voltages of the UltraNEXUS-HD 
processor (see Illustration 6, Processor Voltage Status Screen). 

Jul 21  10:42:37 

01   00:0:01:07 

Jul 10  10:42:37  

SN: 100012 

Jul 10  10:42:37 

IP: 10.16.0.18 
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Illustration 6, Processor Voltage Status Screen 

 Temperature   

The bottom line of this screen displays the internal temperatures of your 
UltraNEXUS-HD server (see Illustration 7, Temperature Status Screen). 

Illustration 7, Temperature Status Screen 

 Schedule Day (future use) 

The bottom line of this screen displays the current day of the UltraNEXUS-HD server 
(see Illustration 8, Current Day Status Screen). 

Illustration 8, Current Day Status Screen 

 Firmware Version 

The bottom line of this screen displays the firmware version of your UltraNEXUS-HD 
server (see Illustration 9, Firmware Version Status Screen). 

Illustration 9, Firmware Version Status Screen 

 UP Time 

Jul 21  10:42:37 

I1: 3.625 I5: 1.25 

Jul 10  10:42:37  

T1: 35C T2: 42.250 

Jul 10  10:42:37  

Day 3 of 7 

Jul 10  10:42:37  

V16.06.30.1613 
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The bottom line of this screen displays how long the UltraNEXUS-HD has been 
running since its last reboot or power up (see Illustration 10, Up Time Status 
Screen). 

Illustration 10, Up Time Status Screen 

 

Jul 10  10:42:37 

UP: 0:04:20 
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UltraNEXUS-HD Rear Panel 

The UltraNEXUS-HD’s rear panel layout includes, from left to right, top to bottom (see 
Illustration 11, UltraNEXUS-HD Rear Panel): 
 

Illustration 11, UltraNEXUS-HD Rear Panel 

 

 A: “COM 2” — RS-232 port with 9-pin male connector for serial 
communications (not used) 

 B: BNC Serial Digital Interface (SDI) input and output connectors 

 C: Audio input and output tension clamp terminal blocks for analog or AES 
digital audio connections 

 D: BNC composite video input and output connectors (input not available) 

 E: “COM 3” — RS-232 port with 9-pin male connector for serial 
communications (not used) 

 F: 2 USB 2.0 ports for external USB hard drive connections 

 G: Internal Solid State Drive (SSD) — The UltraNEXUS-HD comes equipped 
with a one terabyte (1TB) SSD for digital media storage. NOTE: The 
internal SSD is non-serviceable. 

 H: Cooling fan 

 I: Power switch — use to turn the unit on/off. Press the red “X” button on the 
front panel for 8 seconds to shut the unit down before powering off. 

 J: Power cord connector 
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Server Installation & Configuration 

About this Section 

Use this section for step-by-step instructions on connecting your UltraNEXUS-HD 
system wiring, including devices and Ethernet. This section also includes information on 
entering your TCP/IP and serial settings through the front panel.   

 

Packing List 

Ensure your UltraNEXUS-HD shipment box contains the following: 

 (1) UltraNEXUS-HD High-Definition Video Server 

 (1) (1) Part #10-0311, AC Power Cord, 6 ft. 

 (1) Part #10-4856, CAT 5e Ethernet Cable, 7 ft. 
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Connecting UltraNEXUS-HD Signal Wiring  

Throughout the following instructions, refer to Illustration 11, UltraNEXUS-HD Rear 
Panel and Error! Reference source not found.. 

Mount your UltraNEXUS-HD in an equipment rack as follows, ensuring the ventilation 
fan on the back of the unit is not covered and adequate space is available behind the 
back panel for the USB hard drives: 

 
NOTE: LEIGHTRONIX recommends leaving an empty space above and below 

the UltraNEXUS-HD. The UltraNEXUS-HD is not intended to have 
anything stacked on top of it. 

a. Insert the UltraNEXUS-HD into the rack, aligning the holes of the server’s 
mounting bracket with those of the rack. 

b. Secure the UltraNEXUS-HD to the rack with user-supplied rack screws.  

 

The UltraNEXUS-HD is compatible with the external switchers listed in Table 1 and 

supports switcher input/output capacities of 4x4 (minimum) to 250x250 (maximum).  

Install your switcher according to the following steps: 

NOTE: Contact the routing switcher manufacturers listed below for help 
in selecting specific models. 

a. Connect the switcher to the UltraNEXUS-HD’s “COM 1” port. (Future firmware 
should allow the choice to use the “COM 3” port if desired.) 

b. Configure your switcher according to the corresponding parameters listed in 
Table 1, Supported External Switchers and Parameters. This is necessary to 
ensure your switcher works with the UltraNEXUS-HD. 
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Table 1, Supported External Switchers and Parameters 

SUPPORTED SWITCHER OPTIONS SWITCHER SERIAL PARAMETERS 

AMX/Autopatch  

8Y-XL™, 4YDM™, EPICA™, Precis™ and Optima™ 
Switchers Using BCS Protocol 

9600 baud, 8N1 (Level 1: Video, Level 0: All) 

Blackmagic Design 

Smart Videohub 12x12 
And 

Smart Videohub 16x16 or 40x40, Micro Videohub, 
Compact Videohub 

9600 baud, 8N1 

Cable RS-2/3J from Addenda.com or Ethernet control 
(requires firmware addition) 

Cable RS-2/3R from Addenda.com or Ethernet control 
(requires firmware addition) 

EXTRON A (most common) & B (ISS 
series) 

MAV, Crosspoint, Matrix 

9600 baud, 8N1 

KNOX  

Chameleon 64 & 64i, RS Series, ProSwitch Series 

9600 baud, 8N1 

KRAMER 

Switchers Using Communications Protocol 2000; contact 
Kramer to determine if null or straight cable is needed 

9600 baud, 8N1 

Imagine Communications/Harris/Leitch 

Platinum™, VIA 32™, X-Plus™, Integrator™, and 
Panacea™ 

9600 baud, 8N1 

PESA Serial 

Routing Switchers supporting CPU Link Serial Protocol 

9600 baud, 8N2 

PESA P1N Network 

Routing Switchers supporting P1N Network Protocol 

N/A 

SIERRA 

Aspen, Lassen, Ponderosa, and Yosemite 

9600 baud, 8N1 

SIGMA A & B 

Dagger Series, ADX Series, MRX Series, SLX Series, 12X, 
2100 Series, 3200 Series, and 9600 Series 

9600 baud, 8N1 

UTAH A 38400 baud, 8N1 

UTAH B 1200 baud, 7E2 

UTAH Sandar 9600 baud, 7O1 

c. Route the video/audio from any studio/satellite feeds, character generator, 
etc. to the switcher input connectors.   

d. Connect switcher output connectors to the desired destinations (such as 
modulators or television monitors). 

Connect playback destinations to the UltraNEXUS-HD’s SDI or CVBS video outputs as 
follows: 

 SDI Out: Connect the desired destination or switcher input to the 
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UltraNEXUS-HD SDI video output. 

 CVBS Out: Connect the desired destination or switcher input to the 
UltraNEXUS-HD composite video output. 

Connect video sources for recording to the UltraNEXUS-HD’s SDI video input as 
follows: 

 SDI Input: Connect the desired video source or switcher output to the 
UltraNEXUS-HD SDI video input. 

 CVBS IN: Not available.  

 
Your UltraNEXUS-HD audio connections are determined by the type of audio signal you 

wish to record and play out, as described below: 

 Embedded Digital Audio: part of your digital video signal; no additional audio 
connections are needed to play or record this type of audio signal. 
Non-Embedded Audio Signals: the UltraNEXUS-HD supports two-channel 
analog and AES balanced digital audio signals. The UltraNEXUS-HD server 
comes equipped with two audio terminal blocks for playing/recording your non-
embedded audio signals (see Illustration 12).  

Illustration 12, Audio Terminal Blocks on Rear Panel of UltraNEXUS-HD Server 

 

 

To play/record any of the UltraNEXUS-HD’s supported, non-embedded audio 
signals, connect your audio signal wiring according to the following steps: 

NOTES:  The illustrations for the following examples show the terminal 
blocks in vertical positions.  

 When connected to the rear panel, the blocks are horizontal with the 
AES terminals on each block rotated toward its “SDI IN” BNC video 
input. 

  The UltraNEXUS-HD supports an audio wiring gauge range of 18 
(maximum) to 28 (minimum) AWG. 

a. Prepare your audio wiring for connection to the terminal blocks by stripping 
approximately a 1/4 inch of shield off the end of each wire. Twist each wire’s 
individual strands together to prevent separation. 

 
 

Illustration 13, Example of Wire Prepared for an UltraNEXUS-HD Server Terminal Block 

Audio Output 
Terminal Block 1  
For Playback on 

Channel 1 

Audio Input  
Terminal Block 1  
For Recording on 

Channel 1 
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b. Perform the following steps for the UltraNEXUS-HD to play and/or record non-

embedded audio (refer to Illustration 12, Audio Terminal Blocks on Rear Panel of 
UltraNEXUS-HD Server). 

i. With your fingers, gently grasp the desired terminal block on the UltraNEXUS-
HD’s rear panel and pull to separate the block from the server.  

ii. Secure each of your prepared audio wires in their appropriate terminals as 
follows, referring to Table 2 for each wire’s placement on the terminal block: 

Table 2, Non-Embedded Audio Terminal Block Configurations 

AES  
Terminal Block Configuration 

Two-Channel Analog  
Terminal Block Configuration 

  

 

NOTE: The above diagrams are rotated clockwise 90 degrees so the 
actual unit connections would look as follows: 

  

 

Terminals 

Shield Stripped from 

End of Wire 

NOTE: The AES audio 
configuration uses 
only one of either 
common ground 

terminal. 
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AES  
Terminal Block Configuration 

Two-Channel Analog  
Terminal Block Configuration 

Illustration 14, Example of AES Terminal 
Block Wiring 

 

Illustration 15, Example of Two-Channel 
Analog Terminal Block Wiring 
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(1) Using a slotted, pocket clip screwdriver with a maximum tip width of 
2.5mm and thickness of .4mm, open the terminal’s tension clamp by 
inserting the screwdriver tip into the clamp’s corresponding tension 
release slot (see Illustration 16 for an example). Firmly push the 
screwdriver into the slot until the clamp in the bottom of the terminal 
slides open (see Illustration 17). 

Illustration 16, Tension Clamp Release Slot on an UltraNEXUS-HD Server Terminal Block 

 

 

 

 

 

 
 

Illustration 17, Screwdriver Inserted into Tension Clamp Release Slot 

 

Terminal 

Tension Clamp 
Tension Clamp 

Release Slot 
(highlighted to 

illustrate) 
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(2) Insert the audio wire into its corresponding terminal until it touches the 
bottom. 

(3) While holding the wire in place, pull the screwdriver from the slot. The 
wire should now be clamped into place and should not fall out of the 
terminal if gently tugged. 

(4) Repeat steps b.ii(1)–(3) for each of the remaining terminals in your audio 
terminal block configuration. 

iii. Push the wired terminal block back into its slot on the rear panel of the 
UltraNEXUS-HD server, with the AES terminals on the block rotated towards 
BNC video input (“SDI In”). The block only fits one way into its holder on the 
rear panel. 

Attach up to two, LEIGHTRONIX-approved USB hard drives to the USB ports. The 
UltraNEXUS-HD system can support up to 4 TB of storage. For more information on 
USB drives compatible with the UltraNEXUS-HD, refer to www.leightronix.com or 
contact LEIGHTRONIX at (800) 243-5589. 

NOTE: USB drives can be removed or installed only after the UltraNEXUS-HD 
is shut down from its front panel.  Do not connect the drives to a PC 
for file management operations. 

Attach the included power cord to the power cord connector on the back of the 
UltraNEXUS-HD, and then plug it into an AC power source.  

 
CAUTION 

LEIGHTRONIX strongly recommends the use of an 
Uninterruptible Power Supply (UPS) with the UltraNEXUS-HD and 
associated USB drives. Damage from power loss or spikes is not 
covered under warranty. 

Turn on the UltraNEXUS-HD by using the power switch on the back of the unit.  

NOTE: The UltraNEXUS-HD can be shut down by pressing the red “X” button on 
the front panel for 8 seconds.  After it shuts down the front display will 
read, “System halting remove power” at that point use the power switch on 
the back to turn the power off. To turn the UltraNEXUS-HD back on, move 
the power switch to the on position. 

The UltraNEXUS-HD will automatically boot up and display the boot up progress 
screens shown in Illustration 18, Boot Progress Screens. During startup, any saved 
UltraNEXUS-HD settings and active schedule are implemented. 

Illustration 18, Boot Progress Screens 

Main Power ON 

Now Booting ... 

http://www.leightronix.com/
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Proceed to “Configuring Ethernet Network Host Management,” on page 40, to configure 
the UltraNEXUS-HD for remote control through Ethernet network host management. 

  

Starting Up ... 
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Configuring Ethernet Network Host Management 

NOTES:  Your PC must have a Windows 7/8/10 operating system in order to run 
WinLGX 7 software (see “WinLGX Minimum System Requirements,” on 
page 53 for further details). 

  Each UltraNEXUS-HD system requires the following ports: 
 23 (Telnet) 
 21 (FTP Control Connection) 
 20 (FTP Data) 
 80 (HTTP — UltraNEXUS-HD Web Interface) 
 443 (HTTPS — UltraNEXUS-HD Web Interface) 
 2000   (UDP): needed for ePRO-BUS control  
 50001 (Web Program Guide): This port can be changed from the 

UltraNEXUS-HD front panel. 
  If you will be connecting to your UltraNEXUS-HD system remotely, the 

following ways can be used to set up your router to access your 
UltraNEXUS-HD system. Keep in mind that more than one method can 
be used, such as VPN, for WinLGX 7 access and port forwarding for 
program guide access. Consult your network administrator and network 
router manual before implementing any of the following methods. 

 The preferred method is using Virtual Private Networking (VPN) to 
gain access to the network from outside of your firewall. You would 
then run WinLGX and connect to the UltraNEXUS-HD system as if 
you were local to it. 

 Another method is to use PC control software such as PCAnywhere® 
or GoToMyPC® to take control of the WinLGX PC from outside the 
network. 

 Ports 80, 443, and/or 50001 only: use port forwarding in your firewall 
router to give public access to Ports 80 and/or 50001. Public access 
to Port 50001 is required when you want to embed the UltraNEXUS-
HD program guide on your own website (see “Viewing Program Guide 
from a Web Browser or Your Own Website,” on page 319). Port 80 
should be made publically available when you want to access the 
UltraNEXUS-HD web interface from public IP addresses on the 
Internet.   

Port forwarding requires an external, public IP address which is 
configured in the network router to have the desired ports forwarded 
to the UltraNEXUS-HD system’s internal IP Address. 

Do not use port forwarding to make the other ports for your 
UltraNEXUS-HD system remotely available, as it allows anyone to 
connect to your UltraNEXUS-HD system and attempt to log in. Some 
advanced network routers can limit external connections to a certain 
address range, providing protection.    
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Each UltraNEXUS-HD server is designed to interact with a host PC through a 100/1000 
BASE-T Ethernet TCP/IP Network. Two of the most common connection scenarios are 
outlined below. 

NOTE: In order to share one external audio/video routing switcher between multiple 
UltraNEXUS-HD servers, your UltraNEXUS-HD system and PC must be 
networked together. 

Connecting the UltraNEXUS-HD to an Existing Ethernet Network 

Obtain the following from your technical support personnel or network administrator and 
enter into the front panel of your UltraNEXUS-HD system (see “Configuring Front Panel 
Settings,” on page 423): 

 IP address 

 Subnet mask 

 Gateway address 

Using a straight-through RJ-45 Ethernet cable, connect the UltraNEXUS-HD system’s 
right Ethernet port (labeled “1”) to a 100/1000 BASE-T switch on the TCP/IP network. 

Ensure the PC from which you wish to control your UltraNEXUS-HD system has been 
configured and attached to the TCP/IP network. 

Connecting an UltraNEXUS-HD System Directly to a PC via Ethernet 

Obtain your PC’s TCP/IP networking IP address and subnet mask as follows: 

a. Open the Command Prompt by clicking Windows Start > All Programs > 
Accessories > Command Prompt. 

b. Type in “IPconfig” at the prompt to reveal your PC’s IP and subnet mask address. 

Enter the following IP and subnet mask addresses into the front panel of your 
UltraNEXUS-HD system (see “Configuring Front Panel Settings,” on page 42): 

 IP address: A similar but not the same number as your PC’s IP address (for 
example, if your PC’s IP address is 10.255.9.15, set your server’s IP address to 
10.255.9.50) 

 Subnet mask: your PC’s subnet mask address 

Using an Ethernet cord, connect the UltraNEXUS-HD Ethernet port 1 to the PC’s 
network interface card (NIC). 
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Turning an UltraNEXUS-HD System ON/OFF 

The UltraNEXUS-HD will start up automatically when the rear panel power switch is 
turned on. The UltraNEXUS-HD can be shut down by pressing the red “X” button on the 
front panel for 8 seconds.  After it shuts down the front display will read, “System halting 
Remove power” at that point use the power switch on the back to turn the power off. To 
turn the UltraNEXUS-HD back on, move the power switch to the on position. 
 
The front panel keypad also reboots the UltraNEXUS-HD.  When held for 10 seconds, 
the green check button reboots the UltraNEXUS-HD.   

Configuring Front Panel Settings 

NOTE: All crucial configuration information, such as user information, schedule 
information, time, and network information are stored in battery backed 
memory or on the internal hard drive. Thus the UltraNEXUS-HD system 
configuration is protected in the instance of an extended power failure. 

Entering Password 

From the front panel of your UltraNEXUS-HD server, press the right arrow key from any 
one of the status screens to display the password entry screen (see Illustration 19, 
Password Entry Screen).   

Illustration 19, Password Entry Screen 

Press five-key password.   

NOTE: The factory-default password is five right arrow keys. To change the front 
panel password, refer to “Changing Front Panel Password,” on page 78. 

If the password entered is correct, the UltraNEXUS-HD system’s configuration menu will 
be displayed (see Illustration 20, Configuration Menu Screen).   

Illustration 20, Configuration Menu Screen 

If an incorrect password is entered, the display returns to the status screens. The 
configuration menu allows you to activate optional features and edit the following 
UltraNEXUS-HD system settings: 

 TCP/IP addresses: see “Editing TCP/IP Network Addresses,” on page 43 

Total Share network addresses (Ethernet port 2): see “Editing DNS 

Use arrows to 

enter pwd:***** 

CONFIG MENU 

Set XXXX                
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 Obtain a DNS address from your technical support personnel or network administrator.   
See Table 8, Editing Subnet Mask 2 from Front Panel, for editing instructions.   

Table 6, Editing DNS from Front Panel 

SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set DNS.”  

2. Press “→” to select “Set DNS.”   

3. Press “→” or “←” to position the cursor under 

the editable fields and press “↑” or “↓” to edit the 

values. 

4. Press “→” to enter next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 
 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

 Editing TOTAL SHARE Network Addresses,” on page 46 

 Shared Switch: see “Editing Shared Switcher IP Address,” on page 49 

 Web schedule port: see “Editing Web Schedule Port,” on page 50 

 Serial port usage: see “Selecting Serial Port Settings,” on page 50 

Editing TCP/IP Network Addresses 

Set DHCP 

Currently the UltraNEXUS-HD can only be set to static IP mode. 

IP Address 

  CONFIG MENU 

Set DNS 

 

Enter DNS >> 

8.  8.  8.  8 

 

Press -> to  

Confirm DNS 
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Obtain IP address from your technical support personnel or network administrator. See 
Table 3, Editing IP Address from Front Panel, for editing instructions. 

NOTE: If you wish to use the ePRO-BUS option to control a LABvault-HD digital 
recorder, a static IP address is required for your UltraNEXUS-HD 
server/controller. 

Table 3, Editing IP Address from Front Panel 

IP ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set IP Address.”  

2. Press “→” to select “Set IP Address.”  
 

3. Press “→” or “←” to position the cursor under 

the editable fields and press “↑” or “↓” to edit the 

values. 

4. Press “→” past all of the editable fields to enter 

the next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

 
 
 
 
 
 
 
 

  CONFIG MENU 

Set IP Address 

 

Enter IP Addr 1   >> 

10.  16.  0.  18 

 

Press -> to  

Confirm IP Addr 
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Subnet Mask 

Obtain subnet mask address from your support personnel or network administrator.   
See Table 4, Editing Subnet Mask from Front Panel, for editing instructions.   

NOTE: If you are sharing one external routing switcher between multiple 
UltraNEXUS-HD servers, enter the same subnet mask into the front panel of 
each UltraNEXUS-HD system. 

Table 4, Editing Subnet Mask from Front Panel 

SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Subnet Mask.”  

2. Press “→” to select “Set Subnet Mask.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” to enter next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 
 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

 

Gateway Address 

Obtain gateway address from your technical support personnel or network 
administrator.  See Table 5, Editing Gateway Address from Front Panel, for editing 
instructions. 
NOTE: If you are sharing one external routing switcher between multiple 

UltraNEXUS-HD servers, enter the same gateway address into the front 
panel of each UltraNEXUS-HD system. 

Table 5, Editing Gateway Address from Front Panel 

GATEWAY ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Gateway 1.”  

2. Press “→” to select “Set Gateway 1”  
 

  CONFIG MENU 

Set Subnet Mask 

 

Enter Subnet Mask  >> 

255.  255.  0.  0 

 

Press -> to  

Confirm Subnet 1 

 

  CONFIG MENU 

Set Gateway 1 
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GATEWAY ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

3. Press “→” or “←” to position the cursor under 

the editable fields and press “↑” or “↓” to edit the 

values. 

4. Press “→” to enter next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 
 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

Editing DNS 

 Obtain a DNS address from your technical support personnel or network administrator.   
See Table 8, Editing Subnet Mask 2 from Front Panel, for editing instructions.   

Table 6, Editing DNS from Front Panel 

SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

6. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set DNS.”  

7. Press “→” to select “Set DNS.”   

8. Press “→” or “←” to position the cursor under 

the editable fields and press “↑” or “↓” to edit the 

values. 

9. Press “→” to enter next screen.   

 

10. Either press “→” again to save your changes or 

“←” to abort changes. 
 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

Editing TOTAL SHARE Network Addresses 

The LEIGHTRONIX TOTAL SHARE networking option included with the UltraNEXUS-
HD digital video server allows users to increase both local digital media storage and 
overall digital playback/record channel capacity.  With TOTAL SHARE, you can create a 
dedicated, high-speed network that supports a combination of up to four UltraNEXUS-
HD units and up to four network attached storage (NAS) devices.  

NOTE: You can use the same network as Ethernet port 1 to access a NAS device. You 
are not required to use Ethernet port 2. 

Enter GW Addr  >> 

10.  1.  0.  1 

 

Press -> to  

Confirm GW Addr 

 

  CONFIG MENU 

Set DNS 

 

Enter DNS >> 

8.  8.  8.  8 

 

Press -> to  

Confirm DNS 
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For proper network operation, enter an IP address and subnet mask for your Ethernet 
port 2 network according to the following steps.  The Ethernet port 2 addresses must be 
different from those used for the UltraNEXUS-HD system control network (port 1). 

IP Address 2 

Obtain an IP address for your Ethernet port 2 network from your technical support 
personnel or network administrator.  See Table 7, Editing IP Address 2 from Front 
Panel, for editing instructions. 

Table 7, Editing IP Address 2 from Front Panel 

IP ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set IP Address2.”  

2. Press “→” to select “Set IP Address2.”  
 

3. Press “→” or “←” to position the cursor under 

the editable fields and press “↑” or “↓” to edit the 

values. 

4. Press “→” past all of the editable fields to enter 

the next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

 

Subnet Mask 2 

 Obtain a subnet mask address for your Ethernet port 2 network from your technical 
support personnel or network administrator.   See Table 8, Editing Subnet Mask 2 from 
Front Panel, for editing instructions.   

Table 8, Editing Subnet Mask 2 from Front Panel 

SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

11. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Subnet Mask2.”  

12. Press “→” to select “Set Subnet Mask2.”  
 

13. Press “→” or “←” to position the cursor under 

the editable fields and press “↑” or “↓” to edit the 

values.  

  CONFIG MENU 

Set IP Address 2 

 

Enter IP Addr 2  >> 

255.  255.  0.  0 

  

Press -> to  

Confirm IP Addr 

 

  CONFIG MENU 

Set Subnet Mask 2 

   

Enter Subnet Mask  2 >> 

255.  255.  0.  0 
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SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

14. Press “→” to enter next screen.   

15. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

Gateway 2 Address 

Obtain gateway address from your technical support personnel or network 
administrator.  See Table 5, Editing Gateway Address from Front Panel, for editing 
instructions. 

 

 

 

 

Table 9, Editing Gateway 2 Address from Front Panel 

GATEWAY ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

6. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Gateway 2.”  

7. Press “→” to select “Set Gateway 2”  
 

8. Press “→” or “←” to position the cursor under 

the editable fields and press “↑” or “↓” to edit the 

values. 

9. Press “→” to enter next screen.   

 

10. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

 

Press -> to  

Confirm Subnet Mask 

 

  CONFIG MENU 

Set Gateway 2 

 

Enter GW 2 Addr  >> 

192.  168.  0.  1 

 

Press -> to  

Confirm GW 2 Addr 

 



UltraNEXUS-HD 
Server Installation & Configuration 

 

LEIGHTRONIX, INC. Page 49 

Revised 11/22/2016 WinLGX ver. 7.0.3.31 
 

 

Editing Shared Switcher IP Address 

If you are sharing an external routing switcher between multiple UltraNEXUS-HD 
systems, enter the IP address of the UltraNEXUS-HD system connected directly to the 
switcher into the front panel of each additional UltraNEXUS-HD system. See Table 10, 
Editing Shared Switcher Configuration from Front Panel, for editing instructions. 

Table 10, Editing Shared Switcher Configuration from Front Panel 

SHARED SWITCH CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Shared SW IP.”  

2. Press “→” to select “Set Shared SW IP.”  
 

3. Press “→” or “←” to position the cursor under 

the editable fields and press “↑” or “↓” to edit the 

values. 

4. Press “→” past all of the editable fields to enter 

the next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

  CONFIG MENU 

Set Shared SW IP 

 

Enter Shared SW IP  >> 

0.  0.  0.  0 

   

Press -> to  

Confirm Shared SW IP 
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Editing Web Schedule Port 

Each UltraNEXUS-HD server uses Port 50001 as the default for the web program 
guide.  If you have already assigned this port number, select a different, unassigned 
port number for the web program guide. See Table 11, Editing Web Schedule Port from 
Front Panel, for editing instructions. 

Table 11, Editing Web Schedule Port from Front Panel 

WEB SCHED PORT CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Web Sch Port.”  

2. Press “→” to select “Set Web Sch Port.”  
 

3. Press “↑” or “↓” to edit the value. 

4. Press “→” to apply change and enter reboot 

message screen or “←” to abort.   

 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

 

Selecting Serial Port Settings 

Com 1 is used to control an external router switch. Com 2 and 3 are for diagnostic and 
future use. 

 

  CONFIG MENU 

Set Web Sch Port 

 

Press RIGHT 

Arrow to confirm 

 

Set Web Sch Port 

50001 
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Sharing External Time Clock with Multiple UltraNEXUS-HD Servers 

The UltraNEXUS-HD servers can be synchronized to clock time on an NTP (Network 
Time Protocol) external master clock.  The UltraNEXUS-HD servers that you wish to 
synchronize to the master clock’s time must be networked together by configuring each 
server with the same subnet mask address (see “Editing TCP/IP Network Addresses” 
on page 43).   

To configure each UltraNEXUS-HD server for time synchronization, you will need to 
input the NTP clock IP address in the UltraNEXUS-HD. See Table 12, Editing “NTP 
address” Options from Front Panel, for editing instructions. 

Table 12, Editing “NTP address” Options from Front Panel 

TIME SETTING CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set NTP IP Address.”  

2. Press “→” to select “Set NTP IP Address.”  
 

3. Press “→” or “←” to position the cursor under the 

editable fields and press “↑” or “↓” to edit the 

values. 

4. Press “→” past all of the editable fields to enter 

the next screen.  

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The UltraNEXUS-HD must be rebooted to apply any network address changes (Press the 
green check button on the front panel for 10 seconds to reboot the UltraNEXUS-HD). 

 

  CONFIG MENU 

Set NTP IP Address 

 

Enter NTP Addr >> 

0.  0.  0.  0 

    

Press -> to  

Confirm NTP Addr 
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Software Installation & Configuration 

About this Section 

This section introduces the UltraNEXUS-HD system management software, WinLGX, 
and provides instructions on how to enter the configuration settings necessary to control 
your UltraNEXUS-HD through the software.  Your UltraNEXUS-HD configuration 
properties define your switch type and digital video recording presets along with your 
system’s devices and media resources.  The configuration properties must be entered 
into the current image file before you can go on to creating a schedule of events (refer 
to the next section, “Software Operation,” on page 161, to learn how to create a 
schedule).  Each UltraNEXUS-HD image file holds your schedule events along with 
your system, device, and library resource properties.  To avoid reentering your 
configuration information every time you create a new schedule, save your image once 
you have entered the system, device, and library properties and before entering any 
schedule events. Open and rename this saved image each time you wish to create a 
new schedule. 
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WinLGX Minimum System Requirements 

For the best results while operating WinLGX, LEIGHTRONIX recommends using a 
display at 1024x768 plus the following, based on your operating system: 

NOTE: WinLGX does not have to be continuously running on your PC for standard 
UltraNEXUS-HD operation.   

Microsoft Windows 7/8/10 

1.6 GHz or faster processor 

1 GB of RAM (2 GB recommended) 
 

Installing WinLGX Software 

NOTE: The following steps were written for Windows 7 and 8 operating systems, and 
may vary for earlier and later versions. 

Log in to the LEIGHTRONIX Support Center website.  

a. Link: www.supportcenter.leightronix.com 

b. If you don’t have an account you can create one by clicking the register button. 

Once logged in, from the Welcome page, click the button for your UltraNEXUS-HD 
server product.  This will load a new page with content specifically for your system.   

From your UltraNEXUS-HD’s web page, click on the “WinLGX Software” link.  If the file 
does not automatically download, choose the save file option when prompted. 

Navigate to where the WinLGX installer (“WinLGX v* Installer.EXE”) was saved on your 
computer. 

Right click the WinLGX installer and choose the “Run as administrator” option to start 
the installation.  Follow the prompts to complete setup. 

As WinLGX installs, a succession of two additional installation windows will be 
displayed.  Refer to the following for a description of each window and installation 
guidelines: 

 Microsoft Visual C++ library window 

This window is used to install the Microsoft Visual C++ runtime components 
needed to run WinLGX on your computer or network.  Click the “Repair” button if 
you are using a version of WinLGX starting with 6 or less (for ex., WinLGX 
version 6.0.1.48).  If you are already running WinLGX 7 or greater, click the 
“Cancel” button on the bottom of the popup window. 

NOTE: Choosing “Cancel” does not stop the WinLGX installation process, 
which will continue as a background operation.  

http://www.supportcenter.leightronix.com/
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 VLC media player setup wizard  

VLC media player is necessary in order to use the WinLGX software preview and 
confidence monitor features (for more information on these features, see “Using 
Instant Video Preview Monitor to Display Digital Video Files within WinLGX” on 
page 175 and “Monitoring a Video File Recording” on page 250).  If you do not 
intend to use the WinLGX software monitor features, you may opt out of the VLC 
installation process by clicking the “Cancel” button on the bottom of the setup 
wizard.  If you choose to install VLC media player, but do not want the player to 
be automatically chosen for playback of your audio and other types of media files 
on your computer, deselect “Audio Files” and “Other” under the “File type 
associations” settings during installation. 

Click “Finish” to close the WinLGX setup wizard and return to Windows. 
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Changing WinLGX Appearance (Themes)  

WinLGX provides the option for changing the appearance or “theme” of its menu bars, 
tabs, and even the entire interface window.  To customize the WinLGX interface:  

NOTE: The “Skins and Themes” options are not available when you are connected 
to your UltraNEXUS-HD server/controller. 

1. Go to the “View” drop down menu and select “Themes and Colors.” 

2. On the "Themes and Colors" window, click the "Skins and Themes" tab if it is not 
already selected (see Illustration 21). 

Illustration 21, "Skins and Themes" Tab Window 

 

Click to choose a different interface, menu bar, and/or tab theme (see Illustration 22). 
To return to the WinLGX default appearance, just select the "Default" button for each 
theme that was changed. 

Themes for 

WinLGX Tabs 

Themes for Entire 

WinLGX Interface 

Themes for 

WinLGX Menu Bars 
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Illustration 22, Example of Custom WinLGX Interface Theme 

 

Once you are finished with your changes, either click the “Done” button or the close icon 
in the upper right corner of the pop-up window. 
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Adding / Deleting UltraNEXUS-HD Locations in the Site Manager 

Use the WinLGX “Site Manager” window to manage your UltraNEXUS-HD server’s 
network IP address information.  WinLGX uses each server’s IP address to locate the 
server and send/receive the server’s system information.  Manage the IP address listing 
of your UltraNEXUS-HD as follows: 

ADDING ULTRANEXUS-HD IP ADDRESSES 

If not already open, click “Site manager” in the “Tools” menu or the  icon on the main 
toolbar to open the “Controller Site Manager” window shown in Illustration 23. 

Illustration 23, “Controller Site Manager” Window 
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Click “Add” on the “Controller Site Manager” window (see Illustration 23) to open the 
“Add new controller” window shown in Illustration 24.  Complete the following fields: 

Illustration 24, “Add New” Window 

 

 “IP Address”: enter the IP address displayed on the UltraNEXUS-HD server’s 
front panel.  This address can be viewed from the front panel by pressing the up 
or down arrows until the IP Address is shown.   

NOTE: Do not enter 255.255.255.255 in the “IP Address” field. 

 Enter your user account name in the “User” field. 

 Enter your password in the “Password” field. 

NOTES:  Your username and password may only contain letters and 
numbers. 

 If you have not changed the username and password from the 
factory defaults, they are as follows: 

FACTORY-DEFAULT USERNAME AND PASSWORD FOR ULTRANEXUS-HD  

“User” field: “admin” in lower-case letters 

“Password” field: the last six digits of your UltraNEXUS-HD server’s serial 
number  
NOTE:  Enter any letters in upper case (e.g., 100ABC).  

Click “Find.”  If you are adding the correct IP address, your server’s site ID, location, 
serial number, and time zone displays in the “Add new” window. 
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NOTE: If this is the first time your UltraNEXUS-HD server has been added to the 
site manager database, the following information will be displayed: 

 “Site ID”: name of the product 

 “Location”: “undefined” 

 “Serial Number”: your UltraNEXUS-HD server’s serial number 

 “Time Zone”: your time zone 

Illustration 25, “Add New” Window 

 

Click “OK” to enter your UltraNEXUS-HD server in the site manager database or 
“Cancel” to abort entry.   

If applicable, repeat the steps for each additional UltraNEXUS-HD server in your 
system. 

DELETING ULTRANEXUS-HD IP ADDRESSES FROM SITE MANAGER 

Click “Site manager” in the “Tools” menu or the  icon on the main toolbar to open the 
“Controller Site Manager” window shown in Illustration 23.  Perform the following steps: 

1. Highlight the UltraNEXUS-HD IP address you wish to delete. 

Click “Delete” to display the delete confirmation box.  Click “OK” to delete the 
UltraNEXUS-HD IP address from the site manager location.   

Click “OK” at the bottom of the “Site Manager” window to save your changes to the 
database, or click “Cancel” to discard your changes. 
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Connecting to Your UltraNEXUS-HD Server 

Before you can start controlling your UltraNEXUS-HD server(s), you must first connect 
to each of your UltraNEXUS-HD servers.  This allows WinLGX to locate the server(s) 
you wish to operate and enables the software to send your settings and commands to 
each connected UltraNEXUS-HD. 

Open the WinLGX “Site Manager” window (see Illustration 32) by performing one of the 
following:   

 Select “Site manager” in the “Tools” menu 

 Click the  icon on the toolbar 

Illustration 26, “Site Manager” Window 

 

Once the WinLGX “Site Manager” is open, you should see a list of your UltraNEXUS-
HD systems.  If not, refer back to “Adding / Deleting UltraNEXUS-HD Locations in the 
Site Manager,” on page 57. 

If desired, reorder your UltraNEXUS-HD server listing.  Clicking on any column header 
in the “Site Manager” sorts the associated information in ascending order, while clicking 
the header again sorts the list in descending order. 

Connect as follows (see Illustration 32): 

NOTE: The WinLGX title bar on the main window states whether or not you are 
connected. 
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a. Select one or more IP addresses.  You may select up to eight IP addresses by 
holding down your keyboard “Ctrl” key and clicking each address with the left 
mouse button.     

b. Log in with the username and password given to you by the UltraNEXUS-HD 
system administrator.  To simultaneously log into multiple servers, all of the 
selected IP addresses must have the same username and password. 

NOTE: Connect to multiple UltraNEXUS-HD servers with different usernames 
and passwords by logging in separately to each controller. 

If the username and password have not been changed from the factory defaults, 
enter the following: 

UltraNEXUS-HD FACTORY-DEFAULT USERNAME AND PASSWORD 

“User” field: “admin” in lower-case letters 

“Password” field: the last six digits of your UltraNEXUS-HD system’s serial 
number 
NOTE:  Enter any letters in upper case (e.g., 100ABC). 

 

NOTES:  Only letters and numbers may be used in your username and 
password. 

  Logins are case sensitive. 

 If the correct characters are not entered, an error message will 
be displayed. 

  An administrator can assign various degrees of rights to each 
username, so not all menu items or functions may be available 
to a user. 

  The last six digits of your UltraNEXUS-HD server’s serial 
number are viewable from the front panel (see “Configuring 
Front Panel Settings,” on page 42) and a sticker on the back of 
your UltraNEXUS-HD server. 

c. Click “Connect” or press “Enter” to connect to the chosen UltraNEXUS-HD 
server(s) and close the login dialog box.  Once you are connected, a tab appears 
for each UltraNEXUS-HD server on the main window beneath the toolbar.  If you 
logged into more than one UltraNEXUS-HD server, switch between the servers 
by clicking on the product tabs on the main window. 
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Creating New UltraNEXUS-HD Image Files 

Before you get started entering your system settings into WinLGX, create and save an 
UltraNEXUS-HD system image file.  UltraNEXUS-HD system image files hold your 
system, device, and library resource properties as well as your schedule events.  
UltraNEXUS-HD image files have a .nmg file extension (e.g., schedule.nmg). 

NOTE: To open a saved UltraNEXUS-HD image file, go to “Opening a Saved Image 
File,” on page 167. 

WinLGX automatically opens with an empty image file loaded.  If you need to clear any 
settings, select “New” under the “File” menu. 

Select “Save as/Export” in the “File” menu to open the window shown in Illustration 27.”  

Illustration 27, “Save As” Window 

 

From the “Save in” drop down box at the top of the window, navigate to the folder where 
you want to save the UltraNEXUS-HD image file.   

Type a name for the image in the “File name” field.   

Ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” 
field. 

Click “Save” to save the image under the entered name or “Cancel” to abort the “Save 
as.”   

As you enter your configuration settings according to the “Configuring WinLGX” section 
starting on page 63, periodically save your settings in your image file by selecting 

“Save” from the “File” menu or clicking the  toolbar button. 
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Configuring WinLGX 

About the Main Window Components 

Icons to run the WinLGX software are installed on the Windows desktop and in the 
“Start Menu\Programs\Leightronix, Inc.” folder.  Choosing either of these icons opens 
the WinLGX main window shown in Illustration 28. 

Illustration 28, WinLGX Main Window 

 
The components of the main window are as follows: 

 Product Tab(s): a tab appears for each login connection so that users with more 
than one UltraNEXUS-HD server or other supported LEIGHTRONIX product can 
switch between product views in WinLGX.  Each product view is self-contained, 
allowing users to enter separate configuration and scheduling information for 
each LEIGHTRONIX product. 

 Channel Output Tabs: each tab corresponds to an output on either your 
UltraNEXUS-HD’s rear panel or external switcher, depending on your system 
setup, and is selected in combination with a day tab to create a scheduling 
window 
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 Day Tabs: each tab corresponds to a day of the week and is selected in 
combination with a channel output tab to create a scheduling window 

 Schedule view tab: contains any scheduled events 

 Overlay Template view tab: Used to create and edit overlay templates. 

 Configuration folders window: contains the “System Configuration,” “Devices,” 
and “Library” folders 

 Resources window: displays the icons of the folder selected in the configuration 
folders window 

 Resource properties window:  displays the properties of the icon selected in 
the “Resources View” window 

 Title bar: displays the program name and connection status, as well as buttons 
for minimizing, restoring/maximizing, and closing WinLGX. 

 Menu bar: contains drop-down menus of WinLGX operations (see Illustration 29, 
Menu Bar and Table 13, Menu Bar Items). 

Illustration 29, Menu Bar 

 

Table 13, Menu Bar Items 

MENU ITEM FUNCTION 

“File” 

 

Click on this menu item to display the following options: 

 “New”: Creates a new image file with default configurations (see page 
62) 

 “Open”: opens file selection window for selecting image files (see page 
167) 

 “Open as New”: opens file selection window to open an image file 
without scheduled events but maintains system configurations (see page 
168) 

 “Close”: disconnects WinLGX from UltraNEXUS-HD server on currently 
selected product tab 

 “Close all”: disconnects WinLGX from all connected UltraNEXUS-HD 
servers 

 “Save”: saves an UltraNEXUS-HD image that was previously saved as a 
file or opens file window for saving an UltraNEXUS-HD image under a 
user-specified name and folder (see page 171) 

 “Save as”: opens file window for saving an UltraNEXUS-HD image under 
a user-specified name and folder (see page 171) 

 “Send”: select to send an UltraNEXUS-HD image with a schedule to the 
UltraNEXUS-HD server (see page 231) 

 “Send all”: sends currently open image files to their corresponding 
UltraNEXUS-HD servers with one click (see page 231) 
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MENU ITEM FUNCTION 

 “Receive”: select to receive image from the connected UltraNEXUS-HD 
server (see page 169) 

 “Receive all”: downloads image files from each of the currently 
connected NEXUS series servers/controllers with one click (see page 
169) 

 “Get log”: select to obtain log file from the connected UltraNEXUS-HD 
server (see page 263) 

 “Page setup”: opens window to configure schedule printout (see page 
83) 

 “Print setup”: opens window to configure the printer and paper settings 
(see page 83) 

 “Print”: click to select template and then print or exports schedule (see 
page 232) 

 “Exit”: closes WinLGX program (see page 165) 

“Edit” 
Click on this menu item to display the following options (see 
“Scheduling/Editing/Deleting All Events,” starting on page 184): 

 “Edit”: use to edit an event in the schedule  

 “Edit switchback”: when an event or channel switchback is selected, 
option displays the “Channel Switchback Editor” window.  The 
switchback editor allows users to quickly change the inputs assigned to 
the channel switchbacks between programs (see page 229) 

 “Cut”: select to remove an event from a schedule and send to 
WinLGX’s clipboard 

 “Copy”: select to copy an event in the schedule to WinLGX’s clipboard 

 “Paste”: select to paste a copied event into the schedule 

 “Delete”: select to remove an event from a schedule 

 “Select All”: select all events on the selected channel and day/WinLGX-
LT tab configuration’s schedule event window  

“View”  Check the following options to display the corresponding toolbar, window, or 
schedule columns (see page 69): 

 “Schedule Columns”: displays a window that allows you to show and 
hide the schedule columns of your choice 

 “Status Bar”: allows you to hide/show the WinLGX status bar 

 “System Configuration”: allows you to show the “System Configuration 
View” window if it has been hidden 

 “Resource”: allows you to show the “Resource View” window if it has 
been hidden 
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MENU ITEM FUNCTION 

 “Properties”: allows you to show the “Properties” window if it has been 
hidden 

 “Reset views”: returns the “System Configuration View,” “Resource View,” 
and “Properties” windows to their default positions and sizes on the main 
window 

 “Themes and colors”: displays pop-up window with options for changing the 
WinLGX interface appearance (themes) as well as the schedule and control 
panel colors (see “Changing WinLGX Appearance (Themes),” on page 55 
and “Configuring WinLGX Interface Colors,” on page 73) 

“Tools” Click on this menu item to display the following options: 

 “Control Panel”: opens the control panel window for immediate control of 
digital video playback and recording as well as switching (see page 232) 

 “Controller”: opens window for configuring site information, setting clock, 
performing firmware updates, and rebooting (see page 79) 

 “Set front panel password”: opens window for setting front panel 
password (see page 78) 

 “Export/Print Templates”: opens window for creating templates that 
determine which schedule information is exported or printed (see page 
81) 

 “User defined data”: opens window for configuring user-defined schedule 
event columns (see page 85) 

 “Storage Manager”: opens window for managing digital videos (see page 
253) 

  “Site Manager”: opens window for adding or deleting UltraNEXUS-HD 
system locations (see page 57) 

 “User accounts”: opens window for configuring user account settings 
(see page 74) 

 “Web Interface”: opens the UltraNEXUS-HD web interface login prompt 
for the connected UltraNEXUS-HD server IP address in your default web 
browser 

  “Total Backup”: not for use with UltraNEXUS-HD servers 

 “System tools”:  
 “Switchback editor”: provides access to the “Channel Switchback 

Editor” window.  The switchback editor allows users to quickly 
change the inputs assigned to the channel switchbacks between 
programs (see page 229) 

 “Sync Library Resources”: checks UltraNEXUS-HD image files for 
library resources and schedule events referencing digital video files 
no longer on the UltraNEXUS-HD’s storage device(s) (see page 229) 

 “Preferences”: opens window for configuring WinLGX main window 
components, including time format, sorting filter for library resource 
items, and display of schedule columns (see page 87) 
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MENU ITEM FUNCTION 

“Help”  “Leightronix Support Center”: opens the LEIGHTRONIX Support Center in 
your default web browser.  Support Center provides manuals, tutorials, and 
software and firmware updates for your UltraNEXUS-HD server. 

 “WebEx”: opens the LEIGHTRONIX WebEx portal in your default web 
browser.  LEIGHTRONIX uses WebEx with customers for training and 
technical support. 

 Click on “About WinLGX” to display a window with the WinLGX version 
number (see “Displaying WinLGX Version Number,” on page 164). 

 Main Toolbar: contains icons for some of the most frequently used operations 
(see Illustration 30 and Table 14, Toolbar Items). 

Illustration 30, Main Toolbar 

 

Table 14, Toolbar Items 

TOOLBAR BUTTON FUNCTION 

 
Opens file selection window for selecting image files (see “Opening a 
Saved Image File” on page 167) 

 
Opens file selection window for opening an image file with a blank 
schedule (see “Opening an Image File as New,” on page 168)  

 

Saves an UltraNEXUS-HD image that was previously saved as a file 
or opens file window for saving an UltraNEXUS-HD image under a 
user-specified name and folder (see “Saving UltraNEXUS-HD Image 
Files,” on page 171) 

 

Opens window for selecting preferences on WinLGX’s appearance 
and select operations (see “Setting WinLGX Viewing and 
Communication Preferences,” beginning on 87) 

 
Displays control panel window (see “Using Control Panel to Perform 
Immediate Device and Switch Actions,” beginning on page 235) 

 
Sends an image file to the connected UltraNEXUS-HD server (see 
“Sending UltraNEXUS-HD Image Files,” on page 231) 

 

Receives image from the connected UltraNEXUS-HD server (see 
“Receiving Image Files from the Connected UltraNEXUS-HD 
Server(s)” beginning on page 169) 

 

Checks UltraNEXUS-HD image files for library resources and 
schedule events referencing digital video files no longer on the 
UltraNEXUS-HD system’s storage device(s) (see “Checking Schedule 
and Library Resources for Missing Digital Video Files” on page 229) 
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TOOLBAR BUTTON FUNCTION 

 
Displays window for managing digital videos (see “Managing Storage 
of Video, SLIDE, and OVERLAY Files,” on page 253) 

 

Obtains log file from the connected UltraNEXUS-HD server (see 

“Retrieving Log Files,” on page 263) 

 
Not for use with the UltraNEXUS-HD servers 

 

Displays window for adding or deleting UltraNEXUS-HD locations 
(see “Adding / Deleting UltraNEXUS-HD Locations in the Site 
Manager,” on page 57) 

 

Displays window for selecting an export/print template (see “Printing 
Schedules from WinLGX,” on page 232, and “Exporting Schedules 
into Comma Separated Values Files,” on page 233) 

 
Opens the UltraNEXUS-HD web interface login screen in your default 
web browser 

 Displays a window with the WinLGX version number (see page 164) 
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Configuring the Main Window Components 

 Product Tabs: you can change the order of your product tabs.  Simply click on each 
tab with the left mouse button and then, while holding down the left mouse button, 
drag the tab into the desired position. 

 Close Icon: to remove a view window from the WinLGX interface, click the close icon 
on the window’s toolbar (see Illustration 31).  To display the window again, go to the 
“View” menu and select “Reset views.” 

Illustration 31, View Window Close Option 

 

 Hiding/Displaying Windows and Schedule Columns through the “View” Menu   

The “View” menu, shown in Illustration 32, may be used to hide or show the 
schedule column headings and status bar, as well as display hidden/closed 
“System Configuration,” “Resource,” and “Properties” windows.   

Illustration 32, “View” Menu 
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 To show/hide the WinLGX status bar, click on “Status Bar” in the “View” menu to 
hide it on the main window or uncheck item to display it.   

 To show hidden/closed “System Configuration,” “Resource,” or “Properties” 
windows, click on the desired window in the “View” menu to display it on the main 
window.   

 To return the “System Configuration,” “Resource,” and “Properties” view windows 
to their default positions on the main window, select “Reset views” in the “View” 
menu. 

 To show/hide schedule columns, click on “Schedule Columns” in the “View” 
menu or the “Schedule” tab under “Preferences” in the “Tools” menu (see 
“Setting WinLGX Viewing and Communication ,” on page 87).  Note that the “Day 
Tab Columns” listing corresponds to the columns on the schedule window’s day 
tabs and the “WinLGX-LT” listing corresponds to the columns in the schedule’s 
WinLGX-LT tab (see Illustration 33, Schedule Columns Selection Menu).  
Perform the following steps: 

Illustration 33, Schedule Columns Selection Menu 

 

1. Show/hide columns as follows: 
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 Click to check column headings you want to show on the schedule 
window and uncheck columns you want to hide 

 Click the “All” button to display all of the columns on the 
corresponding schedule windows  

 Click the “None” button to remove all columns on the corresponding 
schedule windows  

2. When all selections have been made, click “OK” to display changes on 
schedule or “Cancel” to abort changes. 

 Moving Windows  

The “System Configuration,” “Resources,” and “Properties” windows may be 
moved to any location on the main window by clicking on the windows’ title bars 
and dragging the windows to the desired position on the WinLGX interface.  To 
re-dock the windows, click on the windows’ title bars and drag to the far right side 
of the main window. 

 Rearranging Schedule Column Headings   

To rearrange the order of the schedule column headings, click on the desired 
heading and drag it over the heading you would like it to displace.  The displaced 
heading will shift to the left of the newly positioned heading. 

 Resizing Schedule Column Widths 

To resize a column heading, move the mouse pointer over the right-side border 
of the column you wish to resize.  When the pointer changes to the resize arrows 
symbol (see Illustration 34, Resizing Schedule Column), you may perform one of 
the following: 

Illustration 34, Resizing Schedule Column 

 

 Drag the column border to the desired width. 

 Double click to resize the column so it is only wide enough to accommodate 
the column’s largest field item. 

 Using Subfolders to Organize “Library” Folder Resources 

 Creating library subfolders 

1. Right click in the configuration folders window and select “New” in the 
right-click menu that appears. 

Resize Arrows 
Symbol 
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2. A new subfolder will be displayed under the “Library” folder.  To rename 
the subfolder, right click on its name and select “Rename” in the right-click 
menu that appears.  Enter a new folder name. 

 Adding existing library resources to subfolders 

Right click on a library resource icon and select “Move to” in the menu that 
appears to display the window shown in Illustration 35.  Display the “Library” 
folder’s subfolders by either clicking on the “+” next to the folder icon or 
checking the “Expand all” box. 

Illustration 35, "Select Destination Folder" Window 

 

 Adding new library resources to a subfolder 

Select the desired “Library” subfolder in the configuration folders window and 
create a new library resource in the “Resources View” window. 

 Deleting a library subfolder 

Right click on the desired library subfolder and select “Delete” in the menu 
that appears. 
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Configuring WinLGX Interface Colors 

From the “View” drop down menu, select “Themes and Colors” to display the 
corresponding window.  Perform the following tasks from the window’s three color 
selection tabs.  Click “Done” on the bottom of the “Themes and Colors” window to save 
changes you have made in any of the tabs and close the window. 

Schedule Colors Tab 

Click the “Schedule Colors” tab and choose the text and background colors shown in 
Illustration 36 for the following elements on the “Schedule” view window:  

Illustration 36, “Schedule Colors” Tab 

 

 

 Event rows in the “Schedule” view 

 Selected events in the “Schedule” view 

 Channel switchbacks (SWB) 

 Filled channel switchbacks (SWB) 

 “Event Properties” window fields available for editing 

 “Event Properties” window fields not available for editing 

 “Playlist” library resource events 

Colors of 
Alternating 
Events in 

“Schedule” View  

Colors of “Event 
Properties” Window 
Fields Available for 

Editing 

Colors of  
 “Event Properties” 
Window Fields Not 
Available for Editing 

Colors of Selected 
Events in “Schedule” 

View 

Colors Used to Highlight 
Schedule Events with 

MPEG Files Not in 
USB/NAS Storage 

Colors of Channel 
Switchbacks (SWB) 

Colors of Channel 
Switchbacks (SWB) 
Filled with “Playlist” 

Resources 

Colors of Filled 
Channel 

Switchbacks (SWB)  

Colors of 
“Playlist“ Library 
Resource Events  

These options do not 
apply to the 

UltraNEXUS-HD. 

Toggles the Schedule 
Grid Lines On/Off  
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 Selected day and output channel tabs 

 Day and output channel tabs with and without schedule events 
 

Control Panel Colors Tab 

Click the “Control Panel Colors” tab (see Illustration 37) and choose the text and 
background colors for the UltraNEXUS-HD control panel. 

Illustration 37, “Control Panel Colors” Tab Window 

 
 

Other Colors Tab 

The “Other Colors” tab does not apply to the UltraNEXUS-HD.  
 

 

Colors Shown on 
the “List” View 

Colors Shown 
on the 

“Buttons” View 
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Setting User Account Rights (Including WinLGX Password Changes) 

Select “User accounts” in the “Tools” menu to open the “User Accounts” window (see 
Illustration 38).  

NOTE: This menu item will only become enabled upon login for users with 
“Administrator” rights. 

Illustration 38, “User Accounts” Window 

 

WinLGX and UltraNEXUS-HD web interface user rights are described in Table 15, User 
Control and Configuration Rights (see page 77) and Table 16, User File Access Rights 
(see page 78).  Perform any of the following according to the steps below: 

 Add a user account 

 Edit a user account 

 Delete a user account 

NOTE: All functions controllable from the UltraNEXUS-HD server’s front panel are 
only restricted by the front panel password. 

When finished configuring user information, exit the “User Accounts” window by clicking 
the “Close” button. 

 Add a user account 

a. Click “Add.” 

b. Enter new username and password. 

NOTES:  Logins are case sensitive. 
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  Your username and password may only contain letters and 
numbers. 

c. Select the user rights you want the user to be able to access as follows: 

 Click the “All” button to select all of the “Control and configuration” user 
rights. 

 Click the “None” button to deselect all of the “Control and configuration” 
user rights, except “System Status.” 

NOTE: The “System Status” right is automatically given to each user 
and may not be deselected. 

 Individually select the rights you want the user to possess by checking the 
corresponding user rights boxes.  To deselect a right, uncheck it by 
clicking on its box. 

d. Click “Ok” to send the new user settings to the UltraNEXUS-HD server or 
“Cancel” to abort the addition. 

 Edit a user account 

NOTE: When editing the “admin” user account, only the password may be 
changed. 

a. Highlight the desired username and click “Edit.” 

b. If desired, change username and/or password. 

c. Select the user rights you want the user to be able to access as follows: 

 Click the “All” button to select all of the “Control and configuration” user 
rights. 

 Click the “None” button to deselect all of the “Control and configuration” 
user rights, except “System Status.” 

NOTE: The “System Status” right is automatically given to each user 
and may not be deselected. 

 Individually select the rights you want the user to possess by checking and 
unchecking the corresponding user rights boxes.  

d. Click “Ok” to send the new user settings to the UltraNEXUS-HD server or 
“Cancel” to abort the edit. 

 Delete a user account 

a. Highlight the desired username and click “Delete.” 

b. In the dialog box that appears, click “Yes” to delete user or “No” to abort the 
change.  
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Table 15, User Control and Configuration Rights 

USER RIGHTS DESCRIPTIONS 

“Administrator (user 
accounts, firmware)” 

 WinLGX: allows user to change user account rights, front 
panel password, and volume names and perform firmware 
updates 

 Web Interface: allows user to perform Virtual Channel and 
program guide functions 

“Automatic slide 
authorization” 

Causes any slides uploaded or created in the Advanced Slide 
Editor to be automatically approved for display  

“Device (play, 
rewind, stop)” 

Allows user to cause a device to play, rewind, or stop 

“Device (record)” Allows user to cause a device to record 

“MPEG/Slide 
control (play)” 

Allows user to play a digital video file from the WinLGX Control 
Panel; also,allows user to schedule a slide or slide show 

“MPEG/Slide 
control 
(record/setup)” 

 WinLGX: allows user to record MPEG files from the Control 
Panel 

 WebNEXUS: allows user to set up file transfer destinations  

“Schedule control” Allows user to stop or run a schedule  

“Site identity 
configuration” 

Allows user to edit the UltraNEXUS-HD site name and location 
and reboot the server 

“Slide Administrator”  WinLGX: allows user to authorize slides for display in slide 
shows and create emergency messages 

 WebNEXUS: allows user to perform slide management within 
all user folders and authorize slides for display in slide shows; 
perform emergency messaging and program guide functions 

“Switcher control” Allows user to perform switches from the WinLGX Control Panel 

“Switcher and serial 
configuration” 

Not used 

“System 
configuration 
(control/clock)” 

Allows user to set clock from the “Controller” window under the 
“Tools” menu 

“System status” This is a default right that allows all users to view the 
UltraNEXUS-HD server status from the WinLGX Control Panel 

“TCP/IP 
configuration” 

Allows user to set up the TCP/IP addresses 
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Table 16, User File Access Rights 

USER RIGHTS DESCRIPTIONS 

“No file access” WinLGX: user prevented from performing the following: 

 Sending and receiving UltraNEXUS-HD image files 

 Opening the “Storage Manager” window (see “Managing 
Storage of Video, SLIDE, and OVERLAY Files,” on page 
253, for more information on the “Storage Manager” 
window).   

 Accessing current log files 

“Receive only” WinLGX: user prevented from sending UltraNEXUS-HD image 
files and moving/copying digital video files from one storage 
device to another  

“Send and receive” WinLGX: user allowed to send digital video files to UltraNEXUS-
HD servers, but not image (schedule) files; user prevented from 
renaming and deleting files on the remote storage devices 

“Send, receive, 
rename and delete” 

WinLGX: user allowed to perform all software functions, including 
sending and receiving UltraNEXUS-HD images (schedules) and 
renaming and deleting digital video files on the remote storage 
devices 

 
Changing Front Panel Password 

Select “Set front panel password” in the “Tools” menu to open the window shown in 
Illustration 39. 

Illustration 39, “Set Front Panel Password” Window 

 

Click on a combination of five arrows for the new front panel password. 

Click “Set” to accept new password or “Clear” to cancel. 

Click “Done” to close the “Set Front Panel Password” window. 
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Configuring Site Information, Clock, Updating Firmware, and Rebooting 

In the “Tools” menu, choose “Controller” to open the window shown in Illustration 40, 
“Controller” Window. 

Illustration 40, “Controller” Window 

 

Use the “Controller” window to set the following configuration maintenance settings.  
After clicking “Set,” “Update,” or the “Reboot” button, you will be prompted for 
confirmation to perform the action on the connected UltraNEXUS-HD server.  Clicking 
“Yes” opens a box showing location name, action status, progress bar, and connection 
and action attempt counts.  An “action completed” box appears when finished.  If the 
action appears to be stalled or if you would like to interrupt the action, click the “Cancel” 
button. 
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 Site name 

Click on the “Site name” field and enter an alias into the field.  Click “Set” to make 
the change.  This name will appear on the server’s product tab on the main 
window. 

 Site location 

Click on the “Site location” field and enter the server’s location into the field.  
Click “Set” to make the change. 

 Time Zone 

Select the desired time zone from the list and click the “Set” button above the 
time zone field.  The list contains the standard Windows time zones for the 
United States.  If you would like the clock to automatically adjust for daylight 
savings time, check the corresponding box under the time zone field. 

 Clock 

Set your server’s clock using one of the following methods: 

 Use your PC’s time: click the “Set” button to the right of the “PC Current time” 
field.  WinLGX uses the PC time, PC time zone, and server time zone to set 
the time, adjusting the time to account for zones crossed.  All of these items 
need to be correct for the set time to be accurate. 

 Enter the date and/or time in the “User time” date and time fields.  Either type 
or use each field’s drop down menu to enter the new date and/or time and 
click the “Set” button. 

 Firmware Update 

To perform a firmware update, refer to “Updating UltraNEXUS-HD Server,” on 
page 268. 

 Reboot   

To reboot the connected UltraNEXUS-HD server, click the “Reboot” button. 

Click “Close” to close the “Controller” configuration window. 
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Creating Templates for Exporting/Printing Schedules 

Schedule templates allow you to determine what schedule information will be exported 
or printed.  Schedules can be exported into a comma separated values format and then 
printed (see “Exporting Schedules into Comma Separated Values Files,” on page 233) 
or printed directly from WinLGX (see “Printing Schedules from WinLGX,” on page 232). 

Create a schedule template per the following steps:  

a. Click “Export/Print templates” in the “Tools” menu to open the window shown in 
Illustration 41.  

Illustration 41, “Export/Print Templates” Window 

 

b. Select template display items as follows: 

NOTES:  The “Format” field is intended for future use and may only be set to 
“Report.” 

 Click “New” to clear all settings. 
` 

 Determine which event windows will be filtered for the schedule template:   

1. Check the boxes in “Day/LT” section to select the desired days (or LT). 

2. Check the boxes in the “Channel” section to select the channel outputs 
that should be included for the selected days.   

NOTE: The channel list varies depending on your system switcher 
configuration.   
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 Check the “Export/print switchbacks” checkbox to display channel 
switchbacks between programs.   

 Check “Export/print all records” to include all events in the selected event 
windows.   

NOTE: This function overrides any export or print values set to “No” in the 
device and library resource and event properties. 

 Add/remove schedule fields (columns) in template as follows: 

 Add a field to the “Used” list by double clicking a field item in the 
“Available” list or selecting it and clicking “>>.” The fields in the “Used” list 
will be printed/exported in the selection order listed.   

 To add a field in a specific order within the “Used” list, highlight the “Used” 
display item you would like to display the new field before.  Double click a 
field item in the “Available” list or select it and click “>>.” The new field is 
added above the selected field (select the blank field at the bottom to add 
a field to the end of the list). 

 Remove a “Used” field, by double clicking it or selecting it and clicking 
“<<.” 

c. Click “Save” to save the template to a file.   

To revise a template: 

d. Click “Export/Print Templates” in the “Tools” menu to open the window shown in 
Illustration 41, “Export/Print Templates” Window. 

e. Click “Load.”  In the “Select Export/Print Template” window that appears, browse 
for the desired template and open.  The filename will then appear in the 
“Template” box at the top of the “Export/Print Templates” window.   

Click “Done” when finished to close the “Export/Print Templates” window. 
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Configuring Page Layouts For Schedules Printed from WinLGX 

The following steps allow you to determine the page layout of schedules printed directly 
from WinLGX.   

Select “Page Setup” in the “File” menu to open the box shown in Illustration 42, “Page 
Setup” Window, and configure the schedule printout according to the following options: 

Illustration 42, “Page Setup” Window 

 

 “Print Header information” section: check the items you want to appear at the top 
of the printout.  “Program version” refers to the top two lines shown in Illustration 
43, Example of a Schedule Header. 

Illustration 43, Example of a Schedule Header 

WinLGX  Version 7.0.1.12                                                          Page 1 

Copyright © 2015,  LEIGHTRONIX, INC. 

Image Filename: UltraNEXUS-HD.nmg 

Template Filename: nxs.xpt 

Today is: Mon Apr 02 13:02:33 2015 

  “Print Record information” section: check the items you want to appear above 
the schedule data.   

 “Field names” shows the column headers.   
 “Separator bar” inserts a line of dashes. 

 “Print Font” section: choose the font size and weight (normal/bold). 

Click “OK” to save your settings or “Cancel” to close the window without saving. 

Configuring Printer and Paper Settings for Schedules Printed from WinLGX 

Selecting “Print Setup” in the “File” menu opens the box shown in Illustration 44, “Print 
Setup” Window, which allows you to configure the printer and paper settings as follows:   
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Illustration 44, “Print Setup” Window 

 

 “Printer” section: choose the desired printer from a list of your PC’s available 
printers.  When a printer is chosen, its status appears below the “Name” field.   

 “Properties” button”: click to open a window specific to the printer, so that 
detailed printer settings can be made. 

 “Paper” section: choose the size and source tray of the paper.   

 “Orientation” section: choose to print in portrait or landscape mode.  If your 
printing template has many fields (columns) chosen, you may want to print in 
“Landscape” mode to fit it all from left to right.  Print in “Portrait” mode if you don’t 
have many fields (columns) and want to fit more events on a page. 

 “Network” button: click to open a network printing window so that you can attach 
to and print to a network printer, if it is not already in the upper list.  

Click “OK” to save your settings or “Cancel” to close the window without saving. 
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Creating Custom Schedule Columns 

The 11 generic “Field Name” schedule columns allow you to categorize the events in 
your schedule.  Users may assign each of these columns a new heading along with a 
list of menu items that can be used to classify each event added to the schedule. Using 
the “User Defined Data” window, shown in Illustration 46, rename and add menu items 
to the desired field columns as follows: 

Illustration 45, Example of Schedule with User-Defined Fields 

 

Click “User defined data” under the “Tools” menu to open the window shown in 
Illustration 46. 

Illustration 46, “User Defined Data” Window 

 

User-Defined 

Column Headers 

User-Defined 

Field Items 
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Select the fields displayed on your schedule as follows: 

 To show all fields, ensure the “Show all field names” box is checked. 

 To hide all fields, ensure the “Show all field names” box is unchecked. 

 To hide one or more fields, uncheck the “Show” box next to the each field you 
would like to hide. 

Click on the field which you would like to rename.  In the “Edit Field Options” window 
that appears (see Illustration 47), perform the following: 

Illustration 47, “Edit Field Options” Window 

 

a. Enter a new schedule heading into the “Menu title” field. 

b. Add a list of menu items that will be used to define schedule events under the 
renamed column.  The number of menu items that may be added corresponds to 
the number of options shown over each section of field names on the window. 

 Add new menu items: click the “Add” button to display the “Add menu item” 
window (see Illustration 48).  Enter the desired menu item and click “OK” to 
add to the “Menu item” drop down list or “Cancel” to abort the change. 

Illustration 48, “Add Menu Item” Window 

 



UltraNEXUS-HD 
Software Installation & Configuration 

 

LEIGHTRONIX, INC. Page 87 

Revised 11/22/2016 WinLGX ver. 7.0.3.31 
 

 

 Edit menu items: select the desired menu item from the drop down list and 
click the “Edit” button to display the “Edit menu item” window (see Illustration 
49).  Enter a new menu item and click “OK” to change the “Menu item” drop 
down list or “Cancel” to abort the change. 

Illustration 49, “Edit Menu Item” Window 

 

 Delete menu items: select the desired menu item from the drop down list and 
click the “Delete” button to display a confirmation window (see Illustration 50).  
Click “Yes” to change the “Menu item” drop down list or “No” to abort the 
change. 

Illustration 50, Menu Item Delete Confirmation Box 

 

Click “OK” to accept changes or “Cancel” to abort all editing changes made in the “Edit 
Field Options” window and return to the “User Defined Data” window. 

Click “OK” to accept or “Cancel” to abort all field changes and close the “User Defined 
Data” window. 

Setting WinLGX Viewing and Communication Preferences 

In the “Tools” menu, choose “Preferences” to open the “Preferences” window.  Perform 
the following tasks from the window’s five tabs.  Click “OK” on the bottom of the 
“Preferences” window to save changes you have made in any of the tabs or “Cancel” to 
discard them. 

 

 

 

 

 



UltraNEXUS-HD 
Software Installation & Configuration 

Page 88 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.3.17 Revised 11/22/2016 
 

Application Tab 

Click the “Application” tab (see Illustration 51, “Application” Tab) and perform any of the 
following: 

Illustration 51, “Application” Tab 

 

 “Default controller type”: select a default controller type from the drop down 
menu.  When opened, WinLGX will automatically display the window settings for 
the selected controller type.  This allows you to create and save image files when 
you are not connected to your server. 

 “Set schedule to current day on file load”: this preference causes WinLGX to 
select the current day tab when an UltraNEXUS-HD image file is loaded 

 “Sync library resources when sending or receiving image”: when this option 
is selected, WinLGX automatically checks UltraNEXUS-HD image files for library 
resources and schedule events referencing digital video files no longer on the 
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UltraNEXUS-HD system’s storage device(s) (see “Checking Schedule and 
Library Resources for Missing Digital Video Files” on page 229 for more details).  
The check is triggered when the WinLGX open, receive, and send image file 
operations are performed. 

 “How to indicate when a tab has data”: to highlight which of your day and 
channel output tabs contain schedule events, select either the “Asterisk” or 
“Parentheses” indicator options.  The default is “None.” 

 “24 hour time format”: select to change WinLGX to a 24 hour (military) time 
format.  If left unselected, WinLGX defaults to a 12 hour (A.M./P.M.) time format.   

NOTE: This does NOT change the time format on the front of your 
UltraNEXUS-HD server.  

 “Load image from controller after connect/login”: selecting this option 
causes the image file last sent to the server to be loaded after the user logs into 
WinLGX. 

 “Use passive FTP”: if your firewall is blocking your schedule and digital video 
files, check this option and then resend the files to your UltraNEXUS-HD server.    

 “Hide event editor when dropping library objects”: if selected, an event 
properties window will not be displayed when a library item is dragged onto any 
of the schedule’s day tabs unless you are holding down the keyboard “Alt” key. 

 “Show WinLGX-LT tab in the schedule window”: select this box to display the 
corresponding tab at the bottom of the schedule window.  Refer to “WinLGX-LT 
Tab” in the “About Schedule Window Components” section on page 177 for more 
information on this tab. 

 “Default single slide length”: Set the default length for a slide when uploaded 
using the Storage Manager. This does not apply to WebNEXUS slide uploads. 

 “Frame rounding threshold (frames)”: type or use the up/down arrows to set a 
rounding threshold from 5–29 frames (the default value is 5 frames).  This option 
allows you to control the playback duration of your digital video files based on the 
last milliseconds of video/audio frames (1 second of a digital video file = 30 
frames).  Once the threshold value is set, the digital video player will round the 
playback duration of any files with frames equal to or greater than the threshold 
up to the nearest second.  If the number of frames at the end of a file is less than 
the threshold value, the file’s playback duration will be trimmed down to the 
nearest second.   

 “Apply to all channel switchbacks”: when a digital library resource is dragged 
onto a channel switchback and the “Apply to all switchbacks” option is checked 
(see page 227 for more information on changing channel switchbacks), the 
following will occur based on which of the options below is selected: 

 “By the day”: adds resources to channel switchbacks between scheduled 
program events on the selected channel output’s day tab 

 “By the week”: adds resources to channel switchbacks between scheduled 
program events on all of the selected channel output’s day tabs  
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  “Default control panel switch layout (for 256 or fewer crosspoints)”: if you 
are using an external routing switcher, the UltraNEXUS-HD only uses List view, 
Button view is not available.   Those with an external switcher will automatically 
see their inputs/outputs in the “List” view on the Control Panel.  Refer to 
“EXTERNAL SWITCHER Configurations Only—Performing Forced Switches and 
Viewing Switcher Status” on page 236 for more details on both options. 

 “Total Backup application folder”: not for use with the UltraNEXUS-HD 

 Under “Log viewer,” click the button to the right of the log viewer field to select a 
software program for viewing your UltraNEXUS-HD log files. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Event Editor Tab 

Each event properties window for a device or library resource item may be configured to 
show different fields under a “minimum” and “maximum” view.  During scheduling, you 
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may toggle between these views by selecting and deselecting the “Maximum view” 
checkbox on the event properties dialog (refer to Illustration 52). 

Illustration 52, Example of Event Properties Window 

 
 

Maximum View 
Selected 
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To configure the field views for your device and library event properties windows, click 
the “Event Editor” tab (see Illustration 53, “Event Editor” Tab Window) and perform the 
following: 

Illustration 53, “Event Editor” Tab Window 

 

Under “Format type,” select the format of the device/library event properties window you 
would like to configure. 

Perform any of the following options: 

 “Restore defaults” button: click to return the selected format’s minimum and 
maximum views to the factory default settings. 

 “Minimum view” column 
 Click the desired boxes to select/deselect individual event property fields.  A 

checkmark indicates the corresponding field will appear in the minimum view 
for the event properties dialog. 
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 “All” button: click to show all fields within the minimum view for the event 
properties dialog.  

 “None” button: click to hide all fields within the minimum view for the event 
properties dialog. 

  “Maximum view” column 
 Click the desired boxes to select/deselect individual event property fields.  A 

checkmark indicates the corresponding field will appear in the maximum view 
for the event properties dialog. 

 “All” button: click to show all fields within the maximum view for the event 
properties dialog.  

 “None” button: click to hide all fields within the maximum view for the event 
properties dialog. 
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Preview Monitor Tab 

WinLGX includes preview monitor windows for displaying digital video files prior to 
scheduled or immediate playback and as files are recorded.  Set up and control the 
operation of these software monitors by clicking the “Preview Monitor” tab (see 
Illustration 54, “Preview Monitor” Tab) and performing any of the following: 

Illustration 54, “Preview Monitor” Tab 

 

 “Clip editor playback”: choose “Software monitor” to view and edit clips with 
the WinLGX video clip editor or “Hardware monitor” if you would prefer during 
editing to view your video clips on an external monitor attached to the 
UltraNEXUS server. Using the hardware monitor will interrupt any 
programming currently playing on the UltraNEXUS-HD. The software monitor 
will not interrupt any programming. 

  “MPEG preview”: choose one of the following options for previewing your 
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video library resources in the WinLGX instant video preview monitor: 

 “Context menu only”: video library resources may only be displayed in 
the instant video preview monitor by right clicking on a resource and 
choosing the “View resource” option.   

 “Double-click filename”: video library resources can be displayed in the 
instant video preview monitor by either double clicking a resource or by 
right clicking on a resource and choosing the “View resource” option. 

 “Remember screen size and position”: causes the WinLGX instant video 
preview monitors to display in the last place and size they were changed to 

 “Timecode display”: causes the selected video clip’s total time length as well 
as the current playback time to be displayed on the WinLGX video clip editor and 
instant video preview monitors.  

 “Forward and Reverse jump value”: does not apply to the UltraNEXUS-HD. 

 “Record playback delay”: specify how long (five to ninety seconds) after a 
recording begins before the resulting file will display on the WinLGX confidence 
monitor. 

 “Video driver interface”: leave this option set to “Auto-detect,” unless you find 
the WinLGX preview monitors will not display your digital videos.  In that case, try 
the other options until you find the one compatible with your computer’s video 
card. 

 “VLC Application Folder”: VLC media player must be installed on the computer 
running WinLGX if you wish to display digital videos in the WinLGX preview 
monitor windows.  If WinLGX states that it cannot find the VLC media player 
when you open a preview monitor window, first ensure that VLC player is 
installed on your computer.  If the VLC player is not installed, download the free 
program from the Internet.  Once installation has been verified or completed, find 
your computer’s file path for the folder containing the VLC executable file 
(“vlc.exe”).  Enter your file path into the “VLC Application Folder” field (for 
example, C:\Program Files\VideoLAN\VLC). 
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Resource Library Tab 

Click the “Resource Library” tab (see Illustration 55, "Resource Library" Tab) and check 
the “‘Show in program guide’” property to automatically populate the corresponding 
fields when creating digital video file playback library resources (go to page 132 for 
more information on creating digital video library resources).   

Illustration 55, "Resource Library" Tab 
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Resource View Tab 

Click the “Resource View” tab (see Illustration 56, “Resource View” Tab Window) and 
configure the icon sorting filter for your library resource items. 

Illustration 56, “Resource View” Tab Window 
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Schedule Tab 

Click the “Schedule” tab (see Illustration 57, “Schedule” Tab Window) and hide/display 
columns in the “Schedule” view.  Note that the “Day Tab Columns” listing corresponds 
to the columns in the schedule day tabs and the “WinLGX-LT” listing corresponds to the 
columns in the schedule WinLGX-LT tab.  Perform the following steps: 

Illustration 57, “Schedule” Tab Window 

 

1. Select the columns displayed on your schedule as follows: 

 To show all columns in the corresponding schedule tab, click the “All” button.  

 To hide all columns in the corresponding tab, click the “None” button. 

 To hide one or more columns in the corresponding tab, uncheck the boxes next 
to the columns you would like to hide. 

2. When all changes have been made, click “OK” to display changes on schedule or 
“Cancel” to abort changes. 



UltraNEXUS-HD 
Software Installation & Configuration 

 

LEIGHTRONIX, INC. Page 99 

Revised 11/22/2016 WinLGX ver. 7.0.3.31 
 

 

Configuring the Switch Type of an UltraNEXUS-HD  

In order to control your system’s inputs and outputs from WinLGX, you will need to 
specify the switch type setup of your UltraNEXUS-HD system.  Your switch type setup 
indicates whether your destinations and sources are directly wired to your UltraNEXUS-
HD server or connected through one of a wide range of compatible external switchers.     

Click on the “System Configuration” folder on the right side of the schedule editor 
window to display the UltraNEXUS-HD “System Configuration” windows.  Click on the 
“Switch” icon and complete the “Properties” fields for the switch type that applies to your 
UltraNEXUS-HD system.  Each switch type and its properties are described in the 
following subsections: 

 “No Switch Configuration” on page 99 

 “External Switcher Configuration” on page 101 

 “Shared Switcher Configuration” on page 105 

NOTE: Input and output label, description, and icon assignments are optional. 

No Switch Configuration 

An UltraNEXUS-HD server not connected to an external switcher is represented by the 
WinLGX “No Switch” type.  Refer to Illustration 58, No Switch Type Properties 
throughout the “Direct Connect Configuration” section. 

Illustration 58, No Switch Type Properties 
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 “Switch type”:  if not already selected, choose “No Switch.” 

 Channel Tab Assignments 

The UltraNEXUS-HD has one digital video playback/record channel, which is 
represented by its playback and record functions on the channel tab on the left side 
of the schedule window.  WinLGX automatically assigns playback on Player (“Out 
1”) to Channel 1, recording on the Recorder (“Sch Rec”) to Channel 2. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel tabs on your 
WinLGX schedule window.  From the “Channel” drop down box, select the channel 
tab you would like to hide and then select “No” from the “Visible” drop down box.  To 
display the tab, again select the channel and then choose “Yes” under “Visible.” 

 Virtual Channel 

“Yes” enables the Virtual Channel video source for use as a switchback input in a 
schedule, while “No” disables the Virtual Channel feature for this purpose.   

NOTE: If enabled, you will only be able to schedule HD/SD digital video Player on 
the first WinLGX channel output tab (see Illustration 59, Virtual Channel 
WinLGX Output Tab Assignments). 

Illustration 59, Virtual Channel WinLGX Output Tab Assignments 

 

 

 

 

 

The first channel output tab 

in WinLGX is tied to Virtual 

Channel 1. 
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External Switcher Configuration 

Refer to Illustration 60, External Switcher Properties, throughout the “External Switcher 
Configuration” section. 

Illustration 60, External Switcher Properties 

 

 “Switch type”:  select the choice that matches your external switcher and complete 
the following steps: 

 Non-LEIGHTRONIX external switchers only: enter the number of levels in the 
“Levels” field (video, audio left, audio right, etc.). 

NOTES:  Consult your switcher’s manual to determine how many levels 
should be assigned. 

  Pesa switchers automatically send level information to 
UltraNEXUS-HD servers. 

 “Status rate (sec)” field: use to configure the interval at which the UltraNEXUS-
HD server polls the external switcher for output status information.  The range is 
0 – 60 seconds, where 0 means never poll.  The default is 2 seconds. 

 To ensure your switcher works with the UltraNEXUS-HD server, set your 
switcher’s serial parameters according to Table 17, Supported External 
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Switchers and Parameters (refer to your switcher’s manual for further 
instructions).    

Table 17, Supported External Switchers and Parameters 

SUPPORTED SWITCHER OPTIONS SWITCHER SERIAL PARAMETERS 

AMX/Autopatch  

8Y-XL™, 4YDM™, EPICA™, Precis™ and Optima™ 
Switchers Using BCS Protocol 

9600 baud, 8N1 (Level 1: Video, Level 0: All) 

Blackmagic Design 

Smart Videohub 12x12 
And 

Smart Videohub 16x16 or 40x40, Micro Videohub, 
Compact Videohub 

9600 baud, 8N1 

Cable RS-2/3J from Addenda.com or Ethernet control 
(requires firmware addition) 

Cable RS-2/3R from Addenda.com or Ethernet control 
(requires firmware addition) 

EXTRON A (most common) & B (ISS 
series) 

MAV, Crosspoint, Matrix 

9600 baud, 8N1 

KNOX  

Chameleon 64 & 64i, RS Series, ProSwitch Series 

9600 baud, 8N1 

KRAMER 

Switchers Using Communications Protocol 2000; contact 
Kramer to determine if null or straight cable is needed 

9600 baud, 8N1 

Imagine Communications/Harris/Leitch 

Platinum™, VIA 32™, X-Plus™, Integrator™, and 
Panacea™ 

9600 baud, 8N1 

PESA Serial 

Routing Switchers supporting CPU Link Serial Protocol 

9600 baud, 8N2 

PESA P1N Network 

Routing Switchers supporting P1N Network Protocol 

N/A 

SIERRA 

Aspen, Lassen, Ponderosa, and Yosemite 

9600 baud, 8N1 

SIGMA A & B 

Dagger Series, ADX Series, MRX Series, SLX Series, 12X, 
2100 Series, 3200 Series, and 9600 Series 

9600 baud, 8N1 

UTAH A 38400 baud, 8N1 

UTAH B 1200 baud, 7E2 

UTAH Sandar 9600 baud, 7O1 
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 Input Settings 

In the “Input” field, select an input (the number of available inputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of alpha-numeric characters, underscore and dashes 
may be used for labels and descriptions. 

 
 “Label”: type the label you would like to appear on the corresponding Control 

Panel input button (up to 10 characters total—the number of characters that fit 
will depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
input button. 

 “Icon”:  select an icon to represent the selected input in the Control Panel 
window. 

 Non-LEIGHTRONIX external switchers only: enter the switcher’s first and last 
input values into the “First” and “Last” input fields.    

NOTE: The “First” and “Last” fields are locked once an event is scheduled. To 
change these fields delete any events or use the “Open as New” function in the 
File menu. (See page 168) 

 Output Settings 

In the “Output” field, select an output (the number of available outputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of alpha-numeric characters, underscore and dashes 
may be used for labels and descriptions. 

 
  “Label”: type the label you would like to appear on the corresponding Control 

Panel output button, schedule editor window channel output tab, and the web 
program guide (up to 10 characters total—the number of characters that fit will 
depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
output icon and schedule editor window channel output tab. 

 “Icon”:  select an icon to represent the selected output in the Control Panel 
window. 

 Non-LEIGHTRONIX external switchers only: enter the switcher’s first and last 
output values. 

NOTE: The “First” and “Last” fields are locked once an event is scheduled. To 
change these fields delete any events or use the “Open as New” function in the 
File menu. (See page 168) 
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 “Switchback Input”: select one of your inputs as the video source you would like 
WinLGX to automatically switch to the selected output at the end of a scheduled 
event.  During scheduling, the switchback input may be changed in the event 
properties window. 

NOTES:  If you would like to use a “Virtual Channel” video source, ensure 
“Yes” has been selected in the “Virtual Channel” field. 

  The Virtual Channel video source is tied to the first WinLGX 
channel output tab (see Illustration 59, Virtual Channel WinLGX 
Output Tab Assignments). 

 Channel Output Tab Assignments 
An external switcher configuration can have up to 16 outputs represented by 
channel output tabs on the left side of the schedule window.  WinLGX automatically 
assigns Output 1 to Channel 1, Output 2 to Channel 2, and so on.  WinLGX allows 
you to change the default channel-output assignments according to the following 
steps.  This is especially useful if you have a large switcher, as you can choose 
which 16 outputs that you’d like to automate for scheduling.   

NOTE: The highest numbered channel output tab automatically represents the 
record function of the UltraNEXUS-HD recorder.  You may reassign the 
UltraNEXUS-HD record function to any of your switcher’s available 
outputs.  

NOTE: The Channel fields are locked once an event is scheduled. To change 
these fields, delete any events or use the “Open as New” function in 
the File menu. (See page 168) 

 

1. In the “Channel” field, select the channel number you would like to reassign to a 
different output. 

2. Perform one of the following: 

 Select Output 17 or higher from the “Output” drop down menu 

 Associate one of Outputs 1–16 with the channel by first unassigning the 
output according to the steps below: 

a. In the “Channel” field, select the channel number for the output you want to 
reassign.   

b. From the “Output” drop down menu, select “None.” 
c. In the “Channel” field, select the channel number you would like to reassign 

to the output. 
d. Select the newly unassigned output from the “Output” drop down menu.  

The change will be reflected by the channel output tabs on the schedule 
window. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel output tabs 
on your WinLGX schedule window.  From the “Channel” drop down box, select the 
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channel tab you would like to hide and then select “No” from the “Visible” drop down 
box.  To display the tab, again select the channel and then choose “Yes” under 
“Visible.” 

 Virtual Channel 

“Yes” enables the Virtual Channel video source for use as a switchback input in a 
schedule, while “No” disables the Virtual Channel feature for this purpose.   

NOTE: To use the Virtual Channel feature during scheduling, you will need to 
configure and schedule your UltraNEXUS-HD system’s HD/SD digital 
video Player on the first WinLGX channel output tab (see Illustration 59, 
Virtual Channel WinLGX Output Tab Assignments). 

Shared Switcher Configuration 

The “Shared Switch” type allows users to share one external routing switcher between 
multiple UltraNEXUS-HD servers.  Use the following steps to configure each 
UltraNEXUS-HD server not directly connected to the external switcher it is sharing (refer 
to Illustration 61, Shared Switcher Properties, throughout this section).  Follow the 
“External Switcher Configuration” section on page 101 to configure the UltraNEXUS-HD 
server directly connected to the external switcher.  

Illustration 61, Shared Switcher Properties 

 

 Switch Type: select “Shared Switch” from the switch type drop down menu.  WinLGX 
treats the “Shared SW” switch type as an external switcher.  Complete the following 
properties: 

 “Levels”: ignore, as WinLGX does not use this setting for the shared switch type 
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 “Status rate (sec)”: set to specify how often the UltraNEXUS-HD server polls the 
UltraNEXUS-HD server directly connected to the routing switcher for switcher 
status information.  The range is 0 – 60 seconds, with the default set to 2 
seconds.  Do not select 0, as this means never poll.  

 Input Settings 

In the “Input” field, select an input (the number of available inputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of alpha-numeric characters, underscore and dashes 
may be used for labels and descriptions. 

 
  “Label”: type the label you would like to appear on the corresponding Control 

Panel input button (up to 10 characters total—the number of characters that fit 
will depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
input button. 

 “Icon”:  select an icon to represent the selected input in the Control Panel 
window. 

 “First” and “Last” input fields: to allow access to all inputs connected to the 
routing switcher, enter the switcher’s first and last input values.  If you would like 
the UltraNEXUS-HD server to only control a dedicated range of inputs on the 
shared routing switcher, enter the first and last input values for the dedicated 
range.  Dedicating a range of inputs would limit the programming the 
UltraNEXUS-HD server could display and record.  

 Output Settings 

In the “Output” field, select an output (the number of available outputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of alpha-numeric characters, underscore and dashes 
may be used for labels and descriptions. 

 
 “Label”: type the label you would like to appear on the corresponding Control 

Panel output button, schedule editor window channel output tab, and the web 
program guide (up to 10 characters total—the number of characters that fit will 
depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
output icon and schedule editor window channel output tab. 

 “Icon”:  select an icon to represent the selected output in the Control Panel 
window. 

 “First” and “Last” output fields: to allow access to all outputs connected to the 
routing switcher, enter the switcher’s first and last output values.  If you would 
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like the UltraNEXUS-HD server to only be able to access a dedicated range of 
outputs on the shared routing switcher, enter the first and last output values for 
the dedicated range. 

 “Switchback Input”: select one of your inputs as the video source you would like 
WinLGX to automatically switch to the selected output at the end of a scheduled 
event.  During scheduling, the switchback input may be changed in the event 
properties window. 

NOTES:  If you would like to use a “Virtual Channel” video source, ensure 
“Yes” has been selected in the “Virtual Channel” field. 

  The Virtual Channel video source is tied to the first WinLGX 
channel output tab (see Illustration 59, Virtual Channel WinLGX 
Output Tab Assignments). 

 Channel Output Assignments  

An external routing switcher can have up to 16 outputs represented by channel 
output tabs on the left side of the schedule window.  WinLGX automatically assigns 
Output 1 to Channel 1, Output 2 to Channel 2, and so on.  WinLGX allows you to 
change the default channel-output assignments according to the following steps.  
This is especially useful if you have a large switcher, as you can choose which 16 
outputs that you’d like to automate for scheduling. 

NOTE: The highest numbered channel output tab automatically represents the 
record function of the UltraNEXUS-HD recorder.  You may reassign the 
UltraNEXUS-HD record function to any of your switcher’s available 
outputs.  

1. In the “Channel” field, select the channel number you would like to reassign to a 
different output. 

2. Perform one of the following: 

 Select Output 17 or higher from the “Output” drop down menu. 

 Associate one of Outputs 1–16 with the channel by first un-assigning the 
output according to the steps below: 

a. In the “Channel” field, select the channel number for the output you want 
to reassign.   

b. From the “Output” drop down menu, select “None.” 
c. In the “Channel” field, select the channel number you would like to 

reassign to the output. 
d. Select the newly unassigned output from the “Output” drop down menu.  

The change will be reflected by the channel output tabs on the schedule 
window. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel output tabs 
on your WinLGX schedule window.  From the “Channel” drop down box, select the 
channel tab you would like to hide and then select “No” from the “Visible” drop down 
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box.  To display the tab, again select the channel and then choose “Yes” under 
“Visible.” 

 Virtual Channel 

“Yes” enables the Virtual Channel video source for use as a switchback input in a 
schedule, while “No” disables the Virtual Channel feature for this purpose.   

NOTE: To use the Virtual Channel feature during scheduling, you will need to 
configure and schedule your UltraNEXUS-HD system’s HD/SD digital 
video Player on the first WinLGX channel output tab (see Illustration 59, 
Virtual Channel WinLGX Output Tab Assignments). 
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Configuring Digital Video Recording Presets 

Click on the “System Configuration” folder on the right side of the schedule editor 
window to display the UltraNEXUS-HD “System Configuration View” windows.  Click on 
the “Internal Video Record” icon and complete the “Properties” fields for each record 
preset according to the following steps (see Illustration 62, UltraNEXUS-HD Record 
Preset Fields).  For more information on recording a video file, refer to “Digital Video 
Recorder Specifications,” on page 23. 

Illustration 62, UltraNEXUS-HD Record Preset Fields 
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 “Record Preset x”: if desired, click in the field and enter a new name for the preset. 

 “Input source”: Select to record the incoming audio video signals from either the 
“SDI” or “Composite” inputs.  (NOTE: Composite option not functional – will work in 
future firmware.) 

 “Video resolution”: 

 The UltraNEXUS-HD recorder will record the incoming signal at its native 
resolution.  

 HD content: The UltraNEXUS-HD will ignore this setting – it is 16:9. 

 SD content: Select either “4:3” or “16:9” to match the input signal. 

  “Bitrate type”: The UltraNEXUS-HD only uses “VBR” for variable bit rate. 

 The “Min video bitrate” and “Max video bitrate” fields will be displayed: click on 
the fields and use the up/down arrows to set your minimum and maximum video 
bitrates.  WinLGX requires that an increment of two be left between the bit rates.  
Select a minimum of at least 1.50 Mb/sec and a maximum of up to 10.00 Mb/sec 

  “Record audio source”: from the “Record audio source” drop down, select the type 
of embedded or non-embedded (“Analog” or “AES”) audio signal your system is 
setup to record.  

o “Analog”: corresponds to the analog audio inputs on the UltraNEXUS-HD’s 
back panel terminal blocks  

o “AES”: corresponds to the AES audio inputs on the UltraNEXUS-HD’s back 
panel terminal blocks  

o “Embedded 1-2”, “Embedded 3-4,” “Embedded 5-6,” and “Embedded 7-8”: if 
your audio is embedded within the incoming video signal, select the 
embedded audio channel pair that you want to record 

 “Audio bitrate”: select 128 or 192 kb/sec from the drop down list 

 “Audio sample rate”: fixed at 48 kHz 
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Editing Internal Digital Video Playback and Recording Device Resources 

The UltraNEXUS-HD contains one digital video play/record channel, which is 
represented in the WinLGX “Resource View” window as separate player and recorder 
device icons (see Illustration 63, “Devices” Window).  The following steps describe how 
to change the optional settings for the UltraNEXUS-HD server’s built-in play/record 
devices:  

Click on the “Devices” folder on the right side of the schedule editor window to display 
the “Devices” window (refer to Illustration 63, “Devices” Window). 

Illustration 63, “Devices” Window  

 

In the “Resource View,” click on the desired device icon to reveal the corresponding 
properties fields.  
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Digital Video Player 

 “Title”: if desired, click on “Title” field and enter new alias. 

 “Icon”: if desired, click on the “Icon” field button and select a new icon to represent 
the selected player or recorder. 

 External switcher configurations only: under “Input,” choose the external switcher 
input connected to the selected output on the rear panel of your UltraNEXUS-HD.  
Selecting an input number removes it from the input list. 

 “Assigned Channel/Output”: the function of this property depends on whether or not 
the “Virtual Channel” feature has been enabled in the “Switcher Configuration” 
properties (see “Configuring the Switch Type of an UltraNEXUS-HD,” on page 99 for 
more details).  The following outlines both scenarios: 

 Virtual Channel Feature Enabled: select the output you would like to display 
playback from the UltraNEXUS-HD digital video player from the “Assigned 
Channel/Output” drop down menu. 

 Virtual Channel Feature Disabled: you may assign a channel output to the 
UltraNEXUS-HD digital video player to automate device selection for digital video 
library resources during scheduling.  Whenever a digital video library resource is 
dragged onto the selected HD/SD player/recorder’s assigned channel/output, the 
player will automatically appear in the library resource’s “Device” field. 

 “Setup time”: if desired, indicate how long after the selected player receives a PLAY 
command that picture and/or sound is produced. 

 “Print”: select “Yes” to enable all of the resource’s event records for printing.  If “No” 
is selected, then you can enable printing as follows: 

1. Individual event records: select “Yes” in the “Print” field of each event properties 
window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 

 “Export”: select “Yes” to allow all of the resource’s event records to be exported into 
comma separated values format.  If “No” is selected, then you can enable the export 
function as follows: 

1. Individual event records: select “Yes” in the “Export” field of each event 
properties window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 
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Digital Video Recorder 

 “Title”: if desired, click on “Title” field and enter new alias. 

 “Icon”: if desired, click on the “Icon” field button and select a new icon to represent 
the selected player or recorder. 

 External switcher configurations only: select a “Record Channel” that 
corresponds to the external switcher output connected to the UltraNEXUS-HD’s SDI 
or Composite input on the rear panel of the server (see Illustration 64, UltraNEXUS-
HD Record Channel Output Tab Configuration). 

NOTE: WinLGX automatically completes this field for the HD/SD digital video 
Recorder with the output assigned to the highest numbered channel under 
“System Configuration.” 

Illustration 64, UltraNEXUS-HD Record Channel Output Tab Configuration 

 
 
 

 “Video Quality”: if desired, select a digital video recording quality mode for your 
recording events.  This mode may be changed for each recording event action—see 
“Internal Digital Video Recorder Device Resources,” starting on page 200, for more 
details.  

 “Record overwrite”: if desired, select one of the following: 

 “Always”: prompts WinLGX to automatically record over an existing file with the 
same name.  

 “Create unique”: if an existing filename is entered, WinLGX automatically records 
the file under the first 14 characters of the original filename followed by 
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“yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record date specified as year/month/ 
day and hh/mm/ss is the file record time in hours/minutes/seconds).   

The “Record overwrite” option may be changed for each recording event action—
see “Internal Digital Video Recorder Device Resources,” starting on page 200, for 
more details. 

 “Print”: select “Yes” to enable all of the resource’s event records for printing. If “No” 
is selected, then you can enable printing as follows: 

1. Individual event records: select “Yes” in the “Print” field of each event properties 
window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 

 “Export”: select “Yes” to allow all of the resource’s event records to be exported into 
a comma separated values  format. If “No” is selected, then you can enable the 
export function as follows: 

1. Individual event records: select “Yes” in the “Export” field of each event 
properties window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 
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Creating External Switch Device Resources 

NOTE: This section only applies to those using an external switcher with their 
UltraNEXUS-HD server. 

A device resource must be created for each external switch device attached to the 
external switcher connected to your UltraNEXUS-HD server. Creating a device causes 
a new set of user-configurable information fields to be displayed in the “Properties” 
window. The UltraNEXUS-HD system uses this information to identify your external 
device. Create external switch device resources as follows: 

Click on the “Devices” folder on the right side of the schedule editor window to display 
the “Devices View” window (refer to Illustration 65, New Switch Device Properties). 

Illustration 65, New Switch Device Properties  

 

Right click in the “Resource View” window and select “New” to display the device type 
menu.  Select the “SWITCH” device type to add a new device to the window (see 
Illustration 65, New Switch Device Properties). 

Complete the switch device “Properties” field shown in Illustration 66, Switch Event 
Properties Window.  Refer to Table 18, Switch Event Properties, for a description of the 
editable switch resource properties. 
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Illustration 66, Switch Event Properties Window 

 

Table 18, Switch Event Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Format Choose one of the following switch types: 

 External CG 

 IRD 

 Switch 

 Studio  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Input Choose the switcher input number to which the device is connected.  If the 
device is not connected to a switcher input, select “<None>.”  Assigning an 
input to a device removes the input number from the input list.     
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FIELD DESCRIPTION 

Preferred 
Playback 
Channel/Output 

You may assign a channel output to your device to automate device 
selection for same-type library resources during scheduling.  Whenever a 
library resource of the same format is dragged onto this device’s preferred 
playback channel, this device will automatically appear in the library 
resource’s “Device” field.   

Interface “Switch (SW)” is automatically assigned. 

Device The device numbers for switch resources are automatically assigned. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 
a comma separated values format.  If “No” is selected, then you can 
enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 
event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Creating ePRO-BUS-Controlled Device Resources 

The UltraNEXUS-HD ePRO-BUS control feature uses your Ethernet network rather than 
additional wiring to send start/stop RECORD commands to up to 16 remote or locally 
connected LABvault-HD digital video recorders.  To use, create an ePRO-BUS resource 
for each LABvault-HD digital video recorder that will be receiving ePRO-BUS control 
commands from your UltraNEXUS-HD system.  Create and configure ePRO-BUS-
controlled resources as follows: 

NOTE: Ensure that you have assigned each LABvault-HD recorder’s IP address to an 
ePRO-BUS address number in the UltraNEXUS-HD web interface (see the 
“Configuring ePRO-BUS Settings” section on page 344 for more details). 

Click on the “Devices” folder on the right side of the schedule editor window to display 
the “Devices View” window (refer to Illustration 65, New Switch Device Properties). 

Illustration 67, New Device Properties  

 

Right click in the “Resource View” window and select “New” to display the device type 
menu.  Select “DVR” device type to add a new device resource to the window (see 
Illustration 67, New Device Properties). 

Complete the properties fields shown in Illustration 68, ePRO-BUS Resource Properties 
Window according to Table 19, ePRO-BUS Resource Properties. 
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Illustration 68, ePRO-BUS Resource Properties Window 

 

Table 19, ePRO-BUS Resource Properties 

FIELD DESCRIPTION 

Title Enter a name of up to 31 characters. 

Format Leave at the default setting 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and clicking 
the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Input External switcher configurations only: select “<None>,” as the device is not 
connected to a switcher input.      
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FIELD DESCRIPTION 

Preferred 
Channel/ 
Output 

External switcher configurations only: select “<None>.” 

Interface Select “PRO-BUS (PB)” for the method being used to control the device. 

Device Select the PRO-BUS address number that was chosen for the LABvault-HD 
device in the UltraNEXUS-HD web interface ePRO-BUS configuration 
window (see the “Configuring ePRO-BUS Settings” section on page 344 for 
more details). When a number is chosen, it is removed from the “Device” 
list.   

NOTE: Each LABvault-HD will only respond to those ePRO-BUS 
commands which contain its address number. 

Setup time Not used 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” 
is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 
properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then you 
can enable the export function during scheduling for all or individual playlist 
resources. 

 

Creating Overlays 

Quickly and conveniently enhance your digital programming with graphic and text 
message overlays.  In just a few steps, schedule MPEG clips and programs, slides, and 
slide shows to display with your station icon, “coming up next” program messages, 
community event reminders, holiday greetings, or any other announcements of your 
choosing.   

You can create up to 25 overlay templates, with each template holding up to 10, 
individual overlay library resources.  During scheduling of digital video media, you then 
have the option of selecting an overlay template to accompany the media during 
playback.  Each overlay resource in the template will display in the assigned order for 
10 percent of the scheduled digital program (subtract 60 seconds for the safe area 
buffers from the total length of the program before calculating the 10 percent display 
length).  To create an overlay template and then add it to a digital program, 
perform the following three steps: 
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Step 1: Create Individual Overlays 

Add individual overlay resources to each overlay template to form a custom overlay 
listing that may be reused for a variety of digital programs.  Assign to each overlay 
library resource the properties for a partial or full screen PNG and, if desired, enter a 
series of up to 12, two-line text messages that you would like displayed with the graphic.     

NOTE: Overlay library resources utilize “.png” files, which allow an image to contain 
transparent areas.  This allows your overlay to float over rather than block the 
programming on your MPEG players. 

Either use one of the included graphics or upload your own .png overlay through the 
“Storage Manager” window per “Managing Storage of Video, SLIDE, and OVERLAY 
Files,” on page 253. 

To create a library resource for an overlay, click the “Library” folder and then right click 
in the “Resource View” window and select “New.”  Select “Overlay” under “Format” in 
the “Properties View” window and then complete the remaining properties described in 
Table 20, referring to Illustration 69 throughout. 

Illustration 69, Overlay Library Resource Properties 
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Table 20, Overlay Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Overlay” from the drop down list. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and clicking 
the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Page 
count 

Displays pages added through the “Graphic/Text” field’s “Overlay Graphic 
Editor” window. 

Page 
dwell time 

Displays selection made in the “Graphic/Text” field’s “Overlay Graphic Editor” 
window. 
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FIELD DESCRIPTION 

Graphic 
/Text 

Select a graphic image and, if desired, add a text message as follows: 

1. Select the “Graphic/Text” field and click the right-hand button to open the 
“Overlay Graphic Editor” window shown in Illustration 70. 

Illustration 70, “Overlay Graphic Editor” Window 

 

2. Select a graphic from the “Overlay file” list. 

3. Use the “Overlay text” window to add a sequence of up to 12, two-line 
messages to the lower third position of the overlay screen.  Beneath the 
overlay preview window, the buttons numbered 1–12 correspond to 
separate text message pages on the overlay.  Each button turns green 
when you move the text cursor to the corresponding page.  Enter text on 
each message page as follows: 

 Click the “Coming up next” and/or “Current date/time” buttons to 
automatically enter the corresponding text. 

 Type up to two lines of the default 22 pt, bold Ligurino text. The 
bottom line of text on each page is positioned on the overlay just 
above the safe title guideline.  Move to each new line of text by 
pressing “Enter” on your keyboard. 

4. Select from the “Page dwell time” drop down list to specify a display time 
between 8-90 seconds for each of your messages. When displayed, your 
messages will fade from one to another on the selected overlay. 

5. Click “OK” to close the “Overlay Graphic Editor” window. 
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Step 2: Create Overlay Template 

Create a customized listing of up to ten overlays according to the following steps.   

Select the “Overlay Templates” tab view on the main WinLGX window. 

Add an overlay template to the template listing by clicking the  icon and assigning a 
title in the “Create overlay template” box that appears (see Illustration 71, Add 

Overlay Template).  Click “OK” to create template or cancel to abort.  Click the  
icon to rename the overlay template. 

Illustration 71, Add Overlay Template 

 

Drag up to ten overlay library resources into the desired segments on the overlay 
template and click “OK” in each overlay properties box that appears.   

NOTE: In order to preserve your digital program’s beginning and ending graphics, 
each template has 30 second safe area boundaries. 

The display length of each segment is based on the length of the digital program the 
overlay template is scheduled to accompany.  To obtain the display length, subtract 
60 seconds (the total length of the “safe area” buffers) from the total length of the 
digital program and divide the remainder by ten.  For example, if the “WEEKDAY 
LINEUP” overlay template shown in Illustration 72 is selected to display with an 
hour-long video, the “Road Construction” overlay would display for 5 minutes and 54 
seconds.   
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Illustration 72, Adding Overlays to Template 

 
 

Step 3: Add an Overlay Template to a Digital Program 

Display overlay templates with digital programming in either of two ways:  

NOTE: Overlay templates must be paired with digital programs at least 65 seconds in 
length. 

 When Creating Digital Library Resources 

Assign an overlay template to a digital program when creating a digital library 
resource.  Every time the digital library resource is scheduled, the overlay 
template will display with it. 

 During Scheduling 

When a digital resource is added to the schedule, you may select an overlay 
template or edit the assigned template. 

 

Road Construction 

Overlay 
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Creating Library Resources 

Use the “Library View” windows to create library resources for drag and drop scheduling 
of frequently aired programs.  Then just add properties for a specific digital video or 
switch action to each new library resource.  Before scheduling library resources for 
external devices, ensure you have created resources for the corresponding devices that 
each library resource will be played or recorded on (see “Creating External Switch 
Device Resources,” starting on page 115).   

Create library resources as follows:   

1. Click on the “Library” folder on the right side of the schedule editor window to display 
the library view (see Illustration 73, “Library View” Windows). 

Illustration 73, “Library View” Windows 

 

2. Right-click in the “Resource View” window and select “New” in the context menu to 
insert an undefined, new resource in the window (see Illustration 74, New Library 
Resource Windows). 
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Illustration 74, New Library Resource Windows 

 

3. Complete the “Properties” fields for one of the following library resources: 

 “Switch Library Resources,” on page 130 

 “Digital Video Library Resources,” on page 132 

 “Digital Video Loop Library Resources,” on page 138 

  “Digital Video File Playlist Library Resources,” on page 154 

 “Virtual Channel (VC) List Library Resources,” on page 156  

NOTES:  Only digital video library resource properties can be exported into a 

resource file.    

  Only the library resource properties are exported into a resource file.  
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The digital video files remain in their current storage locations. 

a. Right click on the “Library” configuration folder containing the library resources 
you wish to export and select “Export” from the pop-up menu (see Illustration 75) 
to display the “Export MPEG Resource” window (see Illustration 76).  Resource 
files may only be exported and imported on a folder by folder basis. 

Illustration 75, Library "Export" Option 

 

Illustration 76, "Export MPEG Resource" Window 

 

b. If the selected library folder contains resources for digital videos on more than 
one USB or NAS device, single click to select a storage device in the “Export 
MPEG Resource” window (see Illustration 76, "Export MPEG Resource" 
Window).  Only the library resources referencing digital video files on the 
selected storage device will be exported in the resource file. 
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Illustration 77, "Export Resource" Library Resource Filename 

 

c. When the resource file has been uploaded to the selected UltraNEXUS-HD USB 
or NAS storage device, click “Ok” when you are prompted. 

d. If desired, repeat steps a–c for each set of library resources in the folder 
referencing digital videos on your other storage devices. 
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Switch Library Resources—External Switcher Configurations Only 

Create switch library resources containing properties for switch inputs, such as studio 
feeds or external character generators (CG) connected to your external switcher.  Click 
the “Library” folder and then right click in the “Resource View” window and select “New.”  
Select a switch input type under “Format” in the “Properties” window and then edit the 
remaining properties described in Table 21, referring to Illustration 78 throughout. 

Illustration 78, Example of Switch Library Resource Properties 

 

Table 21, Switch Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters 

Format Choose one of the following switch types: 
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FIELD DESCRIPTION 

 External CG 

 IRD 

 Switch 

 Studio  

Show in 
program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 
on the web program guide (see “Viewing Web Program Guide,” on 
page 317).  The scheduled resource will be listed according to its event 
start time and the text entered into the “Comment” field.     

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Length Enter the on-air length of the program medium. 

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the “Title” 
field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID If desired, assign a library tracking number. 

Field Name 
1–11 

If desired, select the user-defined column field items that pertain to the 
new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 
into a comma separated values format.  If “No” is selected, then you 
can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Digital Video Library Resources 

Create digital file library resources containing properties for video files that will be 
displayed by the UltraNEXUS-HD.  Click the “Library” folder and then right click in the 
“Resource View” window and select “New.”  Select “Video” under “Format” in the 
“Properties” window and then edit the remaining properties described in Table 22, 
referring to Illustration 79 throughout. 

Illustration 79, Digital Video Library Resource Properties 

 

Table 22, Digital Video Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Video” from the drop down list. 
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FIELD DESCRIPTION 

Show in program 
guide 

Select “Yes” from the drop down list to include the scheduled 
resource on the web program guide (see “Viewing Web Program 
Guide,” on page 317).  The scheduled resource will be listed 
according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the 
“Title” field is automatically placed in the “Comment” field, but may 
be changed.  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort 
selection. 

Video filename Use the “Filename” field to select the appropriate filename for the 
source as follows:  

1. Select the “Filename” field.  Click the ellipsis button to open the 
“Select File” window (see Illustration 80, “Select File” Window).  

Illustration 80, “Select File” Window 

 

2. Select a USB drive from the “Storage device” drop down list to 
display the drive’s stored Digital video files. 

3. To display a file’s properties and view the clip before 
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FIELD DESCRIPTION 

completing the selection, either right click on the file or click 
“Properties” to display the instant video preview monitor window 
(see Illustration 81).  For more information on the preview 
monitor, go to the “Using Instant Video Preview Monitor to 
Display Digital Video Files within WinLGX” section on page 
175. 

Illustration 81, Instant Video Preview Monitor 

 
4. Perform one of the following: 

 Enter a filename for a file that will be recorded and played 
within the same schedule: 

NOTE: The digital video record library resource is 
scheduled for recording through the UltraNEXUS-
HD digital video recorder device resources.  Refer 
to “Internal Digital Video Recorder Device 
Resources” on page 200 for further instructions.   

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the record time for the file. 

c. From the “Select file” dialog, click “OK” to accept 
filename or “Cancel” to abort. 

 Select the filename of a pre-recorded file: 

 Double-click the desired file to automatically accept 
selection and close “Select file” window.  

 Select the desired file. From the “Select file” dialog, click 
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FIELD DESCRIPTION 

“OK” to accept selection or “Cancel” to abort. 

Storage device The USB drive containing the digital video file is automatically 
displayed once the filename is selected. 

In/Out point (in 
HH:MM:SS:FF, 
where 
FF=frames) 

To specify where in the selected file you would like playback to 
begin and end, use the “In point” and “Out point” fields.  Either type 
the desired file start and end times into the fields or click either 
field’s ellipsis button to open the clip editor.   

Software Monitor 

The WinLGX video clip editor combines clip editing controls with a 
preview window for quick and convenient clip editing that does not 
interrupt programming playback on your UltraNEXUS-HD server’s 
video player.  To use this option, ensure the “Software Monitor” 
option is selected on the “Preview Monitor” tab in the “Preferences” 
window. 

Illustration 82, WinLGX Video Clip Editor with Preview Monitor 

 

1. If desired, adjust the volume control.  Audio is set to the lowest 
level by default. 

2. Ensure each point you wish to set has a green checkmark next 
to its time field.  
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FIELD DESCRIPTION 

3. If in and out points have already been set (there will be time 

values in the corresponding fields), you can use the seek  in 

and  out point buttons to move the playback bar to those 
points in the clip. 

4. Specify the clip’s playback in and out points using one of the 
following methods: 

 Click the  button to start playing the file and click the  

set in point button and  set out point button at the desired 
spots.  If you would like the clip to restart each time the end is 

reached, click the  loop button. 

 Drag the playback bar to the desired spot and click the  

set in point or  set out point button. 

 Click the  or  button to move between groups of 

pictures (GOPs) in the MPEG file and click the  set in 

point or  set out point button. 

 Click the  or  button to move forward or back in the 
MPEG file by the number of seconds specified on the 

“Playback Tab” of the “Preferences” window.  Click the  

set in point or  set out point button. 

Once the in and out points are selected, their begin and end time 
values will be displayed in the corresponding fields, and the total 
length of time from in to out point will be shown in the “Duration” 
field. 

NOTE: When you seek the current in or out point on the playback 
bar, you will notice a slight discrepancy between the 
current time displayed above the playback bar and the in or 
out point field values.  Clip playback between your in and 
out points will be as shown on the clip editor’s preview 
window. 

 

Length Automatically displayed once the digital video filename is selected.   

Video bit rate Automatically displayed once the digital video filename is selected. 

Video bitrate type Automatically displayed once the digital video filename is selected. 

Audio sample 
rate 

Automatically displayed once the digital video filename is selected. 
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FIELD DESCRIPTION 

Aspect ratio Set the desired playback aspect ratio. 

Overlay If desired, select one of the overlay templates created in the 
“Overlay Templates” view.  The graphic and text message overlays 
that are part of the selected template will then display with the 
program.   

Media ID If desired, assign a library tracking number. 

Field Name 1–11 If desired, select the user-defined column field items that pertain to 
the new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  
If “No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of 
each event properties window that appears during scheduling 
of the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be 
exported into a comma separated values format.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling 
of the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Digital Video Loop Library Resources 

Create digital video loop library resources containing properties for digital video files that 
will be repeatedly displayed on the UltraNEXUS-HD server’s internal HD/SD digital 
video players.  Each digital video loop library resource displays the selected digital 
video file for a specified number of times or loops.  Click the “Library” folder and then 
right click in the “Resource View” window and select “New.”  Select “Video Loop” under 
“Format” in the “Properties” window and then edit the remaining properties described in 
Table 23, referring to Illustration 83 throughout. 

Illustration 83, Digital Video Loop Library Resource Properties 

 

Table 23, Digital Video Loop Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Video Loop” from the drop down list. 
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FIELD DESCRIPTION 

Show in 
program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 
on the web program guide (see “Viewing Web Program Guide,” on 
page 317).  The scheduled resource will be listed according to its event 
start time and the text entered into the “Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the “Title” 
field is automatically placed in the “Comment” field, but may be 
changed.  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the ellipsis button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Video 
filename 

Use the “Filename” field to specify the file you wish to loop as follows:  

1. Select the “Filename” field and click the ellipsis button to open the 
“Select File” window (see Illustration 84, “Select File” Window).  

Illustration 84, “Select File” Window 

 

2. Select a hard drive or NAS storage device from the “Storage 
device” drop down list to display the drive’s stored Digital video 
files. 

3. To display a file’s properties and view the clip before completing 
the selection, either right click on the file or click “Properties” to 
display the instant video preview monitor window (see Illustration 
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FIELD DESCRIPTION 

85).  For more information on the preview monitor, go to the 
“Using Instant Video Preview Monitor to Display Digital Video 
Files within WinLGX” section on page 175. 

Illustration 85, Instant Video Preview Monitor 

 
4. Perform one of the following: 

 Enter a filename for a file that will be recorded and played 
within the same schedule: 

NOTE: The digital video record library resource is scheduled 
for recording through the UltraNEXUS-HD digital 
video recorder device resources.  Refer to “Internal 
Digital Video Recorder Device Resources” on page 
200 for further instructions.  

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the desired record time for the 
file.  

c. From the “Select file” dialog, click “OK” to accept filename 
or “Cancel” to abort. 

 Select the filename of a pre-recorded file: 

 Double-click the desired file to automatically accept 
selection and close “Select file” window.  

 Select the desired file.  From the “Select file” dialog, click 
“OK” to accept selection or “Cancel” to abort. 
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FIELD DESCRIPTION 

Storage 
device 

The storage device containing the digital video file is automatically 
displayed once the filename is selected. 

Length The file length is automatically displayed once the filename is specified.  
To specify the number of times or length of time you would like the file 
to loop, perform the following: 

1. Select the “Length” field and then click the ellipsis button to 
display the “Video Loop Calculator” (see Illustration 86).  

Illustration 86, Video Loop Calculator 

 
2. Enter the number of times you would like the file to loop in the 

“Loop count” field and/or enter a length of time, up to 24 hours, in 
the “Loop length” field. 

Video bit rate Automatically displayed once the digital video filename is selected. 

Video bit rate 
type 

Automatically displayed once the digital video filename is selected. 

Audio 
sample rate 

Automatically displayed once the digital video filename is selected. 

Aspect ratio Set the desired playback aspect ratio.  

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view.  The graphic and text message overlays that are part 
of the selected template will then display with the program.   

Media ID If desired, assign a library tracking number. 

Field Name 
1–11 

If desired, select the user-defined column field items that pertain to the 
new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Export Select “Yes” to allow all of the resource’s event records to be exported 
into a comma separated values format.  If “No” is selected, then you 
can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

 

Slide Library Resources 

Slide library resources contain properties for JPEG slides that will be displayed on the 
UltraNEXUS-HD system’s internal Video player.  Before creating a slide library 
resource, upload the desired slide into an UltraNEXUS-HD user folder(s) through the 
WinLGX Storage Manager window or WebNEXUS: 

 WinLGX Storage Manager: refer to “Managing All Digital Files,” on page 255. 

 WebNEXUS interface: see the “Uploading Slides to a UltraNEXUS-HD 
Server/Controller” on page 289 to learn how to upload slides through 
WebNEXUS and “Approving Slides for Display in Slide Shows” on page 309 for 
instructions on how to enable the slide for display. 

To create a library resource for a slide, click the “Library” folder and then right click in 
the “Resource View” window and select “New.”  Select “Slide” under “Format” in the 
“Properties” window and then complete the remaining properties described in Table 24, 
referring to Illustration 87 throughout. 

NOTE: The UltraNEXUS-HD system ships with sample slides under “ADMIN” and a 
variety of background slides available to all user accounts.  Sample slides are 
provided to demonstrate possible usages for the digital messaging feature.  
Users may create their own slide shows by adding text and graphics to the 
included template backgrounds. 
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Illustration 87, Slide Library Resource Properties 

 

Table 24, Slide Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Slide” from the drop down list. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Slide 
filename 

Use the “Slide filename” field to select the appropriate slide filename 
for the source as follows: 

1. Select the “Filename” field and click the button that appears to 
open the “Select Slide” window (see Illustration 88, “Select Slide” 
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Window). 

Illustration 88, “Select Slide” Window 

 

2. Select a username from the “Users” drop down list to display the 
JPEG slides in the corresponding remote user folder. 

3. Select a slide as follows: 

 Double-click the desired file to accept selection and close 
“Select slide” window.  

 Select the desired file and click “OK” to accept or “Cancel” to 
abort selection. 

User folder Automatically displayed once the slide is selected. 

Length The default slide length specified in the “Application” tab of the 
“Preferences” window is automatically displayed once the slide 
filename is selected (see page 88 for more information), but may be 
edited to any value greater than 5 seconds. 
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Background If desired, select an audio source to play with your slide file display.  
Under the “Background audio input” field, perform one of the following: 

 Select “from MPEG” to play the audio from a video file.  Load a 
video file using the “MPEG filename” field that appears.   

 Select the type of audio signal connected to your UltraNEXUS-
HD:  
 “Analog”: corresponds to the analog audio inputs on the 

UltraNEXUS-HD’s back panel terminal blocks (see Table 2, 
Non-Embedded Audio Terminal Block Configurations, for 
analog audio wiring diagram) 

 “AES”: corresponds to the AES audio inputs on the 
UltraNEXUS-HD’s back panel terminal blocks (see Table 2, 
Non-Embedded Audio Terminal Block Configurations, for 
AES audio wiring diagram) 

 “Embedded 1-2,” “Embedded 3-4,” “Embedded 5-6,” and 
“Embedded 7-8”: if your audio is embedded within the SDI 
video signal, select the embedded audio channel pair that 
you want under your slide 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view.  The graphic and text message overlays that are part 
of the selected template will then display with the program.   

Media ID If desired, assign a library tracking number. 

Field Name 
1–11 

If desired, select the user-defined column field items that pertain to the 
new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 
into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Slide Show Library Resources 

Slide show library resources contain properties for sequences of JPEG slides that will 
be displayed on the UltraNEXUS-HDsystem’s internal player.  The slides displayed in a 
slide show are the slides within each of the selected user account folder(s).   

Before creating a slide show library resource, upload the desired slides into an 
UltraNEXUS-HD user folder(s) and enable/authorize each slide for display in slide 
shows through the WinLGX Storage Manager window or WebNEXUS: 

 WinLGX Storage Manager: refer to “Managing All Digital Files,” on page 255. 

 WebNEXUS interface: see the “Uploading Slides to a UltraNEXUS-HD 
Server/Controller” on page 289 to learn how to upload slides through 
WebNEXUS and “Approving Slides for Display in Slide Shows” on page 309 for 
instructions on how to enable the slide for display. 

If the slide was not uploaded by a user with the “Automatic slide authorization” or “Slide 
administrator” user right, it must also be authorized for display in slide shows by the 
“admin” user account or a user with the “Slide administrator” right (see “Enabling and 
Authorizing Slides for Display in Slide Shows” on page 258 or “Approving Slides for 
Display in Slide Shows,” on page 309. 

To create a library resource for a slide, click the “Library” folder and then right click in 
the “Resource View” window and select “New.”  Select “Slide Show” under “Format” in 
the “Properties” window and then complete the remaining properties described in Table 
25, referring to Illustration 89 throughout. 

NOTE: Each UltraNEXUS-HD server/controller ships with sample slides under 
“ADMIN” and a variety of background slides available to all user accounts.  
Sample slides are provided to demonstrate possible usages for the digital 
messaging feature.  Users may create their own slides by adding text and 
graphics to the included template backgrounds. 
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Illustration 89, Slide Show Library Resource Properties 

 
 

Table 25, Slide Show Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Slide Show.” 

Show in 
program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 
on onscreen program guides (see “Onscreen Program Guide Library 
Resources,” on page 150) and the web program guide (see “Viewing 
Web Program Guide,” on page 317).     

Comment Enter a unique and descriptive name with up to 31 characters to 
represent the resource on the onscreen and web program guides.    
The text entered in the “Title” field is automatically placed in the 
“Comment” field, but may be changed.  
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FIELD DESCRIPTION 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

User list Select one or more usernames to display the JPEG slides in the 
corresponding remote user folders as follows: 

NOTE: Create a default slide to display in case the selected user 
folder is empty or does not contain approved slides (refer to 
“Creating a Default Slide,” on page 306). 

1. Select the “User list” field and click the button that appears to 
open the user selection window shown in Illustration 90, “User list” 
Window. 

NOTE: The UltraNEXUS-HD systems ship with sample slides 
under “ADMIN” and a variety of background slides 
available to all user accounts.   

Illustration 90, “User list” Window 

 

2. Select the desired username(s) as follows: 

 Click the “All” button to select all usernames. 

 Click the “None” button to deselect all usernames. 

 Individually select usernames by clicking on the desired 
username boxes. 

3. Click “OK” to accept selections or “Cancel” to abort. 
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FIELD DESCRIPTION 

Length Edit to the desired run time for the entire slide show.  Each slide within 
the slide show will automatically display for 10 seconds at a time.  The 
display duration for each slide may be changed from the WebNEXUS 
interface (see “Adding Slide Show Settings to Slide Metadata307,” on 
page 306). 

Background If desired, select an audio source to play with your slide file display.  
Under the “Background audio input” field, perform one of the following:  

 Select “from MPEG” to play the audio from a video file.  Load a 
video file using the “MPEG filename” field that appears.   

 Select the type of audio signal your UltraNEXUS-HD has been 
wired to record:  
 “Analog”: corresponds to the analog audio inputs on the back 

panel terminal blocks (see Table 2, Non-Embedded Audio 
Terminal Block Configurations, for analog audio wiring 
diagram) 

 “AES”: corresponds to the AES audio inputs on the SDI’s 
back panel terminal blocks (see Table 2, Non-Embedded 
Audio Terminal Block Configurations, for AES audio wiring 
diagram) 

 “Embedded 1-2,” “Embedded 3-4,” “Embedded 5-6,” and 
“Embedded 7-8”: if your audio is embedded within the SDI video 
signal, select the embedded audio channel pair that you want to 
record. 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view.  The graphic and text message overlays that are part 
of the selected template will then display with the program.   

Media ID If desired, assign a library tracking number. 

Field Name 
1–11 

If desired, select the user-defined column field items that pertain to the 
new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 
into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
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FIELD DESCRIPTION 

each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

 

Onscreen Program Guide Library Resources 

Create dynamic onscreen program guide resources that layer the most current schedule 
events over JPEG slide backgrounds (see Illustration 91 for an example of a program 
guide).  Once a program guide event is executed, up to ten of the upcoming programs 
on the selected channel output tab are displayed on the selected slide.  Each program 
on the guide is listed according to its event start time and “Comment” text in the default 
font size, color, and style shown in Illustration 91. 

Illustration 91, Example of Onscreen Program Guide 

 
 

 
To create a library resource for a program guide, click the “Library” folder and then right 
click in the “Resource View” window and select “New.”  Select “Program Guide” under 
“Format” in the “Properties” window and then edit the remaining properties described in 
Table 26, referring to Illustration 92 throughout. 

JPEG Slide 

Program 
Guide 
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Illustration 92, Program Guide Library Resource Properties 

 
 

Table 26, Program Guide Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Program Guide” from the drop down list. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Slide 
filename 

Use the “Slide filename” field to select the appropriate slide filename 
for the source as follows: 
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FIELD DESCRIPTION 

1. Select the “Filename” field and click the button that appears to 
open the “Select Slide” window (see Illustration 93, “Select Slide” 
Window). 

Illustration 93, “Select Slide” Window 

 

2. Select a username from the “Users” drop down list to display the 
JPEG slides in the corresponding remote user folder. 

3. Select a slide as follows: 

 Double-click the desired file to accept selection and close 
“Select slide” window.  

 Select the desired file and click “OK” to accept or “Cancel” to 
abort selection. 

User folder Automatically displayed once the slide is selected. 

Length Automatically displayed once the slide file is selected, but may be 
edited to any value greater than 5 seconds. 

Background If desired, select an audio source to play with your slide file display.  
Under the “Background audio input” field, perform one of the following:  

 Select an audio input. 

 Select “from MPEG” to play the audio from a video file.  Load a 
video file using the “MPEG filename” field that appears.   
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Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view.  The graphic and text message overlays that are part 
of the selected template will then display with the program.  

Media ID If desired, assign a library tracking number. 

Field Name 
1–11 

If desired, select the user-defined column field items that pertain to the 
new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 
into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Digital Video/Slide Playlist Library Resources 

Create digital video/slide file playlist library resources containing properties for multiple 
digital video files that will be displayed by the UltraNEXUS-HD’s internal HD/SD 
player/recorder.  Playlist resources allow users to simultaneously schedule one or more 
digital video files and/or slides.  Click the “Library” folder and then right click in the 
“Resource View” window and select “New.”  Select “Playlist” under “Format” in the 
“Properties” window and then edit the remaining properties described in Table 27, 
referring to Illustration 94 and Illustration 95 throughout. 

Illustration 94, Playlist Library Resource Properties 

 

Illustration 95, “Playlist Editor” Window 
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Table 27, Playlist Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Playlist.” 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Resource list Select the “Resource list” field and click the button that appears to 
open the “Playlist Editor” window shown in Illustration 95 and perform 
the following steps: 

1. Under “Library View,” click on the library folder to display the 
resource you would like to add to the playlist. 

2. Select the desired resource under “Resource View.” 

3. Click the “Add” button to add resource to the “Playlist” window. 

4. Repeat steps for each additional resource you would like to place 
in the playlist. 

5. Use any of the following options to edit playlist: 

 To remove an item from the playlist, highlight the resource and 
click the “Delete” button. 

 To remove all items from the playlist, click the “Clear All” 
button and select “Yes” in the dialog that appears or “No” to 
abort the operation. 

 To reorder playlist, highlight a resource and click the “Up” 
and/or “Down” buttons to move resource into new playlist 
position. 

6. Click “OK” to create playlist resource or “Cancel” to abort 
changes. 

Length Displays total length of library resources added to playlist. 

Playlist Displays filename and length of each library resource added to playlist. 

 

Virtual Channel (VC) List Library Resources 

Virtual Channel library resources allow you to use your Virtual Channel playlist files as 
scheduled programming.  Before you can create a Virtual Channel library resource, you 
must first create one or more Virtual Channel playlist files in the UltraNEXUS-HD web 
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interface (see “Creating/Modifying Virtual Channel Playlists,” on page 330).  Click the 
“Library” folder and then right click in the “Resource View” window and select “New.”  
Select “VC List” under “Format” in the “Properties” window and then edit the remaining 
properties described in Table 27, referring to Illustration 94 and Illustration 95 
throughout. 

Illustration 96, VC List Library Resource Properties 

 

Table 28, Playlist Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “VC List.” 

Show in 
program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 
on onscreen program guides (see “Onscreen Program Guide Library 
Resources,” on page 150) and the web program guide (see “Viewing 
Web Program Guide,” on page 317).     
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FIELD DESCRIPTION 

Comment Enter a unique and descriptive name with up to 31 characters to 
represent the resource on the onscreen and web program guides.    
The text entered in the “Title” field is automatically placed in the 
“Comment” field, but may be changed.  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

VC List 
Filename 

Click the ellipsis button to open the “Select Virtual Channel” popup 
window.  Single click to select a Virtual Channel playlist file from the 
listing and click “OK” to add the file to your library resource’s properties 
or “Cancel” to abort.  

Length Defaults to the total length of all resources in the playlist, but may be 
changed to any length of time up to 23 hours:59 minutes:59 seconds.  
If a longer length is specified, the playlist will repeat in order, and if 
less, not all of the playlist resources will be displayed.   

Media ID If desired, assign a library tracking number. 

Field Name 
1–11 

If desired, select the user-defined column field items that pertain to the 
new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 
into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Exporting Library Resources  

When you have finished creating your library resources, you have the option of 
exporting any MPEG library resource properties into resource files (.res) on your 
UltraNEXUS-HD system’s USB and NAS storage devices.  Resource files are useful for 
quickly importing library resource properties into a new NEXUS series image file and, if 
saved on a NAS storage device, are accessible to any NEXUS series server in your 
system.  To export library resources into a resource file, perform the following: 

NOTES:  Only video library resource properties can be exported into a resource 

file.   

  Only the library resource properties are exported into a resource file.  
The video files remain in their current storage locations. 

1. Right click on the “Library” configuration folder containing the library resources you 
wish to export and select “Export” from the pop-up menu (see Illustration 97) to 
display the “Export Video Resource” window (see Illustration 98).  Resource files 
may only be exported on a folder by folder basis. 

Illustration 97, Library "Export" Option 

 

Illustration 98, "Export Video Resource" Window 
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2. If the selected library folder contains resources for MPEG videos on more than one 
USB or NAS device, you will see a list of storage devices at the top of the “Export 
MPEG Resource” window (see Illustration 98).  Single click to select the storage 
device containing the MPEG files in the library resources you wish to export.  To 
export all of your MPEG library resources, you will need to create a separate export 
file for each storage device. 

3. If you wish to overwrite an existing resource file, single click to select the file in 
“Resource Files” listing.  Click the “Export” button and, if saving a new resource file, 
enter an alphanumeric filename without spaces into the “Export resource” window 
(see Illustration 99).  Click “Ok” to upload the file to the selected storage device or 
“Cancel” to abort. 

Illustration 99, "Export Resource" Library Resource Filename 

 

4. When the resource file has been uploaded to the selected NEXUS series USB or 
NAS storage device, click “Ok” when you are prompted. 

5. If desired, repeat the steps in this section for each set of library resources in the 
folder referencing MPEG videos on your other storage devices. 
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Software Operation 

About this Section 

Introduced in the previous section, the tabs, icons, and menu items for the WinLGX 
schedule view will now be explained in greater detail.  The first part of this section 
teaches you how to use the schedule view components to add events to your 
UltraNEXUS-HD image files for automated playback and recording.  The system, 
device, and library (media) properties must be entered into the current image file before 
event scheduling can occur (see “Software Installation & Configuration,” starting on 
page 52, for instructions).  To create a schedule, simply drag and drop your device and 
library icons onto the schedule view and then complete the corresponding event 
properties windows.  This section also shows you how to use the WinLGX control panel 
for the times you wish to immediately perform switching and device control or start/stop 
a schedule. 

At the end of this section, you will learn how to manage the storage of any digital videos 
on your UltraNEXUS-HD system’s internal and external storage areas.  With the 
WinLGX “Storage Manager” window, you can delete, move, and copy digital video files 
between your local (PC) and remote storage areas.   
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Performing General WinLGX Operations 

Opening WinLGX and Connecting to an UltraNEXUS-HD Server 

Double click the WinLGX desktop icon.  The login window shown in Illustration 100 
automatically appears when WinLGX is opened or when you click one of the following: 

 Select “Site manager” in the “Tools” menu 

 Click the  icon on the toolbar 

Illustration 100, “Site Manager” Window 

 

If desired, reorder your IP address listing.  Clicking on any column header in the “Site 
Manager” sorts the associated information in ascending order, while clicking the header 
again sorts the list in descending order. 

Connect as follows (see Illustration 100, “Site Manager” Window): 

NOTE: The WinLGX title bar on the main window states whether or not you are 
connected. 

a. Select one or more IP addresses.  You may select up to eight IP addresses by 
holding down your keyboard “Ctrl” key and clicking each address with the left 
mouse button.     
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b. Log in with the username and password given to you by the UltraNEXUS-HD 
system administrator.  To simultaneously log into multiple servers, all of the 
selected IP addresses must have the same username and password. 

NOTE: Connect to multiple UltraNEXUS-HD servers with different usernames 
and passwords by logging in separately to each system. 

If the username and password have not been changed from the factory defaults, 
enter the following: 

UltraNEXUS-HD FACTORY-DEFAULT USERNAME AND PASSWORD 

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR UltraNEXUS-HD 

SYSTEM’S SERIAL # 

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 

 

NOTES:  Only letters and numbers may be used in your username and 
password. 

  Logins are case sensitive. 

 If the correct characters are not entered, an error message will 
be displayed. 

  An administrator can assign various degrees of rights to each 
username, so not all menu items or functions may be available 
to a user. 

  The last six digits of your UltraNEXUS-HD server’s serial 
number are viewable from the front panel (see “Configuring 
Front Panel Settings,” on page 42) and a sticker on the back of 
your UltraNEXUS-HD server. 

c. Click “Connect” or press “Enter” to connect to the chosen UltraNEXUS-HD 
server(s) and close the login dialog box.  Once you are connected, a tab appears 
for each UltraNEXUS-HD server on the main window beneath the toolbar.   

d. If you logged into more than one UltraNEXUS-HD system, switch between the 
servers by clicking on the product tabs on the main window.   
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Displaying WinLGX Version Number 

Select “About WinLGX” in the “Help” menu or click the  main toolbar icon to open a 
window with the WinLGX version number.  Click on the window to close it. 

Illustration 101, About WinLGX Window 
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Disconnecting from an UltraNEXUS-HD Server 

To disconnect WinLGX from your UltraNEXUS-HD system, perform the following steps: 

NOTE: The UltraNEXUS-HD system will continue to operate while disconnected from 
WinLGX. 

Select “Site manager” in the “Tools” menu or click the  icon on the toolbar to open 
the “Site Manager” window shown in Illustration 100. 

Select the UltraNEXUS-HD address(es) you would like to disconnect.  If you want to 
disconnect from more than one address, hold down your keyboard “Ctrl” key and click 
on each address with the left mouse button. 

Click the “Disconnect” button.  A box will appear asking whether or not you would like to 
disconnect from the current UltraNEXUS-HD location(s).  Click “Yes” to disconnect or 
“No” to remain connected. 

Exiting WinLGX 

To disconnect from your UltraNEXUS-HD server(s) and close the WinLGX software, 
perform the following steps: 

NOTE: The UltraNEXUS-HD server will continue to operate while disconnected from 
WinLGX.  

Select “Exit” in the “File” menu or click the  in the upper right corner of the main 
window.   

If an image file has not been saved for one of the connected UltraNEXUS-HD servers, 
the dialog box shown in Illustration 102 appears and asks if you want to save the 
changes.  Select one of the following options: 

Illustration 102, WinLGX Exit Dialog Box 
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 “Save to disk”: click “Yes” to open the “Save As” window.  Once you browse to 
the desired file path and save your changes (see “Saving UltraNEXUS-HD Image 
Files,” on page 171), WinLGX will automatically close.  

 “Save to controller”: click “Yes” to send the image file to the UltraNEXUS-HD 
server.  Once the send is complete, the server will contain and execute the 
schedule and WinLGX will automatically close.   

 “Save to disk and controller”: click “Yes” to open the “Save As” window.  Once 
you browse to the desired file path and save your changes (see “Sending 
UltraNEXUS-HD Image Files,” on page 231), WinLGX will send the image file to 
the UltraNEXUS-HD server.  Once the send is complete, the UltraNEXUS-HD 
server will contain and execute the schedule and WinLGX will automatically 
close.   

 Select “No” to discard any changes made since the last save and close WinLGX. 

 Select “Cancel” to prevent WinLGX from closing and keep the current image file 
open. 

Opening UltraNEXUS-HD Image Files 

Each UltraNEXUS-HD image file (.nmg) holds your schedule events along with 
your system, device, and library resource properties.  The “Configuring WinLGX” 
section, starting on page 63, describes how to define these configuration properties.  
The image file’s configuration properties must be entered into the current image file 
before event scheduling can occur.    

NOTE: If you have not yet created an UltraNEXUS-HD image file, go to “Creating 
New UltraNEXUS-HD Image Files,” on page 62. 

If an unsaved image is open in WinLGX when you attempt to open another image, a 
dialog box (see Illustration 102) appears and asks if you want to save the changes.  
Select one of the following options: 

 Save to disk: click “Yes” to open the “Save As” window.  Browse to the desired 
file path and save your changes (see “Saving UltraNEXUS-HD Image Files,” on 
page 171).  

 Save to controller: click “Yes” to send the image file to your UltraNEXUS-HD 
system.  Once the send is complete, the UltraNEXUS-HD system will contain and 
execute the schedule.   

 Save to disk and controller: click “Yes” to open the “Save As” window.  Once you 
browse to the desired file path and save your changes (see “Saving 
UltraNEXUS-HD Image Files,” on page 171), WinLGX will send the image file to 
the UltraNEXUS-HD system.  Once the send is complete, the UltraNEXUS-HD 
system will contain and execute the schedule.   

 Select “No” to discard any changes made since the last save and close WinLGX. 

 Select “Cancel” to prevent WinLGX from closing and keep the current image file 
open. 
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Open an UltraNEXUS-HD image file according to one of the following 
subsections: 

 “Opening a Saved Image File,” on page 167 

 “Opening an Image File as New,” on page 168 

 “Receiving Image Files from the Connected UltraNEXUS-HD Server(s),” on 
page 169 

 “Associating UltraNEXUS-HD Image Files with WinLGX,” on page 170 

Opening a Saved Image File 

An image file contains any data that was entered and saved in the schedule and 
system, device, and library properties windows.  Open a saved image file as follows: 

Select “Open” in the “File” menu or click the  icon on the main toolbar to open the file 
selection window shown in Illustration 103.   

Illustration 103, Open Image File Window 

 

NOTE: If your image file was saved without the Virtual Channel feature enabled 
and the image file contains MPEG events scheduled on the first channel 
output tab, WinLGX will display a “schedule fixup” message.   

 No external switcher configurations will be given the option to 
automatically enable the Virtual Channel feature and assign the video 
player to the first channel output tab.  

 External switcher users who would like to use the Virtual Channel 
feature must manually make the necessary image changes.  Assign 
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channel to the Video player, change existing MPEG events on the first 
channel output tab to display on the assigned MPEG player, and then 
enable the Virtual Channel feature. 

Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” 
field. 

Select an image file folder from the “Look in” drop down box at the top of the window.   

Single click a .nmg file to select it and click “Open” or double click the file.  The image 
file data is then loaded into WinLGX.   

As you enter/edit your schedule events according to the “Scheduling Events” section 
starting on page 177, periodically save your settings in an image file as described in 
“Saving UltraNEXUS-HD Image Files,” on page 171. 

Opening an Image File as New 

Opening a previously saved image file as new causes WinLGX to load any system, 
device, and library configuration properties contained within the file.  Any schedule 
events will not be imported.  

Select “Open as new” in the “File” menu or click the  icon on the main toolbar to open 
the file selection window shown in Illustration 104, Open Image File as New Window.   

Illustration 104, Open Image File as New Window 

 

Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” 
field. 
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Select an image file folder from the “Look in” drop down box at the top of the window.     

Single click a .nmg file to select it and click “Open” or double click the file.  The image 
file data minus the schedule is then loaded into WinLGX as an unnamed file.    

As you enter/edit your schedule events according to the “Scheduling Events” section 
starting on page 177, periodically save your settings in an image file as described in 
“Saving UltraNEXUS-HD Image Files,” on page 171. 

Receiving Image Files from the Connected UltraNEXUS-HD Server(s) 

An image received from a connected UltraNEXUS-HD server contains any schedule 
events and system, device, and library properties last sent to the server.   

Download the last image file sent to one or more of your UltraNEXUS-HD servers as 
follows: 

 One server: ensure the server’s product tab is selected and choose “Receive” in 

the “File” menu or click its  icon on the main toolbar.  A dialog box will ask 
whether you want to receive the image currently loaded on the connected 
UltraNEXUS-HD server.  Click “Yes” to complete the receive and display the 
status box shown in Illustration 105. 

Illustration 105, Image Status Window 

Progress Bar

 

 Multiple servers: from any of the product tabs, select “Receive all” in the “File” 
menu.  Click “Yes” when prompted to download each connected server’s 
image file into WinLGX.  You will see a status box like the one shown in 
Illustration 105 for each image file. 

NOTE: If your image file was saved without the Virtual Channel feature 
enabled and the image file contains video events scheduled on the 
first output tab, WinLGX will display a “schedule fixup” message.   

 No external switcher configurations will be given the option to 
automatically enable the Virtual Channel feature and assign the video 
player to the first channel output tab.  Be aware that all events on the 
first channel output tab will then be changed to display on Video 
Player 1. 

 External switcher users who would like to use the Virtual Channel 
feature must manually make the necessary image changes.  Assign 
channels to the MPEG players, change existing MPEG events on the 
first channel output tab to display on the MPEG player, and then 
enable the Virtual Channel feature. 
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As you enter/edit your schedule events according to the “Scheduling Events” section 
starting on page 177, periodically save your settings in an image file as described in 
“Saving UltraNEXUS-HD Image Files,” on page 171. 

Associating UltraNEXUS-HD Image Files with WinLGX 

Associating an UltraNEXUS-HD image (.nmg) files with WinLGX enables you to double 
click on an image file and have it automatically open in WinLGX.  Perform the following 
procedure: 

1. Browse to an UltraNEXUS-HD image (.nmg) file.   

2. Right click on the UltraNEXUS-HD image file and choose "Open with" or "Open." 

3. Choose "Select the program from a list." 

4. Browse to and choose the WinLGX executable file path.   

5. Check the "Always use ..." checkbox and click "OK." 
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Saving UltraNEXUS-HD Image Files 

Save a copy of your current image file to your PC or network through one of the 
following options: 

 “Save” Option 

If an UltraNEXUS-HD image has not been saved to your PC or network or has been 
modified, the “Save” option becomes enabled.  Select “Save” from the “File” menu or 

click the  toolbar button.   

 If the UltraNEXUS-HD image already has a local filename, visible in the title bar 
(WinLGX – filename.nmg), the “Save” option saves the loaded image to that 
name without prompting, overwriting the old file.   

 If the image does not have a local filename, “Save” opens the “Save as” box 
shown in Illustration 106, allowing a name and file path to be specified. 

 “Save as” Option 

The “Save as” option allows you to save an UltraNEXUS-HD image under a new 
filename.  Select “Save as” in the “File” menu to open the window shown in  
Illustration 106, and perform the following steps:  

Illustration 106, “Save As” Window 

 

From the “Save in” drop down box at the top of the window, navigate to the folder where 
you want to save the UltraNEXUS-HD image file.   



UltraNEXUS-HD 
Software Operation 

 

Page 172 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.3.17 Revised 11/22/2016 
 

Type a name for the image in the “File name” field.   

If you plan to re-open this file in WinLGX, ensure the “Controller Image (*.nmg)” option 
has been selected in the “Save as type” field. 

Click “Save” to save the image under the entered name or “Cancel” to abort the “Save 
as.”  If you enter a name of a file that already exists, WinLGX will ask you if you want to 
overwrite it. 
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Importing Digital Video Library Resources 

If your digital video library resource properties have been exported into one or more 
resource files (see step “Exporting Library Resources” on page 159 for information on 
exporting digital video library resource properties), simply upload the resources into 
your current UltraNEXUS-HD image file as follows: 

Right click on the “Library” configuration folder you wish to import digital video library 
resources into and select “Import” from the pop-up menu (see Illustration 107) to display 
the “Import MPEG Resource” window (see Illustration 108).  Resource files may only be 
imported on a folder by folder basis. 

Illustration 107, Library "Import" Option 

 

Illustration 108, "Import MPEG Resource" Window 

 

If more than one device is shown in the “Storage Device” listing on the “Import MPEG 
Resource” window (see Illustration 108, "Import MPEG Resource" Window), single click 
to select the storage device containing the resource files with the library resource 
properties you wish to import.   
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If more than one resource file exists, single click to select the file with the library 
resources you wish to import (see Illustration 109). 

Illustration 109, Selecting File on "Import MPEG Resource" Window 

 

Click the “Import” button to start importing the resources or “Done” to cancel the 
operation and close the “Import MPEG Resource” window. 

After clicking the “Import” button, click “Yes” when prompted to import the file’s digital 
video library resource properties or “No” to abort. 

When the digital video library resource properties have been imported, click “Ok” when 
you are prompted.  The imported library resources will be shown in the “Resource View” 
(see Illustration 110 for an example). 

Illustration 110, Imported Library Resources 
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Using Instant Video Preview Monitor to Display Digital Video Files 
within WinLGX 

WinLGX gives you the option to preview the digital video files on your remote (USB 
and/or NAS devices) and local (PC, network) storage areas through its instant video 
preview monitor window.  Conveniently access the instant video preview monitor when 
you are scheduling a digital video device or library resource, choosing a digital video file 
for immediate display through the control panel, or using the Storage Manager window 
to manage your digital videos.   

Access the instant video preview monitor (see Illustration 111) from any of the following: 

 Storage Manager window 

 Double click a digital video file 

 Right click a digital video file and select “View” from the right-click menu 

 “Select File” window (available when initiating playback from control panel, 
scheduling digital video device resources, and creating library resources):  

 Right click on digital video file 

 Single click an digital video file and click the “Properties” button 

 Library Resource View Window 

 Double click a library resource 

 Right click a library resource and select “View Resource” from right-click menu 

IMPORTANT! VLC media player must be installed on the computer running WinLGX 
if you wish to display digital video videos in the WinLGX preview 
monitor windows.  If WinLGX states that it cannot find the VLC media 
player when you open a preview monitor window, first ensure that VLC 
player is installed on your computer.  If VLC player is not installed, 
download the free program from the Internet.  Once installation has 
been verified or completed, find your computer’s file path for the folder 
containing the VLC executable file (“vlc.exe”).  Open the WinLGX 
“Preferences” window, select the “Preview Monitor” tab, and enter your 
file path into the “VLC Application Folder” field (for example, 
C:\Program Files\VideoLAN\VLC). 

The instant video preview monitor includes controls for managing playback of the 
selected digital video file.  Refer to the following for more information on each of the 
controls labeled in Illustration 111, Preview Monitor Controls: 
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Illustration 111, Preview Monitor Controls 

 

 Scrub Bar Slider: click and drag with your mouse pointer to go forward or backward 
in  the video 

 Play/Pause Button: click to toggle between pause and playback of the video 

 Step Forward Button: moves the video one frame forward each time it is clicked 

 Close Window Red X Icon: closes preview monitor window when clicked 

 Volume Control: click and drag the volume control slider to adjust video’s volume.  
The volume control defaults to no audio. 

 Mute Button: click the mute button to toggle between silenced and restored audio. 

 File Properties: provides the name, length, video bit rate, audio sample rate, and 
storage device of the selected digital video file 

NOTE: The digital video file’s properties are only displayed when the preview 
monitor is accessed from the “Select File” window. 

 Resize Window Control: use to expand or shrink the size of the preview monitor 
window. 
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Scheduling Events 

The “Schedule” window, shown in Illustration 112, with a sample schedule loaded, is 
where an event schedule is created.   

Illustration 112, Schedule Window 

 

About Schedule Window Components 

Product Tabs 

For each LEIGHTRONIX product you are logged into, a separate tab appears on the 
main window.  Click on a tab to display the corresponding product view and then enter 
your scheduling information for the selected product. 

Schedule View 

The schedule view window displays the channel output tabs, day tabs, WinLGX-LT tab, 
and schedule columns.  Add (drag and drop) your events to this window. 
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Overlay Templates View 

The “Overlay Templates” view displays the overlay template creation icons and the 
program segments available for your individual overlay resources.  Use this window to 
create overlay templates for your digital media resources. 

Illustration 113, "Overlay Templates" View in WinLGX 

 

 

Channel Output Tabs 

 Channel output tabs: use to schedule events that contain switches to the selected 
tab’s assigned output.   

NOTE: The number of outputs, labels, and channel/output assignments are 
entered in the “System Configuration View” (see “Configuring the Switch 
Type of an UltraNEXUS-HD,” on page 99).  On external switchers, 
WinLGX only allows scheduling on up to 16 channel output tabs. 

 No external switcher configurations: use “Sch Rec” tab to schedule record events on 
the HD/SD digital video Recorder. 
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Day Tabs 

Day tabs are used to schedule events on specified days.  The day tabs perform output 
and device conflict checking across all of the channel tabs, so that an output or a device 
can never have more than one event scheduled at the same time.   

Each event contains all of the starting and ending actions for a program, and thus uses 
up a block of time for the length of the program.  WinLGX orders these blocks vertically 
in the schedule window, one row per event, so that for a particular output on a particular 
day, you can see the day’s 24 hours divided into programs. 

 Locked Events 

If an event is locked, it has a fixed time entered by the user.  This allows it to be 
scheduled away from the end of the previous event or away from the beginning 
of the day.  If this is done, a channel switchback is indicated between the events, 
or at the beginning of the day.  Each channel switchback equals the length of 
time separating the preceding event from the next scheduled event.  Channel 
switchbacks appear in a different color (yellow by default). 

 Unlocked Events 

An unlocked event’s time is assigned by WinLGX to coincide with the ending time 
of the event above it.  This time is not fixed and will be adjusted by WinLGX if 
events above the unlocked events are inserted, deleted, moved, or modified. If 
an added or edited event’s time or length causes it to overlap an unlocked event, 
the unlocked event will move downward in the schedule if it can. 

NOTE: If adding, editing, or deleting an event causes two events to conflict, an error 
message appears.  If the added/edited event is one of the conflicting events, 
the event it conflicts with is listed, the error is described, and the outcome is 
given.  If the added/edited/deleted event is not one of the conflicting events, 
the two conflicting events are listed, the error is described, and the outcome is 
given.  Use this information to correct the conflict. 
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WinLGX-LT Tab 

The WinLGX-LT tab (see Illustration 112, Schedule Window) has its own date/day and 
time entry and does not assign blocks of time in a linear fashion like the day tabs.   

NOTE: To display the WinLGX-LT tab on the bottom of your schedule window, 
select the “Show WinLGX-LT tab in the schedule window” option on the 
“Application” tab of the Tools\Preferences window. 

The WinLGX-LT tab is useful in the following situations: 

NOTE: The WinLGX-LT tab does not prevent two events from occupying the same 
time. 

 External Switcher Configuration Only: schedule device or library resources 
attached to external switcher outputs outside the range of the 16 channel output 
tabs. 

 When you would like to use the same event on multiple days, schedule the event 
on the WinLGX-LT tab once and avoid having to recreate or copy the event on 
multiple day tabs.  

 If you would like to create a schedule that encompasses more than the next 
seven days, use the WinLGX-LT tab and schedule according to date. 

 Schedule a device-only event without a switch on the WinLGX-LT tab to test a 
device-only event action before sending it to the destination or to perform 
nonplayback events such as recording. 
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Channel and Day/WinLGX-LT Tab Configurations 

Each pair of channel and day tabs displays its own event window.  In addition, the 
WinLGX-LT tab displays a single event window, regardless of the channel.  Selecting 
one of the channel output tabs merely causes its output to be the default when adding 
an event, with the ability to select a different output.  The channel output tabs will 
appear as follows based on the switcher configuration (see Table 29, Channel Output 
Tabs and Available Event Windows).   

NOTE: On an UltraNEXUS-HD server without an external switcher, Output 2, labeled 
as “Sch Rec,” is automatically assigned to the internal digital video Recorder.  
For external switcher configurations, the highest numbered channel output 
tab is automatically assigned to the internal digital video recorder. 

Table 29, Channel Output Tabs and Available Event Windows 

SWITCHER CHANNEL OUTPUT TABS # OF EVENT WINDOWS 

No switcher Output 1, Sch Rec 
15 event windows (2 channels x 7 days 
+ 1 WinLGX-LT tab) 

External 4 Output Switcher Output 1–Output 4 
29 event windows (4 channels x 7 days 
+ 1 WinLGX-LT tab) 

External 16 Output 
Switcher 

Output 1–Output 16 
113 event windows (16 channels x 7 
days + 1 WinLGX-LT tab) 

 

Schedule Columns 

The schedule window columns display the events’ fields, giving all the information and 
actions of the event.  When the schedule window contains an event, the columns can 
be moved and resized by dragging the headers and header boundaries.  A horizontal 
scroll bar at the bottom of the window is used to view all of the columns.  For a listing of 
the fields, see Table 30, Schedule Columns. 

Table 30, Schedule Columns 

FIELD DESCRIPTION 

Time  Program’s scheduled time: reflects time of any initial switch and the 
beginning of the program time block.  If the event time is fixed (locked), this 

field will also contain a thumbtack symbol .   

Title  Name of the event.  The title may be assigned in the resource’s “Title” field 
either when the resource is configured or when it is added to the schedule.  If 
the event consists of a channel switchback, the field shows which user-
configured input or video source switchback will be displayed during the 
unscheduled time slot. 

Interface/ 
Device  

N/A 
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FIELD DESCRIPTION 

Format  Format selected for the device or library resource in the “Properties” window. 

Input  Number and name of the device or switch input that will be taken to the 
output at the scheduled time (shown in “Time” field). 

Output  Number and name of the output the initial input switches to at the schedule 
time (shown in “Time” field). 

Channel  Number and name of the channel in which the event resides. 

Title/Chap  N/A 

Setup  Time the device takes to produce video and/or sound after receiving a PLAY 
command. 

Preroll  Indicates amount of unwanted video (black, etc.) at the beginning of the 
program.   

In point If assigned, indicates an digital video’s playback starting point 

Out point If assigned, indicates an digital video’s playback ending point  

Length  Length of the program block and the time between initial and ending 
switches, if any.  WinLGX subtracts “End” from “Time” to obtain the “Length” 
value. 

Reset  Time the device is busy and unavailable for scheduling after the end of the 
block (“End”), usually due to rewind time. 

Start CMD  Device command that occurs initially at “Start.” 

End CMD  Device command that occurs at “End” (usually “Stop” or “Rewind”). 

Switchback  Indicates the input that is switched to the event’s channel output following 
the “End” command.  Back to back scheduled events have the “End” time of 
the first event equal to the “Time” of the second event.  This puts the first 
event’s switchback at the same time as the second event’s initial switch.  If 
this occurs, the UltraNEXUS-HD system cancels the switchback. 

Start  Indicates time of the initial device command.   WinLGX subtracts “Setup” 
plus “Preroll” from “Time” to obtain the “Start” value, which is the start time of 
the device command.  “Start” is not included in the time block used for 
vertical positioning within the schedule.  The time progression is as follows:   

1. At the time shown in the “Start” field, a PLAY command is issued. 
2. The event waits for “Setup” and “Preroll” to complete before performing 

the initial switch.   

End  Indicates end of the program block, end time of the device command, and 
switchback, if any.  WinLGX adds “Length” to “Time” to obtain “End” value. 
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FIELD DESCRIPTION 

Filename (1) Displays the filename of the chosen digital video file. 

Storage 
Device (1) 

Indicates the storage device of the chosen digital video file. 

Record 
Preset 

Displays the title of the selected record preset for a digital video recording 
event. 

Overwrite Displays the selected file overwrite option for a digital video recording event. 

Record CC 
data 

Indicates whether or not a digital video recording event will capture any 
closed caption data from the source. 

Filename (2) N/A 

Storage 
Device (2) 

N/A 

Audio Input N/A 

Print  Determines if the event will be included in a print operation. 

Export  Determines if the event will be included in an export operation. 

Overlay N/A 

Show in 
program 
guide 

Indicates whether or not an event will be shown on the web program guide 

Comment  Used to enter an event comment up to 31 characters. 

Media ID Assigned by user as a library tracking number. 

Field Name 
(1–11) 

Schedule column headings that may be assigned by user. 
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Scheduling/Editing/Deleting All Events 

Scheduling an Event on a Day/Channel Output Event Window 

Select a scheduling event window as follows: 

a. Click the desired day tab to select the day you want the event to occur. 

b. Select one of the following channel tabs: 

 Digital video recording events only: select the “Sch Rec” tab for 
UltraNEXUS-HD servers without an external switcher or the channel output 
tab assigned to the digital video recorder in an external switcher configuration 
(see “Editing Internal Digital Video Playback and Recording Device 
Resources,” on page 111 for more information on configuring channel output 
tabs). 

 Channel output tab 

Drag an icon from the “Device” or “Library” “Resource View” into the selected event 
window.  This opens an “Event properties” box with editable event information like the 
one shown in Illustration 114, Day/Channel Output Event Properties Box. 

Illustration 114, Day/Channel Output Event Properties Box 

 

To add or change the event information, click on each of the desired editable fields 
(described on pages 193–228) and enter the new information.  An icon can be dragged 
and dropped into a day/channel output event window in the following five ways: 
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 Empty Window—the event is locked and given the initial time of 12:00 A.M. 
(Unless a previous day’s event overlaps midnight, in which case, its “End” time is 
used.) 

 Initial Channel Switchback—if an event is dragged onto a channel switchback at 
the start of the day (1st row), it is locked and given the initial time of 12:00 A.M.  
(Unless a previous day’s event overlaps midnight, in which case, its “End” time is 
used.) 

 Any Other Channel Switchback—the event is initially unlocked, with a time equal 
to the “End” time of the previous event. 

 On Top of an Unlocked Event—the new event is initially unlocked and given the 
time of the event on which it was dragged.  The existing event is pushed 
downward and out of the way if possible.  If not, an error box appears.  Dragging 
an icon on top of a locked event instantly generates an error. 

 Below the Bottom Event—the event is initially unlocked, with a time equal to the 
“End” time of the previous event. 

Scheduling an Event on the WinLGX-LT Event Window 
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NOTE: To display the WinLGX-LT tab on the bottom of your schedule window, select 
the “Show WinLGX-LT tab in the schedule window” option on the 
“Application” tab of the Tools\Preferences window. 

1. Click the “WinLGX-LT” tab to open the corresponding event window.   

2. Drag an icon from the “Device” or “Library” “Resource View” onto the WinLGX-LT 
event window.  This opens an event properties box like the one shown in Illustration 
115, WinLGX-LT Event Properties Box.   

Illustration 115, WinLGX-LT Event Properties Box 

 

3. To add or change the event information, click on each of the desired editable fields 
(described on pages 193–212) and enter the new information.  The WinLGX-LT 
event properties box is the same as the event edit box displayed for the day/channel 
output event windows with the following exceptions. 

 There is no Lock/Unlock checkbox; you must enter a time for each event.   

 If an output assignment is desired, the output must be selected from the “Output” 
field drop down menu.   

 A date and/or day(s) must be selected as follows: 
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NOTE: If a date is selected, the event happens on that date.  If days are 
selected, the event happens on those days.  If both are selected, the 
event happens on the selected date and days. 

c. To select a date, change “Absolute date” to “Yes.”  A date field appears below to 
allow date entry.   

d. To enter a day, change the desired day field(s) to “Yes.”  These fields can be 
toggled quickly by double clicking on the day name. 

4. If desired, you may edit the properties of a device or library resource and then apply 
those changes to any events added to the WinLGX-LT event window by performing 
the following steps: 
a. Select the desired device or library resource icon. 
b. Click on the desired editable resource fields in the “Properties” window and make 

the changes.  
c. WinLGX displays a dialog box that gives you the option to merge the resource 

editing changes into each event in the WinLGX-LT event window that was 
created from the same resource. 

Copying/Cutting/Pasting an Event 

To move or replicate an event or group of events to another location on the schedule, 
perform the following steps: 

1. Select the desired event(s) using one of the following options: 

 Highlight an individual event. 

 Hold down your keyboard’s “Ctrl” key and highlight multiple events. 

 Highlight all events on an event window by selecting “Select All” from the “Edit” 
menu or the right-click menu or simultaneously pressing your keyboard’s “Ctrl” 
and “A” keys. 

2. Copy, cut (if you wish to move event), and paste by selecting the function you wish 
to perform from either the “Edit” menu or the right-click pop-up menu.   

3. In the “Event Properties” box that appears once the paste has been completed, click 
“Ok” if one event was pasted or “Ok to all” if more than one event was pasted.   

NOTE: If the event(s) is pasted channel switchback of a shorter duration than the 
event(s) itself, WinLGX will display a dialog asking whether or not you 
would like to trim/discard the ending playlist items to fit the channel 
switchback or cancel the operation. 

Editing an Event 
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To edit an event in the schedule, double click event, right click event and choose “Edit” 
in the right-click menu, or select “Edit” from the “Edit” menu.  Edit the event information 
in the “Event properties” box that appears.  To add or change the event information, 
click on each of the desired editable fields (described on pages 193–212) and enter the 
new information. 

Deleting an Event 

If the first event in the schedule window is deleted, the next event is locked in place, if 
necessary.  If any other event is deleted, any unlocked events immediately below it will 
float up until they rest against the event above (unless this causes a device conflict, in 
which case the first unlocked event will be locked in place).   

To delete an event(s), perform the following steps: 

1. Select the desired event(s) using one of the following options: 

 Highlight an individual event. 

 Hold down your keyboard’s “Ctrl” key and highlight multiple events. 

 Highlight all events on an event window by selecting “Select All” from the “Edit” 
menu or the right-click menu or simultaneously pressing your keyboard’s “Ctrl” 
and “A” keys. 

2. Press the “Delete” key, right click event and choose “Delete” in the right-click menu, 
or select “Delete” from the “Edit” menu.  You will be prompted for confirmation before 
the event is deleted.  If you selected multiple events, one of the following dialog 
boxes is displayed: 

 If you selected a list of events that includes non-playlist events, the dialog 
shown in Illustration 116 appears.  Perform one of the following options: 

Illustration 116, Delete Dialog Box 

 

 “Delete this event?”: click “OK” to delete the current selection in a list of 
selected events.  

 “Delete all events?”: click “OK” to simultaneously delete all of the selected 
events.   
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 “Skip this event?”: click “OK” to keep the current selection in a list of 
selected events. 

 If you only selected a playlist of events, the dialog shown in Illustration 117 
appears.  Perform one of the following options: 

Illustration 117, Playlist Delete Dialog Box 

 
 

 “Delete this event?”: click “OK” to delete the current selection in the playlist.  

 “Delete entire playlist?”: click “OK” to simultaneously delete the entire 
playlist.  

 “Delete entire playlist in all switchbacks?”: this option will be enabled if the 
selected playlist was added to a channel switchback between programs.  
Click “OK” to simultaneously delete all instances of the playlist from the 
selected channel output’s switchbacks. 

 

 

 

 

 

 

 

 

 

Replacing Library Resource Events 
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By performing the following steps, you can replace one or more schedule events 
created with the same library resource with any library resource of the same format: 

1. If you would like to change your library resource before using it to replace event(s), 
select the library resource in the “Resource View” window and then edit its resource 
properties. 

2. Drag a library resource onto a same-format library resource event you would like to 
replace.  The event properties window for the library resource will open, displaying a 
“Replace” button on the bottom of the window (see Illustration 118).   

Illustration 118, "Replace" Button on Event Properties Window 

 

3. If desired, edit the properties of the library resource. 

4. Click the “Replace” button to open the “Find and Replace” window shown in 
Illustration 119.  This window gives you a variety of options for replacing the selected 
event or all schedule events like the selected one with the dragged library resource.   

5. To make a replacement, click one of the replacement buttons on the bottom of the 
“Find and Replace” window.  The replacement buttons are described in Illustration 
119.     
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NOTE: If your library resource is too long for the schedule time slot, you will be 
given the option to trim the resource to fit or cancel the replacement. 

Illustration 119, "Find and Replace" Window 

 
 

If you plan to replace multiple instances of the selected event, pay attention to the 
indicators above the replacement buttons on the “Find and Replace” window.  The 
indicators give a quick overview of how many instances of the selected event exist 
throughout your schedule.  Here is a quick description of each indicator: 

 “Day/Ch: x of x:” the second “x” indicates how many instances of the selected 
library resource event exist on the current day tab and channel output tab 
window, while the first “x” shows how many of the events have been replaced on 
the same window 

 “Ch: x of x:” the second “x” indicates how many instances of the selected library 
resource event exist on the current channel output tab windows, while the first “x” 
shows how many of the events have been replaced on the same windows 

 “Sch: x of x:” the second “x” indicates how many instances of the selected library 
resource event exist on all of the day and channel output tab windows, while the 
first “x” shows how many of the events have been replaced on the same windows 
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Inserting Library Resource Events 

By performing the following steps, you can insert a library resource into the time slot of 
an unlocked library resource event of the same format.  The inserted event will take the 
start time of the event onto which it was dragged.  Unlocked events below the inserted 
event will be automatically pushed downward in the schedule by an amount of time 
equal to the length of the inserted event.   

  If there are locked events above and/or below the selected event, the 
desired time slot may not be long enough to accommodate the dragged 
library resource.   

 If there is not a channel switchback between the selected event and 
a locked event, the “Insert” button will be unavailable on the 
resource’s “Event Properties” window.   

 If there is a short channel switchback between the selected event 
and a locked event, you will be given the option of trimming the 
resource to fit the available time slot or cancelling the insert. 

1. If you would like to change your library resource before inserting it in your schedule, 
select it in the “Resource View” window and then edit its resource properties. 

2. Drag a library resource onto an unlocked library resource event of the same format.  
The event properties window for the library resource will open. If there is enough 
time available to accommodate the new resource’s length, an “Insert” button will be 
displayed on the bottom of the window (see Illustration 120).   

Illustration 120, "Insert" Button on Event Properties Window 
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3. If desired, edit the properties of the library resource. 

4. Click the “Insert” button to assign the selected event’s start time to the dragged 
library resource event.  All unlocked events below the inserted event will shift 
downward in the schedule by an amount of time equal to the length of the inserted 
event.  

Scheduling/Editing Device Resources 

Adding or editing device resource events opens windows like the examples shown in 
this section.  Editable event fields are highlighted in each event properties window.  
Click “OK” to submit the event or “Cancel” to abort the add/edit.   

Switch Device Resources—External Switcher Configurations Only 

Dragging an external switch device resource onto the schedule reveals a box in 
Illustration 121, Switch Device Event Properties Window.  Refer to Table 31, Editable 
Switch Device Event Properties, for a description of the editable event properties. 

Illustration 121, Switch Device Event Properties Window 
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Table 31, Editable Switch Device Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure you have selected the device you wish to schedule. 

Length Enter duration of the event. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air” time of the event. 

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Show in 
program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 
on the web program guide (see “Viewing Web Program Guide,” on 
page 317).  The scheduled resource will be listed according to its event 
start time and the text entered into the “Comment” field.   
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Internal Digital Video Player Device Resources 

Dragging an UltraNEXUS-HD digital video player device resource onto the schedule 
reveals the window shown in Illustration 122, Digital Video Player Event Properties 
Window.  Refer to Table 32, Editable Digital Video Player Event Properties, for a 
description of the editable event properties. 

NOTE: The digital video player may only be scheduled on its assigned playback 
channel (see “Editing Internal Digital Video Playback and Recording Device 
Resources,” on page 111, for more information on digital video playback 
channel assignments). 

Illustration 122, Digital Video Player Event Properties Window 

 

Table 32, Editable Digital Video Player Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes the 
“Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the end 
of the event above it in the schedule. 
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FIELD DESCRIPTION 

Title Allows a name with up to 31 characters to be typed. 

Device The digital video player. 

Setup time If desired, indicate how long after the digital video player is activated that 
picture and/or sound is produced. 

Reset If desired, enter time the digital video player will be busy and unavailable 
for scheduling after the end of the program.   

Filename Use the “Filename” field to select the appropriate filename for the source 
as follows:  

1. Select the “Filename” field.  Click the ellipsis button to open the 
“Select File” window.  

2. Select a USB drive from the “Storage device” drop down list to display 
the drive’s stored digital video files. 

3. Perform one of the following: 

 Enter a filename for a file that will be recorded and played within 
the same schedule: 

NOTE: The digital video recording library resource is scheduled 
for recording through the MPEG device resource.  Refer 
to “Internal Broadcast MPEG Recorder Device 
Resources” on page 200 for further instructions.   

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the record time for the file. 

c. From the “Select file” dialog, click “OK” to accept filename or 
“Cancel” to abort. 

 Select the filename of a pre-recorded file through one of the 
following methods listed below.  To display a file’s properties and 
view the clip before completing the selection, either right click on 
the file or click “Properties” to display the instant video preview 
monitor.  For more information on the preview monitor, go to the 
“Using Instant Video Preview Monitor to Display Digital Video Files 
within WinLGX” section on page 175. 

o Double-click the desired file to automatically accept selection 
and close the “Select file” window.  

o Click to select the desired file. From the “Select file” dialog, 
click “OK” to accept selection or “Cancel” to abort. 

 

In/Out point 
(in 
HH:MM:SS:F

To specify where in the selected file you would like playback to begin and 
end, use the “In point” and “Out point” fields.  Either type the desired file 
start and end times into the fields or click either field’s ellipsis button to 
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FIELD DESCRIPTION 

F, where 
FF=frames) 

open the clip editor.   

Software Monitor 

The WinLGX video clip editor combines clip editing controls with a 
preview window for quick and convenient clip editing that does not 
interrupt programming playback on your UltraNEXUS-HD server’s video 
player.  To use this option, ensure the “Software Monitor” option is 
selected on the “Preview Monitor” tab in the “Preferences” window. 

Illustration 123, WinLGX Video Clip Editor with Preview Monitor 

 

5. If desired, adjust the volume control.  Audio is set to the lowest level 
by default. 

6. Ensure each point you wish to set has a green checkmark next to its 
time field.  

7. If in and out points have already been set (there will be time values in 

the corresponding fields), you can use the seek  in and  out 
point buttons to move the playback bar to those points in the clip. 

8. Specify the clip’s playback in and out points using one of the following 
methods: 

 Click the  button to start playing the file and click the  set in 

point button and  set out point button at the desired spots.  If 
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FIELD DESCRIPTION 

you would like the clip to restart each time the end is reached, 

click the  loop button. 

 Drag the playback bar to the desired spot and click the  set in 

point or  set out point button. 

 Click the  or  button to move between groups of pictures 

(GOPs) in the MPEG file and click the  set in point or  set 
out point button. 

 Click the  or  button to move forward or back in the MPEG 
file by the number of seconds specified on the “Playback Tab” of 

the “Preferences” window.  Click the  set in point or  set out 
point button. 

Once the in and out points are selected, their begin and end time values 
will be displayed in the corresponding fields, and the total length of time 
from in to out point will be shown in the “Duration” field. 

NOTE: When you seek the current in or out point on the playback bar, 
you will notice a slight discrepancy between the current time 
displayed above the playback bar and the in or out point field 
values.  Clip playback between your in and out points will be as 
shown on the clip editor’s preview window. 

 

Length The length of the file is automatically entered into this field, but it may be 
changed to a value between 6 seconds and 23 hours:59 minutes:59 
seconds 

Time If the event is locked, the event start “Time” can be modified.  This is the 
scheduled “On-Air” time of the event. 

Command 
(Event start) 

The “PLAY” command is automatically displayed.    

Command 
(Event end) 

Choose between “STOP” and “<None>.”  It will almost always be 
“STOP.”  

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Show in 
program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 
on the web program guide (see “Viewing Web Program Guide,” on page 
317).  The scheduled resource will be listed according to its event start 
time and the text entered into the “Comment” field.   
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FIELD DESCRIPTION 

Comment Enter a unique and descriptive name with up to 31 characters to identify 
the resource on program guides.  The text entered in the “Title” field is 
automatically placed in the “Comment” field, but may be changed.  

Media ID Assign as a library tracking number. 

Field Name 
1–x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 
selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into a 
comma separated values format.  If “No” is selected, then you can 
enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 
Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and “maximum” 
view (for instructions, see “Event Editor Tab” on page 92).  To toggle 
between these views, select and deselect the “Maximum view” checkbox. 
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Internal Digital Video Recorder Device Resource 

Dragging an UltraNEXUS-HD digital video recorder device resource onto the schedule 
reveals the box in Illustration 124, Digital Video Recorder Event Properties Window.  
Refer to Table 33, Editable Digital Video Recorder Event Properties, for a description of 
the editable event properties.  

NOTE: When creating Digital video files, first create a short test file for playback on 
your UltraNEXUS-HD system.  Use this test file to verify video playback 
compatibility with your LEIGHTRONIX system and to check your encoding 
audio level settings.  Verify that your audio levels match the audio levels from 
other UltraNEXUS-HD sources.  Once you have determined the proper digital 
video record settings, make note of them for use during future recording 
sessions. 

If you would like to play a video file within the same schedule it was recorded, 
create and schedule a digital video library resource with the same filename and length 
given to the digital recording event.  See “Digital Video Library Resources” on page 132 
for further instructions on creating a digital video library resource.  The library resource 
will be available for playback once the digital recording event ends. 

Illustration 124, Digital Video Recorder Event Properties Window 
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Table 33, Editable Digital Video Recorder Event Properties 

FIELD DESCRIPTION 

Lock At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Add to 
Library 

The “Add to library” option causes WinLGX to automatically create a 
library playback resource for the recording event.  This library resource 
may be used to schedule a playback event with the recorded digital 
video file.  To enable this option, check the “Add to library” box at the 
bottom of the event properties window.  The “Add to library folder” 
window shown in Illustration 125 will display.  Select the library folder 
you would like to contain the library resource and click “OK.” 

NOTES:  WinLGX will not create a library resource for a file that 
possesses the same video filename and length as a 
pre-existing library resource. 

  If the new file possesses the same title as another 
resource, but has a different video filename and/or 
length, WinLGX will copy the new file to the library with 
a numbered increment added to its title.  For example, 
if this is the first time you have reused the title of a pre-
existing library resource, WinLGX will add the new file 
to the library under the name “title01.” 

Illustration 125, “Add to library folder” Window 
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FIELD DESCRIPTION 

Title Allows a name up to 31 characters to be typed. 

Input Select the input signal you want the digital video recorder to record. 

Device Ensure the digital video recorder is selected. 

Setup time If desired, indicate how long after the selected digital video recorder is 
activated that recording starts. 

Reset If desired, enter time the digital video recorder will be busy and 
unavailable for scheduling after the end of the program. 

Record 
Preset 

Select one of the three recording settings configured under “System 
Configuration.” 

Record 
Overwrite 

Select “Always” to automatically record over an existing file with the 
same name or “Create Unique” to record a file entered under an 
existing MPEG filename with the first 14 characters of the original 
filename followed by “yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record 
date specified as year/month/ day and hh/mm/ss is the file record time 
in hours/minutes/seconds). 

Record CC 
data 

Select “Yes” to capture any closed caption data from the source.  
Closed captions are hidden in the video signal and decoded for display 
on televisions with built-in decoders or televisions connected to 
external decoders. 

VOD  This option allows you to override the VOD automatic upload 
enable/disable feature in WebNEXUS. If the VOD auto upload has 
been enabled in WebNEXUS, selecting “No VOD” stops the VOD 
transfer. Changing this option to “Use Web” will cause it to operate 
according to its WebNEXUS enable/disable setting. 

MPEG 
Filename 

Perform one of the following: 

 Enter up to 27 characters to create a new filename for the 
recording event.   

 If you created a playback library resource for the digital video file 
to be recorded, enter the exact filename used for the library 
resource.   

Storage 
device 

Select the storage device you would like to hold your recorded file. 

Length Enter recording duration of up to 23 hours:59 minutes:59 seconds.  If 
you created a digital video library resource for the digital video file to be 
recorded, enter the same time duration used for the library resource.  

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 
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FIELD DESCRIPTION 

Command 
(Event start) 

The “RECORD” command is automatically displayed. 

Command 
(Event end) 

Choose either “STOP” or “<None>.”  It will almost always be “STOP.”   

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Show in 
program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 
on the web program guide (see “Viewing Web Program Guide,” on 
page 317).  The scheduled resource will be listed according to its event 
start time and the text entered into the “Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the “Title” 
field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID Assign as a library tracking number. 

Field 1–x Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into a 
comma separated values format.  If “No” is selected, then you can 
enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 
Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 92).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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Scheduling/Editing ePRO-BUS-Controlled Device Resources 

Adding or editing an ePRO-BUS record schedule event for your remote or locally 
connected LEIGHTRONIX LABvault-HD recorder opens an event properties window 
containing editable properties.  Edit the properties for your remote or local ePRO-BUS 
record event according to the following subsections, clicking “OK” to submit the event or 
“Cancel” to abort the add/edit. 

NOTE: ePRO-BUS record events can only be scheduled on the WinLGX-LT 
tab.  If the WinLGX-LT tab is not displayed at the bottom of your schedule 
window, go to the “Tools”/“Preferences” menu option and select “Show 
WinLGX-LT tab” option on the “Application” tab. 

Remote ePRO-BUS-Controlled Devices 

A remote ePRO-BUS-controlled device is a LABvault-HD that has been added to the 
same TCP/IP network as your UltraNEXUS-HD system.  This allows you to start and 
stop recording on a LABvault-HD that is in a different location than your UltraNEXUS-
HD.  Perform the following steps to schedule or edit a remote ePRO-BUS resource 
event: 

Select the WinLGX-LT tab on the bottom of the scheduling window.  If you do not see 
this tab, go to the “Tools”/”Preferences”/”Applications” tab and select the “Show 
WinLGX-LT tab” option. 

Open the ePRO-BUS record “Event Properties” window (see Illustration 126, Remote 
ePRO-BUS Record Event Properties Window) by either adding or editing the ePRO-
BUS record event.  To add a new event, drag the desired ePRO-BUS-controlled device 
resource onto the schedule window.  To edit, double click the ePRO-BUS event row on 
the schedule.   

Illustration 126, Remote ePRO-BUS Record Event Properties Window 
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Complete or edit the event properties fields according to Table 34, Editable Remote 
ePRO-BUS Record Event Properties.   

Table 34, Editable Remote ePRO-BUS Record Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 
lock the event or uncheck it to unlock the event.  Locking an event 
causes the “Time” field to become enabled, allowing the user to 
enter a fixed execution time for the event.  Unlocking an event 
disables the “Time” field, causing WinLGX to assign a time to the 
event that starts at the end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure this field displays the PRO-BUS address number assigned 
to the LABvault-HD. 

Output Select “<None>.” 

Length Enter duration of the event in hours:minutes:seconds. 

Event Date 
and/or 
DaysReset time 

Select an absolute date and/or days that you want to event to 
occur.Not used 

TimeEvent Date 
and/or Days 

If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event.Select an absolute date and/or 
days that you want to event to occur. 

Command 
(Event 
start)Time 

Select “RECORD.”If the event is locked, the event “Time” can be 
modified.  This is the scheduled “On-Air“ time of the event. 

Command 
(Event 
end)Command 
(Event start) 

Choose “STOP.”Select “RECORD.” 

Switchback 
inputCommand 
(Event end) 

Not usedChoose “STOP.” 

Show in 
program 
guideSwitchback 
input 

Not usedNot used 

CommentShow 
in program guide 

Not usedNot used 

Media Assign as a library tracking number.Not used 
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FIELD DESCRIPTION 

IDComment 

Field Name 1–
xMedia ID 

Schedule column headings you may assign.Assign as a library 
tracking number. 

PrintField Name 
1–x 

Select “Yes” to enable the resource’s event record for printing.  If 
“No” is selected, then you can enable printing for all of the 
resource’s event records by checking the “Export/print all records” 
option under the “Export/Print Templates” window. Schedule 
column headings you may assign. 

ExportPrint Select “Yes” to allow the resource’s event record to be exported 
into comma delimited or Microsoft Excel® formats.  If “No” is 
selected, then you can enable the export function for all of the 
resource’s event records by checking the “Export/print all records” 
option under the “Export/Print Templates” window.Select “Yes” to 
enable the resource’s event record for printing.  If “No” is selected, 
then you can enable printing for all of the resource’s event records 
by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Maximum 
viewExport 

Each event properties window for a device or library resource item 
may be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 
92).  To toggle between these views, select and deselect the 
“Maximum view” checkbox.Select “Yes” to allow the resource’s 
event record to be exported into comma delimited or Microsoft 
Excel® formats.  If “No” is selected, then you can enable the export 
function for all of the resource’s event records by checking the 
“Export/print all records” option under the “Export/Print Templates” 
window. 

Maximum view Each event properties window for a device or library resource item 
may be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 
92).  To toggle between these views, select and deselect the 
“Maximum view” checkbox. 

  

  

Local ePRO-BUS-Controlled Devices 

A local ePRO-BUS-controlled device is a LABvault-HD that has been directly wired to 
an output on your UltraNEXUS-HD system’s external switcher.  Connecting a LABvault-
HD to your switcher provides you with another way to record your UltraNEXUS-HD’s 
external video switch resources.  Perform the following steps to schedule or edit a local 
ePRO-BUS record event: 



UltraNEXUS-HD 
Software Operation 

 

LEIGHTRONIX, INC. Page 207 

Revised 11/22/2016 WinLGX ver. 7.0.3.31 
 

 

NOTE: The UltraNEXUS-HD should be connected to an external switcher when 
creating local ePRO-BUS record events. 

1. Select the WinLGX-LT tab on the bottom of the scheduling window.  If you do not 
see this tab, go to the “Tools”/”Preferences”/”Application” tab and select the “Show 
WinLGX-LT tab” option. 

2. In order to capture playback from an UltraNEXUS-HD video switch resource, the 
video source must be scheduled on the external switcher output connected to your 
LABvault-HD.  For information on scheduling a video switch resource, refer to 
“Switch Device Resources—External Switcher Configurations Only” on page 193 
and “Switch Library Resources—External Switcher Configurations Only” on page 
210.  This step may be performed from either the day tabs or the WinLGX-LT tab, 
but the latter is recommended for consistency. 

3. Open the ePRO-BUS record “Event Properties” window (see Illustration 127, Local 
ePRO-BUS Record Event Properties Window) by either adding or editing the ePRO-
BUS record event. To add a new event, drag the desired ePRO-BUS-controlled 
device resource onto the schedule window.  To edit, double click the ePRO-BUS 
event row on the schedule.   

Illustration 127, Local ePRO-BUS Record Event Properties Window 

 

4. Complete or edit the properties fields according to Table 35, Editable Local ePRO-
BUS Record Event Properties.   
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Table 35, Editable Local ePRO-BUS Record Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure this field displays the PRO-BUS address number assigned to 
the device you wish to control. 

Setup time Not used 

Output Select “<None>.” 

Length Enter duration of the event in hours:minutes:seconds. 

Preroll  Not used 

Reset time Not used 

Event Date 
and/or Days 

Select an absolute date and/or days that you want to event to occur. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 

Command 
(Event start) 

Select “RECORD.” 

Command 
(Event end) 

Choose “STOP.” 

Switchback 
input 

Not used 

Show in 
program 
guide 

Not used 

Comment Not used 

Media ID Assign as a library tracking number. 

Field Name 
1–x 

Schedule column headings you may assign. 
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FIELD DESCRIPTION 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 92).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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Scheduling/Editing Library Resources 

Adding or editing a library resource event opens windows like the examples shown in 
this section.  Editable event fields are highlighted in each event properties window.  
Click “OK” to submit the event or “Cancel” to abort the add/edit. 

Switch Library Resources—External Switcher Configurations Only 

Dragging a switch library resource onto the schedule reveals a box like Illustration 128, 
Switch Event Properties Window.  Refer to Table 36, Editable Switch Event Properties, 
for a description of the editable event properties. 

Illustration 128, Switch Event Properties Window 

 

Table 36, Editable Switch Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 
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FIELD DESCRIPTION 

Device Allows a same format device to be chosen.  Its associated interface 
and input will appear in the corresponding fields. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air” time of the event. 

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Show in 
program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 
on the web program guide (see “Viewing Web Program Guide,” on 
page 317).  The scheduled resource will be listed according to its event 
start time and the text entered into the “Comment” field.   

 

Digital Video Library Resources 

To preview a digital video library resource’s video before scheduling the resource, either 
double click the resource or right click on the file and select “View Resource” to display 
the file in the WinLGX instant video preview monitor.  For more information on the 
preview monitor, go to the “Using Instant Video Preview Monitor to Display Digital Video 
Files within WinLGX” section on page 175. 

Dragging a digital video library resource onto the schedule reveals a box like Illustration 
129, Digital Video Library Event Properties Window.  Refer to Table 37, Editable Digital 
Video Library Event Properties, for a description of the editable event properties. 

Illustration 129, Digital Video Library Event Properties Window 
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Table 37, Editable Digital Video Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 
lock the event or uncheck it to unlock the event.  Locking an event 
causes the “Time” field to become enabled, allowing the user to enter 
a fixed execution time for the event.  Unlocking an event disables the 
“Time” field, causing WinLGX to assign a time to the event that starts 
at the end of the event above it in the schedule. 

In/Out points 
(in 
HH:MM:SS:FF, 
where 
FF=frames) 

To specify where in the selected file you would like playback to begin 
and end, use the “In point” and “Out point” fields.  Either type the 
desired file start and end times into the fields or click either field’s 
ellipsis button to open the clip editor.   

Software Monitor 

The WinLGX video clip editor combines clip editing controls with a 
preview window for quick and convenient clip editing that does not 
interrupt programming playback on your UltraNEXUS-HD server’s 
video player.  To use this option, ensure the “Software Monitor” 
option is selected on the “Preview Monitor” tab in the “Preferences” 
window. 

Illustration 130, WinLGX Video Clip Editor with Preview Monitor 

 

9. If desired, adjust the volume control.  Audio is set to the lowest 
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FIELD DESCRIPTION 

level by default. 

10. Ensure each point you wish to set has a green checkmark next to 
its time field.  

11. If in and out points have already been set (there will be time 

values in the corresponding fields), you can use the seek  in 

and  out point buttons to move the playback bar to those 
points in the clip. 

12. Specify the clip’s playback in and out points using one of the 
following methods: 

 Click the  button to start playing the file and click the  

set in point button and  set out point button at the desired 
spots.  If you would like the clip to restart each time the end is 

reached, click the  loop button. 

 Drag the playback bar to the desired spot and click the  set 

in point or  set out point button. 

 Click the  or  button to move between groups of 

pictures (GOPs) in the MPEG file and click the  set in point 

or  set out point button. 

 Click the  or  button to move forward or back in the 
MPEG file by the number of seconds specified on the 

“Playback Tab” of the “Preferences” window.  Click the  set 

in point or  set out point button. 

Once the in and out points are selected, their begin and end time 
values will be displayed in the corresponding fields, and the total 
length of time from in to out point will be shown in the “Duration” field. 

NOTE: When you seek the current in or out point on the playback 
bar, you will notice a slight discrepancy between the current 
time displayed above the playback bar and the in or out 
point field values.  Clip playback between your in and out 
points will be as shown on the clip editor’s preview window. 

Length The video file library resource length is automatically entered, but it 
may be edited to a value between 6 seconds and 23 hours:59 
minutes:59 seconds. 

Time If the event is locked, the event start “Time” can be modified.  This is 
the scheduled “On-Air“ time of the event. 
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FIELD DESCRIPTION 

Command 
(Event start) 

The “PLAY” command is automatically displayed.   

Command 
(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 
input 

If desired, select a video source to be taken to the output at the end 
of the event. 

Show in 
program guide 

Select “Yes” from the drop down list to include the scheduled 
resource on the web program guide (see “Viewing Web Program 
Guide,” on page 317).  The scheduled resource will be listed 
according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the 
“Title” field is automatically placed in the “Comment” field, but may be 
changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If 
“No” is selected, then you can enable printing for all of the resource’s 
event records by checking the “Export/print all records” option under 
the “Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
a comma separated values format.  If “No” is selected, then you can 
enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 
Templates” window. 

Maximum view Each event properties window for a device or library resource item 
may be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 
92).  To toggle between these views, select and deselect the 
“Maximum view” checkbox. 
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Digital Video Loop Library Resources 

Dragging a digital video loop library resource onto the schedule reveals a box like 
Illustration 131.  Refer to Table 38, Editable Digital Video Loop Library Event Properties, 
for a description of the editable event properties. 

Illustration 131, Digital Video Loop Event Properties Window 

 

Table 38, Editable Digital Video Loop Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 
lock the event or uncheck it to unlock the event.  Locking an event 
causes the “Time” field to become enabled, allowing the user to enter 
a fixed execution time for the event.  Unlocking an event disables the 
“Time” field, causing WinLGX to assign a time to the event that starts 
at the end of the event above it in the schedule. 
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Length To change the number of times or length of time you would like the 
file to loop, perform the following: 

1. Select the “Length” field and then click the ellipsis button to 
display the “MPEG Loop Calculator” (see Illustration 86, Video 
Loop Calculator).  

2. Enter the number of times you would like the file to loop in the 
“Loop count” field and/or enter a length of time, up to 24 hours, 
in the “Loop length” field. 

Time If the event is locked, the event start “Time” can be modified.  This is 
the scheduled “On-Air“ time of the event. 

Command 
(Event start) 

The “PLAY” command is automatically displayed.   

Command 
(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 
input 

If desired, select a video source to be taken to the output at the end 
of the event. 

Show in 
program guide 

Select “Yes” from the drop down list to include the scheduled 
resource on the web program guide (see “Viewing Web Program 
Guide,” on page 317).  The scheduled resource will be listed 
according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the 
“Title” field is automatically placed in the “Comment” field, but may be 
changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If 
“No” is selected, then you can enable printing for all of the resource’s 
event records by checking the “Export/print all records” option under 
the “Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
a comma separated values format.  If “No” is selected, then you can 
enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 
Templates” window. 

Maximum view Each event properties window for a device or library resource item 
may be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 
92).  To toggle between these views, select and deselect the 
“Maximum view” checkbox. 
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Slide Library Resources 

To preview a slide library resource before scheduling, either double click the resource or 
right click on the file and select “View Resource” to display the file in the WinLGX 
preview monitor window.  To close the window, click the red “x” icon in the corner. 

Dragging a slide library resource onto the schedule reveals a box like Illustration 132, 
JPEG Slide Event Properties Window.  Refer to Table 39, Editable JPEG Slide Library 
Event Properties, for a description of the editable event properties. 

Illustration 132, JPEG Slide Event Properties Window 

 

Table 39, Editable JPEG Slide Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Device The video player device.  
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FIELD DESCRIPTION 

Length The default slide length specified in the “Application” tab of the 
“Preferences” window is automatically displayed once the slide 
filename is selected (see page 88 for more information), but may be 
edited to any value greater than 5 seconds. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 

Command 
(Event start) 

The PLAY command is automatically displayed.   

Command 
(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view (see “Creating Overlays” on page 120).  The graphic 
and text message overlays that are part of the selected template will 
then display with the program.  Each overlay resource in the template 
will display in the listed order for ten percent of the total length of the 
scheduled digital program. 

Comment Enter a descriptor with up to 31 characters to display on schedule. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 92).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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Slide Show Library Resources 

Dragging a slide show library resource onto the schedule reveals a box like Illustration 
133, JPEG Slide Show Event Properties Window.  Refer to Table 40, Editable JPEG 
Slide Show Library Event Properties, for a description of the editable event properties. 

NOTE: Slides must be enabled and authorized in the Storage Manager or 
WebNEXUS before they will appear in slide shows (see “Enabling and 
Authorizing Slides for Display in Slide Shows,” on page 258, and 
“Approving Slides for Display in Slide Shows,” on page 309). 

Illustration 133, JPEG Slide Show Event Properties Window 

 

Table 40, Editable JPEG Slide Show Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Device The video player.   
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FIELD DESCRIPTION 

User list If desired, edit the user list to change the corresponding slide 
selections.  

Length Enter the display duration for the slide show.  Each slide within the 
slide show will automatically display for 10 seconds at a time.  The 
display duration for each slide may be changed from the WebNEXUS 
interface (see “Adding Slide Show Settings to Slide Metadata,” on page 
307). 

Time If the event is locked, the event start “Time” can be modified.  This is 
the scheduled “On-Air” time of the event. 

Command 
(Event start) 

Choose “PLAY” or “STOP.”  It will nearly always be “PLAY.”   

Command 
(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view (see “Creating Overlays” on page 120).  The graphic 
and text message overlays that are part of the selected template will 
then display with the program.  Each overlay resource in the template 
will display in the listed order for ten percent of the total length of the 
scheduled digital program. 

Show in 
program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 
on onscreen program guides (see “Onscreen Program Guide Library 
Resources,” on page 150). The scheduled resource will be listed 
according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the “Title” 
field is automatically placed in the “Comment” field, but may be 
changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 
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FIELD DESCRIPTION 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 92).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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Program Guide Library Resources 

Dragging a program guide library resource onto the schedule reveals a box like 
Illustration 134, Program Guide Event Properties Window.  The program guide will 
display up to ten of the upcoming events scheduled on the same channel output. Refer 
to Table 41, Editable Program Guide Library Event Properties, for a description of the 
editable event properties. 

Illustration 134, Program Guide Event Properties Window 

 

Table 41, Editable Program Guide Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Device Allows you to select internal player or other device.  Its associated 
input will appear in the “Input” field.   

Length If desired, edit the event duration. 
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FIELD DESCRIPTION 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 

Command 
(Event start) 

The PLAY command is automatically displayed.   

Command 
(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view (see “Creating Overlays” on page 120).  The graphic 
and text message overlays that are part of the selected template will 
then display with the program.  Each overlay resource in the template 
will display in the listed order for ten percent of the total length of the 
scheduled digital program. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 92).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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Digital Video/Slide Playlist Resources 

Dragging a playlist of digital video files and/or slides onto the schedule reveals an event 
properties window for each item in the playlist (see Illustration 135 for an example).  
Perform either of the options below:  

NOTE: If the playlist resource is dragged onto a channel switchback between events 
with a shorter time duration than the playlist itself, WinLGX will display a 
dialog asking whether or not you would like to trim/discard the ending playlist 
items to fit the channel switchback or cancel the operation.   

Illustration 135, Playlist Event Properties Window 

 

 Change the editable fields for each resource item according to the tables referenced 
below.  Click “Ok” after changing or reviewing each resource or “Cancel” to abort 
entire operation. 

 Slide: see Table 39 on page 217 

 Slide Show: see Table 40 on page 219 

 Digital Video File: see Table 37 on page 212  

 Looped Digital Video File: see Table 38 on page 215 

 Click “Ok to all” to enter all playlist resource properties into the schedule without 
editing or “Cancel” to abort entire operation. 
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VC List Library Resources 

Dragging a VC list library resource onto the schedule reveals a box like Illustration 136, 
VC List Event Properties Window.  Refer to Table 42, Editable VC List Library Event 
Properties, for a description of the editable event properties. 

Illustration 136, VC List Event Properties Window 

  

Table 42, Editable VC List Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Length The length assigned to the VC list library resource may be changed to 
any length of time up to 23 hours:59 minutes:59 seconds.  If the 
combined length of the resources in the Virtual Channel playlist is less 
than the time in the length field, the resources will be replayed in order 
(looped) as needed to fill the remaining time. 
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FIELD DESCRIPTION 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 

Command 
(Event start) 

The PLAY command is automatically displayed.   

Command 
(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Comment Enter a description with up to 31 characters to display on schedule. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into a 
comma separated values (.csv) format.  If “No” is selected, then you 
can enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 
Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 92).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 



UltraNEXUS-HD 
Software Operation 

 

LEIGHTRONIX, INC. Page 227 

Revised 11/22/2016 WinLGX ver. 7.0.3.31 
 

 

Changing Channel Switchbacks 

Adding Digital Video Library Resources to Channel Switchbacks 

WinLGX gives you the option to use digital video library resources (video files and  
video playlists) to automatically fill time between all programs on the selected channel 
output within your schedule.  The bottom of the WinLGX schedule window includes a 
“Channel switchback count” that keeps track of the total number of unscheduled time 
slots between programs on the selected channel output tab (see Illustration 137, 
Channel Switchbacks).   

To add a resource to a switchback, drag a digital library resource onto a channel 
switchback and check the “Apply to all switchbacks” option on the resource’s event 
properties window before clicking “Ok” (see Illustration 137 and  

Illustration 138). Whether you selected “By the day” or “By the week” on the 
“Application” tab of the “Preferences” window will determine if the channel switchbacks 
will be filled on just the selected channel output’s day tab or all of the channel’s day tabs 
(see the “Application” tab section of the “Setting WinLGX Viewing and Communication 
Preferences,” on page 88). 

NOTE: If the library resource is shorter in duration than your channel switchbacks, the 
default channel switchback input will be switched to the channel output for the 
time remaining after the resource displays.  You may add multiple library 
resources to your channel switchbacks. 

Illustration 137, Channel Switchbacks 

 

Channel Switchback 

“Channel 

switchback count” 
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Illustration 138, Digital Library Resource Apply to all Switchbacks Option 

 

 

“Apply to all 
switchback” 

Option 
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Changing Channel Switchback Inputs 

The “Channel Switchback Editor” (see Illustration 139), under the WinLGX 
“Tools”/”System Tools” menu, provides a quick way to change the inputs that will switch 
to your channel outputs between programs.  Change the switchback inputs on each of 
your channel/day tab windows to the “Virtual Channel” feature or any of your external 
inputs.  Perform the following steps: 

Illustration 139, "Channel Switchback Editor" 

 

Select “Switchback editor” under “Tools”/”System Tools” to open the “Channel 
Switchback Editor” (see Illustration 139). 

Select the channel output/day tab schedule window containing the switchback inputs 
you would like to change by selecting a channel output under “Channel” and a day 
under “Day of week.”  You may select “All” under “Day of week” to select all schedule 
windows for the channel output. 

Under “Replace all,” select the switchback input you would like to change. 

Use the “With” drop down menu to select a new switchback input. 

Click “OK” to make the changes or “Cancel” to abort. 

Checking Schedule and Library Resources for Missing Digital Video Files 

Ensure your image files’ schedule events and library resources do not contain digital 
video files that have been removed from your UltraNEXUS-HD system’s remote storage 
devices (USB hard drives and NAS) as described below:  

If you have not already done so, open an UltraNEXUS-HD image file in WinLGX. 

Click the  sync icon on the main toolbar or choose the “Tools”/”System tools”/”Sync 
Library Resources” menu item.  Those events containing missing digital video files are 
highlighted in the schedule and a “Sync Library Resources” box pops up to report the 
total number of schedule events and each library resource containing digital video files 
no longer available on the UltraNEXUS-HD storage device(s).  Perform any of the 
following from the pop-up window: 

 Delete library resources and corresponding schedule events: empty library 
resources and their schedule events may be removed from the UltraNEXUS-HD 
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image file by selecting each resource in the “Sync Library Resources” window 
and then clicking the “Delete” button.  When prompted, click “Yes” to delete the 
library resource and any events scheduled with the resource or “No” to abort. 

 Update status report on pop-up window: if modifications are made to the 
schedule and/or library resources while the “Sync Library Resources” window is 
open, click the “Refresh” button to update the pop-up window.   

 Close pop-up window: click “Done” to close the window. 

Illustration 140, Synced Schedule 
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Sending UltraNEXUS-HD Image Files 

To activate a schedule of event actions, send an image file to each connected 
UltraNEXUS-HD server as follows: 
NOTE: Users must have “Send, receive, rename and delete” rights in order to 
send an image file to an UltraNEXUS-HD system (refer to “Setting User Account Rights 
(Including WinLGX Password Changes),” on page 75, for more information on user 
rights).   

Send an image file to one or more of the currently connected servers according to the 
following steps: 

 One server: ensure the server’s product tab is selected and choose “Send” in the 

“File” menu or click its  icon on the main toolbar.  A dialog box will ask 
whether you want to send the tab’s currently open image to the connected 
UltraNEXUS-HD server.  Click “Yes” to complete the send and open the status 
box shown in Illustration 141. 

 Multiple servers: from any of the product tabs, select “Send all” in the “File” 
menu.  Click “Yes” when prompted to send each open image to its 
server/controller.  You will see a status box like the one shown in Illustration 141 
for each image file. 

Illustration 141, “Send image” Status Box 

 

NOTE: To interrupt the send, click the “Cancel” button.  If the send action appears 
to be stalled, cancel it and check your default location IP address and your 
network connections. 

Once each transfer is completed, the UltraNEXUS-HD system(s) will contain and 
execute the scheduled events.   
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Printing Schedules from WinLGX 

Perform the following steps to print the current schedule from WinLGX: 

1. Create a print template to select the desired schedule information for printing (see 
“Creating Templates for Exporting/Printing Schedules,” on page 81).  

Determine the page layout of your schedule printout (see “Configuring Page Layouts 
For Schedules Printed from WinLGX,” on page 83).  

Select “Print” in the “File” menu or click the  icon on the main toolbar to open the 
template selection window shown in Illustration 142. 

Illustration 142, “Select Export/Print Template” Window 

   

Choose the desired template from the “File name” list in the “Select Export/Print 
Template” Window (see Illustration 142) and click “Open,” or double click the template 
file to open the “Print” window.  Click “Cancel” to abort the print. 

In the “Print” window, configure the printer and copy settings according to the following 
steps. Click “OK” to print or “Cancel” to abort the print. 

NOTE: You may have already performed these steps through the “Print Setup” 
window.  See “Configuring Printer and Paper Settings for Schedules 
Printed from WinLGX,” on page 83. 

 “Printer” section: lets you choose the desired printer from a list of your PC’s 
available printers.  When a printer is chosen, its status appears below the printer 
“Name” field. 
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 “Properties” button: click to open a window specific to the printer, so that detailed 
printer settings can be made. 

 “Print range” is fixed at “All.”   

 “Copies” section: choose the number of schedule copies you wish to print.  If you 
choose more than one, checking “Collate” causes the printer to print each copy’s 
pages together and in order.  If “Collate” is unchecked, all of the first pages will 
be printed together, the second pages will be printed together, etc. 

Exporting Schedules into Comma Separated Values Files 

Perform the following steps to export schedules into a comma delimited format: 

1. Ensure the schedule you wish to export is currently open in WinLGX (see “Opening 
UltraNEXUS-HD Image Files,” on page 166). 

If you have not already done so, create a template (see “Creating Templates for 
Exporting/Printing Schedules,” on page 81). 

Select “Save as” in the “File” menu to open the window shown in Illustration 143, which 
allows you to export the loaded schedule as a comma separated values file (.csv) as 
follows: 

Illustration 143, “Save As” Window 

 

a. Select a folder in the “Save in” field.   
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b. Type a name for the exported file in the “File name” field.  If you leave the 
extension off, WinLGX puts it on for you.   

NOTE: If you enter a name of a file that already exists, WinLGX will ask you if 
you want to overwrite it. 

c. Select the .csv export format in the “Save as type” drop down menu.   

d. Click “Save” to open the template selection window shown in Illustration 144.  To 
apply a template to your schedule information, select the desired template and 
either click “Open” or double click the template file to create the export schedule 
.csv file.  The file can then be opened in your database program. 

Illustration 144, “Select Export/Print Template” Window 
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Using Control Panel to Perform Immediate Device and Switch Actions 

Use the Control Panel to perform unscheduled control actions, such as starting and 
stopping a schedule loaded on the UltraNEXUS-HD system, controlling your HD/SD 
digital video player/recorder, and, for external switcher configurations, switching an 
input to a different output.   

Open the Control Panel window (see Illustration 145) by clicking “Control Panel” under 

the “Tools” menu or  icon on the main toolbar.   

NOTE: The routing switcher and external switch device information displayed in 
the control panel depends on the switcher configuration (see “Configuring 
the Switch Type of an UltraNEXUS-HD,” on page 99) and the external 
switch device configurations (see “Creating External Switch Device 
Resources,” on page 115). 

Illustration 145, Control Panel Window 

 

If desired, sort the device icons by right clicking in the “Devices” column and selecting 
one of the sorting filters in the right-click menu that appears (see Illustration 146, 
Control Panel Device Sorting Menu). 

Illustration 146, Control Panel Device Sorting Menu 
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Perform any of the following steps: 

 Start/stop a schedule (see page 236). 

 Force a switch and view switcher status (see page 236). 

 Select a device in the “Devices” column and refer to one of the following sets of 
control steps: 

 “Controlling Internal Digital Video Player,” on page 237 

 “Controlling the Internal Digital Video Recorder,” on page 247 

 “Controlling ePRO-BUS Record Devices,” on page 252 

When finished, click “Close” to exit the Control Panel. 

Stop/Start a Schedule 

Once an UltraNEXUS-HD image file with a schedule of events has been sent to your 
UltraNEXUS-HD server (see “Sending UltraNEXUS-HD Image” on page 231), you may 
use the stop/start schedule button on the bottom of the Control Panel window (see 
Illustration 145, Control Panel Window) to perform the following: 

 Stop the currently running schedule by clicking the “Stop Schedule” button. 

 Restart the current schedule by clicking the “Start Schedule” button. 

EXTERNAL SWITCHER Configurations Only—Performing Forced Switches and 
Viewing Switcher Status 

Immediately switch one of your inputs to an output by using the “Switch” portion of the 
Control Panel.   

 “List” View 

To switch an input to an output from the “List” view (see Illustration 147, Control Panel 
“Switch” "List" View), single click on an input and then the output you wish to switch it to.  
When you have both an input and output highlighted, click the “Take” button to make 
the switch.  The “Current Input” column will then change to show the input has been 
routed to the output.  If valid video is present, you will see “Yes” in the “Valid” column of 
the selected output.  Any breakaway audio source accompanying the video will be 
indicated in the “Break Away” column.  
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Illustration 147, Control Panel “Switch” "List" View  

 

Controlling Internal Digital Video Player 

Select the digital video player icon in the Control Panel window’s “Device” list and click 
the “Play” tab to display the corresponding device control panel (see Illustration 148, 
Digital Video Player Control Panel).  

Illustration 148, Digital Video Player Control Panel 

 

The following is a list of the operations that may be performed: 

 “Queuing a File” on page 238 

 “Looping a Digital Video File” on page 241 

  “Playing a File” on page 241 

 “Queuing the Next File” on page 241 

 “Stopping a File” on page 242 

 “Pausing a File” on page 242 

 “Creating a Library Video Clip Resource” on page 243 

“Play” 

Tab 
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 “Activating the Virtual Channels” on page 245 

 “Selecting and Displaying Virtual Channel Playlist Files” on page 246  

Queuing a File 

Open the “Select File” window for either slides or digital video files as follows: 

 Digital video files:  

1. Click the ellipsis button next to “Queued Video File” to open the “Select File” 
video window (see Illustration 149, “Select File” Video Window).   

Illustration 149, “Select File” Video Window 

 
 

2. Select the storage device containing the desired video file from the “Storage 
device” drop down list. 

3. To display a file’s properties and view the clip before completing the selection, 
either right click on the file or click “Properties” to display the instant video 



UltraNEXUS-HD 
Software Operation 

 

LEIGHTRONIX, INC. Page 239 

Revised 11/22/2016 WinLGX ver. 7.0.3.31 
 

 

preview monitor.  For more information on the preview monitor window, go to 
the “Using Instant Video Preview Monitor to Display Digital Video Files within 
WinLGX” section on page 175. 

4. Select the desired file by double-clicking or highlighting the file and clicking 
“OK.”  The player control panel will then display the properties of the selected 
file under “Queued Video File” (see Illustration 150, Queued Video File 
Properties).  

NOTE: Click “Cancel” to abort any selections and close the “Select File” 
video window. 

Illustration 150, Queued Video File Properties 
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 Slides:  

1. Click the ellipsis button next to “Queued Slide” to open the “Select File” slide 
window (see Illustration 151, “Select File” Slide Window).   

Illustration 151, “Select File” Slide Window 

 
2. Select the desired username from the “Users” drop down list to display the 

desired slides. 

3. Select the desired file by double-clicking or highlighting the file and clicking 
“OK.”  The player control panel will then display the properties of the selected 
file under “Queued Slide” (see Illustration 152, Queued JPEG Slide).  

NOTE: Click “Cancel” to abort any selections and close the “Select File” 
slide window. 

Illustration 152, Queued JPEG Slide  
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Looping a Digital Video File 

Click the “Loop” checkbox to set up a digital video file for repeat playback.  Once the 

 button is clicked, the file will play over and over, from beginning to end, until the  
button is clicked or a scheduled event occurs. 

Playing a File 

Click the  button under “Audio/Video” for a digital video or “Slide” for a slide to play 
the most recently queued file.  The activated file moves into the current position on the 
control panel.  While a .m2t digital video file is playing, the counter displays the file 
playback time in HH:MM:SS:FF (FF=frames).  The counter displays “**” in the FF or 
frames place holder during playback (furthest to the right) (see Illustration 153), showing 
the current frame number when the file is paused. 

Illustration 153, Digital Video File Playback Counter 

 

Queuing the Next File  

While a file is playing, another file may be loaded into the “Queued Video File” position 
(see “Queuing a File” on page 238 and Illustration 154, Queued and Currently Playing 
Files). 

NOTE: Clicking the  button while another file is playing will cause the queued file 
to override the current file and begin playing. 

Illustration 154, Queued and Currently Playing Files 

 

 

Displaying a Slide with Audio from a Video File 

1. Ensure the “Synced” box is checked. 

2. Ensure that the desired digital video file and slide have been queued (see “Queuing 
a File” on page 238 for more information). 
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3. Control the synced files as follows from either the “Audio/Video” or “Slide” controls: 

 Click the  button to simultaneously activate the video file and slide. 

 To stop both files, click the  button. 

 To pause the audio track from the video file, click the  button. 
 

Stopping a File 

Click the  button under “Audio/Video” for a digital video file to stop a file.  Stopping a 
file unloads it from the “Current Video File” position. 

Pausing a Digital Video File 

Click the  button under “Audio/Video” to pause a digital video file in the “Current 
Video File” position.  When a digital video file is paused, the counter displays the current 
frame number in the FF or frames place holder (furthest to the right) (see Illustration 

155).  To reactivate the file, click the  button again. 

Illustration 155, Digital Video File Playback Counter with Frame Number Displayed 
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Creating a Library Video Clip Resource 

Use the digital video clip creation panel to create a library resource for a clip of a video 
file. 

 
1. Click the “Clip” tab to display the clip creation panel (see Illustration 156). 

Illustration 156, Digital Video Clip Creation Panel 
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2. Load the file you would like to use to create a clip according to the following steps: 

a. Click the button next to “Storage device” to display the “Select File” window (see 
Illustration 157). 

Illustration 157, “Select File” Window 

 

b. Select the storage device containing the desired digital video file from the 
“Storage device” drop down list. 

c. To display a file’s properties and view the clip before completing the selection, 
either right click on the file or click “Properties” to display the instant video 
preview monitor.  For more information on the preview monitor, go to the “Using 
Instant Video Preview Monitor to Display Digital Video Files within WinLGX” 
section on page 175. 

d. Single click on the desired file to highlight it and either double click or click “OK” 
on the bottom of the window to finish loading the file. 

3. Specify the clip’s playback start point using one of the following methods: 

 Click the  button to start playing the file and click the  button at the 
desired spot. 

 Drag the playback bar to the desired spot and click the  button. 
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 Click the  or  button to move between groups of pictures (GOPs) in the 

video file and click the  button. 

4. Specify the clip’s playback end point using one of the methods outlined above for 

selecting an in point and click the  button. 

5. To move to the selected in point and/or out point, click the  or  button. 

6. Preview the clip before airing by clicking the  button. 

7. Once you have specified the desired in and out points, create a new library item for 
the clip by clicking the “Add to library” button to display the “Add to library folder” 
window (see Illustration 158).  Perform the following steps: 

Illustration 158, “Add to library folder” Window 

 
a. Select the library folder in which the corresponding MPEG file library resource 

will be created. 

b. If desired, rename the clip in the “Resource name” field. 

c. Click “OK” to add the clip to the library or “Cancel” to abort the changes. 

Activating the Default Virtual Channel Playlists 

Before a Virtual Channel’s default “Current” playlist will display, the Virtual Channel 

must be activated through a schedule event or the Control Panel’s  
button.  Select the Virtual Channel’s player in the “Devices” column and then just click 
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the  button to display the playlist currently saved in the Virtual 
Channel’s default “Current” playlist preset.   
 

Selecting and Displaying Virtual Channel Playlist Files 

Virtual Channel playlist files can be displayed from the WinLGX control panel according 
to the following steps.   

1. Select the video player you want to display the playlist file’s digital resources in the 
“Devices” column. 

2. Click the ellipsis button next to the “Force Start Virtual Channel” button to display the 
"Select Virtual Channel List" Window shown in Illustration 159.   

Illustration 159, "Select Virtual Channel List" Window 

 

3. Select a Virtual Channel playlist as follows: 

 Double-click the desired file to accept selection and close “Select Virtual 
Channel List” window.  

 Select the desired file and click “OK” to accept or “Cancel” to abort selection. 

Once a playlist file selection is made, the playlist will immediately display. 
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Controlling the Internal Digital Video Recorder 

Select the digital video recorder tab in the control panel window to display the recorder’s 
control panel (see Illustration 160, Digital Video Recorder Control Panel).  Perform the 
following steps: 

Illustration 160, Digital Video Recorder Control Panel 

 

Select the digital video file recording parameters: 

a. Check the “Record CC data” box to capture any closed caption data from the 
source during recording.  Closed captions are hidden in the video signal and 
decoded for display on televisions with built-in decoders or televisions connected 
to external decoders. 

b. Select one of the following record overwrite options: 

 “Never”: WinLGX does not allow a file entered with an existing filename to 
record and displays an error message  

 “Always”: WinLGX records over an existing file with the same name 

NOTE: Selecting the “Always” option disables the “Add to library” option. 

 “Create unique”: if an existing filename is entered, WinLGX automatically 
records the file under the first 14 characters of the original filename followed 
by “yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record date specified as 
year/month/ day and hh/mm/ss is the file record time in 
hours/minutes/seconds) 

c. Select the volume of the drive on which you would like to store the recorded file 
from the “Storage Device” drop down list. 

NOTE: The WinLGX software will store the last selected storage device in the schedule 
image file. 

d. Under “File,” enter up to 27 characters (no spaces) for the filename. 

e. Select one of the user-defined record presets for the desired recording quality.  
See “Configuring Digital Video Recording Presets,” on page 109, for more 
information on defining the recording quality settings. 
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f. If you would like a library resource for the video file added to the “Library” tab 
window, select the “Add to library” option.  Once the digital video recorder stops, 
WinLGX displays the “Add to library” window (see Illustration 161).  Select the 
library folder in which the corresponding digital video file library resource will be 
created. 

 NOTES:  WinLGX will not create a library resource for a file that possesses 
the same video filename and length as a pre-existing library 
resource. 

  If the new file possesses the same title as another resource, but 
has a different video filename and/or length, WinLGX will copy the 
new file to the library with a numbered increment added to its title.  
For example, if this is the first time you have reused the title of a 
pre-existing library resource, WinLGX will add the new file to the 
library under the name “title01.” 

Illustration 161, “Add to library folder” Window 

 

Start and stop recording through one of the following options: 

 All Switch Type Configurations (with and without external switcher): 

 Manual Start/Stop 

a. Click the  button to begin recording the source connected to the 
UltraNEXUS-HD digital video recorder. 

b. When you have captured all of the desired video/audio, click the  
button to stop recording. 

 Direct Connect Configuration (no switcher):  

 Manual Start/Automated Stop 
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a. Click on the “MPEG Ingest” button on the digital video recorder control 
panel to display the window shown in Illustration 162. 

Illustration 162, Digital Video Ingest Window for a “No Switch” Configuration 

 
b. If desired, set a delay time for the digital video recorder from the 

“Recorder delay” field.  Once recording is initiated, this is the time that will 
elapse before the recorder begins capturing video/audio from the source 
connected to the recorder input.  WinLGX displays a countdown window 
that allows you to cancel the delay. 

c. Enter a record time in the “Length” field.   The digital video recorder 
automatically stops at the end of the record time. 

d. Start recording by clicking the  button. 

e. Click the “Close” button to exit the window. 

 External Switcher Configurations Only: 

 Switcher Panel 

a. From the switcher panel on the bottom of the Control Panel window, go to 
the digital video recorder output row and click on the external input switch 
resource that you would like to record.  

b. Click the  button to begin recording. 

c. Once the file reaches the desired length, click the  button to stop the 
recording.   

 Ingest Option 

Use the ingest option to digitally record playback from your switch resources 
connected to your external switcher inputs.  This option also allows you to 
delay the activation of the selected UltraNEXUS-HD digital video recorder and 
set a record time length.  Perform the following steps: 

a. Click on the “MPEG Ingest” button on the digital video recorder control 
panel to display the window shown in Illustration 163, “MPEG Ingest” 
Window. 
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Illustration 163, “MPEG Ingest” Window 

 

b. From the “Input/Source” drop down list, select the external switch resource 
that you would like to record. 

c. Under “Destination,” select the UltraNEXUS-HD digital video recorder that 
you would like to use to record the selected input. 

d. If desired, set a delay time for the digital video recorder from the 
“Recorder delay” field.  Once recording is initiated, this is the time that will 
elapse before the recorder begins capturing video/audio from the external 
switch resource.  WinLGX displays a countdown window that allows you to 
cancel the delay. 

e. If desired, enter a record time in the “Length” field.   The input device and 
digital video recorder automatically stop at the end of the record time. 

f. Start recording by clicking the  button. 

g. If you did not enter a record time in the “Length” field, stop the digital video 

recorder by clicking the  button. 

h. Click the “Close” button to exit the window. 

Monitoring a Video File Recording 

Once a digital video file recording has been initiated from a scheduled event or the 
control panel, WinLGX allows you to watch the recorded video on the control panel’s 
confidence monitor.  Select the recorder tab in the control panel window to display the 
recorder control panel and then click the “Monitor” tab (see Illustration 164).  After the 
recording is initiated, the confidence monitor automatically begins to display the 
recorded video footage after the number of seconds specified on the “Preview Monitor” 
tab of the “Preferences” window (default is 10 seconds; see page 94 for more details).  
To control playback of the recorded video, refer to the information below on the 
confidence monitor controls: 
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Illustration 164, MPEG Recorder Confidence "Monitor" Tab Window 

 

 “Recorder” Time Display: shows the total length of the recording file in 
hours:minutes:seconds 

 Play/Pause Button: click to toggle between pause and playback of the video. 

 Step Forward Button: moves the video forward one GOP each time it is clicked. 

 Seek End Button: moves current playback position to the end of the recorded file. 

 Volume Control: click and drag the volume control slider to adjust video’s volume.  
The volume control defaults to lowest audio setting. 

 Mute Button: click the mute button to toggle between silenced and restored audio. 

 “Current Recording File” Properties: provides the name, length, video bit rate, 
audio sample rate, and storage device of the selected video file. 
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Controlling ePRO-BUS Record Devices 

Select the ePRO-BUS record device icon in the “Device” list to display the 
corresponding control panel (see Illustration 165, Control Panel: ePRO-BUS Record 
Device Control) with the following information:  

Illustration 165, Control Panel: ePRO-BUS Record Device Control   

 

  “Format”: type of device.  This should be a DVR device. 

 “Interface type”: always a “PRO-BUS” device interface for ePRO-BUS record 
devices 

 “Device”: PRO-BUS address number assigned to the LABvault-HD recorder you 
wish to control.  The PRO-BUS address numbers are configured in the UltraNEXUS-
HD web interface (see the “Configuring ePRO-BUS Settings” section on page 344 
for more details). 

 “Input”: should be set to “<None>,” as ePRO-BUS record devices are outputs 

Immediately start/stop a record on your LABvault-HD player/recorder according to the 
following steps.  Start a remote ePRO-BUS record session if the LABvault-HD is 
networked to your UltraNEXUS-HD server.  A local ePRO-BUS record should be 
initiated for ePRO-BUS record devices that are directly wired to your UltraNEXUS-HD’s 
external switcher.  

 Remote ePRO-BUS Record: click the record icon to initiate a record on your 
LABvault-HD.  When you have captured the desired footage, click the stop record 
icon. 

 Local ePRO-BUS Record: for LABvault-HDs directly connected to your UltraNEXUS-
HD’s external system switcher, you will first need to switch a video source over to 
your LABvault-HD before initiating a record.  Perform the following: 

1. Use the control panel’s switcher subpanel underneath the ePRO-BUS device 
controls to switch a video source input to the output connected to your LABvault-
HD. 

2. If applicable, activate playback on your video source by selecting the input device 
in the left-hand column of the control panel.  Use the corresponding control panel 
controls to start playback on the video source input. 
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3. Return to the recorder controls by clicking the ePRO-BUS device controls in the 
control panel’s left-hand column.  Click the record icon to initiate a record on your 
LABvault-HD.  When you have captured the desired footage, click the stop 
record icon.  

Managing Storage of Video, SLIDE, and OVERLAY Files 

Manage digital media storage for one or more LEIGHTRONIX video servers/controllers 
with the WinLGX “Storage Manager” window.   The Storage Manager provides access 
to your videos, JPEG slides, PNG overlays, and JPG/PNG background images.  Just 
select the file type you want to manage and then add and delete the files to and from 
your local (PC/network) and remote (UltraNEXUS-HD compact Flash, USB hard drives, 
and NAS) storage devices. Open the Storage Manager window by selecting “Storage 

Manager” from the “Tools” menu or click the  icon on the main toolbar to open the 
window shown in Illustration 166, “Storage Manager” Window.   

Illustration 166, “Storage Manager” Window 

 
 

 

“File type” 

Selection Options 

Depending on selected storage 
device, lists files stored on local 
or remote storage devices for the 

selected “File type” 
Lists files stored only on 
remote storage devices 

for the selected “File type” 
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Perform any of the file management operations listed under the following sections: 

 “Choosing File Storage Devices” on page 254 

 “Managing All Digital Files” on page 255 

 “Previewing Video Files” on page 257 

 "Creating a Default Slide” on page 258 

 “Creating & Managing Background SubFolders” on page 259 

 “Transferring Graphic/Text Layers with Slides Created in a WebNEXUS Slide 
Editor,” on page 261 

When you are finished, click the “Close” button to exit the “Storage Manager” window. 

Choosing File Storage Devices 

Select one of the following to enable the display of the corresponding file type: 

 “Video”: displays video files only 

 “Slides”: displays JPEG slides only 

 “Overlay”: displays PNG graphic overlays only 

 “Background”: displays JPEG/PNG graphics available for slide creation in your 
WebNEXUS slide editor 

The left side of the Storage Manager window allows you to access both your local and 
remote storage devices.  Select a storage device as follows: 

 “Local storage device”: select to access files stored on your PC or network.  
Use the “Drive” drop down box and file navigation window to find and select 
your videos or graphics files. 

 “Remote storage device”: select to access the internal and external storage 
devices for your UltraNEXUS-HD system.  Specify the UltraNEXUS-HD 
storage device you wish to access as follows:   

a. Select a UltraNEXUS-HD system from the “Controller” drop down box.  All 
WinLGX connected UltraNEXUS-HD server/controllers will appear in the 
drop down box, allowing you to access the remote storage devices for the 
UltraNEXUS-HD system that you choose.  

b. From the “Device” drop down box, select a remote storage device based 
on the file type chosen in step 0: 

 “Video”: select the USB hard drive or network attached storage (NAS) 
device containing the MPEG files you wish to access 

 “Slides”: select a user account folder containing the slides you wish to 
access.  The “public” folder serves as a common storage area into 
which all users can add slides and cannot be displayed in slide shows. 

 “Overlay”: select the “Emergency” or “Standard” folder 

 “Background”: the “Background” subfolders are not accessible from 
the left side of the “Storage Manager” window. Instead, select “Local 
Storage Device” to display the UltraNEXUS-HD server’s background 
subfolders and contents on the right side of the “Storage Manager” 
window. 
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The right side of the Storage Manager window only allows you to access your 
UltraNEXUS-HD remote storage devices.  Refer to the remote storage device selection 
instructions in step 0, while noting the following for the “Background” folder: 

“Background”: when “Background” is selected, the right side of the Storage 
Manager shows the file folders containing graphics for your WebNEXUS slide 
editor’s “Images” selection window. By default, your UltraNEXUS-HD server includes 
several folders of background images and icons available for use during slide 
creation.  

Managing All Digital Files 

 Preview slides, overlays, and backgrounds: single click on a JPEG or PNG file to 
display it in the “Preview” window. 

 Select one or more files 

Selected files are highlighted with a blue stripe. 

 Single file: single click on the file 

 All Files: right click on a file and select “Select All” from the right-click menu. 

 Block of Files Next to Each Other: while holding down the “Shift” key on your 
keyboard, single click two files to select both files plus any in between. 

 Random: hold down the “Ctrl” key on your keyboard and click on the desired 
files. 

 Copy files from one storage area to another 

Copying leaves the original files in their current locations.  Select one or more files 
and then right click on the selected file(s) to display the right-click menu.  Select 
“Copy” from the menu.  A dialog box (see Illustration 167, Storage Manager Copy 
Dialog Box) will ask whether or not you would like the file copied to the storage 
device selected on the opposite side of the Storage Manager screen.  Depending on 
your selected storage device/file type, you may also perform the following: 

 Create a library resource for the file: if you are copying a video, slide, or 
background to a remote storage device, you may click the “Add to library” option 
to create a WinLGX library resource for the file. 
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 Export XML data to local storage device: if you are copying a digital file from a 
remote to a local storage device, you will see an “Export XML data” checkbox in 
place of the “Add to library option.”  The “Export XML data” checkbox is reserved 
for future use. 

Illustration 167, Storage Manager Copy Dialog Box 

 

NOTE: Clicking the “Cancel” button on the FTP window stops the transfer, leaving a 
file fragment which should be deleted.  Cancel only when necessary.  When 
multiple files are finished, a summary dialog appears giving the final results. 

 Move file(s) from one storage area to another 

Moved files are removed from their original locations and transferred to the selected 
storage areas.  Select one or more files and then right click on the selected file(s) to 
display the right-click menu.  Select “Move” from the menu.  Depending on your 
selected storage device/file type, you may also perform the following:  

 Create a library resource for the file: if you are copying a video, slide, or 
background to a remote storage device, you may click the “Add to library” option 
to create a WinLGX library resource for the file. 

 Export XML data to local storage device: if you are copying a digital file from a 
remote to a local storage device, you will see an “Export XML data” checkbox in 
place of the “Add to library option.”  The “Export XML data” checkbox is reserved 
for future use. 

NOTE: Clicking the “Cancel” button on the FTP window stops the transfer, leaving a 
file fragment which should be deleted.  Cancel only when necessary.  When 
multiple files are finished, a summary dialog appears giving the final results. 

 Delete files from your storage areas 

 Select desired file(s) and press the “Delete” key. 

 Right click on the selected file(s) and select “Delete” from the right-click menu.   

A pop-up box will appear, showing the name and path of the digital file to be deleted.  
If you are deleting the file off of a remote internal or external storage device for your 
UltraNEXUS-HD system, the Storage Manager will also allow you to select an option 
that automatically deletes any library resources and events containing the file.  Click 
“Yes” to complete the deletion or “No” to abort. 

Illustration 168, Storage Manager Digital File Delete Option 
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 Rename files 

Right click on the selected file(s) and select “Rename” from the menu. Enter new 
volume name in the “Rename File” window. 

NOTE: NEXUS series server/controllers will not display files with filenames 
containing spaces. 

 Create library resources for your videos and JPEG slides 

Right click on the file(s) selected on one of your remote storage devices and select 
“Add to library” from the right-click menu to display the “Add to library folder” Window 
shown in Illustration 161.  Select the library folder you want to contain the 
corresponding library resource(s) and click “OK.” 

NOTES:  WinLGX will not create a library resource for a file that possesses the 
same filename and length as a pre-existing library resource. 

  If the new file possesses the same title as another resource, but has a 
different filename and/or length, WinLGX will copy the new file to the 
library with a numbered increment added to its title.  For example, if this is 
the first time you have reused the title of a pre-existing library resource, 
WinLGX will add the new file to the library under the name “title01.” 

 Rename remote storage device(s) 

In a remote storage device file listing on either side of the Storage Manager window, 
right click and select “Rename volume.”  Enter the new volume name in the “Rename 
Volume” window and click “OK” to make the change or “Cancel” to abort. 

 Refresh file listing 

Click the “Refresh” button to update the files on the Storage Manager window. 

Previewing Video Files 

WinLGX gives you the option to display the digital video files in the Storage Manager 
“Video” listings within the instant video preview monitor by either double clicking the file 
or right clicking on the file and selecting “View” in the right-click menu.  For more 
information on the preview monitor, go to the “Using Instant Video Preview Monitor to 
Display Digital Video Files within WinLGX” section on page 175. 
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Enabling and Authorizing Slides for Display in Slide Shows 

Slide .jpg files must be enabled and authorized before they will display in slides shows 
(see  
Illustration 169).  All users who have the right to upload slides can indicate their slides 
are appropriate for slide shows by checking the “Enable” box next to each slide in their 
user folders.  However, the “Authorize” box next to each slide must also be checked 
before it will display on-air in slide shows.  Only the “admin” user and users with the 
“Slide administrator” right can authorize slides in any user folder.  Slides uploaded by 
users with the “Automatic slide authorization” right into their own user folders will be 
automatically approved for display.  Refer to “Setting User Account Rights (Including 
WinLGX Password Changes)” on page 75. 

Illustration 169, Slide Show Authorize and Enable Options 

 

 

Creating a Default Slide 

The default slide will display if a slide show is scheduled in a slide show without slides 
or without approved slides. 

1. The “admin” user must upload the slide into his “admin” user account folder (see the 
“Managing All Digital Files” on page 255). 

2. Right-click on the file and select “Rename” from the menu.  Change the slide 
filename to “Default.jpg.” 

3. Enable and approve the slide for display (see the “Enabling and Authorizing Slides 
for Display in Slide Shows” section on page 258). 
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Creating & Managing Background SubFolders 

Graphic files in the “/Internal/DATA/backgrounds” subfolders are available for use 
during slide creation from your WebNEXUS slide editor’s “Images” selection window 
(see “Creating New Slides” on starting on page 292 for more details). The subfolders 
are on your NEXUS series server’s internal compact Flash storage area and contain 
factory default slide templates, backgrounds, and icon graphics from LEIGHTRONIX as 
well as any files you have chosen to upload.   

NOTE: The “Background” file type on the “Storage Manager” window only appears 
for users with the “Slide Administrator” user right.  Users must also be granted 
the “Send and Receive” user right in order to transfer any files between local 
and remote storage areas.  See “Setting User Account Rights (Including 
WinLGX Password Changes) on page 75 for more information on adding and 
assigning rights to user accounts. 

You may create additional subfolders for your own PNG and/or JPEG background files 
created with any third-party graphic program.  Create and delete background subfolders 
according to the following steps: 

 Create a background subfolder 

1. Ensure you have selected “Local Storage Device” on the left side of the “Storage 
Manager” window.   

2. On the right side of the “Storage Manager” window, right click in the 
“backgrounds” directory window and select “Create directory” as shown in 
Illustration 170. In the “Create directory” window that appears, type in a name for 
your subfolder and click “OK” to create the subfolder or “Cancel” to abort. 

NOTE: Your WebNEXUS slide editor will only display graphics within the 
“backgrounds” subfolders.  

Illustration 170, “Create directory” Backgrounds Option 

 

3. Copy or move files into the new subfolder according to “Managing All Digital 
Files” on page 255. 

NOTE: Images of any size resolution may be uploaded to a WebNEXUS slide 
editor, but keep in mind the editor slide creation area and save 
resolution is 1920 pixels wide x 1080 pixels high. 

 Delete a background subfolder 

1. Ensure you have selected “Local Storage Device” on the left side of the “Storage 
Manager” window.   
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2. On the right side of the “Storage Manager” window, right click on a subfolder in 
“/Internal/DATA/backgrounds” and select “Delete directory” in the pop-up menu 
that appears.  Click “Yes” to delete the subfolder or “No” to abort. 
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Transferring Graphic/Text Layers with Slides Created in a WebNEXUS Slide Editor 

Slides created in a WebNEXUS slide editor can still be modified after they are 
transferred to a local storage device or another NEXUS series server if they are 
copied/moved from the WinLGX Storage Manager with their graphic/text layers.  By 
choosing the Storage Manager’s “Show Edit Files” option and transferring slides with 
their graphic/text layers to a NEXUS series server (remote storage device), you will be 
able to modify the slides’ layers in your WebNEXUS slide editor.  To transfer a slide with 
its layers, perform the following: 

1. Select the “Slides” file type. 

2. Select your storage devices on the 
right and left sides of the Storage 
Manager window (see “Choosing 
File Storage Devices,” on page 
254 for instructions). 

3. Select the “Show Edit Files” option 
to list the .fie files for any slides 
originally created in a WebNEXUS 
slide editor.  Each .fie file contains 
the text/graphic layers used to 
create the slide with the same 
name.   

4. Show each .fie file next to its 
corresponding .jpg slide in the 
slide listing by clicking the “Name” 
category header.  The Storage 
Manager does not provide preview 
images of the .fie files. 

Illustration 171, “Show Edit Files” Option 

 
 

5. Select both the slide’s .jpg and .fie files as follows: while holding down your 
keyboard’s “Ctrl” key, single click both the .jpg and .fie files to select the pair.  While 
still holding down the “Ctrl” key, right click to display the file management menu (see 
Illustration 172).    

“Show Edit Files” 

Slides Option 

Example of .fie file 

and .jpg slide pair 

“Name” 

Category Header 
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Illustration 172, Transfer Slide and Layer Files 

 
 

6. From the file management menu (see Illustration 172), select either “Move” to 
remove the files from the storage device and transfer them to the storage device 
selected on the opposite side of the Storage Manager window or “Copy” to create a 
duplicate of the slide files on the other selected storage device.  If your target file 
destination was a slide user folder on a NEXUS series remote storage device, you 
may modify the slide in the server’s WebNEXUS slide editor (see the "Creating New 
Slides” section starting on page 292, as applicable). 

 
 

 
 
 
 
 
 
 
 
 
 

File Management 

Menu 
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Retrieving Log Files 

Each UltraNEXUS-HD server keeps track of everything done to or by it in internal log 
files.  The UltraNEXUS-HD log files cannot be deleted, written to, or manipulated by a 
user in any way; however, once downloaded, you can then save, write, and format the 
file just like any other text document. 

WinLGX allows you to access the UltraNEXUS-HD log files with the “Get log” menu item 

under the “File” menu or  icon on the main toolbar.  Selecting one of these options 
will display the "Select Controller Log File" Window shown in Illustration 173.   

Illustration 173, "Select Controller Log File" Window 

 

At the top of the “Select Controller Log File” window, you will see three different tabs for 
accessing the UltraNEXUS-HD log files.  Access the UltraNEXUS-HD event, system, 
and firmware log files as follows: 

As Played Log Files  

NOTE: Currently not available. These logs will be available in future firmware. 

Especially useful for tracking playback events, each UltraNEXUS-HD server logs its 
event execution status into a .CSV file spreadsheet on a monthly basis (see Illustration 
174).  The execution results for each event are logged under the spreadsheet’s “Result” 
column, with “Ok” indicating the event was successfully executed and “Exception” 
meaning the event was not executed.  For those events with the “Exception” status, 

Log File Tabs 
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refer to the “Report” column on the spreadsheet for more information about why the 
event did not occur.  Also logged are each event’s date and time of execution, format 
type, device type, and other major event descriptors. 

Illustration 174, Example of Event Log File 

 

To access As Played log files, perform the following steps: 

Click on the “As played” tab on the “Select Controller Log File” window.   

Single click on the desired .CSV file to select it and then click “OK.”   

A “Save as Played log File” window will open.  Save the .CSV file to a new file path or 
use the WinLGX default log file path (Shared Documents\Leightronix\WinLGX\Controller 
Data\IP xxx.xxx.xxx.xxx\Log”).   

Click the “Save” button to save the file to your chosen file path.  The “Save as Played 
log File” and “Select Controller Log File” windows will close.   

Navigate to the file path for the saved .CSV file and open it in Excel. 
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System Log Files 

The UltraNEXUS-HD system activity log files are called “EVENTS.LOG” and 
“OLDEVNTS.LOG.”  When a new UltraNEXUS-HD server is powered on for the first 
time, it creates a file called “EVENTS.LOG.”  The UltraNEXUS-HD system will 
continually write to this file until it reaches 7 MB.  Once “EVENTS.LOG” reaches 7 MB, 
the UltraNEXUS-HD system will rename it to “OLDEVNTS.LOG” (deleting the previous 
“OLDEVNTS.LOG”) and then create a new “EVENTS.LOG.”  This ongoing cycle 
ensures that recent events are always logged.  

The UltraNEXUS-HD system log files are useful in identifying specific events within the 
system, such as when a particular program aired, when a user logged in from a remote 
terminal, and more.  To view a system log file, perform the following steps: 

1. Click on the “System” tab on the “Select Controller Log File” window (see Illustration 
175, “System” Tab on the “Select Controller Log File” Window).  

Illustration 175, “System” Tab on the “Select Controller Log File” Window 

 

2. Select one of the log files from the listing and then download log records based on 
the following filter options: 

 “Date/Time filter”: check box to enable the date/time fields 
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 Within a range of dates and times: use the start/end date and start/end time 
fields to download all log records within the selected dates and times  

 No filter: click the “Raw data (no filter)” button to download all log records  

 Digital video playback events of low severity: click the “MPEG Play” filter 
preset button to download all noncritical log records containing the text “MPEG 
Play” in their action descriptions 

 Severity of event action: download all log records with the event severity 
code selected with the “Severity filter” drop down menu 

 Group action type: download all log records with the group action type 
selected with the “Group filter” drop down menu 

 Action descriptions: download all log records with action descriptions 
containing one of the text options selected with the drop down menu under 
“Text filter.”  To create your own action description filter, select “User text” from 
the drop down menu and type in the desired keyword in the “User text” 
comment field. 

3. Click “OK” to open the “Save Log File” dialog box.  Once saved to the desired 
location, the log is displayed in a text editor of your choosing (see Illustration 176, 

Example of Log File).  This will also turn off the log LED  that appears on the 
UltraNEXUS-HD system’s front panel when a severity 1 or 2 event action is logged. 

NOTE: The default viewer is Notepad, but the viewer can be changed from the 
“Tools”/“Preferences”/”Application” tab (for more details, see “Setting 
WinLGX Viewing and Communication Preferences,” beginning on page 
87).  
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Illustration 176, Example of Log File 

 

Each action performed through or by the UltraNEXUS-HD server is recorded in the log 
file along with its date and time, severity, and action type.  The following information 
identifies and explains each part of the “EVENTS.LOG” file in more detail. 

 Date 

 Time 

 Severity of event action—event actions are classified according to the following 
three levels of severity: 

 0: events that occur during the course of normal operations 

 1: warning events 

 2: critical events or failures 

 Types of actions recorded: 

 Diagnostic: UltraNEXUS-HD system health and status  

 File: actions involving files, typically file transfers (also UltraNEXUS-HD image 
send/retrieve)  

 Front Panel: actions performed based on commands given by user through 
the front panel of the UltraNEXUS-HD system 
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 MPEG: digital video player/recorder actions 

 Remote: actions performed based on commands given by user from the 
WinLGX control panel 

 Schedule: actions performed based on user-created schedule  

 Switcher: actions based on switcher events and functions 

 USB drive: actions pertaining to the external USB hard drives 

 Web: actions performed through the UltraNEXUS-HD’s web interface 

 Descriptive message of actions performed 

 

Updating Firmware/Software 

LEIGHTRONIX places the most current firmware/software files for each LEIGHTRONIX 
product on its Support Center website.  Save the update files to an accessible directory 
on your PC. 

Updating UltraNEXUS-HD Server 

Open the WinLGX software and log in to your UltraNEXUS-HD system (see “Opening 
WinLGX and ” on page 162). 

Choose “Controller” under the “Tools” menu to open the “Controller” window shown in 
Illustration 177. 

Illustration 177, Controller Window 
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Under “Firmware update,” click “Browse” to open the “Choose controller firmware file” 
window shown in Illustration 178.   

Illustration 178, “Choose Controller Firmware File” Window  

 
- 

Navigate to and open the current .lpf file to update your UltraNEXUS-HD server’s 
firmware and, if needed, your web interface.  Once you have selected and opened the 
file, the “Select firmware options” window is displayed (see Illustration 179).  Leave all 
options checked and click “OK” to save your firmware update options or “Cancel” to 
abort the changes and close the dialog.  If you would like to reopen the window, click 
the “Options” button under “Firmware update.” 
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Illustration 179, “Select Firmware Options” Window 

 

Click “Update” to continue the firmware update.  Click “Yes” when prompted to start the 
update. 

Once the update has completed, click “OK” to apply the changes and reboot the 
UltraNEXUS-HD server.  You will be logged out and the “Site Manager” window will be 
displayed. 

NOTE: You will not be able to log back in until the UltraNEXUS-HD system 
finishes rebooting.  The update may take several minutes. 

After the UltraNEXUS-HD system finishes rebooting, log back in and confirm the 
UltraNEXUS-HD system has been upgraded to the latest firmware version in the “Site 
Manager” database.   

Updating WinLGX Software 

Close WinLGX. 

Navigate to and open the WinLGX_vx.x.x.x_Installer.exe.  Follow the prompts to install 
the latest version of the client software.  

Click “OK” to continue WinLGX update. 

Follow the prompts to complete the installation.
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Web Control 

About this Section 

Access your UltraNEXUS-HD system from the Internet with WebNEXUS, a built-in, 
password-protected web interface.  WebNEXUS provides the ability to manage slides, 
create and display emergency messages, create looping playlists for display between, 
as, or in place of scheduled programming, transfer video files to specified destinations, 
record video files, and view the UltraNEXUS-HD system’s status, program guide, and 
log files.  Note that slides can only be activated for broadcast through the WinLGX 
scheduler and control panel.   

WebNEXUS works on any computer with Microsoft Internet Explorer 8 and above, 
Google Chrome, Firefox , Safari, and Opera.  While WebNEXUS may work with other 
browsers, full functionality is not guaranteed.  No special software installation is 
required.     

Up to 32 different users can log into WebNEXUS.  All user accounts may perform the 
following: 

 Upload slides into their own user folders on the UltraNEXUS-HD’s internal 
storage drive 

 Specify slide availability settings for slide shows 

 Add text and program guides to slides 

 View UltraNEXUS-HD system status 

 

Some user accounts have access to additional WebNEXUS features, as outlined in 
Table 43.  The “admin” user account has access to all WebNEXUS features.  See 
“Setting User Account Rights (Including WinLGX Password Changes)” on page 75, for 
instructions on assigning rights to user accounts. 

Table 43, User Rights with Access to Additional WebNEXUS Features 

Description 
“Administrator” 

Right 

“Slide 
Administrator” 

Right 

“MPEG/Slide 
control 
(record/ 
setup)” 

Right 

“No file 
access” 

Right 

“Receive only,” 
“Send and 

receive,” and 
“Send, receive, 

rename, & delete” 
Rights 

Create and display 
emergency messages 
over digital programs   
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Description 
“Administrator” 

Right 

“Slide 
Administrator” 

Right 

“MPEG/Slide 
control 
(record/ 
setup)” 

Right 

“No file 
access” 

Right 

“Receive only,” 
“Send and 

receive,” and 
“Send, receive, 

rename, & delete” 
Rights 

Authorize slides for on-
air display in slide 
shows 

 
 

   

Add, edit, rename, and 
delete slides with all 
user account folders 

 

 

   

Configure file transfer 
destinations as well as 
enable recording of 
VOD files for VieBit 

 
 

 
  

Transfer video files to 
another UltraNEXUS-
HD, FTP destination, 
and/or VieBit 

 
   

 

Record Video files and 
add VieBit index points 

 

 

 
  

Display program guide 
  

   

View log files 
 

    

Manage “System” 
settings  

    

Create looping Virtual 
Channel playlists  
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Opening and Logging into Web Interface 

Open the UltraNEXUS-HD web interface through one of the following steps: 

 If you already have WinLGX open and are logged into the desired UltraNEXUS-

HD’s IP address, select “Web interface” from the “Tools” menu or click on the  
toolbar icon to open the web interface in your default web browser. 

 Enter your UltraNEXUS-HD’s IP address into the address bar of Internet Explorer 
(see Illustration 180). 

Illustration 180, Accessing UltraNEXUS-HD from Internet Explorer 

 

A login prompt will appear (see Illustration 181, Login Prompt).  Enter your username 
and password. 

NOTE: Your username and password are assigned through WinLGX.  Refer to 
“Setting User Account Rights (Including WinLGX Password Changes)” on page 75 for 
information on adding/editing usernames and passwords. 

 
 

Illustration 181, Login Prompt 
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If login is successful, the window shown in Illustration 182, “System Dashboard” Screen, 
opens.  All web-based control functions are accessible from the menu sidebar. 

Illustration 182, “System Dashboard” Screen 

 

“Site Information” 

Displays your UltraNEXUS-HD’s site information, including serial number and firmware 
version. 

“Storage” 

Displays the storage availability on your UltraNEXUS-HD’s internal hard drive and for 
any connected USB drive and NAS storage device. 

Video Player/Recorder Statuses 

Displays the properties of the files currently playing on the Video Player and the files 
currently being recorded by the Video Recorder.  Click the tab of the desired Video 
Player or Recorder to display the corresponding information. 
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“Network Settings” 

Displays your UltraNEXUS-HD’s network addresses. 

“Switcher Status” 

If using an external switcher, provides a quick overview of which of your inputs are 
currently switched to the switcher outputs. 

Managing Digital Video Files 

The “File Management” and “Destinations” screens provide the ability to control digital 
video file transfers from the Internet.   
 

Setting Up Transfer Destinations 

Easily control where your recorded files are transferred by clicking the 
“DESTINATIONS” button and using the “Destinations” screen tabs.  Recorded files may 
be automatically or manually transferred to another UltraNEXUS-HD server/controller, 
LEIGHTRONIX VieBit streaming VOD website, and/or third party server with FTP 
capabilities, as outlined below.  The settings apply to each recording session until you 
change them. 

ULTRANEXUS-HD VIDEO SERVER DESTINATION 

If you own another LEIGHTRONIX UltraNEXUS-HD video server, you can send your 
digital video files to any of the other server’s storage volumes.  Enter the destination 
UltraNEXUS-HD server’s IP address, username, and password along with the name of 
the volume that you want to store the files.  The names of your storage volumes can be 
viewed in the WinLGX “Storage Manager” window.  Complete the remaining settings 
according to the steps below and click the “Apply Changes” button when you have 

finished (refer to Illustration 183). 

“Verify Connectivity”: after entering your UltraNEXUS-HD’s IP address, username, 
and password, click the “Verify Connectivity” button to ensure your UltraNEXUS-HD can 
connect to the destination server. 

“Automatic Upload”: when selected, files will be automatically transferred to the 
specified UltraNEXUS-HD after each recording session. 

“Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours 
of the week your UltraNEXUS-HD will transfer files to your destination UltraNEXUS-HD.  
Single click each hour segment on the timeline to toggle transfer capabilities on or off 
(green = on, red = off). 

“Enable Auto-Play CH”: once the “PEGcasting” option is enabled on the UltraNEXUS 
“Record Settings” tab (see “Setting up Video File Record ,” on page 279), you may 
choose to have a transferring file stream automatically begin playing on your second 
UltraNEXUS-HD system’s video player while the file is still recording. Select a “Playback 
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Delay” of 2-60 minutes to specify how long after the file stream is transferred that it 
should begin playing.  

 

Illustration 183, "UltraNEXUS-HD" File Destinations Tab 

 
 

LEIGHTRONIX VIEBIT VIDEO-ON-DEMAND WEBSITE (INTERNET VOD)  
 

This option causes the UltraNEXUS-HD to transfer a copy of manually or scheduled 
recorded files to the LEIGHTRONIX VieBit Web hosting and streaming video-on-
demand service.  Complete the settings according to the steps below and click the 
“Apply Changes” button when you have finished (refer to Illustration 184). 

“Automatic Upload”: when checked, files will be automatically transferred to 
LEIGHTRONIX streaming video-on-demand site after each recording session. 

“Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours 
of the week your UltraNEXUS-HD will transfer files to your VieBit server.  Single click 
each hour segment on the timeline to toggle transfer capabilities on or off (green = on, 
red = off). 
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Illustration 184, "VieBit" File Destinations Tab 
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Server with FTP Capabilities 

Push your files to another LEIGHTRONIX or third party video server with FTP 
capabilities.  Enter your server’s IP address, username, and password along with the 
name of the destination path.  Complete the remaining settings according to the steps 
below and click the “Apply Changes” button when you have finished (refer to Illustration 
185).  

1. “Verify Connectivity”: after entering your server’s IP address, username, and 
password, click the “Verify Connectivity” button to ensure your UltraNEXUS-HD can 
connect to the destination server. 

“Automatic Upload”: when checked, video files will be automatically transferred to the 
specified server after each recording session. 

“Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours 
of the week your UltraNEXUS-HD will transfer files to your destination server.  Single 
click each hour segment on the timeline to toggle transfer capabilities on or off (green = 
on, red = off). 

Illustration 185, "FTP Server" File Destinations Tab 
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Setting up Video File Record Settings 

From WebNEXUS, UltraNEXUS-HD users can change their record quality and 
automation settings for video file recordings. 

Click the “DESTINATIONS” button and then select the “Record Settings” tab.  Edit any 
of the following record settings and then click the “Apply Changes” button to send the 
changes to your UltraNEXUS-HD or “Cancel” to abort.  The settings will be applied to 
every web recording session until they are changed. 

Illustration 186, "Record Settings" 

 

 “Volume”: select the USB hard drive or NAS storage device that WebNEXUS 
broadcast file recordings will be added to.  

  “File Name”: in the “File Name” field, enter up to 14 characters (letters, numbers, 
and underscores only—no spaces).  If you use the same filename for more than one 
recording session, the record date and start time will be appended to the name of 
each additional recorded file as “yy/mm/dd-hh/mm/ss” (year/month/day-
hours/minutes/seconds). 

 “Create Unique Files”: when this option is selected, the record date and start time 
will be appended to the filename of every recorded file as “yy/mm/dd-hh/mm/ss” 
(year/month/day-hours/minutes/seconds). 

 “File Quality”: select a “File Quality” recording preset.  Each recording quality preset 
represents the range of bit rates within which your broadcast files will be recorded.  
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  “PEGcasting”: if you want your recorded files transferred to a second UltraNEXUS-
HD 15 seconds after the files begin recording, select the “Enable” “PEGcasting” 
option.  To use the PEGcasting Next to Live autoplay feature for simulated live 
broadcasting, you must still complete the “PEGcasting N2L” configuration settings 
on the “UltraNEXUS-HD” tab (see “Setting Up Transfer Destinations,” on page 275). 

 “Closed Captions”: Select the “Enable Closed Captions” option to capture any closed 
caption data from the source.  Closed captions are hidden in the video signal and 
decoded for display on televisions with built-in decoders or televisions connected to 
external decoders. 

Recording 

NOTE: Currently, the index point and Input selection does not function. This 
should be functional in a future firmware version. The recorder will record 
whatever input is selected in the WinLGX Control Panel.  

WebNEXUS allows users to immediately start/stop file recordings and add index point 
to any VieBit VOD file that is being recorded.  Start/Stop recording and add index points 
to your files through the “Video Recorder” panel on the WebNEXUS sidebar as follows: 

NOTE: Ensure the desired record quality, name, and automation settings have been 
selected on the “File Destinations”/”Record Settings” tab (see “Setting up 
Video File Record Settings,” on page 279 for instructions). 

Illustration 187, Video Recorder Closeup 

 

Choose the video source you want to record from the “Source” drop down menu.  You 
may select one of your UltraNEXUS-HD’s player or a video source connected to 
your switcher. 

Click the record button to start recording your file.  

LEIGHTRONIX VieBit VOD Streaming Service Users Only: add video index points for 
use in LEIGHTRONIX VieBit VOD streaming application.  Index points appear as 
links next to the published video in the streaming application’s player window, 
allowing viewers to quickly move to points of interest within the video.  

Stop Record Button 

Index Point  
Name Field 

“Set Index” Button 

“Clear Index” Button 

Record Button 

Video “Source” 

Drop Down Menu 
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Either enter a custom name (64 characters maximum) for your index points into the 
index name field or leave it blank and the UltraNEXUS-HD will use the current 
date/time as the name. Each index point also indicates the hours:minutes:seconds 
into the video that it marks. When you have chosen your naming method, click the 
“Set Index” button to add an index point to the recording file. Create additional index 
points at key intervals in the recording with each click of the “Set Index” button.  If a 
custom name was entered, each additional index point will be assigned the same 
custom name until the name field is reset. To add an index point with a new custom 
name, click the “Clear Index” button and then type a new name into the name field 
before clicking the “Set Index” button.    

To end the recording session, click the stop recording button.  If a file destination was 
configured and enabled in WebNEXUS, your recorded file will be automatically 
transferred to the destination. 
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Manually Transferring Digital Video Files 

Click the “Files” menu button to display the screen shown in Illustration 188.  The “File 
Management” screen displays a “Video Files” listing of the digital video files on your 
UltraNEXUS-HD’s storage volumes and a video file transfer queue.   

NOTE: Ensure that any destinations you want to receive files have been configured 
on the “File Destinations” screen. 

Illustration 188, Pop-Up Menu for "Video Files" Listing on the "File Management" Screen 

 

VIEW FILE INFORMATION 

Hovering over a filename in the “Video Files” listing with your mouse pointer will bring 
up a popup that shows the file’s storage volume, filename, length, size, and date of 
creation.  Except for storage volume, this information is also displayed in each row of 
the “Video Files” listing. 

“Video Files” Listing 
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ADD FILES TO TRANSFER QUEUE 

Under the “Video Files” listing, use one of the following methods to add a digital video 
file to your transfer queue: 

 Drag the desired file to the right side of the screen 

 Double click the desired file 

 Single click on the digital video file you would like to transfer and click the “Add” 
button to transfer the file to any configured destination(s) 

 Right click on the file and select a configured destination(s) from the pop-up 
menu (see Illustration 188).   

RENAME FILES ON DIGITAL STORAGE DEVICES 

Under the “Video Files” listing on the left side of the screen, either single click on the file 
you would like to rename and then click the “Rename” button or just right click on the file 
and select “Rename” from the menu that appears (see Illustration 189).  In the “Rename 
File” window that appears, enter a new filename of up to 27 alphanumeric characters, 
no spaces, and click “Ok” to accept the change or “Cancel” to abort.    

Illustration 189, Pop-Up Menu for "Video Files" Listing on the "File Management" Screen 

 

DELETE FILES FROM STORAGE DEVICE/TRANSFER QUEUE 

• Storage Device:  under the “Video Files” listing, either single click on the file you 
would like to delete and then click the “Delete” button or just right click on the file and 
select “Delete File” from the pop-up menu.  Click “Yes” when prompted to delete the 
file or “No” to abort. 

• Transfer Queue: to delete a single file under “Video Transfers,” either single click 
on the file you would like to delete and then click the “Remove” button or just right 
click on the file and select “Remove Transfer” from the pop-up menu.  To remove all 
files from the transfer catalog, either single click on a file and then click the “Remove 
All” button or just right click on the file and select “Remove All Transfers” from the 
pop-up menu.  Click “Yes” when prompted to delete the file(s) or “No” to abort. 

CHANGE FILE TRANSFER DESTINATIONS 
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Change the destination of any file in the “Video Transfers” queue by right clicking on the 
file and selecting one of the add/remove options in the popup menu (see Illustration 
190).  The remove options de-select current file transfer destinations, while the add 
options transfer the file to the corresponding destinations.   

Illustration 190, Pop-Up Menu for "Video Transfers" Listing on the "File Management" Screen 

 

STOP FILE TRANSFERS 

End a file transfer from the “Video Transfers” queue by either single clicking the 
filename and then clicking the “Remove” button or right clicking on the file and selecting 
the remove option for the file’s intended destination.  To end all file transfers, either click 
the “Remove All” button or right click on a file and select the “Remove All Transfers” 
option. 
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Managing Log Files 

Each UltraNEXUS-HD server keeps track of everything done to or by it in internal log 
files which are accessible from its web interface.  Click the “LOGS” menu button to 
display the list of current logs for your UltraNEXUS-HD on the “Log Files” screen (see 
Illustration 191 and Table 44).  

Illustration 191, "Log Files" Screen 

 

Table 44, Log File Types 

Log File Type Description 

Playback Event Each playback event log file is a monthly record of digital video 
playback events scheduled on your UltraNEXUS-HD (see 
Illustration 174 for an example).  Playback event log filenames 
are formatted as “PLyear-month.CSV.” 

Tracked in each playback event log are playback event dates 
and start times, format types, device types, and other major 
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Log File Type Description 

event descriptors, including the status of each event.  Event 
execution results are logged in the file’s “Result” column, with 
“OK” indicating the event was successfully completed and 
“Exception” meaning the event did not occur.  For those 
events with the “Exception” status, refer to the “Report” column 
in the file for more information about why the playback event 
was not executed. 

System Event The UltraNEXUS-HD activity log files are called 
“EVENTS.LOG” and “OLDEVNTS.LOG” (see Illustration 191 
for example).  When a new UltraNEXUS-HD is powered on for 
the first time, it creates a file called “EVENTS.LOG.”  The 
UltraNEXUS-HD will continually write to this file until it reaches 
7 MB.  Once “EVENTS.LOG” reaches 7 MB, the UltraNEXUS-
HD will rename it to “OLDEVNTS.LOG” (deleting the previous 
“OLDEVNTS.LOG”) and then create a new “EVENTS.LOG.” 
This ongoing cycle ensures that recent events are always 
logged. 

The system event logs are useful in identifying specific events 
occurring on the UltraNEXUS-HD, such as when a particular 
program aired, user logins, file transfers, all schedule event 
actions, and more.  Refer to page 267 for more detailed 
information on system event logs. 

Firmware Update The UltraNEXUS-HD server creates log files that specifically 
track firmware installations.  LEIGHTRONIX uses firmware 
update logs to troubleshoot unsuccessful firmware updates.  A 
separate firmware update log is created each time you update 
your UltraNEXUS-HD server and is named after the 
corresponding firmware update file.   

   
Manage your UltraNEXUS-HD server log files according to the following: 

Save/Open a Log File 

From the top panel on the “Log Files” screen, single click on the desired log file to select 
it and then click the “Save” button to display an open/save file dialog box.  Either open 
or save the selected log file on your computer or network as a .txt file. 

Search a Log File 

Search for specific entries within either of the event or firmware logs.  From the top 
panel on the “Log Files” screen, single click the desired log file to display the “Find” box 
and corresponding log information.  Enter your search term into the “Find” box and click 
the “Search” button to filter out any entries not containing the search term.  Use the 
“Previous” and “Next” buttons to move up and down between entries in the log file. 
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Delete a Log File 

From the top panel on the “Log Files” screen, single click the desired log file to select it 
and then click the “Delete Log” button.  A popup box will appear, asking whether or not 
you wish to delete the file.  Click “Yes” to delete or “No” to abort. 
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Managing Slides 

Click the “Slides” menu button to display the "JPEG Slide Management" Screen (see 
Illustration 192, "JPEG Slide Management" Screen, "JPEG Slide Management" Screen). 
The WebNEXUS slide management screen allows all users to upload, create, edit, and 
delete slides in their own user account folders on your UltraNEXUS-HD 
server/controller.  Additionally, all users may specify if and when their slides will appear 
in slide shows through each slide’s metadata settings.  The following subsections 
provide instructions for using the slide management features. 

IMPORTANT!  SLIDES MUST BE AUTHORIZED AND ENABLED BEFORE 
THEY WILL DISPLAY IN SLIDE SHOWS.  Refer to “Approving 
Slides for Display in Slide Shows,” on page 309 for 
instructions on how to enable and authorize slides. 

  Slides and slide shows can only be activated for display through 
the WinLGX scheduler or control panel. 

Illustration 192, "JPEG Slide Management" Screen 
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Uploading Slides to a UltraNEXUS-HD Server/Controller 

NOTE: Slides within each user folder play back in alphabetical order when 
scheduled in slide shows, so assign filenames accordingly. 

1. In the “File” list on the left hand side of the screen, single click on the user folder you 
want to contain the slide.   

Click the  button to open the upload file window shown in Illustration 193.   

Illustration 193, New Slide Upload Window 

 

Click the  browse button to open the “Select file(s)” window shown in Illustration 194.  
Navigate to the desired file and click “Open.” 

NOTE: UltraNEXUS-HD series server/controllers only support slide names 
containing up to 27 characters (no spaces and no symbols) in addition to 
the “.jpg” extension. 
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Illustration 194, “Choose File to Upload” Window 

 

WebNEXUS allows you to add and remove slides from the “Upload File” window as 
follows: 

 Add slides: to upload a batch of slides, click the plus  button and repeat step 3 
for each additional slide.   

 Remove one slide: click the red “x”  button next to the slide you wish to remove. 

 Remove all slides: click the blue trash  button to clear the upload file listing. 

Click the  upload button to load the slide(s) onto the UltraNEXUS-HD or “Cancel” to 
abort the change (see Illustration 195).  When each slide has finished loading, the 
“Upload File(s)” window will indicate the slide is “100%.” 
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Illustration 195, "Upload File" Window 

 

When you have finished uploading files, click the close “x” button in the upper right 
corner of the window. 



UltraNEXUS-HD 
Support 

 

Page 292 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.3.17 Revised 11/22/2016 
 

Creating New Slides 

The following section describes the UltraNEXUS-HD server slide editor.  The 
UltraNEXUS-HD comes with an Advanced Slide Editor, which provides enhanced 
drawing and image effects tools as well as the ability to capture images from your 
webcam. 

Click the  button on the “JPEG Slide Management” screen to open your 
UltraNEXUS-HD server’s slide editor window (see Illustration 196, Advanced Slide 
Editor Window and Illustration 197, Advanced Slide Editor Toolbox) or, if you have 
already been working in your slide editor, select the “File”/”New” menu option.  To abort 

your changes and close the slide editor, click the  button in the upper right corner of 
the editor or select the “File”/”Close” menu option and then click the “Close Without 
Saving” button. 

Illustration 196, Advanced Slide Editor Window 

 

Using the “Grid” menu options, set up your canvas grid and safe title/safe action 
guidelines to aid in slide layout: 

 “Grid Settings”: use to adjust the color and spacing of the canvas grid 

 “Show Grid”: toggles the canvas grid on/off 

 “Snap to Grid”: when checked, elements re-positioned on the canvas will align 
with the nearest grid lines 
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 “Grid at Top”/”Grid at Bottom”: toggle between these options to move the grid 
from the top of your layer stack to underneath all of your layers 

 “Safe Title”: use to toggle the red safe title border on/off.  Text that extends 
beyond the safe title area may be cut off when the slide is displayed on-air. 

 “Safe Action”: use to toggle the red safe action border on/off.  The portion of any 
graphic that extends beyond the safe action area may be cut off when the slide is 
displayed on-air. 

Add graphics and/or text to the slide editor’s canvas using the tools in the editor’s 
toolbox (see Illustration 197).  Each new graphic or text element will be automatically 
placed on a separate layer, allowing you to individually manipulate each image and text 
message on the canvas (see the “Layer Management” section below).  Refer to the 
following “Layer Types” section for more information on the graphics and text that may 
be added to the editor’s canvas and the custom display settings available for each layer 
type. 

  

Illustration 197, Advanced Slide Editor Toolbox 

 

Layer Management 

When adding your layers, keep in mind the following slide editor layer management 
features: 

 Zoom: if no layer is selected, the “Canvas Info” panel displays the width and 
height of the canvas in pixels, while also providing a zoom slider for viewing the 
canvas in more or less detail.  



UltraNEXUS-HD 
Support 

 

Page 294 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.3.17 Revised 11/22/2016 
 

 Delete: to remove a layer from your slide, select the layer on the canvas with the 

 cursor tool or by clicking on the layer in the “Layers” panel.  Click the  
icon on the bottom of the “Layers” panel or press your keyboard “Delete” key. 

 Graphic Toolbar: each slide editor also provides a universal graphic toolbar that 
provides display settings for any layer type except text (see Illustration 198).  

The graphic toolbar appears at the top of the editor whenever the cursor 
tool is clicked or an image layer is added to the canvas.  To apply any of 

the settings described in Illustration 198, first select the layer on the canvas with 
the cursor tool or by clicking on its layer in the “Layers” panel.  

Illustration 198, Graphic Toolbar 

 
Layer Types 

The following is a list of the graphic/text elements you can add to your slide 
canvas: 

 Images: add one or more .JPEG, .PNG, or .GIF image files to the canvas from 
any of the following sources: 

 Local storage area 

a. Click “Image”/”Import” to open the “Select file to upload” window. 
b. Navigate to an image file and click “Open.”   

 Third-party webcam 

a. Click “Image”/”Webcam” or click the  webcam tool to open the editor’s 
“Webcam” window.   

b. If this is the first time you have opened the “Webcam” window since 
connecting a webcam to your computer, you will see a settings box.  From 
the “Privacy” panel, allow your UltraNEXUS-HD system to access your 
webcam by clicking the “Allow” option (see Illustration 199).  Save this 
setting by clicking “Remember” and then click “Close” to exit the settings 
box. 

NOTE: If the “Privacy” panel is not currently displayed, click the  
icon. 
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Illustration 199, Webcam "Privacy" Setting 

 

c. Click the “Ok” button to create a still image from the current webcam 
display or “Cancel” to return to the canvas without creating an image.  Any 
image created will be in the resolution of your webcam (typically 640 x 480 
pixels). 

  Clip Art Tool: click the clip art tool to display a window containing the 
graphic backgrounds and images included with your slide editor along with 
any custom JPEG/PNG background files that may have been uploaded 
through the WinLGX “Storage Manager” window.  To add an image graphic to 
the slide canvas, just click on the image. 

 Gradient Layer 

An easy way to create a background for your slide is with the  gradient tool.  
Click the gradient tool and select your gradient color, pattern, and opacity from 
the gradient toolbar at the top of the editor (see Illustration 200) according to the 
following: 

Illustration 200, Gradient Toolbar 

 

 Select gradient pattern 

o “Linear”: select “Linear” to create a gradient that transitions in the 
direction of the line you create when dragging the gradient tool across the 
canvas.  The first and last points of the line mark the start and end of the 
gradient, which transitions from left to right through the color cup values 
on the “Spread” bar.  The shorter the line, the more abrupt the gradient 
color transitions will be.  Choose one of the three linear gradient patterns: 
− “Pad”: extends the last color cup value in your gradient from where 

your gradient line stops to fill the remainder of your canvas 
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− “Reflect”: a mirror image of your gradient will be reflected on both ends 
of your drawn line and, depending on the length of your gradient line, 
will continue reflecting throughout the canvas 

− “Repeat”: your gradient will repeat the length and direction of your 
drawn line across the canvas, with short lines resulting in greater 
repetition 

o “Radial”: the gradient line you create forms the radius of a circle, with the 
first point of the line establishing the center of the circle.  The radial 
gradient starts with the leftmost “Spread” color cup value at the center of 
the circle and concludes with the last color cup value forming the 
outermost diameter of the circle and filling the remainder of the canvas.  

 Change gradient color values 

Create a gradient that transitions between two or more colors of your 
choosing with the “Spread” color value bar.  By default, the left end of the bar 
will automatically show a lighter color cup transitioning to a darker color cup 
on the opposite end.  To change, perform any of the following: 

− Change a color: double click the color cup to display the “Color Picker” 
window.  Use the slider to adjust the color palette and then click on a color 
within the palette.  Click “Ok” to make your selection.   

− Add color cups: increase the number of color transitions within your 
gradient by clicking on the “Spread” bar to add a color cup.  Drag the cup 
to the desired position on the bar.   

− Delete a color cup, single click the color cup icon and then click the “X” 
button. 

 Change gradient opacity 

Change the opacity of each color value in your gradient by single clicking on a 
color cup icon and then typing a number value from 0 to 100 into the “Alpha” 
box. A value of “0” renders the color invisible, while “100” returns the color to 
full opacity. 

With the gradient tool positioned over the canvas, click your left mouse button 
and drag the tool across the slide canvas to create your gradient layer.  The 
gradient created will be based on the length and direction of the line you dragged 
on the canvas.  If you don’t like the effect, you can always delete the layer and 
experiment with dragging your gradient tool in different directions and lengths. 
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 Shapes 

Click the desired basic shape tool or the polygon or arrow shape tool (see 
Illustration 197, Advanced Slide Editor Toolbox).  With your mouse pointer 
positioned over the editor’s canvas, hold down the left button on your mouse and 
drag the pointer to create your shape.  When you let go of your mouse button, 
the editor will finalize your shape and add the shape element to a canvas layer. 

Use the shape/line toolbar at the top of the editor (see Illustration 201) to select 
the shape’s fill and outline color, outline width, and orientation according to the 
following: 

Illustration 201, Shape Toolbar 

 
Shape Gradients: clicking on the gradient fill swatch will open the window 
shown in Illustration 202.  When you have finished selecting your gradient 
settings based on the following information, click “Ok” to make your changes. 

Illustration 202, "Gradient Fill" Window 

 
 Select gradient pattern  

o “Linear”: select “Linear” to automatically apply a gradient that transitions 
in a straight line across your selected shape.  “Linear” gradients may be 
rotated clockwise from 0 to 360 degrees within your shape by either using 
the “Rotate” slider or entering a degree number value in the “Rotate” field 
and pressing your “Enter” key. 

o “Radial”: select “Radial” to automatically apply a circular gradient to the 
center of your shape.  Radial gradients begin with the leftmost “Spread” 
color cup value at the center of the circle and conclude with the last color 
cup value forming the outermost diameter of the circle and filling the 
remainder of the shape. 

Color Cup 

No-Fill Swatch 

Color Swatch 
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 Change gradient color values 

Create a gradient that transitions between two or more colors of your 
choosing with the “Spread” color value bar.  By default, the left end of the bar 
will automatically show a lighter color cup transitioning to a darker color cup 
on the opposite end.  To change, perform any of the following: 

o Change a color: double click the color cup or first single click the color cup 
and then the color swatch to display the “Color Picker” window.  Use the 
slider to adjust the color palette and then click on a color within the palette.  
Click “Ok” to make your selection.   

o Add color cups: increase the number of color transitions within your 
gradient by clicking on the “Spread” bar to add a color cup.  Drag the cup 
to the desired position on the bar.   

o Delete a color cup, single click the color cup icon and then click the “X” 
button. 

 Change gradient opacity 

Change the opacity of each color value in your gradient by single clicking on a 
color cup icon and then typing a number value from 0 to 100 into the “Alpha” 
box. A value of “0” renders the color invisible, while “100” returns the color to 
full opacity. 

 Remove fill color from shape: click the  no-fill swatch to completely 
remove any color applied to your shape and close the “Gradient Fill” window. 

 Lines 

Your slide editor provides the following tools for drawing lines.  When you select 
a line tool, use the shape/line toolbar that appears at the top of the editor (see 
Illustration 201) to select the line’s color and thickness. 

 Straight line: click the  line tool and use your mouse to position the tool 
on the canvas.  Hold down your left mouse button and drag the tool to create 
a straight line at any angle.  Let go of the mouse button to finalize your line 
and add the line element to a canvas layer. 

 Freeform line: click the  pencil line tool and use your mouse to position 
the tool on the canvas.  While holding down your left mouse button, drag the 
tool to draw a custom line.  Let go of the mouse button to finalize your line 
and add the line element to a canvas layer.  

 Curved line: click the  curved line tool and use your mouse to position 
the tool on the canvas.  Hold down your left mouse button and drag the tool to 
create a straight line at any angle.  When the line is the length you want, let 
go of the mouse button.  Then left click on the line and while holding down the 
mouse button, drag your mouse to curve the line in the direction you are 
dragging.  Let go of the mouse button to finalize your curved line and add the 
line element to a canvas layer. 
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 Text 

Click the  text tool.  Use the text toolbar that appears at the top of the editor 
(see Illustration 203) to select the orientation, font, font size, and color. 

Illustration 203, Text Toolbar 

 

Click your mouse pointer on the area of the canvas that you would like to add 
text.  Type in your message and then press your keyboard “Enter” key to add the 
text element to a canvas layer. 

If desired, enhance individual graphic and/or text layers with graphic effects.  To apply 
an effect, first select a layer on the canvas with the cursor tool or by clicking on its layer 
in the “Layers” panel.  Change any of the following: 

 Layer Position: when a layer is selected, the “Canvas Info” panel displays the 
position of the layer along the canvas’s x and y axes.  The x/y position values for 
the selected layer may be changed by typing a new value into either or both 
fields and pressing the “Enter” key. 

 Layer Size 

When a layer is selected, the “Canvas Info” panel displays the height and width 
of the selected layer element.  The height/width values for the selected layer 
element may be changed by simply typing a new value into the desired field(s) 
and pressing the “Enter” key.  If the height/width values are locked, entering a 
new value in only one of the fields will keep both values true to the proportion of 
the original dimensions.  To distort the layer element by only changing the height 
or width, click the padlock to unlock before entering in the new dimension. 

 Color of Shape/Line/Text 

 Choose a color from any graphic/text element on the canvas: select the 

 eyedropper tool and then click on a color within any canvas element. 

 Select a color from the “Swatches” color palette: click on the “Swatches” 
tab to display the color palette (see Illustration 204).  Click on one of the color 
swatches to select a new color. 
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Illustration 204, "Swatches" Tab Panel 

 

 Image Saturation: 

Desaturate: click the  black/white tool to remove the color from a selected 
image layer. 

 Text Filter Effects: clicking a text filter effect icon will cause selected text to take 
on the look depicted by the filter icon (see Table 45, Text Filter Effects). 

Table 45, Text Filter Effects 

Filter Icon Effect Name Result 

 

Black Plastic 
 

 

 

Candy 

 

 

Casino 

 

 

Chrome 

 

 

Gold 

 

 

Horizon 

 

 

Horizon2 

 

 

Mercury 
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Filter Icon Effect Name Result 

 

Metal 

 

 

Neon 

 

 

Plastic 

 

 

Water 

 

 Layer Blend Modes: on the “Layers” panel, click the down arrow next to 
“Normal” to display a drop down menu of layer blend effects.  The blend modes 
create a composite image from the selected layer and, depending on their 
canvas size and opacity, the first one or more layers below it in the layer stack.  
Refer to Table 46, Layer Blend Modes, for a description of each blend mode. 

Table 46, Layer Blend Modes 

Filter Effect Result  

“Normal”: Returns the selected image layer to 
its original settings 

 
“Add”: Blends layers together by adding the 

colors in the selected layer to the 
colors in the underlying layer(s) 

 
“Alpha”: N/A  
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Filter Effect Result  

“Darken”: Blends the selected layer with the 
layer(s) below it, putting the darker of 
the colors from each layer on the 
surface 

 
“Difference”: Blends the selected layer with the 

layer below it, subtracting the RGB 
values of the darker colors from the 
RGB values of the lighter colors to 
the obtain color values for the 
blended image 

 
“Erase”: N/A  

“Hardlight”: Darkens the darkest areas on the 
selected layer while blending the 
lightest areas with the layer(s) below 
it 

 
“Invert”: Displays the layer(s) just beneath the 

selected layer and changes the 
colors of the underlying layer(s) to 
their opposite RGB color values 

 
“Layer”: N/A  
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Filter Effect Result  

“Lighten”: Blends the selected layer with the 
layer(s) below it, putting the lighter of 
the colors from each layer on the 
surface 

 
“Multiply”: Blends the selected layer with the 

layers below it by multiplying the 
layers’ RGB color values together for 
a darkening effect 

 
“Overlay”: Blends the selected layer with the 

layer(s) below it by lightening the 
lighter pixels and darkening the 
darker pixels in each layer 

 
“Screen”: Blends the selected layer with the 

layer(s) below it by multiplying the 
opposite RGB color values of the 
selected layer by the complementary 
RGB color values of the underlying 
layer 
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Filter Effect Result  

“Subtract”: Subtracts the RGB color values in 
the selected layer from RGB color 
values in the underlying layer(s) 

 

 Layer Filters: 

 Blur 

Click the  blur tool or select “Filters”/”Blur” to display the “Blur” window.  
Adjust the sliding scale between “0” to “50” to decrease/increase the amount 
of blur applied to the selected element.  Click “Ok” to make the change or 
“Cancel” to abort. 

 Sharpen 

The sharpen filter creates more defined edges in fuzzy and dim image layers 
by increasing the contrast between light and dark pixels.  Apply the “Sharpen” 
filter to your selected image layer by selecting “Filters”/”Sharpen.”  The 
“Sharpen” filter may be repeatedly applied to achieve the desired effect. 

 Bevel 

A quick way to create a three dimensional effect, the “Bevel” filter gives each 
selected layer a shadow on its right and bottom inner edges and a highlight 
on its top and left inner edges.  To apply, select “Filters”/”Bevel” to display the 
“Bevel” window.  Use the “Blur” and “Distance” sliders to customize the bevel 
effect and then click “OK” to finalize or “Cancel” to abort. 

Illustration 205, "Bevel" Effect Window 

 

 Glow 

The “Glow” filter applies a blurred shadow of a custom size and color to the 
outer edges of the selected layer.  To apply, select “Filters”/”Glow” to display 
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the “Glow” window.  Use the color swatch and “Distance” slider to respectively 
adjust the color and size of the glow.  Click “OK” to finalize or “Cancel” to 
abort. 

 Shadow 

Use the “Shadow” filter to add dark shadow to the right and bottom outer 
edges of the selected layer.  To apply, select “Filters”/”Shadow” to display the 
“Shadow” window and use the “Blur” and “Distance” sliders to customize the 
effect.  Click “OK” to finalize or “Cancel” to abort. 

When you have finished making changes, save your slide by clicking the  save icon 
or selecting the “File”/”Save” menu option.  The “Save Slide” window shown in 
Illustration 206 will appear, allowing you to add metadata to your slide that will control 
display of the slide in slide shows.  Perform the following:   

Illustration 206, "Save Slide" Window 

 
a. In the “File Name” field, type in a filename with up to 27 characters (no spaces).  

If the filename already exists, a pop-up box will prompt you to either click “Ok” to 
overwrite the existing file or “Cancel” to enter a new filename on the “Save Slide” 
window. 

b. If you logged into WebNEXUS under an “admin” account or are using an account 
with the “slide administrator” or “automatic slide authorization” right, the 
“Authorize” box will be available for selection.  Authorize the slide for display in 
slide shows by checking the “Authorize” box (see “Approving Slides for Display in 
Slide Shows” on page 309 for more information on authorizing slides).  

c. Complete the remaining slide show metadata fields according to the instructions 
in “Adding Slide Show Settings to Slide Metadata,” on page 307, with the 
following exceptions: 

 “Program Guide”: checking the box will cause the slide to show the 
scheduled, upcoming programs for the channel its slide show is displayed on, 



UltraNEXUS-HD 
Support 

 

Page 306 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.3.17 Revised 11/22/2016 
 

while leaving the box unchecked disables the program guide setting for the 
slide during slide shows 

 “Duration”: type in or use the up/down arrows to select the number of hours, 
minutes, and/or seconds (hours:minutes:seconds) that you would like the 
slide to display within a slide show 

d. Click “Ok” to save or “Cancel” to abort.  The slide editor automatically saves a 
.jpeg and .fie file for each slide, where the .jpeg file is the actual slide and the .fie 
file contains the editable layers data for the slide.  The .fie files are only visible in 
the WinLGX Storage Manager window and are useful if you wish to transfer 
slides to a local storage device and then back to your UltraNEXUS-HD server for 
editing in your slide editor (see “Managing Storage of Video, SLIDE, and 
OVERLAY Files,” starting on page 253). 

Creating a Default Slide 

Create a default slide that will automatically display if a slide show is scheduled without 
slides or without approved slides.  

Select the “admin” user folder in the “File” list.  Your UltraNEXUS-HD system will only 
look for a default slide in the “admin” user folder. 

NOTE: If you do not see an “admin” folder, the user account you logged into does 
not have “admin” or “Slide Administrator” rights. 

Upload the slide you would like to serve as the default (see “Uploading Slides to a 
UltraNEXUS-HD Server/Controller,” on page 289). 

Rename the slide to “Default.jpg” (see “Renaming Slides on a UltraNEXUS-HD 
Server/Controller,” on page 311). 

Approve the slide for display (see “Approving Slides for Display in Slide Shows,” on 
page 309). 

Finding Slides/User Folders 

WebNEXUS provides the following tools for managing and searching your slide list for 
user folders and files: 

 “Expand All/Collapse All” links: by default, the WebNEXUS slide management page 
opens with all slide user folders fully expanded.  If you have a lot of slides, this can 
make for a really long file listing.  To quickly locate a particular folder of slides, click 
the “Collapse All” link at the bottom of the window.  This action is easily reversed by 
clicking the “Expand All” link. 

 “Filter” box: if you know the name or even the first few letters of the filename or 
folder you are looking for, display the “Filter” box by clicking the drop down arrow 
next to “Filter.”  Then type the name of a file or folder to find an exact match or just 
enter the first few letters to get a list of possible files and folders.  
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Adding Slide Show Settings to Slide Metadata 

Each UltraNEXUS-HD server/controller processes slide metadata to determine when 
your slides will appear in scheduled slide shows.  Perform the following steps to modify 
the slide show availability settings for your slides (refer to “Scheduling/Editing Library 
Resources,” on page 210, for information on scheduling a slide show).   

NOTE: Slide metadata settings do not put your slides on-air.  The settings limit when 
the slides will appear when scheduled in slide shows.  All slide shows must 
be scheduled for display through WinLGX.     

Select the desired file in the “File” list to enable the metadata fields on the right side of 
the slide management screen (see Illustration 207, Slide Metadata Fields).  The 
following settings may be modified: 

Illustration 207, Slide Metadata Fields 

 

 “Transition Effect” drop down list: select from the following to determine how 
the slide will be displayed on screen: 

1. “Cut”: displays entire slide image at once  
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2. “Random Wipes”: reveals slide image with 14 possible transitions 

 “Slide Duration” drop down list: select between 5–99 seconds to determine 
how long the slide will be displayed on screen.  

 “Guide Channel” drop down list: use this setting to display a list of up to ten 
upcoming programs on the selected slide during a slide show.  Each program is 
listed on the program guide according to its schedule event time and “Comment” 
text in the default font size, color, and style (see Illustration 91, Example of 

Onscreen Program Guide, on page 150).  The “File” list will show a  icon next 
to each slide that has the program guide option activated.  Select one of the 
following options:   

 “OFF”: disables the program guide setting for the slide 

 “AUTO”: slide will display its scheduled channel’s upcoming programs 
 Channel Output:  slide will display the selected channel’s upcoming 

programs, regardless of which channel the slide show is scheduled on 

 “Limit Date” button: if you would like the slides to appear only between 
specified dates, click to check the corresponding box and perform any of the 
following steps: 

 Enter the slide display start date into the top month/day/year fields and the 
display end date into the bottom month/day/year fields by using the 
corresponding drop down calendar.  Just click in either field to display the 
calendar and perform the following: 
a. First select the appropriate month and year as follows: 

o Click on the calendar month to show a list of months. Click to select 
the desired month. 

o Click on the calendar year to show a list of years. Click to select the 
desired year. 

b. Next, select the date on the calendar by clicking. 
 Click the “Today” button to automatically enter today’s date into the top 

and bottom month/day/year fields.   
 Click the “1 Week” button to automatically enter today’s date into the top 

month/day/year fields and the date seven days from today into the bottom 
month/day/year fields. 

 Click the “2 Weeks” button to automatically enter today’s date into the top 
month/day/year fields and the date fourteen days from today into the 
bottom month/day/year fields. 

 Click to check the “Automatic Delete” box if you would like the slide 
deleted from the UltraNEXUS-HD at the conclusion of the display period. 

 “Limit Days of Week” fields: check the desired day boxes to specify which 
days you would like the slide displayed and/or use the following buttons: 

 “All Days”: click this button to automatically select every day of the week. 
 “Mon-Fri”: click this button to automatically select Monday through Friday. 
 “Sat & Sun”: click this button to automatically select Saturday and Sunday. 
 “Clear”: click this button to clear the day fields. 
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 “Limit Time of Day” fields: click to check the “Limit Time of Day” box to enable 
the time fields and perform any of the following steps: 

  Type in the start and end times for slide display and select AM or PM for 
each from the drop down boxes.  

 Click the “Morning” button to automatically enter 12 am into the “Start” field 
and 12 pm into the “End” field 

 Click the “Afternoon” button to automatically enter 12 pm into the “Start” field 
and 5 pm into the “End” field 

 Click the “Evening” button to automatically enter 5 pm into the “Start” field and 
12 pm into the “End” field 

Click the  button to save your slide metadata.  If you don’t click the “Save 
Metadata” button, your changes will be lost when you select a different slide or folder or 
close the slide management screen. 

If desired, enable and authorize the slide for display in slide shows according to 
“Approving Slides for Display in Slide Shows” on page 309. 

Approving Slides for Display in Slide Shows 

There is a two part approval process for allowing each slide to be part of a slide show.  
Each slide must be enabled as well as authorized for slide show display as described 
below. This approval process does not apply to the display of single slides. 

 “Enable” Slides: when set, the “Enable” setting tells your UltraNEXUS-HD that the 
slide is allowed to be included in slide shows.  Each user has the ability to enable 
slides in his own user folder, while the “admin” user and users with the “Slide 
Administrator” right can change the “Enable” setting for all slides.  To enable a slide, 

just select the slide in the “File” list and click the  button.  Each enabled slide 

will have a  icon next to it in the “File” list. 

 “Authorize” Slides: the “Authorize” setting lets your UltraNEXUS-HD know whether 
or not each slide has been approved for display in slide shows by the system 
“admin” user or a user with advanced slide management rights. 

Automatic approval: all slides uploaded by user accounts granted the “automatic slide 
authorization” user right will be automatically approved for display in slide shows.  The 
“admin” account and user accounts with the “slide administrator” right automatically 
have this right.  Refer to “Setting User Account Rights,” on page 75 for more information 
on assigning users the “automatic slide authorization right.” 

 Selective approval: the “admin” account and accounts with the “slide 
administrator” right can also approve slides that have been uploaded through 
accounts without the automatic slide authorization right as follows (refer to 
Illustration 208, WebNEXUS Authorize and Enable Buttons, throughout the 
following steps): 
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Illustration 208, WebNEXUS Authorize and Enable Buttons 

 

1. Scroll to the desired user folder in the “File” list to display the selected 
user’s slides. 

2. Highlight the desired filename in the “File” list. 

3. Click the  button.  The  authorization icon appears in the “File” 
list next to each slide authorized for display in slide shows.  

Editing Slides Created in WebNEXUS 

WebNEXUS gives you the ability to edit any slides created in your UltraNEXUS-HD 
server/controller’s slide editor.  Perform the following steps: 

NOTE: Uploaded slides cannot be edited by WebNEXUS. 

1. From the “JPEG Slide Management” screen, single click on the slide you wish to edit 
in the “File” list (see Illustration 209).  When selected, the slide will be highlighted in 
orange. 

Illustration 209, WebNEXUS Slide Editing Feature 

 

If the selected slide can be modified in your slide editor, the “Edit” button will be 
enabled.  Click on the “Edit” button (see Illustration 209) to display your selected slide in 
the slide editor window for your system. 

Edit your slide with any of the formatting options described in the “Creating New Slides” 
section on page 292 

“Authorize” 
Button 

“Enable” 
Button 
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Save over your existing slide or save out your changes as a new slide with a different 
filename with up to 27 characters (no spaces) according to step 0 of the “Creating New 
Slides” section on page 305. 

Renaming Slides on a UltraNEXUS-HD Server/Controller 

Single click to select the desired file in the “File” list. 

Click  icon to open the rename window shown in Illustration 210. 

Illustration 210, “Rename File” Window 

 

Enter up to 27 characters in the rename field. 

Click the “Ok” button to make the change or “Cancel” to abort. 

Deleting Slides from a UltraNEXUS-HD Server/Controller 

Select the desired file in the “File” list. 

Click the  icon.  A dialog box will appear asking whether or not you would like to 
delete the selected slide from the UltraNEXUS-HD server/controller.  Click “Yes” to 
make the change or “No” to abort. 
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Creating Emergency and Overlay Messages 

NOTE: Only the “admin” user and users with the “slide administrator” right are 
able to access the emergency messaging screen. 

Use the emergency messaging feature to immediately alert viewers to weather 
conditions, school closings, road construction, and any other urgent events.  You have 
the option of displaying a partial or full screen graphic with or without a text message 
over scheduled and unscheduled (activated from the Control Panel) digital 
programming.   

The emergency message will be displayed by the MPEG player for the specified 
duration or until the message is manually deactivated.   

To create an emergency message, click the “Overlay” menu button to open the Overlay 
screen (see Illustration 211, Overlay Screen) and perform the following steps: 

NOTE: To display the emergency messaging steps on the “Overlay” screen, click the 
expand/collapse arrow button on the “Instructions” panel. 

Illustration 211, Overlay Screen 

 

Creating a New Emergency Message 

If you need to clear a previously entered emergency message, click the “New” button. 

Select a graphic overlay through one of the following methods: 
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 In the “File” list window, open the “Graphic Files” or “Saved Presets” folder and 
single click on a file to select it. 

 Search for a graphic overlay file in the “Filter” field.  Click the expand/collapse 
arrow next to “Filter” to reveal the corresponding field and then type any part of 
the filename you are looking for.  WebNEXUS will display all folders/files in the 
“File” window that contain the text in their names.  Single click on the desired file 
to select it. 

 Click the  button and add your own overlay through the “Upload 
Graphics” window (see Illustration 212).  

NOTE: The emergency messaging feature utilizes “.png” files.  These images 
can be created in most popular graphics programs.  PNG files can 
contain transparent areas, allowing your MPEG player programming to 
be seen behind your overlays. 

Illustration 212, New Graphic Overlay Upload Window 

 

a. Click the  browse button to open the “Select file(s)” window shown in 
Illustration 213.  Navigate to the desired file and click “Open.” 

NOTE: The UltraNEXUS-HD only supports overlay names containing up to 
27 characters (no spaces or symbols) in addition to the “.png” 
extension. 
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Illustration 213, “Select file(s)” Window 

 

b. WebNEXUS allows you to add and remove overlays from the “Upload 
Graphics” window as follows: 

 Add overlays: to upload a batch of overlays, click the plus  button and 
repeat step 3 for each additional overlay.   

 Remove one overlay: click the red “x”  button next to the overlay you 
wish to remove. 

 Remove all overlays: click the blue trash  button to clear the upload 
graphics listing. 

c. Click the  upload button to load the overlay(s) onto the UltraNEXUS-HD 
system or “Cancel” to abort the change.  When each overlay has finished 
loading, the “Upload Graphics” window will indicate the overlay file is “100%.” 

Illustration 214, "Upload Graphics" Window 
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d. When you have finished uploading files, click the close “x” button in the upper 
right corner of the window. 

In the message box on the right, type a sequence of up to 12 pages of two-line 
messages, as shown in Illustration 215.  Move to each new line of text by pressing 
“Enter” on your keyboard.  These messages will appear in the lower third position of the 
overlay screen as 22 pt, bold Ligurino text. The bottom line of text on each page is 
positioned just above the safe title guideline.   

Illustration 215, Text Entry on Emergency Messaging Screen 

 

A preview window at the top of the “Overlay” screen shows your image with safe 
action and title lines.  Above it, the buttons numbered 1–12 correspond to the 
separate two-line text message pages on the overlay.  You can view how each page 
of text will appear on your overlay image by clicking on the page number buttons. 

On the “Options” panel shown in Illustration 216, complete the following steps: 
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Illustration 216, "Options" Panel 

 

a. From the “Page Dwell Time” drop down list, select how many seconds you would 
like each page of messages to display on the overlay, starting with 8 seconds, 
skipping to 10, and then increasing in increments of 5 seconds, up to a total of 30 
seconds.  Once activated, your message pages will change from one to another 
on the selected overlay. 

b. From the “Event Duration” field, choose to display your emergency message for 
up to 7 days, 99 hours, and 59 minutes or select the “Rest of day” field to display 
the overlay until midnight.  The message pages will continue cycling until the 
duration time completes. 

If you wish to save the message for reuse, click the “Save” button. 

If desired, activate the emergency message for display according to “Activating an 
Emergency Message,” on page 316. 

Activating an Emergency Message 

If you wish to display a saved emergency message, click on the “Saved Presets” tab 
and single click the desired message in the presets listing.  Otherwise, create a new 
message according to the steps in the “Creating Emergency and Overlay Messages” 
section on page 312. 

Click the “Activate” button to display the message.  The “System Status” panel on the 
“Emergency Messaging” screen indicates the message activation status for the MPEG 
player.  

 

Deactivating an Emergency Message 

To end an emergency message before the event duration completes, click the 
“Deactivate” button. 
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Viewing Web Program Guide 

View upcoming programs on the current UltraNEXUS-HD schedule from its web 
interface, a web browser, or your own website. 

Viewing Program Guide within the Web Interface 

Click the “Program Guide” menu button to display a program guide screen like the 
example shown in Illustration 217.   

Illustration 217, Web Interface Program Guide Screen 

 

From the “Channel” drop down menu, click one of the channel outputs to only display 
the programming lineup for the selected channel or click “All Channels” to display the 
programming schedule for all WinLGX channel tabs. 
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From the “Mode” drop down menu, select “Day” if you would like to view programming 
for just one day in your schedule (see Illustration 217) or choose “Week” to view 
programming for all seven days of your schedule (see Illustration 218).  If you choose 
“Week,” the “Day Headers” buttons are enabled on the toolbar. Selecting “on” will cause 
each day’s programming to be displayed under separate day, date, and program time 
headings, as shown in Illustration 218. If the “Day Headers” option is set to “off,” each 
day’s programming will be displayed under one set of date, day, and program time 
headers. 

Illustration 218, Program Guide Screen in Week Mode with Day Headers "ON" 

 

For the “Day” mode view, click on a day of the week to view programming for the 
corresponding weekday. If you selected “Week” mode, clicking a day button will sort 
your programming schedule by the selected day. 

Day Headers 
ON 
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If you wish to display the program start time down to the second, click the “Show 
Seconds” “on” button. The default option is “off.” 

Viewing Program Guide from a Web Browser or Your Own Website 

The UltraNEXUS-HD program guide frame has been validated by the W3C to be a valid 
XHTML 1.0 transitional document.  It has been successfully tested in the following 
browsers:  

 Microsoft Internet Explorer 
 Google Chrome 
 Mozilla Firefox 
 Opera 
 Apple Safari  

Web Browser 

Users without access to the UltraNEXUS-HD web interface schedule display can use a 
web address to view the current UltraNEXUS-HD schedule online. To obtain the web 
address and display the program guide in a web browser, perform the following steps: 

Click the “Program Guide” menu button to display your UltraNEXUS-HD’s program 
guide.  

Click the URL link on the “Program Guide” screen as shown in Illustration 219 to open 
your UltraNEXUS-HD program guide in a separate browser tab window. 

Illustration 219, Program Guide URL Link 

 

If necessary, edit the following variables (shown in red) in the web address to change 
the programming display: 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea
ders=0”: change to the IP address of the UltraNEXUS-HD server/controller 
containing the schedule you wish to display 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea
ders=0”: 

 “channel=0”: displays the programming on all channels 

 “channel=1”: displays the programming on channel one 

  
“http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea

Program Guide URL 

http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
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ders=0”: to show programming for one day, leave mode as “day” or to display up 
to seven days of your schedule’s programming, enter “week” 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea
ders=0”: to show the day of the week without the date on top of your 
programming display, change “date” to “day” and then enter the first three letters 
of the day whose programming you wish to view from the current schedule 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea
ders=0”: if you are using the “week” mode, you may change the “headers” value 
to “1” to display each day’s programming under separate day, date, and program 
time headings (see Illustration 218) 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea
ders=0&secs=0”: to display each program’s start time down to the second, 
change the “secs” value to “1” 

 “http://10.255.11.142:50001/websched.php?channel=1&date=09/17/2007”: to 
show programming for a specific date, change “day” to “date” followed by the 
month, day, and year.   

Distribute the web address as a link or with instructions to paste the address into the 
address bar of one of the supported web browsers. 

Your Own Website 

NOTE: The UltraNEXUS-HD web interface program guide is linked to Port 50001, 
preventing unauthorized users from accessing the other interface features.  If 
you need to select a different port number for the program guide, refer to 
“Editing Web Schedule Port,” on page 50. 

First make the program guide publically accessible by forwarding Port 50001 through 
your firewall to your UltraNEXUS-HD server/controller. Port forwarding requires an 
external, public IP address which is configured in the router to have certain ports 
forwarded to the UltraNEXUS-HD’s internal IP Address. Forward Port 50001 of the 
external IP address to your UltraNEXUS-HD server/controller, then point your website to 
the external address. 

Once your “Program Guide” has been made publically accessible, add the web 
interface’s program guide embed code to one of your own web pages according to the 
following steps: 

1. Click the UltraNEXUS-HD web interface’s “Program Guide” button to display the 
corresponding screen. 

To display the embed code, click on the “Embed Script” arrow (see Illustration 220).   

http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
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Illustration 220, Program Guide "Embed Script" 

 

Drag your mouse cursor across the code to highlight and select it, then simultaneously 
press the “Ctrl” and “C” keys on your keyboard to copy the code.   

Paste the code onto one of your web pages by simultaneously pressing the “Ctrl” and 
“V” keys on your keyboard. 

If desired, customize the code for your website by editing the embed code variables as 
described below: 

 var channel = "1"; 

 "channel=0": displays the programming on all channels 
 "channel=1": displays the programming on channel one 

 var mode = "day"; 

 var mode= "day": displays programming for the current day 
 var mode= "week": displays seven days of programming 

 var headers = "0"; 

 var headers= "0": displays the day’s programming under one set of date, day, and program 
time headers  

 var headers= "1": displays each day’s programming under separate day, date, and program 
time headings 

 var showSecs = "0"; 

 var headers= "0": hides the second of each program’s start time  
 var headers= "1": displays the second of each program’s start time 

Upload the web page with the embed code to your web server.  The embedded 
program guide will dynamically update to display your current program schedule. 
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Using The Virtual Channel 

Overview 

NOTE: Only users with the “administrator” right are able to access the Virtual 
Channel feature. 

The Virtual Channel provides looping playlists consisting of your video clips, slides, 
switcher input devices, and LEIGHTRONIX TOTAL INFO-HD, a subscription-based 
dynamic video content service.  Virtual Channel playlists are convenient for filling time 
when a schedule is not running or between scheduled programs and also can be easily 
scheduled as program events.  

Click on the “Virtual Channel” menu button to access the WebNEXUS Virtual Channel 
editor (see Illustration 221). The four content boxes on the right side of the Virtual 
Channel editor contain the resources that may be added to your playlists, as described 
in Table 47, Virtual Channel Playlist Resources. 
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Illustration 221, Virtual Channel Editor 

 

Table 47, Virtual Channel Playlist Resources 

CONTENT BOX DESCRIPTION 

TOTAL INFO-HD Displays the available TOTAL INFO-HD 
data categories. The 

“News” selection offers worldwide headlines, while “Traffic” and 
“Weather” information is specific to the registered location.   

Video Files Displays a list of the video files on your attached digital media 
storage devices. 

Slide Show Displays a list of all user accounts on your UltraNEXUS-HD 
server.  When you add a user account to a Virtual Channel 
playlist, enabled and authorized slides within that account will 
display as a slide show. Individual slide durations, transitions, 
and time/date display restrictions can be specified in each slide’s 
metadata from the WebNEXUS “JPEG Slide Management” 
screen (see ”Adding Slide Show Settings to Slide Metadata” on 

Playlist 
Resources 
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CONTENT BOX DESCRIPTION 

page 307).  

NOTE: Adding a user account without enabled/authorized 
slides to a Virtual Channel playlist will cause the 
Virtual Channel to freeze and display black. 

External Input Displays a list of your routing switcher’s inputs.  When the 
UltraNEXUS-HD is controlling an external switcher, the number 
of available inputs in this field will correlate to the number of 
inputs on the external switcher. 

NOTE: This option is disabled for the no switch type 
(configuration without an external switcher) and the 
Zoned TOTAL INFO-HD feature. 

 
 
 
 
Set up and use your Virtual Channel according to the following steps: 

1. If you have a new TOTAL INFO-HD subscription or just wish to take advantage of 
the free trial, you will need to submit the necessary location and contact information 
before you can display TOTAL INFO-HD content in your Virtual Channel playlists.  
TOTAL INFO-HD enhances your digital video playback with automatically updated 
video content, including news, sports, and entertainment.  Refer to “TOTAL INFO-
HD Configuration,” on page 325, for setup and configuration information. 

2. Refer to the following sections for playlist management instructions: 

 “Creating/Modifying Virtual Channel Playlists,” on page 330 

 “Saving Virtual Channel Playlists,” on page 335 

 “Deleting Virtual Channel Playlist,” on page 341 

3. Activate Virtual Channel playlists for display according to “Displaying Virtual Channel 
Playlists,” on page 338. 
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TOTAL INFO-HD Configuration 

SETTING UP TOTAL INFO-HD 

Before you can display TOTAL INFO-HD content on your Virtual Channel, you must 
submit the necessary configuration information to LEIGHTRONIX.  For your 
convenience, WebNEXUS gives you the option to submit this information online.  
LEIGHTRONIX will use the information submitted through WebNEXUS to register your 
Virtual Channel and activate TOTAL INFO-HD on your UltraNEXUS-HD server. 

NOTES:  The free trial starts counting down from the date you submit the 
WebNEXUS configuration information. 

  

1. If you are not already on the Virtual Channel editor screen (see Illustration 221, 
Virtual Channel Editor), click on the “Virtual Channel” menu button. 

2. On the Virtual Channel editor screen follow the steps below to configure your TOTAL 
INFO-HD account. 

a. Click the “TOTAL INFO-HD Configuration” button (see Illustration 222).   

Illustration 222, "TOTAL INFO-HD" Configuration Message on Virtual Channel Editor 

 

A dialog box will appear, explaining the TOTAL INFO-HD activation process (see 
Illustration 223).  Click “Next” to continue. 
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Illustration 223, “TOTAL INFO Subscription Configuration” Box 
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b. In the subscription configuration box (see Illustration 224), enter the following 
information: 

Illustration 224, TOTAL INFO Subscription Configuration Information 

 

 “Name,” “Company,” “Email,” and “Telephone”: LEIGHTRONIX uses this 
information to contact users about TOTAL INFO-HD.       

 “Contact Preference”: method LEIGHTRONIX will use to contact user about 
TOTAL INFO-HD. 

 Location Configuration: information entered into the “Location Type,” 
“ZIP/Location Code,” “Metro Area,” and “Time Zone” fields will be used by the 
NEXUS series system to download and display traffic and weather 
information for your area.   

 “Location Type” and “ZIP/Location Code” fields: select your location type 
and then enter the corresponding information into the “ZIP/Location Code” 
field.  Entering a U.S. zip code will cause TOTAL INFO-HD to display 
weather information for the corresponding area, while the 4-character 
International Civil Aviation Organization (ICAO) and 5-digit World 
Meteorological Organization (WMO) codes cause TOTAL INFO-HD to pull 
meteorological information from the weather observing station associated 
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with the code.  The ICAO or WMO codes provide weather information for 
locations both in and outside the U.S. 

 “Metro Area”: traffic data is displayed for the selected area.  

 “Time Zone”: information containing sporting event times, such as game 
start times, will be adjusted to local times. 

 “MPEG Volume”: select the UltraNEXUS-HD storage device that you would 
like to hold your TOTAL INFO-HD files.  

c. Click “Next” once you are satisfied with your settings or “Cancel” to abort.  
Clicking “Next” will cause WebNEXUS to ask whether or not you would like to 
transmit your TOTAL INFO-HD activation information to LEIGHTRONIX.  Please 
read the TOTAL INFO-HD user agreement.  Click “Accept” to transmit your 
TOTAL INFO-HD subscription information to LEIGHTRONIX or “Decline” to 
abort. 

d. If you clicked “Accept,” a subscription information box will appear.  At this time, 
you have the option to select one or more data categories listed on the box and 
then click the “Add” button to immediately add the selected TOTAL INFO-HD 
content to your Virtual Channel playlist before your subscription is officially 
activated (see Illustration 225).  Alternatively, just click the “Finish” button and 
wait for your subscription to be activated before adding TOTAL INFO-HD content 
to your Virtual Channel playlists. 

Illustration 225, Adding TOTAL INFO-HD Content to Current Playlist 
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e. Click “Done” to close the last window in the TOTAL INFO-HD subscription 
configuration process. 
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Creating/Modifying Virtual Channel Playlists 

A Virtual Channel playlist is a collection of playback resources from the four content 
boxes on the right hand side of the Virtual Channel editor.  There are three types of 
Virtual Channel playlists—Day playlists, the Default playlist, and Virtual Channel or VC 
playlist files (.vc). There is also the “Current” playlist. The Current playlist is the list that 
is currently playing.  The Day presets allow you to create and save a separate playlist 
for automatic display in the empty time slots between scheduled programming on each 
day of the week, while the “Default” preset acts as a backup playlist for any empty day 
presets.  Individual playlists can also be saved as Virtual Channel playlist files (.vc) for 
scheduling as program events or immediate display through the WinLGX control panel.  
The “Current” playlist contains the playlist resources that were last submitted to your 
UltraNEXUS-HD server either by clicking the “Current” button or automatically through a 
day/default preset or a scheduled Virtual Channel playlist file (.vc).  Any playlist may be 
displayed in place of a schedule. 

Create or edit playlists with up to 500 resources per list according to the following steps: 

1. If you are modifying an existing playlist, load it according to the corresponding set 
of steps below.  Otherwise, skip to step 2 on page 331. 

Load Resources from a Virtual Channel Playlist File (.vc) or a Day/Default 
Preset: from the “Preset” drop down box at the top of the Virtual Channel editor, 
select a playlist file or day/default preset to load the corresponding playback 
resources into the playlist window (see Illustration 226).   

Illustration 226, Loading a Playlist Preset into the Virtual Channel Playlist Window 

 

Preset Drop Down Box 

Virtual Channel 

Playlist Window 
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2. Add, remove, and re-order resources in the Virtual Channel playlist window 
according to Error! Reference source not found. and Table 48.  Virtual 
Channel playlist resources will play in the order listed.  Display durations for each 
resource type are as follows: 

NOTES:  Resources highlighted green in the “Video Files”, “Slide Show”, and 
“External Input” content boxes are in the current Virtual Channel 
playlist.   

  Red highlights on Virtual Channel playlist items indicate resources 
that are no longer available on the UltraNEXUS-HD server’s storage 
areas and will be skipped during playlist playback.   

 TOTAL INFO-HD: data displays at a rate of 180 words/minute, with a total 
minimum duration of three minutes 

 Video File: each video clip displays for its file duration 

 Slide Show: slide show display durations are a total of each slide’s display length 
as specified in its metadata (default is 10 seconds per slide) 

 External Input: when an external switcher input resource is added to the playlist 
window, each resource is automatically assigned a default duration.  To modify, 
refer to step 3 in this section on page 334. 
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Illustration 227, Virtual Channel Playlist 

 

Preset Drop Down Box 

Virtual Channel 

Playlist Window 

4 Content Boxes of 

Playback Resources 
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Table 48, Creating Playlists in the Virtual Channel Playlist Window 

Action Steps 

Select a single 
resource 

Single click the resource.  A successfully selected resource 
will be highlighted in orange. 

Select multiple 
resources 

Perform one of the following: 

 Select a group of consecutive resources: single click 
the first resource in the group you wish to select and 
then hold down your keyboard’s “Shift” key and single 
click the last resource.  All resources between the first 
and last clicked resources will also be selected. 

 Select a non-consecutive group of resources: hold 
down your keyboard’s “Ctrl” key and then single click 
on each of the desired resources.   

Successfully selected resources will be highlighted in 
orange. 

Add a single resource 
to a Virtual Channel 
playlist 

Individual playback resources may be added to the Virtual 
Channel playlist window in one of the following ways: 

 Select a single playback resource and then click the  
add button. 

 Double click the resource.   

Add multiple 
resources from one 
content box to a Virtual 
Channel playlist 

Select multiple resources in the same content box and then 

add to a Virtual Channel playlist window by clicking the  
add button. 

Remove resources 
from a playlist 

Select one or more playback resources in the playlist 

window and then click the  remove button.  Alternatively, 
double clicking a resource in the playlist will also remove 
the resource. 

Remove all resources 
from a playlist 

Click the  clear list button to remove all resources from 
the playlist window.  When prompted, click “Yes” to delete 
the resources from the playlist or “No” to cancel. 

Change the order of a 
playlist 

 One row at a time: select one or more playback 

resources in the playlist window and click the  move 

up or  move down buttons to move the resource(s) 
up or down in the list by one row. 

 First and last playlist positions: select one or more 
playback resources in the playlist window and click the 

 move to top or  move to bottom buttons to move 
the resource(s) all the way to the first or last rows in 
the playlist. 
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Action Steps 

Depending on the operation performed, the remaining 
playlist resources will be pushed above or below the 
moved resources. 

Copy and paste 
resources within and 
between playlists 

Select one or more playback resources in the playlist 

window and click the  copy button.  Click the  paste 
button to add the resources to the bottom of the currently 
loaded playlist preset. 

NOTE: Copy and paste are not available in the Chrome 
and Firefox browsers. 

3. If any switcher input resources were added to the playlist, access each resource’s 
display duration setting by double clicking its length on the playlist window.  The 
resource’s length field will become active, allowing you to type a new length into the 
hours, minutes, and seconds fields.  When you are finished, click off the playlist window 
to complete the change. 

4. If any slide shows were added to your playlist, you may add or remove audio by 
clicking the “Advanced” button and then the “General” tab (see Illustration 228).  Any 
audio preferences you specify will apply to all slide shows.  From the “Background 
Audio Source” drop down list, add or remove audio as follows: 

Illustration 228, Slide Show Audio Settings 

 

 No audio: select an input on your NEXUS series system that does not have an 
audio source connected to it. 

 Audio:   
 “From Video”: pick a file from the “Video File Name” drop down list.  This 

listing displays the video files on your attached digital media storage devices. 
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The selected file’s audio will be played behind the slide show.  Any video in 
the file will not be displayed. 

 Select an “Analog,” “AES,” “Embedded 1-2,” “Embedded 3-4,” “Embedded 5-
6,” or “Embedded 7-8” audio source connected directly to the corresponding 
audio input on the rear panel. 

 

5. Once you have finished creating or modifying your playlist, either continue to “Saving 
Virtual Channel Playlists” on page 335 to learn about the Virtual Channel Editor’s 
options for saving a playlist or click the “Current” button to add the resources into the 
“Current” playlist and submit the resources to your UltraNEXUS-HD server.  The 
“Current” playlist overrides any previously submitted playlist resources and will 
immediately display if a scheduled program or control panel event is not currently being 
displayed and if the Virtual Channel has already been previously activated through a 
WinLGX schedule or control panel command (see “Displaying Virtual Channel Playlists,” 
on page 338, for more details). 

NOTE: If the Virtual Channel is inactive when the “Current” playlist is submitted, 
the playlist will not be displayed.  The “Current” playlist is overwritten with 
the resources currently in the Virtual Channel playlist window each time 
the “Current” button is clicked or when a day/default playlist preset or 
Virtual Channel playlist file (.vc) is submitted. 

Saving Virtual Channel Playlists 

A separate Virtual Channel playlist can be saved for one or more weekdays (seven 
days total plus a default playlist to cover empty days) as well as in files not tied to 
specific days. 

1. Create the playlist according to “Creating/Modifying Virtual Channel Playlists,” on 
page 330. 

2. Save the playlist according to one of the following save options: 
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 Save as a Virtual Channel Playlist File (.vc): save one playlist in a file for 
display in place of scheduling programming or as a scheduled program as 
follows: 

 If you edited an existing .vc file, click the  Save List button.  

 For new .vc files or to overwrite an existing .vc file, click the  Save List As 
button on top of the Virtual Channel playlist window to display the "Save 
Preset" Window shown in Illustration 229 and perform the following steps: 

Illustration 229, "Save Preset" Window 

 

a. Perform one of the following save options: 
o Create a new file: type up to 27 alphanumeric characters without 

spaces into the “File Name” field.   

o  Save over an existing file: single click to select an existing file to 
replace.   

b. Click the “Save” button to save your Virtual Channel playlist file or 
“Cancel” to abort. 
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 Save as a Day or Default Preset: save one playlist in a preset for display in 
place of scheduled programming or to fill time between scheduled programs on a 
specific day as follows: 

 If you edited an existing preset, click the  Save List button.  

 To overwrite a preset, click the  Save List As button on top of the Virtual 
Channel playlist window to display the "Save Preset" Window shown in 
Illustration 229 and perform the following steps: 

a. In the preset file listing, single click on either a day preset to save the 
playlist for display on the specified day or the “Default” preset to save the 
playlist for display when the UltraNEXUS-HD encounters an empty day 
preset. 

b. Click the “Save” button to save your playlist in a Virtual Channel preset or 
“Cancel” to abort. 

c. If desired, save one or more of your day/default presets in a Virtual 
Channel configuration file (.vcf) as described in the following subsection. 

3. If desired, immediately activate your Virtual Channel and display your playlist 
according to “Displaying Virtual Channel Playlists,” on page 338. 
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Displaying Virtual Channel Playlists 

Virtual Channel playlists may be displayed in place of a schedule, as programs within a 
schedule, or in the unfilled time between scheduled programs.  The Video player and 
output that display your Virtual Channel playlists are determined by your switch type as 
follows: 

 “No Switch” Type:  
Virtual Channel playlists as well as playlist files added to the first channel output 
tab will be displayed by the Video Player on the output assigned to WinLGX 
Channel/Output Tab 1, (see Illustration 230, Virtual Channel WinLGX Tab 
Assignments). 

Illustration 230, Virtual Channel WinLGX Tab Assignments 

 

 External Switcher:  
In your WinLGX UltraNEXUS-HD image file, assign the external switcher output 
that you wish to display Virtual Channel content to the UltraNEXUS-HD Video 
player input and first WinLGX channel/output tab.  For more information, see 
“Editing Internal Digital Video Playback and Recording Device Resources,” on 
page 111 and “Configuring the Switch Type of an UltraNEXUS-HD,” on page 99. 

If an UltraNEXUS-HD image file with switcher settings has not been sent to your 
UltraNEXUS-HD and a Virtual Channel playlist is then activated, the Virtual 
Channel will use the Video player and channel output defined in its web interface 
default switcher settings. To set up default switcher settings for your Virtual 
Channel, perform the following steps:     

The first channel output tab 

in WinLGX is tied to Virtual 

Channel 1. 
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1. Click the “Advanced” button on the Virtual Channel editor to display the 
“Advanced Virtual Channel Options” window.   

2. Click the “General” tab to display the window shown in Illustration 231.  Select 
a Video input and channel output from the drop down menus for the Virtual 
Channel.   

 “Video Input”: choose the input on your external switcher that is 
connected to the UltraNEXUS-HD Videoplayer for the Virtual Channel. 

 “Channel Output”: choose the output you wish to air the Virtual 
Channel’s active playlists. 

Illustration 231, Default External Switcher Settings 

 

3. Click “Save” to make your selections or “Cancel” to abort.  Both buttons also 
close the window. 

The following sections describe each method for displaying your Virtual Channel 
playlists: 
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 “Displaying a Playlist between Scheduled Program Events” on page 340  

 “Displaying a Playlist as a Scheduled Program Event” on page 340 

 “Displaying a Playlist in Place of a Schedule” on page 338 

DISPLAYING A PLAYLIST BETWEEN SCHEDULED PROGRAM EVENTS 

Saved day/”Default” Virtual Channel playlists will automatically fill the channel 
switchbacks on the WinLGX schedule editor’s first channel output tab.  Virtual Channel 
playlists are tied to the UltraNEXUS-HD MPEG Player and the first WinLGX channel 
output tab (see Illustration 230, Virtual Channel WinLGX Tab Assignments). 

To display a Virtual Channel playlist between scheduled programs, perform the 
following steps: 

1. In your WinLGX schedule file (.nmg), be sure to do the following: 

a. Enable your Virtual Channel for use as WinLGX switchback resources by 
selecting “Yes” from the “Virtual Channel” drop down menu in the “System 
Configuration” properties (see “Configuring the Switch Type of an UltraNEXUS-
HD,” on page 99).  

b. Perform any of the following to fill channel switchbacks on the first WinLGX 
channel output tab: 

 During configuration of WinLGX: when selecting your switchback input for 
the first WinLGX schedule tab (see “Configuring the Switch Type of an 
UltraNEXUS-HD” on page 99 for further instructions), choose “Virtual 
Channel” as the video source in the “Switchback Input” field.   

 During scheduling: when scheduling a resource on the first channel output 
tab, the switchback input may be changed to “Virtual Channel” in the 
resource’s event properties window. 

Your UltraNEXUS-HD server will automatically display the current day playlist 
preset, or the “Default” playlist preset if the day playlist is empty, during a 
channel switchback at the beginning of the schedule or following the end of a 
scheduled event.   

DISPLAYING A PLAYLIST AS A SCHEDULED PROGRAM EVENT 

Add a Virtual Channel playlist file (.vc) to your programming lineup with the “VC List” 
library resource.  Refer to page 156 for information on creating a Virtual Channel playlist 
file library resource and page 225 for instructions on scheduling the library resource. 

DISPLAYING A PLAYLIST IN PLACE OF A SCHEDULE 

Any type of Virtual Channel playlist may be displayed 24/7 in place of a schedule as 
described in the following steps.       

NOTE: An active Virtual Channel playlist will continue to loop on air until another 
playlist is activated, the MPEG player is stopped from the WinLGX control 
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panel, or a scheduled digital program event is sent to the UltraNEXUS-HD 
server. 

 “Current” Virtual Channel Playlist 

1. Add/remove resources to the Virtual Channel playlist window (see 
“Creating/Modifying Virtual Channel Playlists,” on page 330). 

2. Click the “Current” button to submit the resources as your “Current” playlist.  

3. If the “Current” playlist does not display, go to the WinLGX Control Panel, select 
the MPEG player, and click the “Force Start Virtual Channel” button. 

 Virtual Channel Day/Default Playlist Presets 

1. Select the current day’s playlist or “Default” from the “Preset” drop down menu. 

2. Click the “Current” button on the Virtual Channel toolbar. 

3. If the current day or default preset does not display, go to the WinLGX Control 
Panel, select the MPEG player, and click the “Force Start Virtual Channel” 
button. 

 Saved Virtual Channel Playlist File 

1. Go to the WinLGX Control Panel and select the MPEG player.   

2. Click the ellipsis button to open the “Select Virtual Channel List” window.   

3. Select a Virtual Channel playlist as follows: 

 Double-click the desired file to accept selection and close “Select Virtual 
Channel List” window.  

 Select the desired file and click “OK” to accept or “Cancel” to abort selection. 

Once a playlist file selection is made, the playlist will immediately display. 

Deleting Virtual Channel Playlist Files 

To remove a saved Virtual Channel playlist file (.vc) from your UltraNEXUS-HD server, 
perform the following steps: 

1. From the “Preset” drop down menu, select the playlist file you wish to delete. 

1. Click the  icon on the Virtual Channel toolbar. 

2. On the “Delete Preset” popup window, click “Yes” to delete the file or “No” to cancel 
the action and close the popup. 
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Editing ULTRANEXUS-HD Site Name and Location 

NOTE: Only the “admin” account is able to see the “System Settings” screen. 

Customize the “Site Name” and “Site Location” on the UltraNEXUS-HD web interface 
“System Dashboard” screen and WinLGX “Controller Site Manager” window.  Click the 
“System Settings” button to display the “System Settings” screen and then click the “Site 
Information” tab.  Enter a new identification name for your site into the “Site Name” field 
and a location description in the “Site Location” field.  Click “Apply Changes” to change 
the information on your “Dashboard” screen. 

Illustration 232, “Site Information” Screen 
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Changing UltraNEXUS-HD System Time 

Click the “System Settings” button to display the “System Settings” screen and then 
click the “Site Information” tab.  “UltraNEXUS-HD Time” shows the date and time 
currently on your server.  To change the UltraNEXUS-HD server’s date/time, perform 
one of the following:  

 Sync your UltraNEXUS-HD server’s date and time to your computer’s current date 
and time by clicking the “Set” button next to the “Computer Time” field. 

 Manually change the UltraNEXUS-HD server’s date and time by editing the “Manual” 
fields as follows: 

1. Use the up/down arrows to adjust the time fields. 

2. Click on the date field and select a new date in the calendar that appears.  

3. Click the “Set” button to make the changes. 
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Configuring ePRO-BUS Settings 

The ePRO-BUS control feature allows you to send ePRO-BUS start/stop RECORD 
control commands over your Ethernet network to up to 16 LABvault-HD digital video 
player/recorders.  To get started, the ePRO-BUS feature must be configured for your 
UltraNEXUS-HD server and each LABvault-HD according to the following steps: 

 LABvault-HD: refer to the device’s manual for instructions. 

 UltraNEXUS-HD Server:  

1. Click the “System Settings” menu button and then the “ePRO-BUS” tab to display 
the window shown in Illustration 233.  

Illustration 233, "ePRO-BUS" Tab Screen 

 

2. For each of your LABvault-HD player/recorders, select a PRO-BUS address and 
enter the LABvault’s static IP address. When you schedule or immediately send 
ePRO-BUS commands in WinLGX, your LEIGHTRONIX server uses the PRO-
BUS address assignments to determine which recording devices should receive 
the commands.  The “PRO-BUS Address” and “IP Address” fields can be edited 
once they are double clicked and any changes you make are saved when you 
click off the row.  Make your changes based on the following control options:  

 Assign each LABvault-HD IP address to a separate PRO-BUS address: 
control each of your LABvault-HDs individually by entering the IP address for 
each of your LABvaults on a separate “PRO-BUS Address” line. 

 Assign the same PRO-BUS address to multiple LABvault-HDs: to control 
multiple LABvault-HDs from one PRO-BUS address, enter each LABvault’s IP 
address on a separate line and then make the PRO-BUS address numbers 
the same for the desired LABvault-HD IP addresses.   
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 Give the same PEGvault-SD or LABvault-SD IP address to different PRO-
BUS addresses: allows you to control one PEGvault-SD/LABvault-SD 
independently and as part of a group of PEGvaults/LABvaults. 

3. Click the “Enable” checkbox for each LABvault-HD you want to receive ePRO-
BUS commands from your UltraNEXUS-HD server. 

4. Create a “DVD” or “Tape” device resource in WinLGX for each of your ePRO-
BUS-controlled devices.  Use the device resources to schedule (see 
“Scheduling/Editing ePRO-BUS-Controlled Device Resources,” on page 204) or 
immediately (see the control panel subsection on “Controlling ePRO-BUS Record 
Devices,” on page 252) start/stop recording on your LABvault-HDs. 
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Configuring Total Share Settings 

If you are using the included LEIGHTRONIX TOTAL SHARE option for expanded 
storage, the “Total Share” feature can be used to enter the network address settings for 
your LEIGHTRONIX-supported network attached storage (NAS) devices.  The NAS 
configuration settings enable your UltraNEXUS-HD to recognize your NAS devices.   

NOTE: If LEIGHTRONIX preconfigured all of the UltraNEXUS-HD servers and NAS 
devices for your TOTAL SHARE network at the factory, then you can skip this 
step. 

NOTE: You can use the same network as Ethernet port 1 to access a NAS device. You 
are not required to use Ethernet port 2. 

Click the “System Settings” menu button and then select the “Total Share” tab to display 
the window shown in Illustration 234. 

Illustration 234, "Total Share" Tab Screen 

 

Enter the requested information for each of your NAS devices and click “Save 
Changes.” 

NOTES:  If you have more than one UltraNEXUS-HD server connected to your 
TOTAL SHARE network, you will need to repeat these steps on the web 
interface for each UltraNEXUS-HD. 

  For further instructions on setting up your TOTAL SHARE network, refer 
to the “TOTAL SHARE” tutorial. 
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Logging Out of Web Interface 

Click the “LOGOUT” button in the menu bar to log out of the UltraNEXUS-HD web 
interface and return to the login screen. 
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Support 

Always ensure that the UltraNEXUS-HD system’s physical connections (power cable, 
video/audio cables, and Ethernet cables) are secure. 

Parts Replacement 

Due to the placement and sensitivity of components inside the UltraNEXUS-HD, the unit 
does not contain any user-serviceable parts.   

The UltraNEXUS-HD must be sent back to the factory if battery replacement is 
necessary.  Whenever the UltraNEXUS-HD is unplugged, its backup battery 
automatically provides standby power to the unit. Leaving the UltraNEXUS-HD 
unplugged for extended periods of time will drain its backup battery. 

Contacting LEIGHTRONIX Technical Support 

If you are experiencing a problem that you are unable to resolve, you may: 

Visit our website: www.leightronix.com 
E-mail us at: support@leightronix.com 
Call us at: 

(800) 243-5589 
(517) 694-1600 Fax 

Our technical support phone lines are open Monday through Friday, excluding holidays, 
from 8:30AM – 5:30PM, Eastern Time (ET). 
 
When you report a problem, please provide the following information: 

 Your name, your company name, address, and phone number 

 Model number 

 Serial number 

 Software version 

 Firmware version 

 Description of the problem 

 Status of the unit when the problem occurred (please try to include information on 
user and network activity at the time of the problem) 

 

Please contact the LEIGHTRONIX Technical Support Department at the number below 
for an RMA (Return Material Authorization) number before sending an item in for repair. 
 

LEIGHTRONIX, INC. 
1125 N Cedar Rd 
Mason, MI  48854 

Phone:  (800) 243-5589 
Fax:  (517) 694-1600 

http://www.leightronix/
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Warranty 

LEIGHTRONIX, INC. warrants this UltraNEXUS-HD high-definition video server/system 
controller against defective workmanship or materials for a period of five (5) years from 
the original date of purchase. 

During this warranty period, any parts found to be defective will be replaced at no 
charge.  Labor to repair or replace defective parts will also be performed at no charge 
during the warranty period. 

This warranty does not cover abuse, shipping damage, neglect, tampering by 
unauthorized personnel, acts of God, damage inadvertently caused by the user, 
preventive maintenance, or any product whose serial number or “Warranty Void if 
Removed” sticker is removed or defaced. 

The sole responsibility of LEIGHTRONIX shall be to repair or replace in accordance 
with this warranty.  The seller’s and manufacturer’s only obligation shall be to repair or 
replace such quantity of the product proved to be defective. 

The customer shall bear the cost of shipping products returned to LEIGHTRONIX for 
warranty repair.  The cost for return shipment to the customer will be assumed by 
LEIGHTRONIX and shipped via an equal priority service shipper prepaid and insured. 

Neither seller nor manufacturer shall be liable for any injury, loss or damage, direct or 
consequential, arising out of the use of, or the inability to use the product.  Before using, 
the user shall determine the suitability of the product for his/her intended use, and user 
assumes all risk and liability whatsoever in connection therewith. 

The warranty and the obligations and liabilities thereunder shall replace all other 
warranties or guarantees, express or implied. 
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Declaration of Standards Conformity 

FCC Notice 

NOTE:   This equipment has been tested and found to comply with the limits for 
a Class A digital device, pursuant to part 15 of the FCC Rules.  These 
limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial 
environment.  This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio 
communications.  Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense. 

 

CAUTION 

Changes or modifications to this device not expressly approved by 
LEIGHTRONIX, INC. could void the user’s authority to operate 
this device. 

This equipment is intended to be installed in a controlled environment with restricted 
access. 
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Appendix A: Copyright Statements 

The UltraNEXUS-HD firmware contains portions of the following software. 

The PHP License, version 5.3.4 

Copyright © 1999–2015 The PHP Group. All rights reserved. 

--------------------------------------------------------------------  

Redistribution and use in source and binary forms, with or without modification, is 
permitted provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions, and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions, and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

3. The name “PHP” must not be used to endorse or promote products derived from this 
software without prior written permission. For written permission, please contact 
group@php.net. 

4. Products derived from this software may not be called “PHP,” nor may “PHP” appear 
in their name, without prior written permission from group@php.net.  You may 
indicate that your software works in conjunction with PHP by saying “Foo for PHP” 
instead of calling it “PHP Foo” or “phpfoo” 

5. The PHP Group may publish revised and/or new versions of the license from time to 
time. Each version will be given a distinguishing version number.  Once covered 
code has been published under a particular version of the license, you may always 
continue to use it under the terms of that version. You may also choose to use such 
covered code under the terms of any subsequent version of the license published by 
the PHP Group. No one other than the PHP Group has the right to modify the terms 
applicable to covered code created under this License. 

6. Redistributions of any form whatsoever must retain the following acknowledgment: 
“This product includes PHP, freely available from <http://www.php.net/>”. 

 

THIS SOFTWARE IS PROVIDED BY THE PHP DEVELOPMENT TEAM ``AS IS’’ AND 
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO,THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 
PHPDEVELOPMENT TEAM OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
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NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

This software consists of voluntary contributions made by many individuals on behalf of 
the PHP Group. 

The PHP Group can be contacted via Email at group@php.net. 

For more information on the PHP Group and the PHP project, please see 
<http://www.php.net>. 

This product includes the Zend Engine, freely available at <http://www.zend.com>. 

GD Statement  

 Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 
2004 by Cold Spring Harbor Laboratory. Funded under Grant P41-RR02188 by the 
National Institutes of Health. 

 Portions copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by 
Boutell.Com, Inc. 

 Portions relating to GD2 format copyright 1999, 2000, 2001, 2002, 2003, 2004 Philip 
Warner. 

 Portions relating to PNG copyright 1999, 2000, 2001, 2002, 2003, 2004 Greg 
Roelofs. 

 Portions relating to gdttf.c copyright 1999, 2000, 2001, 2002, 2003, 2004 John 
Ellson (ellson@graphviz.org). 

 Portions relating to gdft.c copyright 2001, 2002, 2003, 2004 John Ellson 
(ellson@graphviz.org). 

 Portions relating to JPEG and to color quantization copyright 2000, 2001, 2002, 
2003, 2004, Doug Becker and copyright © 1994, 1995, 1996, 1997, 1998, 1999, 
2000, 2001, 2002, 2003, 2004 Thomas G. Lane. This software is based in part on 
the work of the Independent JPEG Group. See the file README-JPEG.TXT for 
more information. 

 Portions relating to GIF compression copyright 1989 by Jef Poskanzer and David 
Rowley, with modifications for thread safety by Thomas Boutell. 

 Portions relating to GIF decompression copyright 1990, 1991, 1993 by David 
Koblas, with modifications for thread safety by Thomas Boutell. 

 Portions relating to WBMP copyright 2000, 2001, 2002, 2003, 2004 Maurice Szmurlo 
and Johan Van den Brande. 

 Portions relating to GIF animations copyright 2004 Jaakko Hyvätti 
(jaakko.hyvatti@iki.fi) 

mailto:jaakko.hyvatti@iki
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IJPEG Statement 

 “This software is based in part on the work of the Independent JPEG Group” 

FREETYPE Statement 

“Portions of this software are copyright © 1996-2002 The FreeType Project 
(www.freetype.org).  All rights reserved.” 

 
 

http://www.freetype/
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Appendix B: Cable Pinouts for LEIGHTRONIX-Supported 
External Switchers  

Each UltraNEXUS-HD is equipped with three DB9M RS-232 ports for an external 
switcher. Table 49 lists the external switcher cables compatible with the UltraNEXUS-
HD systems.   

See the LEIGHTRONIX website for specific models and up-to-date switcher 
compatibility and cable requirements here: 
http://www.leightronix.com/products/router_support.php or contact LEIGHTRONIX 
support. Not every manufacturer’s models are supported. 

NOTE: LEIGHTRONIX provides these three external switcher cables upon request 
with each UltraNEXUS-HD: part #s 10-1688, 10-4421, and 10-2372.   

Table 49, Cable Information for LEIGHTRONIX-Supported External Switchers 

 

Check the LEIGHTRONIX website to verify switcher compatibility and cable 
requirements here: 

http://www.leightronix.com/products/router_support.php 

or contact LEIGHTRONIX support. 

Not every manufacturer’s models are supported. 

LEIGHTRONIX  
PART # 

COMPATIBLE 
SWITCHER(S) 

CABLE 
ILLUSTRATION 

PINOUT 
DIAGRAM 

10-1688  Extron 

 Knox  

 Creator 

 Sierra 

 Ensemble (order 
serial port install) 

Illustration 235 Figure 1 

10-4421  AMX/Autopatch 

 Imagine/Harris/Leitch 

 Pesa (Routing Switchers 

Supporting CPU Link Serial 
Protocol) 

Illustration 236 Figure 2 

10-2372  Kramer 

 Sigma 

Illustration 237 Figure 3 

Obtain a PC Com port 
compatible serial cable 
from Utah for your 
switcher model. 

 Utah N/A N/A 

http://www.leightronix.com/products/router_support.php
http://www.leightronix.com/products/router_support.php
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Order cable RS-2/3J from 
Addenda.com or use 
Ethernet. 
OR 

Order cable RS-2/3R 
from Addenda.com or 
use Ethernet. 

 Blackmagic N/A N/A 

Control cable not 
needed, uses Ethernet 
for control. 

 Pesa (Routing Switchers 

supporting P1N Network 
Protocol) 

N/A N/A 

 
Reliable operation with cables other than those provided by LEIGHTRONIX cannot be 
guaranteed. Custom cables may be fabricated according to the following pinouts.  
The color and molding of cables may differ from the cables shown in the following 
illustrations.  

NOTE: Handshaking lines are driven, but not utilized. 
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Illustration 235, DB9F-DB9M Straight-Through Cable, Part #10-4869 

 

 

Figure 1, Pinout of DB9F-DB9M Straight-Through Cable, Part #10-4869 
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Illustration 236, DB9F-DB9F Null Cable, Part #10-4421 

 

 

Figure 2, Pinout of DB9F-DB9F Null Cable, Part #10-4421 
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Illustration 237, DB9F-DB9M 6’ Null Cable, Part #10-2372 

 
 

Figure 3, Pinout of DB9F-DB9M 6’ Null Cable, Part #10-2372 
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Glossary 

The following terms are used throughout this manual. 

TERM DEFINITION 

Baud Rate Controller’s data transmission rate in bits per second  

Bit Rate Bit rate is the speed at which pieces of information are 
transmitted. A bit is the single smallest piece of 
information that is transmitted, and the speed is expressed 
as the number of bits that are transmitted per second.  

BNC Type of connector used with coaxial cables 

CBR Constant Bitrate; the UltraNEXUS-HD only records in 
VBR, but it will play a file that has CBR. 

Character Generator Electronic device which produces graphics and characters 
for creating video titles 

Client (WinLGX) Software program that is used to contact and obtain data 
from a server software program on another computer 

Controller Provides unattended, automatic control over a wide variety 
of video devices including digital video servers, digital disc 
recorders, DVD players, video/audio routing switchers, 
VCRs, and the like 

Cross-Over Cable A twisted pair of patch cables wired to route transmitted 
signals from one piece of equipment and receive signals 
from another, and vice versa 

Decoder A software program and/or hardware device that converts 
a signal back into its original format 

Destination Output 

DHCP Dynamic Host Configuration Protocol: protocol that 
automatically assigns IP addresses to devices as they are 
attached to a network. 

DTE Data Terminating Equipment: a communications device 
that is the source or destination of network signals 

Encoder A software program and/or hardware device that converts 
a signal back into a coded format 

Ethernet Method of networking computers in a local area network 
(LAN) 

Event Control element that holds information about “what” is 
supposed to happen and “when” 
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TERM DEFINITION 

Event Action Any switch or device function 

FAT File Allocation Table: part of a hard disk where data is 
stored. 

Firmware Software contained in a hardware device 

Gateway Address IP address of a computer or router that transfers 
communications from a local network to a broader network 

H.264 Video compression standard for HD video developed by 
the ITU-T Video Coding Experts Group and ISO/ICE 
Moving Picture Experts Group (MPEG); also known as 
MPEG-4 Part 10 and AVC 

HD High-definition video 

Host IP-capable machine connected to an IP network 

Image File See UltraNEXUS-HD Image File 

Immediate (control) Control of UltraNEXUS-HD through WinLGX control panel 
instead of a schedule 

IP Address Internet Protocol; 4-byte address used to identify devices 
on a network 

LAN Local Area Network: a computer network that covers a 
relatively small area (single building). 

LED Light-emitting diode 

Library Resource Library resources contain the event actions of a frequently 
scheduled device medium. Each library resource contains 
event actions for a specific digital video or switch action. 

Locked Event An event with an editable, fixed time entered by the user 

Log File List of UltraNEXUS-HD system actions and alarms 

Mb/s Megabits per second 

MPEG Moving Pictures Expert Group; standards for compressing 
digital video and audio data 

Network Networks are groups of connected computers that can 
communicate with one another. Networks enable 
computers to share files and resources and exchange 
messages. 

NIC Network Interface Card: Ethernet card used to connect to 
a network. 

http://en.wikipedia.org/wiki/ITU-T
http://en.wikipedia.org/wiki/Video_Coding_Experts_Group
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TERM DEFINITION 

OS Operating System 

PC Personal Computer 

Preroll Amount of time the UltraNEXUS-HD system waits before 
switching a device on-air (prevents the transmittal of black 
video or static found at the beginning of a program) 

RCA Plug and jack connector for a two-wire coaxial cable 

Reset Time Time the device is unavailable for scheduling after the end 
of the event, usually due to “rewind” time. 

Setup Time Amount of time a device needs to prepare for playback; 
begins when a device receives a playback command and 
ends at the first sign of video 

SD Standard definition video 

SMTP Simple Mail Transfer Protocol: protocol used to transfer 
email between or among servers. 

Source Input (video and/or audio) 

Subnet Mask Separates an IP address into a network address and host 
address as assigned within the network 

Switchback Input Once the scheduled event time ends, the selected 
switchback input will be switched to the scheduled event’s 
channel output 

TCP/IP Transmission Control Protocol/Internet Protocol 

UltraNEXUS-HD Image 
File 

Contains system, device, and library properties and may 
contain a schedule of events 

Unlocked Event An event whose start time is assigned by WinLGX to 
coincide with the ending time of the event above it is 
“unlocked.” This time is not fixed and will be adjusted by 
WinLGX if events above it are inserted, deleted, moved, or 
modified. 

USB 2.0 Hi-Speed Universal Serial Bus: capable of transmitting 
data between computer and external devices at 480 
Mbits/second. 
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TERM DEFINITION 

VBR Variable Bit Rate: the UltraNEXUS-HD VBR recording 
preset option allows the internal digital video recorders to 
automatically adjust the record rate of a program between 
the user-defined minimum and maximum video bit rates. 
This option ensures that the digital video recorders 
capture the more detailed portions of the program 
(particularly important for motion-intensive video). 

VFD Vacuum Fluorescent Display 

Video .mp4, .mov, .m2t or .mpg file 

Virtual Channel The UltraNEXUS-HD web interface’s Virtual Channel 
feature provides two looping video sources that may be 
configured to automatically appear between scheduled 
programs or in place of a schedule. 

Index 

AUTOMATIC MPEG FILE TRANSFERS . 270 

BACKGROUNDS 
Filenames ...................................... 21 
Recommended resolutions ............ 21 

CAUTION ..................................... 36, 337 

COMPLIANCE CERTIFICATIONS ............. 16 

CONFIDENCE MONITOR ...................... 244 

CONTROL PANEL ............................... 229 
Digital video player ...................... 231 
Digital video recorder ................... 241 
Forcing a switch ........................... 230 
Ingest function for external switcher 
configurations .............................. 243 
Ingest function for no switch 
configurations .............................. 242 

CONTROLLER SETTINGS WINDOW ......... 75 

COPYING/CUTTING/PASTING EVENTS .. 181 

DAY TABS 
Adding an event ........................... 178 
Functions ..................................... 174 

DELETING EVENTS ............................. 182 

DEVICE EVENT PROPERTIES ........ 187, 198 

DIGITAL VIDEO FILE SYNC ................... 223 

DVPLY 
Scheduling devices .............. 198, 200 

EDITING EVENTS ................................ 182 

EPRO-BUS 
Configuring in Web Interface ....... 331 
Creating device resources ........... 114 

ETHERNET 
Connecting directly to a PC via 
Ethernet ......................................... 39 

EXTERNAL SWITCHER 
Cable pinouts ............................... 341 
Channel output tab assignments . 100 
Non-LEIGHTRONIX switcher 
configuration steps ........................ 97 
Supported external switchers and 
parameters .............................. 32, 98 

FRONT PANEL 
Display ........................................... 25 
Keypad .......................................... 24 
Password, changing ...................... 74 
Password, entering ........................ 40 

IMAGE FILES 
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Creating ......................................... 58 
Opening ....................................... 161 
Saving.......................................... 166 
Sending ....................................... 225 

INSERTING LIBRARY RESOURCE EVENTS186 

LIBRARY EVENT PROPERTIES .............. 204 

LIBRARY RESOURCES 
Exporting MPEG library resources154 

LOG FILES 
Downloading from an UltraNEXUS-
HD system ................................... 257 
Viewer............................................ 86 

MASTER CLOCK SYNCHRONIZATION ..... 47 

MPEG RECORDER (BROADCAST) 
Confidence monitor ..................... 244 

NO SWITCH 
Channel output tab assignments ... 96 

OVERLAYS 
Emergency overlays .................... 304 
Filenames ...................................... 21 
Recommended resolution .............. 21 
Templates for scheduling ............. 116 

POWERING ULTRANEXUS-HD ON/OFF
 ...................................................... 40 

PREFERENCES WINDOW ...................... 83 

PRINTING SCHEDULES 
Page layouts .................................. 79 
Print templates ............................... 77 
Printer and paper settings .............. 79 
Printing ........................................ 226 

PROGRAM GUIDE 
Creating library resources ............ 146 
Scheduling library resources ....... 216 

REAR PANEL ....................................... 29 

REBOOTING ULTRANEXUS-HD FROM 

WINLGX ......................................... 76 

REPLACING LIBRARY RESOURCE EVENTS

 .................................................... 184 

SCHEDULE COLUMN HEADINGS ............. 81 

SERIAL PORT ....................................... 46 

SHARED SWITCHER 
Channel output tab assignments . 103 
Front panel IP address configuration
 ...................................................... 45 
WinLGX configuration .................. 100 

SLIDES 
Approving for display ................... 301 
Approving for slide show displays 252 
Default slide ......................... 252, 298 
Filenames ...................................... 21 
Recommended resolutions ............ 21 
Uploading to a NEXUS series 
server/controller ........................... 281 

STORAGE MANAGER 
Copying videos and slides ........... 249 
Deleting videos and slides ........... 250 
Moving videos and slides............. 250 
Renaming videos and slides ........ 251 

SWITCHBACK INPUT ........................... 177 

SWITCHER CONFIGURATION .................. 95 

TCP/IP ADDRESSES 
Gateway address ........................... 42 
IP address ............................... 41, 43 
Subnet mask ............................ 42, 44 

THEMES, CUSTOMIZING WINLGX 

APPEARANCE .................................. 51 

TOTAL INFO-HD 
Activating ..................................... 316 

ULTRANEXUS-HD STATUS REPORT . 269 

ULTRANEXUS-HD WEB INTERFACE .. 266 

UPDATING ULTRANEXUS-HD FIRMWARE

 .................................................... 263 

UPDATING WINLGX .......................... 265 

USB DRIVES 
Storage .......................................... 20 

USER ACCOUNT RIGHTS ....................... 71 

USER-DEFINED DATA DIALOG BOX ........ 81 

VIRTUAL CHANNELS .......................... 314 
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Activating from Control Panel ...... 239 
Creating Playlists ......................... 317 
Creating Virtual Channel Playlist File 
(.vc) Library Resource ................. 151 
Deleting Playlists ......................... 328 
Displaying Playlists ...................... 325 
Immediately Display Virtual Channel 
Playlist File (.vc) .......................... 240 
Overview ...................................... 314 
Saving Playlists ........................... 322 
Scheduling Virtual Channel Playlist 
File (.vc) Library Resource ........... 219 

WARNING ............................................ 15 

WEB SCHEDULE PORT ......................... 46 

WINLGX 
Changing Themes ......................... 51 

FACTORY-DEFAULT USERNAME AND 

PASSWORD ........................ 54, 57, 158 
Hiding/Displaying toolbars, windows, 
and schedule columns ................... 65 
Installation ..................................... 49 
Main window components ............. 59 
Moving windows ............................ 67 
Opening and logging in .......... 56, 157 
Rearranging schedule column 
headings ........................................ 67 
Resizing schedule column widths .. 67 
Updating software ........................ 265 
Version number ........................... 159 

WINLGX-LT TAB 
Adding an event ........................... 180 
Functions ..................................... 175 
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	ii. Secure each of your prepared audio wires in their appropriate terminals as follows, referring to Table 2 for each wire’s placement on the terminal block:
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	Attach up to two, LEIGHTRONIX-approved USB hard drives to the USB ports. The UltraNEXUS-HD system can support up to 4 TB of storage. For more information on USB drives compatible with the UltraNEXUS-HD, refer to www.leightronix.com or contact LEIGHTRO...
	Attach the included power cord to the power cord connector on the back of the UltraNEXUS-HD, and then plug it into an AC power source.
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	Proceed to “Configuring Ethernet Network Host Management,” on page 40, to configure the UltraNEXUS-HD for remote control through Ethernet network host management.

	Configuring Ethernet Network Host Management
	Connecting the UltraNEXUS-HD to an Existing Ethernet Network
	Obtain the following from your technical support personnel or network administrator and enter into the front panel of your UltraNEXUS-HD system (see “Configuring Front Panel Settings,” on page 423):
	Using a straight-through RJ-45 Ethernet cable, connect the UltraNEXUS-HD system’s right Ethernet port (labeled “1”) to a 100/1000 BASE-T switch on the TCP/IP network.
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	a. Open the Command Prompt by clicking Windows Start > All Programs > Accessories > Command Prompt.
	b. Type in “IPconfig” at the prompt to reveal your PC’s IP and subnet mask address.

	Enter the following IP and subnet mask addresses into the front panel of your UltraNEXUS-HD system (see “Configuring Front Panel Settings,” on page 42):
	Using an Ethernet cord, connect the UltraNEXUS-HD Ethernet port 1 to the PC’s network interface card (NIC).


	Turning an UltraNEXUS-HD System ON/OFF
	Configuring Front Panel Settings
	Entering Password
	From the front panel of your UltraNEXUS-HD server, press the right arrow key from any one of the status screens to display the password entry screen (see Illustration 19, Password Entry Screen).
	Press five-key password.
	If the password entered is correct, the UltraNEXUS-HD system’s configuration menu will be displayed (see Illustration 20, Configuration Menu Screen).
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	Editing TOTAL SHARE Network Addresses
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	About this Section
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	Log in to the LEIGHTRONIX Support Center website.
	a. Link: www.supportcenter.leightronix.com
	b. If you don’t have an account you can create one by clicking the register button.

	Once logged in, from the Welcome page, click the button for your UltraNEXUS-HD server product.  This will load a new page with content specifically for your system.
	From your UltraNEXUS-HD’s web page, click on the “WinLGX Software” link.  If the file does not automatically download, choose the save file option when prompted.
	Navigate to where the WinLGX installer (“WinLGX v* Installer.EXE”) was saved on your computer.
	Right click the WinLGX installer and choose the “Run as administrator” option to start the installation.  Follow the prompts to complete setup.
	As WinLGX installs, a succession of two additional installation windows will be displayed.  Refer to the following for a description of each window and installation guidelines:
	Click “Finish” to close the WinLGX setup wizard and return to Windows.

	Changing WinLGX Appearance (Themes)
	1. Go to the “View” drop down menu and select “Themes and Colors.”
	2. On the "Themes and Colors" window, click the "Skins and Themes" tab if it is not already selected (see Illustration 21).
	Click to choose a different interface, menu bar, and/or tab theme (see Illustration 22). To return to the WinLGX default appearance, just select the "Default" button for each theme that was changed.
	Once you are finished with your changes, either click the “Done” button or the close icon in the upper right corner of the pop-up window.

	Adding / Deleting UltraNEXUS-HD Locations in the Site Manager
	If not already open, click “Site manager” in the “Tools” menu or the  icon on the main toolbar to open the “Controller Site Manager” window shown in Illustration 23.
	Click “Add” on the “Controller Site Manager” window (see Illustration 23) to open the “Add new controller” window shown in Illustration 24.  Complete the following fields:
	Click “Find.”  If you are adding the correct IP address, your server’s site ID, location, serial number, and time zone displays in the “Add new” window.
	Click “OK” to enter your UltraNEXUS-HD server in the site manager database or “Cancel” to abort entry.
	If applicable, repeat the steps for each additional UltraNEXUS-HD server in your system.
	1. Highlight the UltraNEXUS-HD IP address you wish to delete.
	Click “Delete” to display the delete confirmation box.  Click “OK” to delete the UltraNEXUS-HD IP address from the site manager location.
	Click “OK” at the bottom of the “Site Manager” window to save your changes to the database, or click “Cancel” to discard your changes.

	Connecting to Your UltraNEXUS-HD Server
	Open the WinLGX “Site Manager” window (see Illustration 32) by performing one of the following:
	Once the WinLGX “Site Manager” is open, you should see a list of your UltraNEXUS-HD systems.  If not, refer back to “Adding / Deleting UltraNEXUS-HD Locations in the Site Manager,” on page 57.
	If desired, reorder your UltraNEXUS-HD server listing.  Clicking on any column header in the “Site Manager” sorts the associated information in ascending order, while clicking the header again sorts the list in descending order.
	Connect as follows (see Illustration 32):
	a. Select one or more IP addresses.  You may select up to eight IP addresses by holding down your keyboard “Ctrl” key and clicking each address with the left mouse button.
	b. Log in with the username and password given to you by the UltraNEXUS-HD system administrator.  To simultaneously log into multiple servers, all of the selected IP addresses must have the same username and password.
	c. Click “Connect” or press “Enter” to connect to the chosen UltraNEXUS-HD server(s) and close the login dialog box.  Once you are connected, a tab appears for each UltraNEXUS-HD server on the main window beneath the toolbar.  If you logged into more ...


	Creating New UltraNEXUS-HD Image Files
	WinLGX automatically opens with an empty image file loaded.  If you need to clear any settings, select “New” under the “File” menu.
	Select “Save as/Export” in the “File” menu to open the window shown in Illustration 27.”
	From the “Save in” drop down box at the top of the window, navigate to the folder where you want to save the UltraNEXUS-HD image file.
	Type a name for the image in the “File name” field.
	Ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” field.
	Click “Save” to save the image under the entered name or “Cancel” to abort the “Save as.”
	As you enter your configuration settings according to the “Configuring WinLGX” section starting on page 63, periodically save your settings in your image file by selecting “Save” from the “File” menu or clicking the  toolbar button.

	Configuring WinLGX
	About the Main Window Components
	Configuring the Main Window Components
	Configuring WinLGX Interface Colors
	Setting User Account Rights (Including WinLGX Password Changes)
	Select “User accounts” in the “Tools” menu to open the “User Accounts” window (see Illustration 38).
	WinLGX and UltraNEXUS-HD web interface user rights are described in Table 15, User Control and Configuration Rights (see page 77) and Table 16, User File Access Rights (see page 78).  Perform any of the following according to the steps below:
	When finished configuring user information, exit the “User Accounts” window by clicking the “Close” button.

	Changing Front Panel Password
	Select “Set front panel password” in the “Tools” menu to open the window shown in Illustration 39.
	Click on a combination of five arrows for the new front panel password.
	Click “Set” to accept new password or “Clear” to cancel.
	Click “Done” to close the “Set Front Panel Password” window.

	Configuring Site Information, Clock, Updating Firmware, and Rebooting
	In the “Tools” menu, choose “Controller” to open the window shown in Illustration 40, “Controller” Window.
	Use the “Controller” window to set the following configuration maintenance settings.  After clicking “Set,” “Update,” or the “Reboot” button, you will be prompted for confirmation to perform the action on the connected UltraNEXUS-HD server.  Clicking ...
	Click “Close” to close the “Controller” configuration window.

	Creating Templates for Exporting/Printing Schedules
	Create a schedule template per the following steps:
	a. Click “Export/Print templates” in the “Tools” menu to open the window shown in Illustration 41.
	b. Select template display items as follows:
	 Determine which event windows will be filtered for the schedule template:
	 Check the “Export/print switchbacks” checkbox to display channel switchbacks between programs.
	 Check “Export/print all records” to include all events in the selected event windows.
	 Add/remove schedule fields (columns) in template as follows:
	c. Click “Save” to save the template to a file.

	To revise a template:
	d. Click “Export/Print Templates” in the “Tools” menu to open the window shown in Illustration 41, “Export/Print Templates” Window.
	e. Click “Load.”  In the “Select Export/Print Template” window that appears, browse for the desired template and open.  The filename will then appear in the “Template” box at the top of the “Export/Print Templates” window.

	Click “Done” when finished to close the “Export/Print Templates” window.

	Configuring Page Layouts For Schedules Printed from WinLGX
	Select “Page Setup” in the “File” menu to open the box shown in Illustration 42, “Page Setup” Window, and configure the schedule printout according to the following options:
	Click “OK” to save your settings or “Cancel” to close the window without saving.

	Configuring Printer and Paper Settings for Schedules Printed from WinLGX
	Selecting “Print Setup” in the “File” menu opens the box shown in Illustration 44, “Print Setup” Window, which allows you to configure the printer and paper settings as follows:
	Click “OK” to save your settings or “Cancel” to close the window without saving.

	Creating Custom Schedule Columns
	Click “User defined data” under the “Tools” menu to open the window shown in Illustration 46.
	Select the fields displayed on your schedule as follows:
	Click on the field which you would like to rename.  In the “Edit Field Options” window that appears (see Illustration 47), perform the following:
	a. Enter a new schedule heading into the “Menu title” field.
	b. Add a list of menu items that will be used to define schedule events under the renamed column.  The number of menu items that may be added corresponds to the number of options shown over each section of field names on the window.

	Click “OK” to accept changes or “Cancel” to abort all editing changes made in the “Edit Field Options” window and return to the “User Defined Data” window.
	Click “OK” to accept or “Cancel” to abort all field changes and close the “User Defined Data” window.

	Setting WinLGX Viewing and Communication Preferences
	Under “Format type,” select the format of the device/library event properties window you would like to configure.
	Perform any of the following options:

	Configuring the Switch Type of an UltraNEXUS-HD
	Configuring Digital Video Recording Presets
	Editing Internal Digital Video Playback and Recording Device Resources
	Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices” window (refer to Illustration 63, “Devices” Window).
	In the “Resource View,” click on the desired device icon to reveal the corresponding properties fields.

	Creating External Switch Device Resources
	Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices View” window (refer to Illustration 65, New Switch Device Properties).
	Right click in the “Resource View” window and select “New” to display the device type menu.  Select the “SWITCH” device type to add a new device to the window (see Illustration 65, New Switch Device Properties).
	Complete the switch device “Properties” field shown in Illustration 66, Switch Event Properties Window.  Refer to Table 18, Switch Event Properties, for a description of the editable switch resource properties.

	Creating ePRO-BUS-Controlled Device Resources
	Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices View” window (refer to Illustration 65, New Switch Device Properties).
	Right click in the “Resource View” window and select “New” to display the device type menu.  Select “DVR” device type to add a new device resource to the window (see Illustration 67, New Device Properties).
	Complete the properties fields shown in Illustration 68, ePRO-BUS Resource Properties Window according to Table 19, ePRO-BUS Resource Properties.

	Creating Overlays
	Select the “Overlay Templates” tab view on the main WinLGX window.
	Add an overlay template to the template listing by clicking the  icon and assigning a title in the “Create overlay template” box that appears (see Illustration 71, Add Overlay Template).  Click “OK” to create template or cancel to abort.  Click the  i...
	Drag up to ten overlay library resources into the desired segments on the overlay template and click “OK” in each overlay properties box that appears.

	Creating Library Resources
	a. Right click on the “Library” configuration folder containing the library resources you wish to export and select “Export” from the pop-up menu (see Illustration 75) to display the “Export MPEG Resource” window (see Illustration 76).  Resource files...
	b. If the selected library folder contains resources for digital videos on more than one USB or NAS device, single click to select a storage device in the “Export MPEG Resource” window (see Illustration 76, "Export MPEG Resource" Window).  Only the li...
	c. When the resource file has been uploaded to the selected UltraNEXUS-HD USB or NAS storage device, click “Ok” when you are prompted.
	d. If desired, repeat steps a–c for each set of library resources in the folder referencing digital videos on your other storage devices.

	Exporting Library Resources
	1. Right click on the “Library” configuration folder containing the library resources you wish to export and select “Export” from the pop-up menu (see Illustration 97) to display the “Export Video Resource” window (see Illustration 98).  Resource file...
	2. If the selected library folder contains resources for MPEG videos on more than one USB or NAS device, you will see a list of storage devices at the top of the “Export MPEG Resource” window (see Illustration 98).  Single click to select the storage ...
	3. If you wish to overwrite an existing resource file, single click to select the file in “Resource Files” listing.  Click the “Export” button and, if saving a new resource file, enter an alphanumeric filename without spaces into the “Export resource”...
	4. When the resource file has been uploaded to the selected NEXUS series USB or NAS storage device, click “Ok” when you are prompted.
	5. If desired, repeat the steps in this section for each set of library resources in the folder referencing MPEG videos on your other storage devices.



	Software Operation
	About this Section
	Performing General WinLGX Operations
	Opening WinLGX and Connecting to an UltraNEXUS-HD Server
	Double click the WinLGX desktop icon.  The login window shown in Illustration 100 automatically appears when WinLGX is opened or when you click one of the following:
	If desired, reorder your IP address listing.  Clicking on any column header in the “Site Manager” sorts the associated information in ascending order, while clicking the header again sorts the list in descending order.
	Connect as follows (see Illustration 100, “Site Manager” Window):
	a. Select one or more IP addresses.  You may select up to eight IP addresses by holding down your keyboard “Ctrl” key and clicking each address with the left mouse button.
	b. Log in with the username and password given to you by the UltraNEXUS-HD system administrator.  To simultaneously log into multiple servers, all of the selected IP addresses must have the same username and password.
	c. Click “Connect” or press “Enter” to connect to the chosen UltraNEXUS-HD server(s) and close the login dialog box.  Once you are connected, a tab appears for each UltraNEXUS-HD server on the main window beneath the toolbar.
	d. If you logged into more than one UltraNEXUS-HD system, switch between the servers by clicking on the product tabs on the main window.


	Displaying WinLGX Version Number
	Disconnecting from an UltraNEXUS-HD Server
	Select “Site manager” in the “Tools” menu or click the  icon on the toolbar to open the “Site Manager” window shown in Illustration 100.
	Select the UltraNEXUS-HD address(es) you would like to disconnect.  If you want to disconnect from more than one address, hold down your keyboard “Ctrl” key and click on each address with the left mouse button.
	Click the “Disconnect” button.  A box will appear asking whether or not you would like to disconnect from the current UltraNEXUS-HD location(s).  Click “Yes” to disconnect or “No” to remain connected.

	Exiting WinLGX
	Select “Exit” in the “File” menu or click the  in the upper right corner of the main window.
	If an image file has not been saved for one of the connected UltraNEXUS-HD servers, the dialog box shown in Illustration 102 appears and asks if you want to save the changes.  Select one of the following options:


	Opening UltraNEXUS-HD Image Files
	Opening a Saved Image File
	Select “Open” in the “File” menu or click the  icon on the main toolbar to open the file selection window shown in Illustration 103.
	Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” field.
	Select an image file folder from the “Look in” drop down box at the top of the window.
	Single click a .nmg file to select it and click “Open” or double click the file.  The image file data is then loaded into WinLGX.
	As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 177, periodically save your settings in an image file as described in “Saving UltraNEXUS-HD Image Files,” on page 171.

	Opening an Image File as New
	Select “Open as new” in the “File” menu or click the  icon on the main toolbar to open the file selection window shown in Illustration 104, Open Image File as New Window.
	Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” field.
	Select an image file folder from the “Look in” drop down box at the top of the window.
	Single click a .nmg file to select it and click “Open” or double click the file.  The image file data minus the schedule is then loaded into WinLGX as an unnamed file.
	As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 177, periodically save your settings in an image file as described in “Saving UltraNEXUS-HD Image Files,” on page 171.

	Receiving Image Files from the Connected UltraNEXUS-HD Server(s)
	Download the last image file sent to one or more of your UltraNEXUS-HD servers as follows:
	As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 177, periodically save your settings in an image file as described in “Saving UltraNEXUS-HD Image Files,” on page 171.

	Associating UltraNEXUS-HD Image Files with WinLGX

	Saving UltraNEXUS-HD Image Files
	From the “Save in” drop down box at the top of the window, navigate to the folder where you want to save the UltraNEXUS-HD image file.
	Type a name for the image in the “File name” field.
	If you plan to re-open this file in WinLGX, ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” field.
	Click “Save” to save the image under the entered name or “Cancel” to abort the “Save as.”  If you enter a name of a file that already exists, WinLGX will ask you if you want to overwrite it.

	Importing Digital Video Library Resources
	Right click on the “Library” configuration folder you wish to import digital video library resources into and select “Import” from the pop-up menu (see Illustration 107) to display the “Import MPEG Resource” window (see Illustration 108).  Resource fi...
	If more than one device is shown in the “Storage Device” listing on the “Import MPEG Resource” window (see Illustration 108, "Import MPEG Resource" Window), single click to select the storage device containing the resource files with the library resou...
	If more than one resource file exists, single click to select the file with the library resources you wish to import (see Illustration 109).
	Click the “Import” button to start importing the resources or “Done” to cancel the operation and close the “Import MPEG Resource” window.
	After clicking the “Import” button, click “Yes” when prompted to import the file’s digital video library resource properties or “No” to abort.
	When the digital video library resource properties have been imported, click “Ok” when you are prompted.  The imported library resources will be shown in the “Resource View” (see Illustration 110 for an example).

	Using Instant Video Preview Monitor to Display Digital Video Files within WinLGX
	Scheduling Events
	About Schedule Window Components
	Scheduling/Editing/Deleting All Events
	Select a scheduling event window as follows:
	a. Click the desired day tab to select the day you want the event to occur.
	b. Select one of the following channel tabs:

	Drag an icon from the “Device” or “Library” “Resource View” into the selected event window.  This opens an “Event properties” box with editable event information like the one shown in Illustration 114, Day/Channel Output Event Properties Box.
	To add or change the event information, click on each of the desired editable fields (described on pages 193–228) and enter the new information.  An icon can be dragged and dropped into a day/channel output event window in the following five ways:
	c. To select a date, change “Absolute date” to “Yes.”  A date field appears below to allow date entry.
	d. To enter a day, change the desired day field(s) to “Yes.”  These fields can be toggled quickly by double clicking on the day name.


	Scheduling/Editing Device Resources
	Scheduling/Editing ePRO-BUS-Controlled Device Resources
	Select the WinLGX-LT tab on the bottom of the scheduling window.  If you do not see this tab, go to the “Tools”/”Preferences”/”Applications” tab and select the “Show WinLGX-LT tab” option.
	Open the ePRO-BUS record “Event Properties” window (see Illustration 126, Remote ePRO-BUS Record Event Properties Window) by either adding or editing the ePRO-BUS record event.  To add a new event, drag the desired ePRO-BUS-controlled device resource ...
	Complete or edit the event properties fields according to Table 34, Editable Remote ePRO-BUS Record Event Properties.

	Scheduling/Editing Library Resources
	Changing Channel Switchbacks
	Select “Switchback editor” under “Tools”/”System Tools” to open the “Channel Switchback Editor” (see Illustration 139).
	Select the channel output/day tab schedule window containing the switchback inputs you would like to change by selecting a channel output under “Channel” and a day under “Day of week.”  You may select “All” under “Day of week” to select all schedule w...
	Under “Replace all,” select the switchback input you would like to change.
	Use the “With” drop down menu to select a new switchback input.
	Click “OK” to make the changes or “Cancel” to abort.

	Checking Schedule and Library Resources for Missing Digital Video Files
	If you have not already done so, open an UltraNEXUS-HD image file in WinLGX.
	Click the  sync icon on the main toolbar or choose the “Tools”/”System tools”/”Sync Library Resources” menu item.  Those events containing missing digital video files are highlighted in the schedule and a “Sync Library Resources” box pops up to report...


	Sending UltraNEXUS-HD Image Files
	Send an image file to one or more of the currently connected servers according to the following steps:
	Once each transfer is completed, the UltraNEXUS-HD system(s) will contain and execute the scheduled events.

	Printing Schedules from WinLGX
	1. Create a print template to select the desired schedule information for printing (see “Creating Templates for Exporting/Printing Schedules,” on page 81).
	Determine the page layout of your schedule printout (see “Configuring Page Layouts For Schedules Printed from WinLGX,” on page 83).
	Select “Print” in the “File” menu or click the  icon on the main toolbar to open the template selection window shown in Illustration 142.
	Choose the desired template from the “File name” list in the “Select Export/Print Template” Window (see Illustration 142) and click “Open,” or double click the template file to open the “Print” window.  Click “Cancel” to abort the print.
	In the “Print” window, configure the printer and copy settings according to the following steps. Click “OK” to print or “Cancel” to abort the print.

	Exporting Schedules into Comma Separated Values Files
	1. Ensure the schedule you wish to export is currently open in WinLGX (see “Opening UltraNEXUS-HD Image Files,” on page 166).
	If you have not already done so, create a template (see “Creating Templates for Exporting/Printing Schedules,” on page 81).
	Select “Save as” in the “File” menu to open the window shown in Illustration 143, which allows you to export the loaded schedule as a comma separated values file (.csv) as follows:
	a. Select a folder in the “Save in” field.
	b. Type a name for the exported file in the “File name” field.  If you leave the extension off, WinLGX puts it on for you.
	c. Select the .csv export format in the “Save as type” drop down menu.
	d. Click “Save” to open the template selection window shown in Illustration 144.  To apply a template to your schedule information, select the desired template and either click “Open” or double click the template file to create the export schedule .cs...


	Using Control Panel to Perform Immediate Device and Switch Actions
	Open the Control Panel window (see Illustration 145) by clicking “Control Panel” under the “Tools” menu or  icon on the main toolbar.
	If desired, sort the device icons by right clicking in the “Devices” column and selecting one of the sorting filters in the right-click menu that appears (see Illustration 146, Control Panel Device Sorting Menu).
	Perform any of the following steps:
	When finished, click “Close” to exit the Control Panel.
	Stop/Start a Schedule
	EXTERNAL SWITCHER Configurations Only—Performing Forced Switches and Viewing Switcher Status
	Controlling Internal Digital Video Player
	Controlling the Internal Digital Video Recorder
	Select the digital video file recording parameters:
	a. Check the “Record CC data” box to capture any closed caption data from the source during recording.  Closed captions are hidden in the video signal and decoded for display on televisions with built-in decoders or televisions connected to external d...
	b. Select one of the following record overwrite options:
	c. Select the volume of the drive on which you would like to store the recorded file from the “Storage Device” drop down list.
	d. Under “File,” enter up to 27 characters (no spaces) for the filename.
	e. Select one of the user-defined record presets for the desired recording quality.  See “Configuring Digital Video Recording Presets,” on page 109, for more information on defining the recording quality settings.
	f. If you would like a library resource for the video file added to the “Library” tab window, select the “Add to library” option.  Once the digital video recorder stops, WinLGX displays the “Add to library” window (see Illustration 161).  Select the l...

	Start and stop recording through one of the following options:

	Monitoring a Video File Recording
	Controlling ePRO-BUS Record Devices

	Managing Storage of Video, SLIDE, and OVERLAY Files
	Choosing File Storage Devices
	Select one of the following to enable the display of the corresponding file type:
	The left side of the Storage Manager window allows you to access both your local and remote storage devices.  Select a storage device as follows:
	The right side of the Storage Manager window only allows you to access your UltraNEXUS-HD remote storage devices.  Refer to the remote storage device selection instructions in step 0, while noting the following for the “Background” folder:

	Managing All Digital Files
	Previewing Video Files
	Enabling and Authorizing Slides for Display in Slide Shows
	Creating a Default Slide
	1. The “admin” user must upload the slide into his “admin” user account folder (see the “Managing All Digital Files” on page 255).
	2. Right-click on the file and select “Rename” from the menu.  Change the slide filename to “Default.jpg.”
	3. Enable and approve the slide for display (see the “Enabling and Authorizing Slides for Display in Slide Shows” section on page 258).

	Creating & Managing Background SubFolders
	Transferring Graphic/Text Layers with Slides Created in a WebNEXUS Slide Editor
	5. Select both the slide’s .jpg and .fie files as follows: while holding down your keyboard’s “Ctrl” key, single click both the .jpg and .fie files to select the pair.  While still holding down the “Ctrl” key, right click to display the file managemen...
	6. From the file management menu (see Illustration 172), select either “Move” to remove the files from the storage device and transfer them to the storage device selected on the opposite side of the Storage Manager window or “Copy” to create a duplica...


	Retrieving Log Files
	Click on the “As played” tab on the “Select Controller Log File” window.
	Single click on the desired .CSV file to select it and then click “OK.”
	A “Save as Played log File” window will open.  Save the .CSV file to a new file path or use the WinLGX default log file path (Shared Documents\Leightronix\WinLGX\Controller Data\IP xxx.xxx.xxx.xxx\Log”).
	Click the “Save” button to save the file to your chosen file path.  The “Save as Played log File” and “Select Controller Log File” windows will close.
	Navigate to the file path for the saved .CSV file and open it in Excel.

	Updating Firmware/Software
	Updating UltraNEXUS-HD Server
	Open the WinLGX software and log in to your UltraNEXUS-HD system (see “Opening WinLGX and ” on page 162).
	Choose “Controller” under the “Tools” menu to open the “Controller” window shown in Illustration 177.
	Under “Firmware update,” click “Browse” to open the “Choose controller firmware file” window shown in Illustration 178.
	Navigate to and open the current .lpf file to update your UltraNEXUS-HD server’s firmware and, if needed, your web interface.  Once you have selected and opened the file, the “Select firmware options” window is displayed (see Illustration 179).  Leave...
	Click “Update” to continue the firmware update.  Click “Yes” when prompted to start the update.
	Once the update has completed, click “OK” to apply the changes and reboot the UltraNEXUS-HD server.  You will be logged out and the “Site Manager” window will be displayed.
	After the UltraNEXUS-HD system finishes rebooting, log back in and confirm the UltraNEXUS-HD system has been upgraded to the latest firmware version in the “Site Manager” database.

	Updating WinLGX Software
	Close WinLGX.
	Navigate to and open the WinLGX_vx.x.x.x_Installer.exe.  Follow the prompts to install the latest version of the client software.
	Click “OK” to continue WinLGX update.
	Follow the prompts to complete the installation.



	Web Control
	About this Section
	Opening and Logging into Web Interface
	Open the UltraNEXUS-HD web interface through one of the following steps:
	A login prompt will appear (see Illustration 181, Login Prompt).  Enter your username and password.
	“Site Information”
	“Storage”
	Video Player/Recorder Statuses
	“Network Settings”
	“Switcher Status”

	Managing Digital Video Files
	Setting Up Transfer Destinations
	“Verify Connectivity”: after entering your UltraNEXUS-HD’s IP address, username, and password, click the “Verify Connectivity” button to ensure your UltraNEXUS-HD can connect to the destination server.
	“Automatic Upload”: when selected, files will be automatically transferred to the specified UltraNEXUS-HD after each recording session.
	“Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours of the week your UltraNEXUS-HD will transfer files to your destination UltraNEXUS-HD.  Single click each hour segment on the timeline to toggle transfer capabilities ...
	“Enable Auto-Play CH”: once the “PEGcasting” option is enabled on the UltraNEXUS “Record Settings” tab (see “Setting up Video File Record ,” on page 279), you may choose to have a transferring file stream automatically begin playing on your second Ult...
	“Automatic Upload”: when checked, files will be automatically transferred to LEIGHTRONIX streaming video-on-demand site after each recording session.
	“Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours of the week your UltraNEXUS-HD will transfer files to your VieBit server.  Single click each hour segment on the timeline to toggle transfer capabilities on or off (g...
	1. “Verify Connectivity”: after entering your server’s IP address, username, and password, click the “Verify Connectivity” button to ensure your UltraNEXUS-HD can connect to the destination server.
	“Automatic Upload”: when checked, video files will be automatically transferred to the specified server after each recording session.
	“Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours of the week your UltraNEXUS-HD will transfer files to your destination server.  Single click each hour segment on the timeline to toggle transfer capabilities on or o...

	Setting up Video File Record Settings
	Recording
	Choose the video source you want to record from the “Source” drop down menu.  You may select one of your UltraNEXUS-HD’s player or a video source connected to your switcher.
	Click the record button to start recording your file.
	LEIGHTRONIX VieBit VOD Streaming Service Users Only: add video index points for use in LEIGHTRONIX VieBit VOD streaming application.  Index points appear as links next to the published video in the streaming application’s player window, allowing viewe...
	To end the recording session, click the stop recording button.  If a file destination was configured and enabled in WebNEXUS, your recorded file will be automatically transferred to the destination.

	Manually Transferring Digital Video Files

	Managing Log Files
	Save/Open a Log File
	Search a Log File
	Delete a Log File

	Managing Slides
	Uploading Slides to a UltraNEXUS-HD Server/Controller
	1. In the “File” list on the left hand side of the screen, single click on the user folder you want to contain the slide.
	Click the  button to open the upload file window shown in Illustration 193.
	Click the  browse button to open the “Select file(s)” window shown in Illustration 194.  Navigate to the desired file and click “Open.”
	WebNEXUS allows you to add and remove slides from the “Upload File” window as follows:
	Click the  upload button to load the slide(s) onto the UltraNEXUS-HD or “Cancel” to abort the change (see Illustration 195).  When each slide has finished loading, the “Upload File(s)” window will indicate the slide is “100%.”
	When you have finished uploading files, click the close “x” button in the upper right corner of the window.

	Creating New Slides
	Using the “Grid” menu options, set up your canvas grid and safe title/safe action guidelines to aid in slide layout:
	Add graphics and/or text to the slide editor’s canvas using the tools in the editor’s toolbox (see Illustration 197).  Each new graphic or text element will be automatically placed on a separate layer, allowing you to individually manipulate each imag...
	If desired, enhance individual graphic and/or text layers with graphic effects.  To apply an effect, first select a layer on the canvas with the cursor tool or by clicking on its layer in the “Layers” panel.  Change any of the following:
	When you have finished making changes, save your slide by clicking the  save icon or selecting the “File”/”Save” menu option.  The “Save Slide” window shown in Illustration 206 will appear, allowing you to add metadata to your slide that will control ...
	a. In the “File Name” field, type in a filename with up to 27 characters (no spaces).  If the filename already exists, a pop-up box will prompt you to either click “Ok” to overwrite the existing file or “Cancel” to enter a new filename on the “Save Sl...
	b. If you logged into WebNEXUS under an “admin” account or are using an account with the “slide administrator” or “automatic slide authorization” right, the “Authorize” box will be available for selection.  Authorize the slide for display in slide sho...
	c. Complete the remaining slide show metadata fields according to the instructions in “Adding Slide Show Settings to Slide Metadata,” on page 307, with the following exceptions:
	d. Click “Ok” to save or “Cancel” to abort.  The slide editor automatically saves a .jpeg and .fie file for each slide, where the .jpeg file is the actual slide and the .fie file contains the editable layers data for the slide.  The .fie files are onl...


	Creating a Default Slide
	Select the “admin” user folder in the “File” list.  Your UltraNEXUS-HD system will only look for a default slide in the “admin” user folder.
	Upload the slide you would like to serve as the default (see “Uploading Slides to a UltraNEXUS-HD Server/Controller,” on page 289).
	Rename the slide to “Default.jpg” (see “Renaming Slides on a UltraNEXUS-HD Server/Controller,” on page 311).
	Approve the slide for display (see “Approving Slides for Display in Slide Shows,” on page 309).

	Finding Slides/User Folders
	Adding Slide Show Settings to Slide Metadata
	Select the desired file in the “File” list to enable the metadata fields on the right side of the slide management screen (see Illustration 207, Slide Metadata Fields).  The following settings may be modified:
	Click the  button to save your slide metadata.  If you don’t click the “Save Metadata” button, your changes will be lost when you select a different slide or folder or close the slide management screen.
	If desired, enable and authorize the slide for display in slide shows according to “Approving Slides for Display in Slide Shows” on page 309.

	Approving Slides for Display in Slide Shows
	Editing Slides Created in WebNEXUS
	1. From the “JPEG Slide Management” screen, single click on the slide you wish to edit in the “File” list (see Illustration 209).  When selected, the slide will be highlighted in orange.
	If the selected slide can be modified in your slide editor, the “Edit” button will be enabled.  Click on the “Edit” button (see Illustration 209) to display your selected slide in the slide editor window for your system.
	Edit your slide with any of the formatting options described in the “Creating New Slides” section on page 292
	Save over your existing slide or save out your changes as a new slide with a different filename with up to 27 characters (no spaces) according to step 0 of the “Creating New Slides” section on page 305.

	Renaming Slides on a UltraNEXUS-HD Server/Controller
	Single click to select the desired file in the “File” list.
	Click  icon to open the rename window shown in Illustration 210.
	Enter up to 27 characters in the rename field.
	Click the “Ok” button to make the change or “Cancel” to abort.

	Deleting Slides from a UltraNEXUS-HD Server/Controller
	Select the desired file in the “File” list.
	Click the  icon.  A dialog box will appear asking whether or not you would like to delete the selected slide from the UltraNEXUS-HD server/controller.  Click “Yes” to make the change or “No” to abort.


	Creating Emergency and Overlay Messages
	Creating a New Emergency Message
	If you need to clear a previously entered emergency message, click the “New” button.
	Select a graphic overlay through one of the following methods:
	In the message box on the right, type a sequence of up to 12 pages of two-line messages, as shown in Illustration 215.  Move to each new line of text by pressing “Enter” on your keyboard.  These messages will appear in the lower third position of the ...
	On the “Options” panel shown in Illustration 216, complete the following steps:
	a. From the “Page Dwell Time” drop down list, select how many seconds you would like each page of messages to display on the overlay, starting with 8 seconds, skipping to 10, and then increasing in increments of 5 seconds, up to a total of 30 seconds....
	b. From the “Event Duration” field, choose to display your emergency message for up to 7 days, 99 hours, and 59 minutes or select the “Rest of day” field to display the overlay until midnight.  The message pages will continue cycling until the duratio...

	If you wish to save the message for reuse, click the “Save” button.
	If desired, activate the emergency message for display according to “Activating an Emergency Message,” on page 316.

	Activating an Emergency Message
	If you wish to display a saved emergency message, click on the “Saved Presets” tab and single click the desired message in the presets listing.  Otherwise, create a new message according to the steps in the “Creating Emergency and Overlay Messages” se...
	Click the “Activate” button to display the message.  The “System Status” panel on the “Emergency Messaging” screen indicates the message activation status for the MPEG player.

	Deactivating an Emergency Message

	Viewing Web Program Guide
	Viewing Program Guide within the Web Interface
	Click the “Program Guide” menu button to display a program guide screen like the example shown in Illustration 217.
	From the “Channel” drop down menu, click one of the channel outputs to only display the programming lineup for the selected channel or click “All Channels” to display the programming schedule for all WinLGX channel tabs.
	From the “Mode” drop down menu, select “Day” if you would like to view programming for just one day in your schedule (see Illustration 217) or choose “Week” to view programming for all seven days of your schedule (see Illustration 218).  If you choose...
	For the “Day” mode view, click on a day of the week to view programming for the corresponding weekday. If you selected “Week” mode, clicking a day button will sort your programming schedule by the selected day.
	If you wish to display the program start time down to the second, click the “Show Seconds” “on” button. The default option is “off.”

	Viewing Program Guide from a Web Browser or Your Own Website
	Click the “Program Guide” menu button to display your UltraNEXUS-HD’s program guide.
	Click the URL link on the “Program Guide” screen as shown in Illustration 219 to open your UltraNEXUS-HD program guide in a separate browser tab window.
	If necessary, edit the following variables (shown in red) in the web address to change the programming display:
	Distribute the web address as a link or with instructions to paste the address into the address bar of one of the supported web browsers.
	1. Click the UltraNEXUS-HD web interface’s “Program Guide” button to display the corresponding screen.
	To display the embed code, click on the “Embed Script” arrow (see Illustration 220).
	Drag your mouse cursor across the code to highlight and select it, then simultaneously press the “Ctrl” and “C” keys on your keyboard to copy the code.
	Paste the code onto one of your web pages by simultaneously pressing the “Ctrl” and “V” keys on your keyboard.
	If desired, customize the code for your website by editing the embed code variables as described below:
	Upload the web page with the embed code to your web server.  The embedded program guide will dynamically update to display your current program schedule.


	Using The Virtual Channel
	Overview
	1. If you have a new TOTAL INFO-HD subscription or just wish to take advantage of the free trial, you will need to submit the necessary location and contact information before you can display TOTAL INFO-HD content in your Virtual Channel playlists.  T...
	2. Refer to the following sections for playlist management instructions:
	3. Activate Virtual Channel playlists for display according to “Displaying Virtual Channel Playlists,” on page 338.

	TOTAL INFO-HD Configuration
	1. If you are not already on the Virtual Channel editor screen (see Illustration 221, Virtual Channel Editor), click on the “Virtual Channel” menu button.
	2. On the Virtual Channel editor screen follow the steps below to configure your TOTAL INFO-HD account.
	a. Click the “TOTAL INFO-HD Configuration” button (see Illustration 222).
	b. In the subscription configuration box (see Illustration 224), enter the following information:
	c. Click “Next” once you are satisfied with your settings or “Cancel” to abort.  Clicking “Next” will cause WebNEXUS to ask whether or not you would like to transmit your TOTAL INFO-HD activation information to LEIGHTRONIX.  Please read the TOTAL INFO...
	d. If you clicked “Accept,” a subscription information box will appear.  At this time, you have the option to select one or more data categories listed on the box and then click the “Add” button to immediately add the selected TOTAL INFO-HD content to...
	e. Click “Done” to close the last window in the TOTAL INFO-HD subscription configuration process.


	Creating/Modifying Virtual Channel Playlists
	1. If you are modifying an existing playlist, load it according to the corresponding set of steps below.  Otherwise, skip to step 2 on page 331.
	3. If any switcher input resources were added to the playlist, access each resource’s display duration setting by double clicking its length on the playlist window.  The resource’s length field will become active, allowing you to type a new length int...
	4. If any slide shows were added to your playlist, you may add or remove audio by clicking the “Advanced” button and then the “General” tab (see Illustration 228).  Any audio preferences you specify will apply to all slide shows.  From the “Background...
	5. Once you have finished creating or modifying your playlist, either continue to “Saving Virtual Channel Playlists” on page 335 to learn about the Virtual Channel Editor’s options for saving a playlist or click the “Current” button to add the resourc...

	Saving Virtual Channel Playlists
	1. Create the playlist according to “Creating/Modifying Virtual Channel Playlists,” on page 330.
	2. Save the playlist according to one of the following save options:
	3. If desired, immediately activate your Virtual Channel and display your playlist according to “Displaying Virtual Channel Playlists,” on page 338.

	Displaying Virtual Channel Playlists
	1. In your WinLGX schedule file (.nmg), be sure to do the following:
	a. Enable your Virtual Channel for use as WinLGX switchback resources by selecting “Yes” from the “Virtual Channel” drop down menu in the “System Configuration” properties (see “Configuring the Switch Type of an UltraNEXUS-HD,” on page 99).
	b. Perform any of the following to fill channel switchbacks on the first WinLGX channel output tab:


	Deleting Virtual Channel Playlist Files
	1. From the “Preset” drop down menu, select the playlist file you wish to delete.
	1. Click the  icon on the Virtual Channel toolbar.
	2. On the “Delete Preset” popup window, click “Yes” to delete the file or “No” to cancel the action and close the popup.
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	Appendix A: Copyright Statements
	The PHP License, version 5.3.4
	1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.
	2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the following disclaimer in the documentation and/or other materials provided with the distribution.
	3. The name “PHP” must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact group@php.net.
	4. Products derived from this software may not be called “PHP,” nor may “PHP” appear in their name, without prior written permission from group@php.net.  You may indicate that your software works in conjunction with PHP by saying “Foo for PHP” instead...
	5. The PHP Group may publish revised and/or new versions of the license from time to time. Each version will be given a distinguishing version number.  Once covered code has been published under a particular version of the license, you may always cont...
	6. Redistributions of any form whatsoever must retain the following acknowledgment: “This product includes PHP, freely available from <http://www.php.net/>”.
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